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Utility Billing Module

Overview

Open, Create or Final a UB customer account

The Account Master Search window (UB> Maintenance> Account) is used to open, create

or final a Utility Billing module customer account. The window will display customer records

with a UB module account and the UB customer accounts associated with each customer
record. Enter information into the Search Criteria section and click the Refresh icon to filter

the customers that display in the window. The customer records that are attached to a UB

module account and that match the search criteria will load in the window. Click the Expand

button next to each customer record to view the UB module accounts attached to a cus-
tomer record. Highlight a UB customer account and click the Modify icon to open the

account in the Account Master Maintenance window.

You can modify the lot and customer record information associated with a UB customer

account using the Account Master Maintenance window and the changes will update to the

entire database. You can also modify a customer record using the Customer window (Cus-
tomer icon on the main desktop) or the Lot window (Lot icon on the main desktop).

Changes to the Customer or Lot window will update all UB customer accounts attached to

the customer record or the lot.

Press INSERT to launch the New Account Wizard. The New Account Wizard is used to cre-

ate new UB module customer accounts.
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Highlight a UB module account (not the customer record) and press DELETE to final the

account. This will launch the Final Account Wizard and calculate the final billing on the UB

customer account.

New Account Wizard – Create a new account

Utility Billing customer accounts are created using the New Account Wizard. The New

Account Wizard can be launched from the Account Master Search window (UB> Main-
tenance> Account> Create icon ), or from the Final Account Wizard when a customer is

moving to a new lot. The New Account Wizard is used to select the connect date, the lot the

customer is moving into, the services and service rates on the account, create any service

requests to read or install devices on the account and charge any fee codes such as depos-

its or connections charges. If the customer already has a UB customer account, a new UB

customer account sequence number will be created. For example, if customer number

000001 already has UB customer account 000001-000, UB customer account 000001-001

will be created.

Depending on how the Utility Billing module is set up in the Setup window (UB> Utilities>

Setup), information attached to the previous UB customer account on the lot will populate

on the new UB customer account. For example, if the Copy All Services toggle is
checked, the services and service rates attached to the previous account on the lot will

copy to the new UB customer account on the lot.
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An account template can be selected during the first step of the New Account Wizard.

Account templates are used to add services, service rates, service requests or fee codes to

a new customer account. This reduces data entry and helps ensure that customer

accounts are created accurately because all of the standardized information on the

account template will populate in the New Account Wizard. Many Springbrook users create

an account template for each standard grouping of services/service rates (residential, com-

mercial, industrial or housing developments) that they generally add to new customer

accounts. Account Templates are created and maintained using the Account Template

Selection window (UB> Maintenance> Account Template).

Final Account Wizard

The Final Account Wizard is used to enter the final meter readings on a UB customer

account, enter the forwarding address of the final billing statement, calculate the final

billing on a UB customer account and change the status of the account to a Final status.

The Final Account Wizard can be launched from the Account Master Search window (UB>

Maintenance> Account> Select a UB customer account> DELETE key) or from the Final

Billing palette if you use final account service requests (UB> Final Billing> Final Accounts).

UB customer accounts will only display in the Final Accounts window (UB> Final Billing>

Final Accounts) if a final account service request has been closed and committed on the

UB customer account.

A final account service request is used to enter the final readings on the devices attached

to the UB account and enter the forwarding address on the final billing. The meter readings

and forwarding address entered on the final account service request will populate on the

Final Account Wizard when the UB customer account is finaled. Committing the final

account service request will not change the status of the UB account, it will only make the
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account available in the Final Accounts window (UB> Final Billing> Final Accounts) and

add the meter reading line items to the meter record. The UB customer account will change

to a Final status after the customer account has been processed in the New Account Wiz-

ard.

Depending on how the Utility Billing module is set up (UB> Utilities> Setup), the final billing

generated by the Final Account Wizard is either processed in UB> Final Billing or UB> New

Billing. If the Bill Finals with cycle toggle is checked on the Setup window (UB> Utilities>

Setup> Billing tab), the final billing for the account will be processed using the New Billings

process (UB> New Billings) when the billing cycle of the finaled account is billed. If the Bill

Finals with cycle toggle is not checked, the finaled account will be billed using the Final

Billing process (UB> Final Billing).

Service Requests

Service requests are used to track the services performed on a UB customer account such

as installing, removing or replacing a device on a UB customer account. Service requests

are created using the Service Request Input Wizard which can be launched from the

Account Master Maintenance window (UB> Maintenance> Account> Open an account>

Service Requests tab or Devices tab) or from the Service Requests window (UB> Service

Requests> Input).

The Service Requests palette is used to view, close, commit or print service requests. The

Service Request Input window (UB> Service Requests> Input) is used to create, view,

modify or close service requests.
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The Door Hangers window (UB> Service Requests> Door Hangers) is used to create door

hangers for service requests of a selected request date and service request code.

The Service Request Proof List Report (UB> Service Requests> Proof List) will display act-

ive and/or closed status service requests filtered by request date, service date, billing cycle

and service request code. If closed status service requests are included on the report, both

committed and uncommitted service requests will display on the report.

The Service Requests window (UB> Service Requests> Service Requests) is used to print

a filtered list of active and/or closed status service requests. Service requests that have

been committed (UB> Service Requests> Commit) will display on the report if you include

closed status service requests. Each service request included in the report will display on a

separate page with space for the technician to manually enter comments and information

on the report. Service requests can also be printed during the last step of the Service

Request Input Wizard.

The Commit step (UB> Service Requests> Commit) is used to commit closed service

requests. Meter readings attached to service requests will post to the meter history when

the service request is committed.

Meter/Device Overview

In order to create a meter or device, you must first create a device type. There is a separate

maintenance window for each type of device that can be created in the Utility Billing mod-

ule.
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The device type determines the generic device information of a device, such as unit type,

reading and consumption multipliers/divisors, number of usage periods, bill type and

default service request codes. Most Springbrook customers create a device type for each

device model they install on UB customer accounts. The most important information on the

device type is the bill type. The bill type attached to a meter determines the service rates

used to bill the consumption on that meter.

After a device type has been created, a meter can be created using that device type from

either the Device Maintenance window (UB> Maintenance> Device) or using a service

request. Service requests are used to install, remove or read the meters on a customer

account and are created using the Service Request Input Wizard. The Service Request

Input Wizard allows you to create devices on the fly or select a device that has been cre-

ated using the Device Maintenance window. Devices created using a service request will

be in pending status until the service request has been committed. You will not be able to

modify the information of a device in pending status. If the service request that created the

device is deleted, the device record will be deleted.

Meter Management

The Meter Management palette (UB> Meter Management) is used to import or manually

input the meter readings on devices. The Meter Management palette is generally used to

enter the meter readings on an entire read route. If you would like to enter a meter reading

on a single meter, you can enter it using either the Account Master Maintenance window

(UB> Maintenance> Account> Open an account> Devices tab> Open a device> Con-

sumption tab) or by creating a read device service request using the Service Request Input

Wizard.
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The Input New (UB> Meter Management> Input New) and Edit (UB> Meter Management>

Edit) selections are used to manually enter and edit meter readings. If you manually import

meter readings using a handheld device, you probably will not use these palette options.

The Meter Management Proof List (UB> Meter Management> Proof List) is used to verify

that the current meter readings have been input correctly on customer accounts. Run this

report after meter reads have been manually input (UB> Meter Management> Input New)

or imported (UB> Meter Management> Readings Import).

The Meter Change-Out Report (UB> Meter Management> Change Out) displays a list of

meters that have been replaced using a meter change-out service request. The report will

display the device that has been removed and the new device that was installed on the cus-

tomer account.

The Meter Misread Report (UB> Meter Management> Misread Reports) displays meters

that have an unexpectedly high or low consumption level.  The report will compare the con-

sumption on a current meter reading to the consumption of the meter reading of the same

read period in the previous year and then calculate a variance percentage. If the variance

percentage is greater than a user-defined amount, the device will display on the report.

The Unread Meters Report (UB> Meter Management> Unread Meters) displays a list of

meters that were not read during a specific date range using the meter read date.
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Meter Sheets Report (UB> Meter Management> Meter Sheets) is list of meters filtered by

meter read route and is used to manually record meter readings. You probably will not use

this report if meter readings are imported from handheld devices.

The Export window (UB> Meter Management> Readings Export) is used to export meter

information from the application to a handheld device in order to enter meter readings. The

Import window (UB> Meter Management> Readings Import) is used to import the meter

readings from a handheld device into the application. You will only use these options if you

enter meter readings using handheld devices.

Services, Service Rates, Bill Types

When charges are generated on UB customer accounts, the charges must be grouped

onto a service. A service represents a unique balance on the customer account and the bal-

ance of each service will display separately on billing statements. For example, all water

service charges are billed using the WATER service. Charges related to other services,

such as ELECTRIC or CONNECTION, will display separately. Since the total balance of a

UB customer account is divided into separate services, you can have a credit balance in

one service and a debit balance in another. Use the Redistribute Credit Balances process

(UB> Adjustments and Fees> Redistribute Credit) to redistribute a credit balance on a ser-

vice to services with a debit balances.

Service rates are attached to customer accounts and determine the rate structure, winter

average, taxes, bill type and prorating options of a billing. The service rate will calculate

charges on the consumption on meters with the same bill type and the charges will be

billed to the service attached to the service rate.
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There are no units of measure (gallons, cubic feet, etc.) attached to the service rate. When

a billing is generated the service rate will be applied to the consumption as it was read on

the meter. For example, if there were 100 units of consumption read on the meter during

the billing period, then the service rate will be applied to the 100 units regardless of the

type of unit the meter was reading (gallon, cubic feet, etc.). If there are meters of multiple

unit types in the same billing batch, or if the consumption should be converted to another

unit type as the billing is being calculated, you can convert the consumption read on the

devices to another unit type using the consumption conversion table (UB> Maintenance>

Consumption Conversion).

Bill types are used to link the consumption on a meter to a service rate on an account.

When a billing is generated the consumption on a meter will be billed using the service

rates attached to the UB customer account with the same bill type. Bill types are attached

to service rates (UB> Maintenance> Service Rates> Open a service rate> General tab>

Bill Type field) and device types (UB> Maintenance> Select a device type> Open a device
type> General tab> Bill Type field).

Bill a customer – New Billing

The New Billing process is used to calculate charges on UB customer accounts in a selec-

ted billing cycle and generate the billing statements.  The bills will be calculated based on

the Billing tab of the UB Setup window (UB> Utilities> Setup> Billing tab), the service rates

attached to the customer accounts in the batch, and the bill types attached to the meters on

those accounts.
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When new bills are generated (UB> New Billing> Generate), there is a Convert Con-
sumption To drop-down menu that allows you to convert the consumption read on the
meters to a different unit type. The consumption will be converted to the unit type using the

conversion formula set up in the conversion table (UB> Maintenance> Consumption Con-

version), and the service rate will be applied to the modified consumption on the meter. For

example, if the consumption was read in cubic feet and changed to gallons, the con-

sumption read on the meter (100) will be multiplied by the conversion amount (7.48000)

and then the service rate will be applied to the modified consumption amount (748).

The statements generated by the New Billing process are created and maintained using

the Statement Setup Maintenance window (UB> Utilities> Statement Setup). The billing

address attached to the UB customer accounts being processed in the billing batch can be

verified using the address certification process. The address certification process will verify

the accuracy of the addresses in the batch and prepare the statements for a bulk mailing.

Final Billing

The Final Billing Palette is used to create the final billing statement for UB customer

accounts that have been processed using the Final Account Wizard. This process also

allows you to run the Final Account Wizard on UB customer accounts that have been pro-

cessed using a final account service request.

The Final Billing palette is an optional palette and will only be used by organizations that do

not process final bills in the New Billing palette. The final bills are set up to be processed in

the New Billing batch using the Setup window (UB> Utilities> Setup> Billing tab> Bill finals
with cycle toggle).
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Adjustments and Fees

The Adjustments and Fees palette is used to create adjustments, miscellaneous billings

and redistribute credit balances on customer accounts.

The Bill a Service Request window (UB> Adjustments and Fees> Bill Service Requests) is

used to bill a UB customer account for a closed and committed service request. Some

organizations charge for certain types of service requests such as the installation of a new

device. To create a billable service request, create a service request code (UB> Main-

tenance> Service Request Code) that is attached to a fee code. The fee code will determ-

ine the billable amount and the general ledger accounts used to create the journal entry

when the service request is billed. The fee code will also display on the billing statement

line item as the description of the charge.

The Miscellaneous Charges window is used to create a billing on all Active status UB cus-

tomer accounts within selected billing cycles based on an adjustment type code. The billing

will default to the flat amount attached to the fee codes of the selected adjustment type, but

you can modify the billing from the default amount.

Additional billings can be created on UB customer accounts using the Input Billings window

(UB> Adjustments and Fees> Input). This window allows you to create billings using fee

codes or the service rates attached to a UB customer account.

Past Dues and Collections
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The Past Due process allows you to pull UB customer accounts into a Past Dues batch

based on billing cycle, age of outstanding transactions and customer account status. Once

customer accounts have been included in a Past Dues batch, penalties are assessed using

an adjustment type code.

The Collections process is used to write off the balance of selected UB customer accounts

and will create an adjustment type transaction on the accounts. The Generate step (UB>

Collections> Generate) of the process is used to select the customer accounts to process

in the batch. The balance of the customer accounts will be written off using the general

ledger accounts attached to the service rates and fee codes being written off. The Col-

lections adjustment type code (UB> Utilities> Setup> General tab> Collections Adjust-
ment Type field) determines which general ledger accounts attached to the service rates
and fee codes on the customer accounts will be used in the journal entry created by the Col-

lections process. The collections adjustment type code will also display on the transaction

line item created on the customer account.

Refunds

The Refunds process is used to refund the credit balance and/or deposit amounts on UB

customer accounts. The Refunds process also allows you to factor interest on deposit

amounts.

Winter Averaging
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The Winter Averaging process is used to calculate an average consumption for UB cus-

tomer accounts based on the consumption during selected meter read periods and meter

reading dates. Depending on how the service rates attached to the UB customer accounts

are set up, the calculated average consumption is billed instead of the actual consumption

when bills are generated in the New Billing process (UB> New Billing). If there is a min-

imum amount or tax attached to a service rate included in the winter average, the minimum

and tax amounts will bill as usual. The calculated winter average will only replace the bil-

lable consumption on the customer account.

Security

Security can be set up on the Utility Billing module using database or menu security.

Database security (SS> Security> DB Security) is application wide security placed on a

specific field in the database. For example, if you would like to restrict access to the social

security number on customer records, you can set up security on the SSN field of the Cus-

tomer table. All windows that display the social security number will be affected by the

security set up on that field.

Menu security (SS> Security> Menu Security) is security placed on a palette menu option.

For example, if a user should have not have access to the Consumption Conversion Main-

tenance window (UB> Maintenance> Consumption Conversion), you can restrict a user

from opening that window using menu security.
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Utility Billing Module

Where do I…
This document lists some common Utility Billing module tasks and where you would go to

complete them.

What you want to do Where to do it

Where can I see all of

the accounts attached to

a customer record?

The Customer window (click the Customer icon on the main

desktop) will display all of the accounts attached to a customer

record, including accounts set up in other modules like the

Accounts Receivable module.

Open the Account Master Search window (UB> Maintenance>

Account) if you would only like to view the UB module accounts

attached to a customer.

What is the balance on a

UB customer account?

You can view the balance of a customer account using the

Overview tab of the Account Master Maintenance window

(UB> Maintenance> Account> Open an account). The Over-

view tab bill display the balance forward of each service on the

customer account.

What is the consumption

on a meter?

You can view the consumption on a meter using either the

Device tab on the Account Master Maintenance window (UB>

Maintenance> Account> Open an account> Devices tab>

Meter History sub-tab) or the Consumption tab on the Device

Maintenance window (UB> Maintenance> Device> Open a

device> Consumption tab).
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How can I reprint a billing

statement?

All of the reports generated in the application are archived on

the application server, including the bills generated in the New

Billing process. The billing statements are saved by batch num-

ber at: \\server path\version folder (for example, v7.10)\d-

b\select a database slot (Springbrook0-9)

\archive\Reports\year the statements were generated\UB\New

Billing\.Use the View Reports window to locate and reprint the

billing statements.

How do I create a new

UB customer account?

UB customer accounts are created using the New Account Wiz-

ard. The New Account Wizard is launched by pressing INSERT

on the Account Master Search window (UB> Maintenance>

Account). .

How do I final an

account?

UB customer accounts are finaled using the Final Account Wiz-

ard. The Final Account Wizard will calculate the final billing on

a customer account and set up the forwarding address where

the final billing will be sent. The Final Account Wizard is

launched by selecting the account to final and pressing

DELETE on the Account Master Search window (UB> Main-

tenance> Account).

How do I add/re-

move/change-out a

meter on an account?

Services are performed on a customer account using a service

request. Service requests are created using the Service

Request Input Wizard which can be launched from the Account

Master Maintenance window (UB> Maintenance> Account>

Service Requests tab, or Devices tab), or from the service

request input window (UB> Service Requests> Input).

How do I adjust a billing? You can adjust a billing that has been committed using the

Adjustment Input Wizard. The Adjustment Input Wizard is
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launched from the Adjustments and Fees palette (UB> Adjust-

ments and Fees> Input> Select Adjustment in the Create icon

drop-down menu), and can be used to create adjustments on

billings, payments and consumption.

Where do I enter a meter

reading?

A single meter reading can be entered manually using the

Device Maintenance window (UB> Maintenance> Device>

Open a device> Consumption tab), or can be entered using a

read device service request (). You can also enter the meter

readings on an entire meter route using the Input New Meter

Readings window (UB> Meter Management> Input New), or

you can import meter readings from a file using the Meter

Readings Import window (UB> Meter Management> Readings

Import).

How do I adjust a meter

reading?

You can adjust a billed meter reading and create an adjust-

ment on the account using the Adjustment Input Wizard (UB>

Adjustments and Fees> Input> Select Adjustment from the

Create icon drop- down menu), or you can adjust an unbilled

meter reading using the Device Maintenance window (UB>

Maintenance> Device> Open a device> Consumption tab). If

you adjust the meter reading using the Device Maintenance

window, you will not create an adjustment on the account.

When the billing is generated, the customer will be billed the

modified amount.

When does a customer

account bill?

Determine which billing cycle the customer account is attached

to using the Account Master Maintenance window (UB> Main-

tenance> Account> Open an account> Account tab> Account

sub-tab> Billing Cycle field). Determine the next billing date
using the Billing Cycle Maintenance window (UB> Main-
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tenance> Cycle Code> Select a billing cycle> Add the Days in
Period field to the Period End Date field).

How do I receive pay-

ment on an UB customer

account?

All payments are received using the Cash Entry window in the

Cash Receipts module.

I received an error mes-

sage saying that the

meter I was trying to

modify had a pending

status. How do change it

to an active status?

Meters will have a pending status until the service request to

install the meter on the account has been closed and com-

mitted. Close the service request using the Input window (UB>

Service Requests> Input), and then commit the service

request using the Commit window (UB> Service Requests>

Commit).
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UB> Maintenance> Bill Type

Bill Type Summary

Summary

Bill types determine what service rate will be used to bill the consumption on a meter.

When a bill is generated on a customer account, the consumption on a meter will be billed

using the service rate with the same bill type as the meter. If there are multiple service

rates on the customer account with the same bill type, all of the service rates will apply. Bill

types do not apply to non-meter devices such as backflow devices.

Most organizations will create a single bill type for each kind of device (water, gas, electric,

etc.) that will be billed. The primary advantage of creating multiple bill types for each kind of

device is to add another grouping level to the service rates of each service. For example, if

you already have 20 services and you would like to create another grouping of service

rates, you can create that grouping using bill types. If you create two water meter bill types

and assign those bill types to the service rates of the water service (since the service is not

attached to the bill type, you can do this for any service), you have created a sub-grouping

of service rates inside the water service rates.

The Bill Type of a Device
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A bill type is not directly attached to a specific device; the bill type is attached to a device

type and then the device type is attached to the device. The meter readings and con-

sumption on that device are then associated with the bill type that was set up on the device

type record.

A device type record represents a unique manufacturer and model of a device and is used

to store the meter size and consumption/reading multipliers of a group of devices. A bill

type is attached to a device type record in the Device Type Maintenance window (UB>

Maintenance> Device Type> Open a device type> General tab> Bill Type field). All
devices that are attached to the device type will be assigned the same bill type and only

one bill type can be attached to a device type.

When a device is created using a service request or the Device Maintenance window (UB>

Maintenance> Device), a device type is attached to the device. The bill type on the device

type is then associated with the device and the meter readings and consumption on that

device are attached to the bill type on the device type.

The Bill Type of a Service Rate

Bill types are attached directly to service rates (UB> Maintenance> Service Rates> Open a

service rate revision> General tab> Bill Type field) and are not associated with services.
Because bill types are not attached to services, you can attach the service rates of multiple

services to a single bill type. This allows you to bill the consumption of a single meter using

the service rates of multiple services.
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For example, if the consumption of a water meter should bill both the WATER service and

the WASTE WATER service, then a service rate attached to the WATER and WASTE

WATER service should be set up with the same bill type as the meter you would like to bill.

If the meter has a bill type ofWater, then create a service rate with theWater bill type in

both the WATER and WASTE WATER service.

When the customer account is billed

When a customer account is billed, the billing engine will link all of the service rates

attached to the customer account to the devices with the same bill type. If there are mul-

tiple service rates attached to the same bill type, all of those service rates will be billed.

If the service attached to the service rate is not included in the billing (services are selected

during the Generate step of UB> New Billing), the service rate will not be included in the

billing. If the service rate has the same bill type as a device, then the consumption on that

device will not be included in the billing. If there are multiple service rates with the same bill

type as the device, then all of the service rates included in the billing will apply.
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Utility Billing Module

Billing Export File Formats

Summary

There are seven Springbrook Billing Export file formats. All files are comma-delimited and it

is recommended to save them as a text file (.txt) or a comma-separated list (.csv).

Click the drop-down arrow next to a billing export file format below to view the export con-

tents.

ss_mailer

Sort Field Name Data Type Description

0 SS Mailer ID Character
The unique identifier for each SS_Mailer

row

1 Recipient Character Full name of recipient of bill

2 Address 1 Character Recipient’s Address Line 1

3 Address 2 Character Recipient’s Address Line 2

4 Address 3 Character Recipient’s Address Line 3

5 Address 4 Character Recipient’s Address Line 4

6 Address 5 Character Recipient’s Address Line 5
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Sort Field Name Data Type Description

7 City Character Recipient’s City

8 State Character Recipient’s State

9 Zip Character Recipient’s Zip code

10 Certified Logical ‘Yes’ if address has been certified

11 Barcode Character Barcode of Zipcode

12 Sort Character Sort Order

13 Tray Character Tray size

14 Package Character Package Dimensions

15 Piece Character Parcel Piece

16
Customer Num-

ber
Integer Customer Number

17
Customer

Sequence
Integer Customer Sequence

18
Vendor Num-

ber
Character Vendor’s Number

19
Account Num-

ber
Integer Recipient’s Account Number

20
Bill-To Cus-

tomer Number
Integer Recipient’s Customer Number

21 Index 1 Character Misc Index field

22 Index 2 Character Misc Index field

23 Character 1 Character Statement Name

24 Character 2 Character

Statement “Copy” info – displays “Tenant

Copy”, “Owner Copy”, or “Copy” if applic-

able and turned on in settings.
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Sort Field Name Data Type Description

25 Integer 1 Integer Misc Integer field

26 Integer 2 Integer Misc Integer field

27 Decimal 1 Decimal Misc Decimal field

28 Decimal 2 Decimal Misc Decimal field

29 Date 1 Date Misc Date field

30 Date 2 Date Misc Date field

31 Logical 1 Logical Misc Logical field

32 Logical 2 Logical Misc Logical field

33
SS Mailer

Header ID
Character Internal use

34 Endorsement Character
If address has been Certified, displays Cer-

tification Endorsement

35
Bill-To Mes-

sage
Character

Unique Message for the specific Bill-To

Customer

36
Use Alternate

Address
Logical Use Alternate Address?

37 Import Info Character Misc Import Info

38
Intelligent

Mailer ID
Character Post Office IMID

39 Last Date Date Internal Use

40 Last Time Integer Internal Use

41 Last User Character Internal Use

42 Last Func Character Internal Use

ub_statement_amt
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Sort Field Name Data Type Description

0
UB Statement

AMT ID
Character

Unique Identifier for

each AMT Row

1
Service Num-

ber
Integer Service Number

2
Beginning Bal-

ance

Decimal

(9,999,999,999.99)

Balance after previous

billing

3
Payments This

Period

Decimal

(9,999,999,999.99)

Payments applied to

account since last billing

4
Adjustments

This Period

Decimal

(9,999,999,999.99)

Adjustments applied to

account since last billing

5
Additional This

Period

Decimal

(9,999,999,999.99)

Any additional (or

manual) Billing charges

incurred since last

billing.

6
Current

Charges

Decimal

(9,999,999,999.99)

Charges incurred for the

current billing batch.

7 End Balance
Decimal

(9,999,999,999.99)

Total Amount Due – cal-

culated as Beginning

Balance – Payments +

Adjustments + Addi-

tional + Current

Charges

8
UB Statement

MST ID
Character

Unique identifier to tie

each DTL line to the

respective MST line.
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Sort Field Name Data Type Description

9
Decimal Mis-

cellaneous 1

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

10
Decimal Mis-

cellaneous 2

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

11
Decimal Mis-

cellaneous 3

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

12
Decimal Mis-

cellaneous 4

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

13
Character Mis-

cellaneous 1
Character

Extra character field for

Miscellaneous use

14
Character Mis-

cellaneous 2
Character

Extra character field for

Miscellaneous use

15
Character Mis-

cellaneous 3
Character

Extra character field for

Miscellaneous use

16
Character Mis-

cellaneous 4
Character

Extra character field for

Miscellaneous use

17 Last Date Date Internal Use

18 Last Time Integer Internal Use

19 Last User Character Internal Use

20 Last Function Character Internal Use

ub_statement_bill_display
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Sort
Field
Name

Data Type Description

0 Amount
Decimal

(9,999,999,999.99999)
Balance of display line

1
Display

Order
Integer (99)

Display order on the UB

Statement for the amount

listed

2 Last Date Date Internal Use

3
Last Func-

tion
Integer Internal Use

4 Last Time Character Internal Use

5 Last User Character Internal Use

6 Text

Text for the amount listed

("Previous Balance",

"Adjustments", etc)

7

UB State-

ment Bill

Display ID

Character
Unique Identifier for each

Bill Display ID

8

UB State-

ment

Master ID

Character

Used to join to Master

record; each Bill Display

record joins to a MST

record

9 ID Integer (99)
Unique Identifier for each

Bill Display ID

ub_statement_cns
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Sort Field Name Data Type Description

0
UB Statement

CNS ID
Character

Unique Identifier for

each CNS row

1 Period Integer (99)

Period (usually the

Month) that the con-

sumption was recor-

ded

2 Month Integer (99)

Month that the con-

sumption was recor-

ded

3 Consumption
Decimal

(9,999,999,999.99999)

Consumption for the

current line’s month

4
Prior Year Con-

sumption

Decimal

(9,999,999,999.99999)

Previous Year’s con-

sumption for the

respective month

5 Bill Type Character

Type of Billed Charge

(Usually tied to a ser-

vice number)

6 Index Character

Miscellaneous Index

Field (sometimes

used for sorting)

7
UB Statement

MST ID
Character

Unique identifier to tie

each DTL line to the

respective MST line.

8
Decimal Mis-

cellaneous 1

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use
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Sort Field Name Data Type Description

9
Decimal Mis-

cellaneous 2

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

10
Decimal Mis-

cellaneous 3

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

11
Decimal Mis-

cellaneous 4

Decimal

(9,999,999,999.99

Extra decimal field for

Miscellaneous use

12
Character Mis-

cellaneous 1
Character

Extra character field

for Miscellaneous use

13
Character Mis-

cellaneous 2
Character

Extra character field

for Miscellaneous use

14
Character Mis-

cellaneous 3
Character

Extra character field

for Miscellaneous use

15
Character Mis-

cellaneous 4
Character

Extra character field

for Miscellaneous use

16 Last Date Date Internal Use

17 Last Time Integer Internal Use

18 Last User Character Internal Use

19 Last Function Character Internal Use

20
Target Con-

sumption

Decimal

(999,999,999,999.00)

ub_statement_dtl
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Sort Field Name Data Type Description

0
UB Statement

DTL ID
Character

Unique Identifier for the

UB_Statement_DTL

file.

1 Code Character

Indicates the type of line

or charge (Flat, Con-

sumption, Meter, or

Budget)

2
Service Num-

ber
Integer Service Number

3 Service Code Character
Charge Code for this

service

4 Tax Code Character Tax code for this service

5 Fee Code Character
Fee Code for this ser-

vice

6 Description Character
Description of charges

incurred

7 Amount Decimal Amount Billed

8 Bill Type Character

Type of Billed Charge

(Usually tied to a ser-

vice number)

9
Transaction

Date
Date

Date transaction was

incurred

10
Transaction

Type
Character

Type of Transaction

(Adjustment, Payment,

Billing, Deposit, Refund)

11 Transaction ID Integer ID which uniquely ties
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Sort Field Name Data Type Description

(9,999,999,999)

each Bill Detail to it’s

respective History

record.

12
Number of

Units
Decimal (999.99)

Number of Dwelling

Units from the

13 Route Number Character Route Number of Meter

14
Sequence Num-

ber
Character

Sequence Number of

Meter

15 Serial Number Character Serial Number of Meter

16 Prior Read Date Date
Date of Previous Meter

Read

17 Read Date Date
Date of Current Meter

Read

18 Prior Reading Integer Previous Meter

19 Reading Integer Current Meter

20 Consumption Integer Meter Consumption

21
Billable Con-

sumption
Integer

Amount of Consumption

that is billable

22
Percent of

Period
Decimal

Percent of Period for the

Meter Read

23
UB Statement

MST ID
Character

Unique identifier to tie

each DTL line to the

respective MST line.

24 Index Character

Misc Character field,

sometimes used for sort-

ing.
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Sort Field Name Data Type Description

25 Current Charge Logical

Used to distinguish Cur-

rent Billing Charges

from other charges

incurred on account

between billings –

“TRUE” if current.

26 Estimated Read Logical

TRUE if the reading was

estimated, FALSE if it

was an actual reading.

27
Decimal Mis-

cellaneous 1

Decimal

(9,999,999,999.99)

Extra decimal field for

Miscellaneous use. For

Past Due Statement

files, contains penalty

amounts.

28
Decimal Mis-

cellaneous 2

Decimal

(9,999,999,999.99)

Extra decimal field for

Miscellaneous use. For

Past Due Statement

files, contains past due

amount used to cal-

culated penalty

amounts.

29
Decimal Mis-

cellaneous 3

Decimal

(9,999,999,999.99)

Extra decimal field for

Miscellaneous use

30
Decimal Mis-

cellaneous 4

Decimal

(9,999,999,999.99)

Extra decimal field for

Miscellaneous use

31
Character Mis-

cellaneous 1
Character

Extra character field for

Miscellaneous use
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Sort Field Name Data Type Description

32
Character Mis-

cellaneous 2
Character

Extra character field for

Miscellaneous use

33
Character Mis-

cellaneous 3
Character

Extra character field for

Miscellaneous use

34
Character Mis-

cellaneous 4
Character

Extra character field for

Miscellaneous use

35
Date Mis-

cellaneous 1
Date

Extra date field for Mis-

cellaneous use

36
Date Mis-

cellaneous 2
Date

Extra date field for Mis-

cellaneous use

37
Date Mis-

cellaneous 3
Date

Extra date field for Mis-

cellaneous use

38
Date Mis-

cellaneous 4
Date

Extra date field for Mis-

cellaneous use

39
Logical Mis-

cellaneous 1
Logical (Boolean)

Extra Logical field for

Miscellaneous use

40
Logical Mis-

cellaneous 2
Logical (Boolean)

Extra Logical field for

Miscellaneous use

41 Last Date Date Internal Use

42 Last Function Character Internal Use

43 Last Time Integer Internal Use

44 Last User Character Internal Use

ub_statement_mst
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Sort Field Name Data Type Description

0
UB Statement

MST ID
Character

Unique Identifier for each

UB_Statement_MST row

– used to join with CNS,

AMT, and DTL tables.

1
Customer Num-

ber
Integer (999999)

This combined with Cus-

tomer Sequence create

the unique identifier for

each customer, and is

used as the main Account

Number. Also used to join

to the SS_Mailer table.

2
Customer

Sequence
Integer (999)

Sequence after the Cus-

tomer Number to create a

unique identifier for each

customer. Also used to

join to the SS_Mailer

table.

3
Customer Full

Name
Character

First Name, Middle

Name, Last Name

4
Service

Address
Character

Address for which service

is given

5 Connect Date Date Date Account is activated

6 Final Date Date Date Account is turned off

7 Period Begin Date
Beginning of current Ser-

vice Period

8 Period End Date End of Current Service
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Sort Field Name Data Type Description

Period

9 Billing Date Date Date of Current Billing

10 Due Date Date Date Bill is due to be paid

11
Statement Mes-

sage
Character Payment Message

12 Message 1 Character
Standard Message 1 for

all customers in batch

13 Message 2 Character
Standard Message 2 for

all customers in batch

14
Beginning Bal-

ance

Decimal

(9,999,999,999.99)

Balance after previous

billing

15
Balance For-

ward

Decimal

(9,999,999,999.99)

Balance Forward on

Account

16
Payments This

Period

Decimal

(9,999,999,999.99)

Payments applied to

account since last billing

17
Adjustments

This Period

Decimal

(9,999,999,999.99)

Adjustments applied to

account since last billing

18
Additional This

Period

Decimal

(9,999,999,999.99)

Any additional (or

manual) Billing charges

incurred since last billing.

19
Current

Charges

Decimal

(9,999,999,999.99)

Charges incurred for the

current billing batch.

20 End Balance
Decimal

(9,999,999,999.99)

Total Amount Due – cal-

culated as Beginning Bal-

ance – Payments +
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Sort Field Name Data Type Description

Adjustments + Additional

+ Current Charges

21 Refund Amount
Decimal

(9,999,999,999.99)

Amount to be Refunded

22 CR_Barcode Character

Cash Receipts Payment

Barcode, usually dis-

played in Code 39 font.

23 OCR_Scanline Character

OCR Scanline for Pay-

ment receipts. Displayed

in OCRA – EXT font.

24 Hold Status Character

Displays if bill should be

printed or held – “Hold”,

or “No Hold”.

25
Character Mis-

cellaneous 1
Character

Extra character field for

Miscellaneous use

26
Character Mis-

cellaneous 2
Character

Extra character field for

Miscellaneous use

27
Character Mis-

cellaneous 3
Character

Extra character field for

Miscellaneous use

28
Character Mis-

cellaneous 4
Character

Extra character field for

Miscellaneous use

29
Character Mis-

cellaneous 5
Character

Extra character field for

Miscellaneous use

30
Character Mis-

cellaneous 6
Character

Extra character field for

Miscellaneous use

31 Character Mis- Character Extra character field for
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Sort Field Name Data Type Description

cellaneous 7 Miscellaneous use

32
Character Mis-

cellaneous 8
Character

Extra character field for

Miscellaneous use

33
Character Mis-

cellaneous 9
Character

Extra character field for

Miscellaneous use

34
Character Mis-

cellaneous 10
Character

Extra character field for

Miscellaneous use

35
Decimal Mis-

cellaneous 1

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

36
Decimal Mis-

cellaneous 2

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

37
Decimal Mis-

cellaneous 3

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

38
Decimal Mis-

cellaneous 4

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

39
Decimal Mis-

cellaneous 5

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

40
Decimal Mis-

cellaneous 6

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

41
Decimal Mis-

cellaneous 7

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

42
Decimal Mis-

cellaneous 8

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

43
Decimal Mis-

cellaneous 9

Decimal

(9,999,999,999.99)

Extra decimal field for Mis-

cellaneous use

44 Decimal Mis- Decimal Extra decimal field for Mis-
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Sort Field Name Data Type Description

cellaneous 10 (9,999,999,999.99) cellaneous use

45
Meter

Exchanged
Character

If a meter was changed

out during the period, this

field will say “METER

CHANGE OUT”

46
Final Billing

Statement
Character

If this is the Final state-

ment for this account, this

field will say “FINAL BILL”

47 Auto Pay Character

If the customer is setup

for auto-pay, this field will

say “AUTO PAY”

48 Index Character

Miscellaneous Index

Field (sometimes used

for sorting)

49 Report Logo Character
Report Logo – Internal

link to logo

50 System Code Character

Code to indicate if the

batch is a New or Final

Billing Batch (New =

“UB3”, Final = “UB2”)

51 Batch Year Integer Year of Batch Creation

52 Batch Month Integer Month of Batch Creation

53 Batch Number Integer Number of Batch

54
Date Mis-

cellaneous 1
Date

Extra date field for Mis-

cellaneous use

55 Date Mis- Date Extra date field for Mis-
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Sort Field Name Data Type Description

cellaneous 2 cellaneous use

56
Date Mis-

cellaneous 3
Date

Extra date field for Mis-

cellaneous use

57
Date Mis-

cellaneous 4
Date

Extra date field for Mis-

cellaneous use

58 Last Date Date Internal Use

59 Last Time Integer Internal Use

60 Last User Character Internal Use

61 Last Func Character Internal Use

62
Total Amount

Due
Decimal

Total Amount due Cal-

culated as Beginning Bal-

ance – Payments +

Adjustments + Additional

+ Current Charges

ub_statement_tier

Sort Field Name Data Type Description

0
UB Statement

TIER ID
Character

Unique Identifier for

each TIER row

1
UB Statement

DTL ID
Character

Used to join to DTL

record; each TIER

record joins to a DTL

2 Cons Level Integer (99) Consumption level for
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Sort Field Name Data Type Description

tiered cons billing

3 Consumption
Decimal

(9,999,999,999.99999)

Consumption for the

current line’s month

4 Amount
Decimal

(9,999,999,999.99999)
Amount Billed

5
Character Mis-

cellaneous 1
Character

Extra character field

for Miscellaneous use

6
Character Mis-

cellaneous 2
Character

Extra character field

for Miscellaneous use

7 Last Date Date Internal Use

8 Last Time Integer Internal Use

9 Last User Character Internal Use

10 Last Function Character Internal Use
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Utility Billing Module

Direct Debits Overview

Summary

UB Direct Debits is a premium feature. Please contact Springbrook Support for information

on Premium Features.

The Direct Debit process in the Clearing House module (CH> Direct Debits) is used to with-

draw funds from a customer bank account to pay the account balance or billings generated

in a New Billings or Final Billing batch. To use the direct debits process, enter bank account

information on a UB customer account in the Account Master Maintenance window (UB>

Maintenance> Account> Open an account> Account tab> ACH Info sub-tab). After a New

Billing or Final Billing batch is committed, you can go to the Direct Debit process in the

Clearing House module and pull the direct debit transaction into the Clearing House mod-

ule.

Create a pre-note batch in the Direct Debits process (CH> Direct Debits> Generate Pre-

Note) after you have entered bank account information on customer accounts. A pre-note

batch is used to verify that the bank account information entered on the customer accounts

is correct. No amount will be charged when a pre-note batch is processed; the batch is only

used to verify that the bank account information is correct on the customer accounts

included in the batch.
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Customer accounts are selected for a pre-note batch by billing cycles, but only accounts

that have not been processed in a pre-note batch will be included in the batch. When cus-

tomer accounts are processed through a pre-note batch, the Clearing House Pre-Note
toggle is checked on the customer account (UB> Maintenance> Account> Open an

account> Account tab> ACH Info sub-tab). Customer accounts with this toggle checked will

not be included in a pre-note batch.

The pre-note batch will generate an export file that contains the bank accounts of the cus-

tomer accounts included in the batch. This is the file you will submit to your ACH pro-

cessing bank. The format of the export file will vary depending on your processing bank, so

make sure you obtain guidelines from your bank regarding the format of the file they

require. Your processing bank will reject the export file if it is not in the correct format.

After your bank has processed the pre-note batch it will notify you if the bank accounts

were incorrect. After you have corrected any incorrect bank account information you can

either process the modified bank accounts through another pre-note batch, or you can

leave the Clearing House Pre-Note toggle checked on the customer account (UB> Main-
tenance> Account> Open an account> Account tab> ACH Info sub-tab) and process the

corrected bank accounts through an actual direct debits batch.

After the bank account information has been entered on the customer account, billings are

generated but the billing statements will indicate that the amount on the statement has

been paid. The statement will only display as paid if the bank account information was

entered on the customer account before the billing batch was generated and the Display
Auto Pay message toggle is checked on the billing statement (UB> Utilities> Statement
Setup). Generate a Direct Debits batch (CH> Direct Debits) after the billing batch is com-

mitted.
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The Generate step of the Direct Debits process will determine if bank accounts will be pro-

cessed in the batch.

The amount of the direct debit charged on the customer accounts depends on the UB mod-

ule payment settings (UB> Utilities> Setup> Payment tab> Direct Debit Amount drop-

down).  If Lesser of Billing and Balance Forward is selected, the process will debit the cus-

tomer bank account the billed amount, or the current balance forward on the account if it is

lower than the billed amount. The current balance forward will include any payments or

charges posted after the billing batch was committed. If there are payments posted to the

account after the bill is committed, the current balance forward on the account could be

less than the billed amount. If Current Balance Forward is selected the current balance for-

ward on a customer account will be debited. The current balance forward will include any

payments or charges posted after the billing batch was committed. If Balance Immediately

After Commit is selected, the process will debit the customer bank account for the balance

forward on the UB account directly after the billing was posted to the UB account. Select

this option if you do not want payments and charges posted to the customer account after

the billing has been committed to affect the direct debit amount.

Send the export file generated by the Direct Debits batch to your processing bank. The pro-

cessing bank will process your transactions and deposit the transaction amounts into your

organization’s bank.

Step by Step

1     Set up the Utility Billing module for the Direct Debits process. 

DIRECT DEBITS OVERVIEW 49



l Open the UB Setup window (UB> Utilities> Setup> General tab).

l Check the CH Interface toggle to enable the Clearing House module interface.

l The CH module will be used to process the transactions and create the ACH

transaction file.

l Open the Payment tab to set up the amount of the direct debit transactions.

l The Direct Debit Amount field is used to select how much of the balance will be

billed on the customer bank account when a direct debits batch is processed. This is

the dollar amount that will be withdrawn from a customer’s bank account. When Dir-

ect Debits are generated in the Clearing House module you will be able to edit the

amount of the direct debit, but the Direct Debit Amount field allows you to set up

the default amount.

l Select Current Balance Forward to withdraw the current balance forward

from a customer’s account.

l Most users select this option so that customers will consistently have a

zero balance on their accounts and adjustments made after the New

Billing has been committed will be included in the direct debit amount.

l Select Balance Immediately After Committing to debit the amount gen-

erated during a committed New Billing batch.  For example, if UB> New Billing

generated a bill amount of $25 and the current balance forward becomes $80,

this option will on debit $25. Adjustments made after the New Billing has been

committed will not be included in the direct debit amount.

l Select Lesser of Billing and Balance Forward if you would like the process

to compare the first two options above and debit whichever is the smaller
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amount.

l Press ENTER or click the Save icon when complete to save the changes.

l Open the Statement Setup Selection window (UB> Utilities> Statement Setup) if

you would like to set up the billing statements to display an auto pay statement on

customer accounts with bank information attached to the Account Master Main-

tenance window (UB> Maintenance> Account> Open an account> Account tab>

ACH Info sub-tab).

l Select the billing statement that prints in the New Billing and Final Billing pro-

cesses. This will open the Statement Setup Maintenance window.

l Open the Miscellaneous tab and check the Display auto pay message

toggle.

2     Create a customer bank. 

l When bank information is attached to a customer account (UB> Maintenance>

Account> Open an account> Account tab> ACH sub-tab), a bank is selected and

the customer’s bank account number is entered. The bank is set up in the SS mod-

ule's Bank Maintenance window (SS> Maintenance> Bank) and the record contains

the routing, transit and check digit of the bank. Every customer bank that you would

like to process direct debits on must be set up.

l Depending on how you will be processing ACH transactions, you may also have to

set up an origin and destination bank. Depending on the format of the export file

your bank requires, these banks may need to be included on the export file gen-

erated by the Direct Debits process.
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l Open the Bank Maintenance window (SS> Maintenance> Bank).

l The Bank Maintenance window will display all banks that have been set up in the

database.

l Press INSERT or click the Create icon to create a new bank.

l Enter the bank information in the window.

l Press ENTER or click the Save icon when complete to save the changes to the win-

dow.

3     Create a UB Direct Debit bank account. 

l The UB bank account will be used when generating the export file in the Direct

Debits process. The bank account name will display on the export file.

l The GL cash account attached to the bank account will not be used in the journal

entry created by the Direct Debits process. The Cash accounts debited by the pro-

cess are the GL cash accounts attached to the service rates and fee codes pro-

cessed in the batch.

l Open the Bank Account Maintenance window (SS> Maintenance> Bank

Account).

l You can have only one UB direct debit bank account set up in the Bank Account

Browse window. If you do not have a UB direct debit account already set up, create

a new one.

l Press INSERT or click the Create icon to create a new bank account.
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l Check the UB toggle. This toggle can only be checked on one bank account.

l Press ENTER or click the Save icon when complete to save the new bank account.

4     Enter bank account information on customer accounts, process a pre-note batch, gen-
erate a billing and then process a Direct Debits batch.
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UB> Service Requests

Overview of Service Requests

Summary

Service requests allow you to track the services performed on customer accounts such as

meter change outs, meter readings and adding or removing a device on a customer

account.

l Create service request codes.

l Create service requests using the Service Request Input Wizard.

l The Service Request Input Wizard can be run from a customer account (UB> Main-

tenance> Account> Open an account> Service Request tab), the Service Request

palette (UB> Service Requests> Input), or from the New Account Wizard (UB> Main-

tenance> Account> Create icon).

l Close and commit service requests after the work has been performed.

l If the service request is billable, generate the charges for the service request on the Bill Ser-

vice Requests window (UB> Adjustments and Fees> Bill Service Requests).

Service Request Codes
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Before you can create a service request, you must set up service request codes (UB> Main-

tenance> Service Request Code). Service request codes act as templates when service

requests are created because they define what type of service is being performed (device

reading, new device, new account, device change out, etc.) and if the service request is bil-

lable (some organizations bill for services such as the installation of a new device).

Create a Service Request

After the service request codes have been set up, you can create service requests using

the Service Request Input Wizard. The Service Request Input Wizard will guide you

through the steps needed to create a service request and can be run from the Service

Requests window (UB> Service Requests> Input> INSERT) or from the Devices tab of the

Account Master Maintenance window (UB> Maintenance> Account> Open an account>

Devices tab> Delete, Change-out or Add icon). Where the Service Request Input Wizard is

opened affects its functionality.

If you open the Service Request Input Wizard from the Account Master Maintenance win-

dow, the default service request codes set up on the device types (UB> Maintenance>

Device Type> Open a device> General tab> Default Change-out, Default Remove,
Default Add fields) will apply to the service request being created. Service request codes
can be attached to device types so that when a specific type of service request (add,

remove, change-out) is performed on a certain device type, the service request will pop-

ulate with a default service request code. For example, if all water meter devices should be

removed with a certain remove device service request code, you can attach that service

request code to all water meter device types. When a user clicks on the Remove icon on

the Devices tab of the Account Master Maintenance window (UB> Maintenance> Account>
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Open an account> Devices tab), the default remove device service request code attached

to the device type will populate on the Service Request Input Wizard. This is an optional

feature, so you are not required to add default service request codes to device types.

If the Service Request Input Wizard is opened from the Service Request window (UB> Ser-

vice Request> Input) the default service request codes set up on the device types will not

apply.

When the service request code is attached to the service request on the Service Request

Input Wizard, the information from the service request code will populate on the service

request as default information but that information can be modified. For example, if you are

creating a billable service request, you can change the amount of the billing. You can also

change the type of service being performed by the service request. For example, if you

select an Add Device service request code but you do not add a device to the service

request, the request will be processed like a Show Device service request. This means that

no device will be added to the UB customer account.

When creating service request codes in the Service Request Code Maintenance window

(UB> Maintenance> Service Request Code) you have the option of adding default device

types to the service request code. If the default device type on the service request code is

attached to the customer account when the service request is being created, the device

type will be automatically selected in the Service Request Input Wizard. This is used when

a certain service request code is generally performed on a certain device type. For

example, you can create a remove device service request code that selects a specific

water meter on the customer account. If the device type is not attached to the customer

account no device type will be automatically selected on the service request.
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The default device types on the service request codes are only default values. If the default

device type is attached to the customer account but the service request should be per-

formed on a different device on the account, you will be able to select the other device type.

Default device types attached to service request codes do not work with add device service

request codes. You cannot add a device type to the add device service request code and

have it populate on the customer account when the service request is created.

Service Request numbering system

Service requests are assigned a unique service request number when they are generated.

The service request number is made of three parts: request number, request month and

request year, and is similar to the batch numbering system. The request number incre-

ments with each service request generated and identifies a unique service request within a

specific request month and request year. The request month and request year portions of

the service request number will populate with the month and year the service request was

generated. Changing the request date on the service request will not affect the service

request number assigned to the service request.

Statuses of Service Requests

Service requests have two statuses: active and closed. A service request is in Active status

until the work has been completed. For example, when a service request is created, it will

default to Active status. When the service has been performed on the account a user can

change the status of the service request to closed to record that the work has been com-
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pleted. The service request can be closed from either the Account Master Maintenance win-

dow (UB> Maintenance> Account> Open an account> Service Requests tab) or the Ser-

vice Requests window (UB> Service Requests> Input> Close Request icon).

When a service request has a Closed status, it can still be modified by users. For example,

if an incorrect meter reading was entered on a closed service request, you can open the

service request and modify the information on it as long as it has not been committed (UB>

Service Requests> Commit).

After the service request has been closed, the service request can be committed. Any

meter readings entered on a service request will not post to the UB customer account

attached to the lot until the service request has been committed. Service requests are com-

mitted using the Commit window (UB> Service Requests> Commit). Only closed status ser-

vice requests will display in the Commit window.

If you are processing a billable service request, after it has been committed in the Commit

window (UB> Service Requests> Commit), the service request should be run through the

Bill Service Requests window (UB> Adjustments and Fees> Bill Service) to bill the cus-

tomer for the service request.

Print the Service Request
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After a service request has been created in the Service Request Input Wizard you can print

a service request form so the technician has a written record of the service that should be

performed on the customer account. The service request form will display the customer

and service address information as well as the device information if there is a device

attached to the service request.

The service request form can be generated during the last step of the Service Request

Input Wizard, from the service request input window (UB> Service Requests> Input), or

from the service request print window (UB> Service Requests> Service Requests). If you

print the service request forms from the service request print window you will be able to

print a service request form for multiple service requests based on several filters.

Door Hangers

The Door Hangers Report (UB> Service Requests> Door Hangers) is used to generate

door hangers for all of the service requests of a selected date range. The date range used

to filter the Door Hanger Report is the service request date, which is generally the date the

work will be performed on the service address. Only Active status service requests will dis-

play on the door hangers report. Closed or committed service requests will not display on

the report because service requests are generally changed to a closed status after the

work is complete.

Proof List
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The Service Request Proof List is used to view a filtered list of service requests. It will dis-

play active and/or closed status service requests filtered by request date, service date,

billing cycle and service request code. If closed status service requests are included on the

report, both committed and uncommitted service requests will display on the report.

Commit a Service Request

After a service request has been closed from either the service request input window (UB>

Service Requests> Input) or manually using the Service Request Input Wizard, the service

request should be committed so the meter readings attached to the service request will

post to the customer account. Meter readings on active or closed status service requests

will not display on the device or the customer account until the service request has been

committed. Service requests must have a closed status before they are committed. After

the service request has been closed, it can be committed (UB> Service Requests> Com-

mit).

Billable Service Requests

Billable service requests are set up by adding a fee code to the service request code. The

billable service request is processed like a normal service request, but charges can be gen-

erated on the Bill Service Requests window (UB> Adjustments and Fees> Bill Service

Requests) after the service request has been committed (UB> Service Request> Commit).

The charge for the service request will not display on the customer account until the

charges have been generated using the Bill Service Requests feature. The generated

charges will display on the billing statement the next time statements are generated (UB>

New Billing).
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Utility Billing Module

Usage Periods Overview

Summary

The Time of Use feature is typically used to charge UB customers different rates for peak

and non-peak usage. Consumption is generally separated into the usage periods by the

meter and then imported into the Springbrook application as separate consumption values

when meter reads are imported (UB> Meter Management> Readings Import). When a

billing is generated (UB> New Billing), charges are applied to the imported consumption

based on the unique rate structure of each usage period set up on the service rate.

Step by Step

1     Set up the Utility Billing module. 

l Open the UB Setup window (UB> Utilities> Utility Billing Setup> Device tab).

l Enter the number of use periods you would like to create in the Use Periods field.

The number of use periods is the number of unique service rate structures you

would like to create. For example, enter 2 if you would like to create a peak and non-

peak usage period. This will create two separate usage periods: one rate structure

for peak usage and one rate structure for non-peak usage.
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l You can create a maximum of six use periods, which will allow you to create

six separate rate structures on a single service rate.

l Press ENTER or click the Save icon to save the changes.

2     Set up the service rates. 

l Adding multiple usage periods to the UB module setup window will add the usage

periods to the Consumption Levels tab of the Service Rate Maintenance window.

This allows you to set up a separate rate structure for each usage period.

l Open the Service Rate Maintenance window (UB> Maintenance> Service Rate>

Select a service rate revision).

l Open the Consumption Levels tab. Each usage period will display as a separate

line item in the window.

l Click the Expand button next to a usage period to create a rate structure for that

period.

l If a usage period does not display on the Consumption Levels tab, you have

not created the usage period in the UB module setup (UB> Utilities> Setup>

Device tab> Use Periods field).

l Enter the rate structure for the usage period, creating a new line item below

the usage period for each level break on the service rate. The rate structure

will only be applied to consumption that is assigned to that usage period. If no

consumption is read for that consumption period during a billing, the service

rate structure set up on that usage period will not be applied to the billing.
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l Click the Save icon when complete.

l Repeat this process for each service rate that will be used to bill multiple usage peri-

ods.

3     Set up the device types. 

l The number of use periods must be set up on the device type so that meter readings

on that device can be separated into the usage periods.

l Open the device maintenance window (UB> Maintenance> XXX Device Main-

tenance> Open a device).

l Open the meter tab on the device maintenance window. The title of the meter tab

will vary depending on the device type. For example, if you have opened a water

meter device type, the title of the tab will beWater.

l Enter the number of use periods in the Number of Use Periods field.

l Press ENTER or click the Save icon to save the changes.

l Repeat this process for each device type that will be used to read multiple usage

periods.

4     Enter a meter read using the use periods. 
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l If you have meters that automatically separate consumption into the separate use

periods, the usage periods will be applied when the meter reads are imported (UB>

Meter Management> Readings Import).

l The meter import is generally customized to handle usage periods.

5     Create a billing. 

l If your billing statements are not set up to display the consumption on usage peri-

ods, the consumption on the statements may not display correctly.
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Utility Billing Module

Credit History Overview

Summary

Credit history information can be attached to adjustment type codes in order to accumulate

credit history on customer accounts. This is an optional feature that allows you to create a

credit score for customer accounts based on the types of transactions processed on those

accounts. For example, customer accounts processed in the Past Dues or Collections pro-

cess, or charged an NSF fee using the Miscellaneous Charges feature (UB> Adjustments

and Fees) can be assessed a credit value. Those values can then be reviewed to assess

the credit risk of a customer.

Any adjustment that is created using an adjustment type code that has credit information

attached (credit value and credit history days) will create credit line items on customer

accounts. Credit information is attached to an adjustment type using the Adjustment Type

Maintenance window (UB> Maintenance> Adjustment Type> Select an adjustment type.)

The Credit History Days field is used to select the number of days the credit line item cre-

ated by the adjustment type code will stay on a customer account. For example, if a credit

line item created by an adjustment type code should stay on the customer account for 120

days, enter 120 in this field.
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The Credit Value field is the credit value of the credit line item created by the adjustment

code. The credit value is user-defined and will be used to create a relative scale. For

example, if Past Dues have a credit value of 50, Collections might create a credit value

100. Past Dues could also have a credit value of 1, and Collections might have a credit

value of 2. As credit lines accumulate on the customer account, you can use these values

to assess the credit risk of the customer account.

When adjustment transactions are processed on a customer account using an adjustment

type code with credit information attached, a credit history line item will be created on the

customer account. The credit history line item will display in the Credit History section on

the Account Master Maintenance window (UB> Maintenance> Account> Open an

account> Overview tab). You can right click on the Credit History section and select Export

to MS Excel to create a spreadsheet of a customer’s credit history.

Step by Step

1     Create or modify an adjustment type code to accumulate credit history. 

l Credit history is created by adjustment type codes. Create or modify the adjustment

type codes in order to accumulate credit history on customer accounts.

l Open the Type Code Maintenance window (UB> Maintenance> Adjustment Type),

and select an adjustment type code that should create credit line items on a cus-

tomer account. This could be an adjustment type code used to assess Past Due pen-

alties or the Collections adjustment type code (UB> Utilities> Setup> General tab>

Collections Adjustment Type).

CREDIT HISTORY OVERVIEW 67



l Enter the number of days the credit line item should stay on a customer account in

the Credit History Days field. For example, if the credit line item should stay on the

customer account for one year, enter 365 days.

l Enter the amount of the credit line item created by the adjustment type code in the

Credit Value field. For example, if the adjustment type code should create a credit

line with a value of 25, enter 25 in this field.

l Use the Account alert, Receipt alert and Alert days fields if you would like the

adjustment type code to generate an alert on the customer account.

l Click the Save icon when complete.

2     Generate credit line items. 

l When an adjustment transaction is created using an adjustment type code set up

with credit information, a credit line item will be added to the customer account (UB>

Maintenance> Account> Open an account> Credit History section).

l As credit history accumulates on customer accounts, you can use the credit score

(total of the credit line items) of a customer account to assess the credit risk of that

account.
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UB Final Account Wizard

Final an Account

Summary

The Final Account Wizard is used to enter the final meter readings on a UB customer

account, enter the forwarding address of the final billing statement, calculate the final

billing on a UB customer account and change the status of the account to a Final status.

The Final Account Wizard can be launched from the Account Master Search window (UB>

Maintenance> Account> Select a UB customer account> DELETE key) or from the Final

Billing palette if you use final account service requests (UB> Final Billing> Final Accounts).

UB customer accounts will only display in the Final Accounts window (UB> Final Billing>

Final Accounts) if a final account service request has been closed and committed on the

UB customer account.

A final account service request is used to enter the final readings on the devices attached

to the UB account and enter the forwarding address on the final billing. The meter readings

and forwarding address entered on the final account service request will populate on the

Final Account Wizard when the UB customer account is finaled. Committing the final

account service request will not change the status of the UB account, it will only make the

account available in the Final Accounts window (UB> Final Billing> Final Accounts) and

add the meter reading line items to the meter record. The UB customer account will change

to a Final status after the customer account has been processed in the New Account Wiz-

ard.
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Depending on how the Utility Billing module is set up (UB> Utilities> Setup), the final billing

generated by the Final Account Wizard is either processed in UB> Final Billing or UB> New

Billing. If the Bill Finals with cycle toggle is checked on the Setup window (UB> Utilities>

Setup> Billing tab), the final billing for the account will be processed using the New Billings

process (UB> New Billings) when the billing cycle of the finaled account is billed. If the Bill

Finals with cycle toggle is not checked, the finaled account will be billed using the Final

Billing process (UB> Final Billing).

Step by Step

1     Open the Final Account Wizard. 

l The Final Account Wizard can be run from the Account Master Search window

(UB> Maintenance> Account) by highlighting a UB account and clicking the Delete
icon .

l You must select the UB account, not just the customer record. This means you must

click the Expand button next to the customer record to display the attached UB

accounts.

l The Delete icon will not be enabled if the selected UB customer account has

a Delete status.

l The Final Account Wizard can also be run from the Final Accounts window (UB>

Final Billing> Final Accounts). UB Accounts will only display in the Final Accounts
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window if a final account service request has been closed and committed on the UB

account.

l Service requests can be created on a UB account on the Service Requests

window (UB> Service Requests> Input), or directly from the UB Account Main-

tenance window (UB> Maintenance> Account> Open an account> Service

Requests tab> Create icon).

l A final account service request code is created by selecting Final

Account from the Request Type drop-down menu on the Service

Request Code Maintenance window (UB> Maintenance> Service

Request Code).

l Service requests are committed in the final step of the Service Request batch

process (UB> Service Requests> Commit).

2     Enter a Final Date. 

l The first step of the Final Account Wizard is used to review the customer account

information and enter a Final Date on the UB account.

l Enter the final date of the UB customer account in the Final Date field.

l If the UB customer account has been processed using a final account service

request, the Final Date field will default to the request date on the final

account service request. If the UB customer account has not been processed

using a final account service request, the Final Date field will default to the cur-

rent date.
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l If the Final Date on the account is prior to the current date, the account will be

backdated. Backdating a final will credit the consumption and minimum

amount on the account that occurred after the final date on the account.

l If there are unbilled readings on the account, the Final Account Wizard will

prorate the final billing based on the final date on the account.

l If there are no unbilled readings on the account and the final date on the

account is before the last billed meter reading, the Final Account Wizard will

calculate a credit on the UB account. The credit on the account is refunding

the previously billed amount. In order to create a credit on the account the UB

module must be set up correctly.

l The Reading Year and Reading Period fields will populate based on the Period

End Date and Days in Period of the billing cycle on the account and the Final Date

on the account.

l The Period Begin and Period End fields in the window will display the period

begin and period end date of the billing cycle attached to the account.

l If the Final Date on the account falls outside of the current period, the Read-

ing Year and Reading Period field will be calculated based which billing

period the Final Date will fall into.

l The next two toggles on the Initialization window of the Final Account Wizard do not

apply unless the customer is moving to a new lot or a new customer is moving to the

lot attached to the account being finaled.

l Check the This customer is moving to another lot toggle to transfer the

customer account being finaled to a different lot. This will launch the New

Account Wizard when the Final Account Wizard is complete in order to create

the UB customer account at the new address.
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l The lot that the account is moving to does not have to be in the data-

base. You can create a new lot for the account if you check this toggle.

l Check the A new customer is moving to this lot toggle to move a new cus-

tomer to the finaled lot. This will launch the New Account Wizard after the

Final Account Wizard is complete in order to create the new UB customer

account.

l The information that will be copied to the new account on the lot is set

up in the Utility Billing Setup window (UB> Utilities> Setup> General

tab).

l If you check both of these toggles, the New Account Wizard will launch twice

after the Final Account Wizard is complete. First you will create the new UB

customer account for the account being finaled, and then you will create the

new UB customer account for the customer moving to the lot.

l The Deposits drop-down menu is used to apply an existing deposit to an account

when it is finaled.

l Select Apply to apply the deposit to the customer's final bill.

l When Apply is selected, the Calculate Interest and Alternate Interest

Rate fields will be enabled.

l The Calculate Interest field is used to determine how the interest will be

calculated on the applied deposit.

l Select For One Year to accrue interest of an entire year.

l Select Since Last Time to accrue interest since the last time

interest was calculated on the deposit fee codes included in the

batch.
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l The Alternate Interest Rate field is used to change the interest rate that

will be calculated on the applied deposit. This drop-down menu will pop-

ulate with the interest rate associated with all the deposit fee codes in

the module.

l Select Transfer to transfer the deposit to another lot associated with the same

customer.

l Transfers are only enabled when the This customer is moving to

another lot toggle is checked.

l When Transfer is selected, the Use original deposit date toggle will

be enabled.

l Check this toggle to use the deposit date associated with the original

deposit as the deposit date that will be associated with the transferred

deposit. If this toggle is not checked, the current date will be used as the

deposit date.

l The Deposits section below will display all of the deposits on the account.

Check the Selected column for each deposit you would like to apply.

l Click the Next button when complete to move onto the next step.

3     Enter the final meter readings. 

l All of the meters attached to the account will display in the window. Backflow

devices attached to the account will not display in the window.
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l Enter the Final Reading on the devices attached to the UB account. If there are

unbilled meter reading on the account, the unbilled meter readings will display in the

Current Read field.

l If a final account service request has been closed and committed on the UB

account, the device readings from the final account service request will pop-

ulate in the Current Read column.

l The Consumption field will calculate after the Current Reading has been

entered.

l The Prior Estimated column will display True if the prior read on the meter

was an estimated meter reading.

l If the New and Billed toggles are checked on a meter reading (UB> Main-

tenance> Account> Open an account> Devices tab> Meter History sub-tab>

New and Billed toggles), the meter reading will not display Prior Reading

column. If you would like this meter reading to display on the Final Account

Wizard, delete the meter reading in the Device Maintenance window (UB>

Maintenance> Device> Open a device> Consumption tab). After the meter

reading has been deleted, enter a new meter reading with the Billed toggle

checked, but not the New toggle.

l The Read Date on the meter reading will default to the Final Date entered on the

first step of the Final Account Wizard. Modify the read date if the final date does not

apply.

l Click the Next button when complete.

4     Preview the final billing. 
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l The Review Bills step of the Final Account Wizard displays the calculated charges

on the final bill and any refunds that will be applied. You cannot modify the billing

from this step. If the calculated charges are incorrect, you can click the Back button

to adjust the readings or click Cancel to exit the Final Account Wizard.

l The Review Bills step will display a separate line item for each service on the billing.

Click the Expand button to view the detail line items associated with each service.

l The Detail Code column will display if the detail line item is a tax, consumption or

flat/minimum amount line item. The line item will display Flat for both minimum and

flat amount charges.

l The Percentage of Period column will display the percentage of the period that the

charge represents.

l If the minimum/flat amount or the consumption is set up to prorate, the per-

centage of the period value will affect the calculated billing.

l The Billable Consumption column will display the consumption based on the

meter readings entered on the previous step.

l The total billing will display at the bottom of the Billing section.

l The Refunds section will display any deposit details that are being applied through

the Final Account Wizard.

l Click the Next button when complete.

5     Enter a forwarding address. 
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l If a final account service request has been closed and committed on the account,

the forwarding address fields will populate with the forwarding address entered on

the service request.

l Entering a forwarding address will modify the address on the customer record.

l Click the Next button when complete.

l If the A new customer is moving to this lot toggle was checked on the first

step of the Final Account Wizard, the Finish button will display rather than the

Next button. Please skip the next step if that is the case.

6     Activate any suspended accounts associated with the lot.

l The Account Activation step of the Final Account Wizard displays any suspended

account that are associated with the lot.

l Check the Active toggle to activate a suspended account for the lot.

l If only one suspended account is associated with the lot, that account will be

selected by default.

l If a Master Account is associated with the lot, that account will selected by

default.

l Enter a Connect Date for the selected account to become active.

7     Final the account. 
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l Click the Finish button to complete the final account process.

l If the This customer is moving to another lot or the A new customer is

moving to this lot toggles were checked on the first step of the Final

Account Wizard, the New Account Wizard will launch.

l Upon completion of the Final an Account Wizard, the Status on the finaled

account is changed from Active to Final.

l A Billing line item is created on the account on the History tab. The Trans-

action Date is the Final Date on the account.

l After the account has been finaled proceed to UB> Final Billing to generate

the last charges or process them during a regular New Billing Cycle depend-

ing on how the UB module was set up (UB> Utilities> UB Setup> Billing Set-

tings).

l Once an account in final status has been committed in a Final Billing or New

Billing batch, the account status will change from Final to Delete.
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UB> Maintenance> Account

UB New Account Wizard

Summary

Utility Billing customer accounts are created using the New Account Wizard. The New

Account Wizard can be launched from the Account Master Search window (UB> Main-
tenance> Account> Create icon ), or from the Final Account Wizard when a customer is

moving to a new lot. The New Account Wizard is used to select the connect date, the lot the

customer is moving into, the services and service rates on the account, create any service

requests to read or install devices on the account and charge any fee codes such as depos-

its or connections charges. If the customer already has a UB customer account, a new UB

customer account sequence number will be created. For example, if customer number

000001 already has UB customer account 000001-000, UB customer account 000001-001

will be created.

Depending on how the Utility Billing module is set up in the Setup window (UB> Utilities>

Setup), information attached to the previous UB customer account on the lot will populate

on the new UB customer account. For example, if the Copy All Services toggle is
checked, the services and service rates attached to the previous account on the lot will

copy to the new UB customer account on the lot.
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The Copy Service Codes, Copy all Services, Copy Winter Averages and Re-Use
Reference Numbers toggles on the Setup window (UB> Utilities> Setup) determine the

information that will be copied from the previous customer account on a lot to the new cus-

tomer account when it is created using the New Account Wizard. If you are using Account

Templates (UB> Maintenance> Account Templates), the information on the template will

be populate on the new account as well as the information copied from the previous

account. For example, if you have the Copy Service Codes toggle checked, the services

and service rates on the template will be copied to the new account as well as the service

and service rates on the template. The Services step on the New Account Wizard allows

you to add or remove any of the services or service rates that have been added to the cus-

tomer account (both copied services/service rates and service/service rates on the tem-

plate).

Account templates are used to add services, service rates, service requests or fee codes to

a new customer account. This reduces data entry and helps ensure that customer

accounts are created accurately because all of the standardized information on the

account template will populate in the New Account Wizard. Many Springbrook users create

an account template for each standard grouping of services/service rates (residential, com-

mercial, industrial or housing developments) that they generally add to new customer

accounts. Account Templates are created and maintained using the Account Template

Selection window (UB> Maintenance> Account Template).

Step by Step

1     Open the New Account Wizard. 
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l The New Account Wizard can be opened from the Account Maintenance window
(UB> Maintenance> Account> Create icon ).

l The New Account Wizard can also be launched at the end of the Final Account Wiz-

ard if a new customer is moving to the lot being finaled or the customer being finaled

is moving to a new lot.

2     Select an account template. 

l Enter a Connect Date or click the down arrow in the field to select a date using a

calendar. The connect date is the date that service will begin on the account.

l The connection date of the service rates on the customer account will default

to the date entered in the Connect Date field. The connect date on the service

rates will determine how the bills on the new customer account will prorate.

l The connection date will also act as the default transaction date of any fees

generated by the New Account Wizard and sent to an Adjustments and Fees

batch (UB> Adjustments and Fees). For example, the transaction date of a

deposit or connection charge transaction generated in the New Account Wiz-

ard will default to the value entered in the Connect Date field.

l Select an Account Template from the drop-down menu.

l Account templates are groups of services, service rates, service requests and

fee codes (for example, deposits) that can be added to new customer

accounts when they are created. Account templates reduce data entry time

and errors when creating new accounts because they eliminate the process of
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adding that information to each new account as they are created.

l Account Templates are created and maintained on the Account Tem-

plate Maintenance window (UB> Maintenance> Account Templates).

l If the Utility Billing module is set up to copy services and/or the service rates

from the previous account on the lot, those services/service rates will be

copied to the new account and the template will add services and service

rates that have not already been copied onto the new account.

l Services and service rates are set up to copy over onto the new account

on a lot on the Setup window (UB> Utilities> Setup> General tab). For

example, if the Copy All Services toggle is checked, all of the services

will be copied from the previous account to the new account. This will

only copy the services, not the services and service rates.

l Check the This customer will take ownership of the lot toggle if the new cus-

tomer account is also the owner of the lot.

l If you do not check this toggle, the owner of the lot will stay the owner of the

lot and the new customer will become a tenant on the lot. When the customer

account is created the Account Master Maintenance window (UB> Main-

tenance> Account> Open an account> People tab> Customer and Owner tab)

will display the new customer information and the owner information.

l If the current owner should receive copies of billings or past due notices, you

can add the current owner as a recipient of those documents during a later

step of the New Account Wizard (Account step> Recipients section).

l Click the Next button at the bottom of the window when complete to move to the

next step.
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3     Enter the lot information on the new account. 

l The Lot step is used to set up the lot the new customer will occupy. This step is used

to either select an existing lot in the database or create a new lot.

l Create a new lot if the customer is moving into a lot that is not in the database. For

example, if a customer is moving into a new housing development that has not been

entered into the database.

l If you would like to create a new lot, enter the lot information into the window.

The lot city and state of the lot will populate based on the city and state of the

customer information entered on the next step.

l The Street Number and Street Name fields are the only required fields on

the Lot step.

l Click on the Miscellaneous tab to add miscellaneous information to the lot.

You must enter a street number and street name on the lot before you can

open the Miscellaneous tab.

l Select an existing lot if the customer is moving onto an existing lot in the database.

For example, if a customer is moving onto a lot that currently has service.

l There can be only one UB customer account active on a lot at a time. This val-

idation ensures that the service on a lot will not be billed on two separate UB

customer accounts.

l Click the Lot Number field label to select a lot from the list. This will open the

Lot window to select an existing lot.

l After the lot has been selected, the fields on the Lot step of the New Account

Wizard will populate with the information attached to the lot.
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l Click the Lookup button at the bottom of the window to use a user-configured URL

type code to look up additional details about the lot.

l Organizations can set up URL type codes to complete web-based actions

such as interfacing with online county tax records or locating the lot in Google

Maps.

l URL type codes are set up and maintained on the URL Setup Maintenance

window (SS> Maintenance> URL Setup).

l Click the Next button at the bottom of the window to enter the customer information

on the new account.

4     Enter the customer information on the new account. 

l The Customer step is used to select either an existing customer record or create a

new customer record. This step is used to select a customer record, not a UB cus-

tomer account, so if the customer has an account in a separate module you will be

able to select that customer.

l If you select an existing customer and that customer has a UB account, a new

UB account will be created for the customer. For example, if customer 000001

has a UB account (000001-001), selecting an existing customer will create a

new UB account (000001-002).

l Click the Customer Number field label to create a new customer or select an exist-

ing customer account. This will open the Customer window.
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l Press INSERT or click the Create icon to create a new customer record.

l Enter information into the Search Criteria section to locate an existing cus-

tomer record.

l The Social Security Number field will display the social security number of the cus-

tomer.

l If the Validate SSN toggle is checked on the Setup window (UB> Utilities>

Setup> General tab), you will be required to enter a unique value in this field.

l The Driver’s License field will display the driver’s license number of the customer

record selected in the Customer Number field.

l If the Validate DLN toggle is checked on the Setup window (UB> Utilities>

Setup> General tab), you will be required to enter a unique value in this field.

l After the customer account has been created or selected the customer information

will populate on the Customer step. The address from the lot selected on the Lot

step will also populate on the Customer step. The lot address of the lot selected on

the Lot step will overwrite the mailing address on the customer record.

l As with the previous step, the Lookup button can be used to launch a user-con-

figured URL type code in order to look up additional details about the customer.

l Springbrook also offers a premium interface between the UB account and the

bad-debt management tool from Online Utility Exchange (OUE). This inter-

face allows Springbrook users to log into the OUE tool, populate the tool with

the relevant UB data, and investigate any debt-related issues associated with

the new customer, directly from the UB New Account Wizard. Please contact

Springbrook Support for more information on this premium feature.

l Changes to the customer record will update when the New Account Wizard is com-

plete.
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l Click the Next button at the button of the window to move to the next step.

5     Add an optional co-applicant to the account. 

l As an optional step, you can enter co-applicant customer details on the Co-Applic-

ant step.

l This step is identical to the Customer step, so please refer to the steps above for

more information.

6     Create a service request to install, turn on or record an initial meter read on a device on the
account.

l The Service Requests step is used to create a service request on the new customer

account.

l Any service requests attached to the account template selected during the Ini-

tialization step of the New Account Wizard will populate on the Service Requests

step.

l Click the Add Requests button at the bottom of the window to open the Service

Request Input Wizard.

l Highlight a service request in the Service Requests section and click the Delete

Requests button to delete a created service request.
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l The Devices section will display the devices attached to the lot.

l Click the Next button when complete.

7     Select the services and service rates that should be attached to the new account. 

l The Services step is used to set up the services and service rates that should be

attached to the new customer account. The Services step will display the services

and service rates that a have been copied from the previous account on the lot.

l If the Copy All Services toggle is checked on the Setup window (UB> Util-

ities> Setup> General tab), the services attached to the previous account will

display, including services that were not attached to service rates. The ser-

vice rates attached to the previous account will not display.

l If the Copy Service Codes toggle if checked on the Setup window (UB> Util-

ities> Setup> General tab), the services and service rate codes attached to

the previous account on the lot will display. Services that were not attached to

a service rate will not display on the new account.

l If the Copy Service Codes toggle and the Copy All Services toggle are

checked on the Setup window (UB> Utilities> Setup> General tab),  all of the

services and service rates attached to the previous account to copy to the

new account on the lot.

l The services and service rates attached to the Account Template selected

during the Initialization step will also populate on the Services step.
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l Press INSERT or click the Add Service button to add a service or service rate line

item to the new customer account. This will open the Service Selection window to

select a service.

l Select a Service in the Service Selection window.

l After the service has been selected the Connect Date column will populate

with the connect date selected during the first step of the New Account Wiz-

ard.

l Select a Service Rate from the drop-down menu. Only service rates attached

to the service selected in the Service column will display in the drop-down

menu.

l The Description column will populate with the description of the service rate

selected in the Rate column.

l Highlight a line item and press DELETE or click the Delete button to remove a ser-

vice and service request from the customer account.

l Click the Next button to move to the next step of the New Account Wizard.

8     Enter the billing cycle on the account and add recipients to the billing statements. 

l Click the Billing Cycle field label or enter a billing cycle number to attach a billing

cycle to the account.

l Billing cycles are created and maintained on the Cycle Code Maintenance win-

dow (UB> Maintenance> Cycle Code).

l Enter a Reference Number on the account.
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l The format of the reference number is set up on the UB Setup window (UB>

Utilities> Utility Billing Setup> General tab> Reference Format field).

l The Status field will display the status of the customer account being created.

l You can change the status of a customer account to Active either using a New

Account service request or by manually changing the status of the account to

Active from the Account Master Maintenance window (UB> Maintenance>

Account> Open an account> Account tab> Account sub-tab> Account

Status field).

l Check the Copy ACH Account from Final Account toggle to copy ACH account

information from a finaled account to this new account.

l This toggle will only be enabled when the New Account Wizard is launched as

a result of running the Final Account Wizard for a user that is moving to a new

lot (Final Account Wizard> This customer is moving to another lot toggle).

l The Recipients section will populate with all of the statements available to new cus-

tomer accounts (UB> Utilities> Statement Setup> Open a statement> Mis-

cellaneous tab> Add to new accounts toggle).

l Click the Add Recipients button to add a billing statement to the customer account.

l Highlight a recipient and click the Delete button to remove the recipient from the cus-

tomer account.

l Click the Next button to move to the next step in the New Account Wizard.

9     Enter connection charges on the new customer account. 
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l The Connections Charges step is used to enter connection fees and select a UB

module Adjustments and Fee batch to process to process the fees. The trans-

actions date of any charge generated from this step will be the connect date of the

UB customer account being created (Connect Date field on the first step of the New

Account Wizard).

l If you charge connection charges on new customer accounts, click the Add Charges

button to select a fee code. This will open the Fee Code Selection window.

l Click the right border of the Fee Code Selection window to display the Main-

tenance section in the window. The Maintenance section will display the

information attached to each fee code.

l Modify the value in the Amount column to change the amount of the fee.

l After a fee has been added to the Connection Charges step, the Batch Number

field will become enabled. Click the Batch Number field to select the UB module

Adjustments and Fees batch that will be used to process the connection charges.

This will open the Batch Selection window.

l Only open batches will display in the window. If you would like to process the

connection charges in a new Adjustments and Fees batch, close the Batch

Selection window, create a new Adjustments and Fees batch (UB> Adjust-

ments and Fees), and the open the Batch Selection window to select the new

batch.

l Click the Finish button when the new customer account is complete.
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Utility Billing Module

Address Certification

Summary

Address certification allows you to verify that the addresses of the customers in a Final

Billings, New Billings or Past Dues batch are correct before the statements are created.

Address certification also prepares your billing for bulk mailing by generating all relevant

documents and tray tags as well as calculating the postage amount.

If there is an alternative address attached to a UB customer account (UB> Maintenance>

Account> People tab> Alternative Address sub-tab), that is the address that will be cer-

tified. If no alternative address is present, the process will certify the address attached to

the customer account on the People tab of the Account Master Maintenance window (UB>

Maintenance> Account).

The Export window (UB> Final Billing/New Billing/Past Dues> Export Addresses) is used to

enter the mailing information (size, weight, etc. of the mailing). The Final Billing, New

Billing or Past Dues batch should contain more than 500 pieces in order to qualify for bulk

first-class mailing rates. After the mailing information has been entered, click the Export

icon. This will send a file to Springbrook that contains the statement addresses and the

mailing information of the batch. Springbrook will certify the addresses and generate post-

age reports based on the mailing information. The verified addresses and postage reports

will then be sent to an email address entered on the Export Addresses window.
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After the addresses have been certified at Springbrook, you will receive an email that con-

tains three postage reports, tray tags, and a file containing the certified addresses. The sub-

ject line of the email that contains the certified addresses and postage reports will be

similar to the following: Past Dues 001-06-2019 certified, sorted, and ready for download.

Addresses that could not be certified will also be included in the file so that you can make

modifications to those addresses and resubmit them. Certain address errors such as

spelling errors will be corrected automatically.

Once you receive the email containing the postage reports and the certified addresses,

open the addresses in the Import Addresses window. The Import Addresses window will

display the certified addresses. Addresses that could not be certified will also display and

can be modified and imported back into the batch. If you would like to certify the modified

addresses, you can re-export the addresses using the Export Addresses window and them

Import the addresses back into the batch.

After the addresses have been certified, you can print the statements. Use the information

on the Qualification Report, and the tray tags to prepare and sort the bulk mailing.

When the Final Billing, New Billing or Past Dues batch is committed, the customer account

addresses will be updated with the certified addresses. This will update the address on the

customer record, not the address on the lot.

Step by Step
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1     Export the addresses to be certified. 

l The Export Addresses and Import Addresses steps on the Final Billing, New Billing

and Past Dues palettes are used to verify the addresses on the process statements.

The mailing information (size, weight, etc. of the mailing) is entered into the Export

Address window.

l When you click the Save icon on the window, a file will be sent to Springbrook

that contains the statement addresses and the mailing information. Springbrook will

then certify the addresses and then generate postage reports based on the mailing

information. The verified addresses and postage reports will then be sent to an

email address entered on the Export Addresses window.

l Select Export Addresses from the Final Billing, New Billing or Past Dues palette to

open the Export Addresses window.

l Enter the email address where you would like the postal reports to be sent in the

Email field. Enter the entire email address and verify it is correct. If the email

address is incorrect, you may not get the postage reports.

l The URL field displays the address of the server that will receive the addresses and

mailing information. This field should contain: https://cer-

tify.springbrooksoftware.com

l The Drop Date field is used by those users who would like to specify a mailing date

that will populate the Mailer's Mailing Date field on the postage statement. If no date

is specified, the field will default to the current date.

l The Permit Number field is the bulk mailing permit number of your organization.
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l The POE field is the post office entry point of the mailing. This is generally a portion

of the zip code where the post office distributes mail. For example, a POE of a post

office in Portland, Oregon may be 970.

l The POE Description is the description of the post office entry. For example, if the

post office entry is in Portland, Oregon, the POE Description field would be Port-

land, Oregon.

l The Pay By drop-down field is used to select the payment method of the mailing.

This is generally the choice you made on the USPS FORM 3615 Mailing Permit that

you submitted to the US Postal Service.

l Select Stamps if you are using pre-canceled checked.

l The Size drop-down menu is used to select the size of the mailing.

l Select Postcard if you are sending cards. In order to be eligible for card or

postcards postage rates, the mailing must be rectangular, and at least 3.5” in

height, 5” in width, and .007” thick. A card/postcard may not be more than

4.25” in height, 6” in width, or .016” thick.

l Select Letter if you are sending letters. In order to be eligible for letter postage

rates, the mailing must be rectangular, at least 3.5” in height, 5” in width, and

.007” thick. A letter may not be more than 6.125” in height, 11.5” in width, or

.25” thick.

l Enter the dimensions of the mailing in the Height,Weight,Width and Thickness

fields.

l TheWeight field is the weight of a single piece of the mailing in ounces.

l The Thickness field is important because it is used to determine how many

pieces can fit in each tray and how many trays will be needed for the mailing.
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l The SSI Customer Number field is used to enter the customer number of your

organization.

l When your organization becomes a Springbrook Software customer, your

organization is assigned a customer number. Please contact support if you do

not know this number.

l Check the Sort by Carrier Route toggle if you would like to sort the certified mail by

carrier route.

l Since sorting the bills by carrier route can be labor intensive, you can uncheck

this toggle to sort the bills by zip code.

l Click the Save icon when complete to send the addresses and mailing inform-

ation to Springbrook. You will receive an email at the email addresses entered in the

Email field when the addresses have been certified and the postal reports have

been generated.

2     The email notification. 

l You will receive an email notification when the batch has been processed. The sub-

ject line of the email will be similar to this: UB Bills 001-06-2019 certified, sorted,

and ready for download.

l The email will contain the CASS report, Postage Statement, Qualification Report,

tray tags and a zip code list file.
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l The CASS summary report will display the total pieces coded in the mailing.

l The software that displays in Section A of the report will not be Spring-

brook software.

l The Postage Statement report will print in two separate files. The first file will

display the Total Postage and Net Postage Due on the mailing based on the

dimensions you entered in the mailing setup. The Mailer information portion of

the form will populate with the organization name and address set up in the

Organization Information section of the System Setup window (SS> Utilities>

System Setup> Organization> Name field). The second page of the Postage

Statement will display a breakdown of the mailing.

l The USPS Qualification Report will display how the mailing should be sorted

and prepared.

l The tray tags report is the printable tray tags for the trays that should be used

based on the USPS Qualification Report.

3     Import the certified addresses. 

l The Import Addresses step is used to import the verified addresses and postage

reports after you have received the Notification email from Springbrook.

l Open the Import Addresses window (UB> Final Billing/New Billing/Past Dues>

Import Addresses).

l The URL field should display: https://certify.springbrooksoftware.com.
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l The SSI Customer Number field should display the customer number of your

organization.

l When your organization becomes a Springbrook Software customer, your

organization is assigned a customer number. Please contact support if you do

not know this number.

l Click the Preview icon to display the addresses that have been verified. This will

populate the Completed Jobs section with the XML files that contain the verified

addresses. The XML files will contain the type of batch and the batch number in the

file name. For example, Past_Dues_00001-06-2019.xml.

l Highlight the file that contains the verified addresses in the Completed Jobs section

and click the Import and Display icon . This will populate the certified addresses

in the Addresses section.

l An error message will display in the Error Description field if the address could not

be certified. By default, the addresses that could not be certified will display at the

top of the Addresses section.

4     Review and correct the address errors. 

l The address errors will display at the top of the Addresses section, and there will be

an error message in the Error Desc column. You do not have to correct the address

errors in order to import the certified addresses. This is an optional step.

l Here is a list of some of the errors you might receive and their possible solutions.
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l No match found using input address - The address is incorrect or is not in the

certification database.

l Invalid input state abbreviation code - State field is either blank or incorrect.

This error will also display if no address is entered.

l Highlight a customer in the Addresses section and the Update section will populate

with the address information attached to the highlighted customer account. You will

only be able to modify the address fields of the customers whose addresses could

not be certified.

l After you have modified the address of customer accounts, click the Save icon

to import the modified addresses into the billing batch.

l If you want to certify the modified addresses, return to the Export Addresses win-

dow (Export Addresses step on the palette) and resend the addresses. When you

receive a new email containing the modified shipping reports, return to the Import

Addresses step to import the recertified mailing addresses. Click the Save icon

to import the recertified addresses back into the billing batch.
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Utility Billing Module

Overview of Deposits

Summary

There are two ways to generate a deposit on a UB customer account: the New Account Wiz-

ard and the Cash Entry window in the Cash Receipts module. No matter which way a

deposit is created, there are three transactions created when a deposit is recorded on a

customer account.

l A billing transaction type is created to record the receivable for the deposit amount.

l A payment transaction type is created to record the receipt of cash for the deposit.

l A deposit type transaction is created to record the obligation to repay the deposit.

Once deposits have been added to customer accounts, you have the option of factoring

interest on those deposits. The interest factored on deposits can either increase the

deposit balance or it can be used to reduce the balance on the UB customer accounts.

Interest can either be factored regularly using the Factor Interest process (UB> Adjust-

ments and Fees> Factor Interest), or it can be factored when deposits are refunded using

the Refunds process (UB> Refunds> Generate).

Set up the UB module
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You must create a deposit adjustment type code and deposit fee codes before you can cre-

ate deposits in the Utility Billing module. You must also define the deposit settings on the

Setup window (UB> Utilities> Setup). If you want to be able to create deposit on UB cus-

tomer accounts from the Cash Receipts module, you will also have to set up a Cash

Receipts module type code.

New Account Wizard

The New Account Wizard allows you to charge deposits on customer accounts when the

account is created. To create a deposit, add a deposit fee code to an account template or

manually add the deposit fee code to the customer account during the Connection Charges

step of the New Account Wizard. The deposit fee code will determine the amount of the

deposit, the service that will be charged and the GL accounts used in the journal entries to

create the deposit on the UB customer account.

When the customer account and deposit is created in the New Account Wizard, the deposit

transaction is created in a UB Cash Receipts batch.

Cash Deposits

A deposit can be entered on a UB customer account by creating a receipt in the Cash

Receipts module. If a deposit is created from the New Account Wizard, the wizard will cre-

ate a Billing transaction in UB Adjustments and Fees. When the Billing transaction is paid,
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a Payment transaction will be created to pay the Billing line and a Deposit transaction will

be created to record the deposit amount on the customer account. A Cash Deposit is dif-

ferent because it records the Billing, Payment and Deposit transactions in one step.

The cash deposit is created using a Cash Receipts module type code. The CR type code is

used to link the CR module with a fee code in the UB module. The GL accounts used in the

journal entry transaction and the service to charge will be pulled from the UB fee code with

the same code as the CR module type code.

Factor Interest

If you would like the customer deposits to accumulate interest, you can factor interest in UB

Receipts or in Refunds when the deposits are being refunded. Interest factored in UB Cash

Receipts can either be added to the deposit amount or used to lower the account balance.

Interest can be factored in:

l UB> Adjustments and Fees> Factor Interest

l UB> Refunds> Generate

Refund Deposit

Deposits are refunded in UB> Refunds.

Deposit Reports
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The Deposit Transactions Report (UB> Reports> Deposit Transactions) displays deposit

and interest transactions filtered by transaction date, fee code and/or billing cycle. The

transactions included on the report can be totaled by UB customer account or by batch

number.

The Deposit Balances Report displays the deposit balance on UB customer accounts. The

report can be filtered by billing cycle, deposit fee code and customer account status (Act-

ive, Delete, Final, etc.). The report also includes an option that allows you to include refun-

ded deposits on the report.
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New Account Wizard

Create a Customer Deposit using the New Account
Wizard

Summary

The Utility Billing module allows you to charge deposits on customer accounts when a new

customer account is created using the New Account Wizard. To create a deposit, a deposit

type fee code is added during the final step of the Wizard. The fee code will determine the

amount of the deposit, the service that will be charged the deposit amount and the GL

accounts used in the transactions. The service attached to the deposit fee code (UB> Main-

tenance> Fee Code> Select a fee code> Service to Charge drop-down) must be attached
to the UB customer account.

When the New Account Wizard is completed, a billing transaction is created in an open UB

Adjustments and Fee batch to record a receivable for the deposit amount. When the cus-

tomer pays the deposit amount, both a payment and a deposit transaction are created. The

Payment transaction reverses the Billing transaction and the Deposit transaction records

the deposit and represents the obligation to repay the deposit amount.

Step by Step

1     Create the deposit in the final step of the New Account Wizard. 
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l Open the New Account Wizard (UB> Maintenance> Account> Create icon). You

can also open the New Account Wizard from the Final Account Wizard if a customer

is moving to a new lot or a new customer is moving to the lot being finaled.

l The date entered in the Connection Date field on the Initialization step will be used

as the transaction date of the Billing type deposit transaction line item generated by

the New Account Wizard.

l Select the customer account to create the deposit on during the Customer step.

l Add the service attached to the deposit fee code to the customer account on the Ser-

vices step. The service charged by the deposit must be attached to the customer

account.

l The deposit fee code is created and maintained using the Fee Code Main-

tenance window (UB> Maintenance> Fee Code). The service selected in the

Service to Charge field must be attached to the customer account. This is

the service that will be billed the deposit amount on the Billing transaction gen-

erated to create the deposit.

l Click the Add Charges button on the Connection Charges step of the New Account

Wizard. This will open the Fee Code Selection window.

l Select a deposit type fee code in the Fee Code Selection window. Fee codes

are set up as deposit fee codes by checking the Deposit toggle (UB> Main-

tenance> Fee Code> Select a fee code).

l The selected deposit type fee code will populate in the Fees section of the

New Account Wizard. The deposit amount (UB> Maintenance> Fee Code>

Select a fee code> Flat Amount field) set up on the deposit fee code will pop-

ulate in the Amount column in the Fees section. This is the amount of the
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deposit. Modify the amount in the Amount column to change the amount of

the deposit.

l Select the Adjustments and Fees batch used to process the Billing transaction in

the Batch Number field.

l The Adjustments and Fees batch must be an open batch (uncommitted). If a

Proof List or GL Distribution Report has already been run on the open Adjust-

ments and Fees batch, the batch will be returned to the Input step.

l Click the Finish step to create the deposit on the customer account. This will close

the New Account Wizard, create the customer account and generate the Billing line

item in the Adjustments and Fees batch.

2     Commit the Billing type transaction in the Adjustments and Fees batch. 

l Open the Adjustments and Fees batch that the deposit transaction was sent to on

the Connection Charges step of the New Account Wizard.

l Open the Input and Display window (UB> Adjustments and Fees> Input). The

Input step will display the deposit transaction as a Billing type transaction. Highlight
the transaction and press ENTER or click the Modify icon to view the details of the

transaction being created.

l The transaction date of the Billing transaction line is the Connect Date

entered during the Initialization step of the New Account Wizard.

l Review the Proof List Report.
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l The Proof List Report (UB> Adjustments and Fees> Proof List) will display the

deposit amount and the service charged.

l The service charged by the deposit must be attached to the customer

account. Services are attached to customer accounts using the Account

Master Maintenance window (UB> Maintenance> Account> Select an

account> Service Rates tab).

l Review the GL Distribution Report.

l Generate the GL Distribution Report (UB> Adjustments and Fees> GL Dis-

tribution).

l The deposit will create the following journal entry:

Description of GL Account Debit Credit

AR GL Account attached to the deposit fee code XXX

Revenue GL Account attached to deposit fee code XXX

l The amount of the journal entry is the amount of the deposit on the account.

This is generally the flat amount that was set up on the fee code (UB> Main-

tenance> Fee Code> Select a fee code> Flat Amount field), but this value

could have been changed when the deposit was attached to the account on

the Connection Charges step on the New Account Wizard.

l If the journal entries used in the transaction are incorrect, you can change the

GL accounts attached to the fee code using the Fee Code Maintenance win-

dow (UB> Maintenance> Fee Code > Select a fee code> Revenue Account

and AR Account fields). Changing the GL accounts on the fee code will
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update the GL accounts used in the journal entry in the Adjustments and Fees

batch.

l Commit the Adjustments and Fees batch if the journal entry is correct.

l If the service attached to the deposit type fee code is not attached to the customer

account, you will receive an error message. To fix this error message, attach the ser-

vice on the deposit fee code to the customer account (UB> Maintenance> Account>

Open the account> Service Rates tab).

l The deposit will not display on the History tab of the Account Master Maintenance

window (UB> Maintenance> Account> Select an account> History tab> Deposit His-

tory) until the deposit has been paid.

3     Receive payment on the deposit. 

l When payment of the deposit is received, the AR journal entry line item created by

the Billing transaction type will be reversed, the receipt of the deposit will be recor-

ded and, once committed, the deposit will display on the account.

l Enter the customer payment using a Cash Receipts batch in the CR module (CR>

Cash Receipts).

l The date entered on the receipt will be used as the transaction date on the

deposit. When you are factoring interest on the deposit (UB> Refunds, or UB>

Transactions and Fees> Factor Deposit Interest), this is the date that will be

used when calculating the amount of interest to apply to the customer

account.
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l Review the GL Distribution.

l The payment of the deposit will create the following general entry based.

Description of GL Account Debit Credit

Cash GL Account attached to the deposit special

charge code

XXX

AR GL Account attached to the deposit special

charge code

XXX

l The journal entry reverses the receivable journal entry line item created by the

Billing transaction.

l If the general ledger accounts used in the journal entry are not correct you

can change the GL accounts attached to the fee code using the Fee Code

Maintenance window (UB> Maintenance> Fee Code> Open the deposit type

fee code). Changing the GL accounts on the fee code will update the GL

accounts used in the journal entry created.

l Commit the Cash Receipts batch if the journal entry is correct.

l Once you commit the payment, the deposit will display on the History tab of the

Account Master Maintenance window (UB> Maintenance> Account> Open an

account> History tab> Deposit History).

l The deposit has now been created.
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Utility Billing Module

Deposit Setup

Summary

Deposit fee codes and a deposit adjustment type code must be created before you can cre-

ate a deposit on a UB customer account. You can also create an interest fee code that will

be used to factor interest on the deposits on customer accounts. The factored interest can

either be used to reduce the balance of the UB customer account or increase the deposit

amount that will be returned when the deposit is refunded.

Step by Step

1     Create a service to contain the deposits. This is an optional step. 

l Some Springbrook Software customers create a separate service to display the

deposit amounts on the billing statements. This is optional because you do not have

to create a separate service for deposits. You can have services that contain

deposit amounts and account balances. For example, you can charge deposits

using a service that also contains billings for meter consumption.

l Open the Service Maintenance window (UB> Maintenance> Service) to create a ser-

vice.
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l If you have already created 20 services in the Utility Billing module, you will

either have to use an existing service for deposits or modify an existing ser-

vice.

l The service created in this step should be attached to the fee codes used to create

the deposits (UB> Maintenance> Fee Code> Select a fee code> Service to charge

drop-down).

2     Create a deposit fee code. 

l The deposit fee code is used to create the deposit on the customer account. The

deposit fee code is used to define the service that will be charged, deposit amount

and GL accounts used to create the journal entries.

l Open the Fee Code Maintenance window (UB> Maintenance> Fee Code).

l The Flat Amount field on the fee code will be used as the default deposit amount.

l When a deposit is created using the New Account Wizard, the deposit fee

code is attached to the New Account Wizard to create the deposit. When the

deposit fee code is attached to the New Account Wizard, the deposit amount

will default to the value entered in the Flat Amount field. This is just a default

value and you can modify the amount before completing the wizard.

l The percentage amount in the Percent Amount field is used as the interest amount

when factoring interest on a deposit when factoring interest in either the Refunds

process or the Factor Deposit Interest process (UB> Adjustments and Trans-

actions> Factor Deposit Interest). The interest rate entered in this field will be
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applied as an annual interest rate. For example, enter 3.75 if you would like to factor

interest at an annual interest rate of 3.75%.

l If you are not going to factor interest on deposit amounts, you do not have to

enter a value in this field.

l For specific information on factoring interest, see the Refunds process or the

Factor Deposit Interest process documents.

l The service selected in the Service to Charge drop-down menu is used to select

the service that will be charged by the deposit.

l If you have created a service that will only be used for deposits, select that ser-

vice in the Service to Charge drop-down menu.

l There will be three transaction line items generated when a deposit is created:

Billing, Payment and a Deposit.

l The GL account entered in the Revenue Account field will be credited when

the Billing line item is created.

l Most organizations will use the deposit liability GL account here.

l The GL account entered in the AR Account field will be debited when the

Billing line item is created. This account will then be credited when the Pay-

ment transactions line item is created.

l The GL account entered in the Cash Account field will be debited when the

Payment line item is created.

l Check the Deposit toggle to define the fee code as a deposit fee code.

3     Create a fee code titled INT. You can skip this step if you are not factoring interest on deposits. 
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l The INT fee code is used when factoring interest on a customer deposit. The gen-

eral ledger accounts attached to the INT special charge code will be used when

interest is factored.

l Open the Fee Code Maintenance window (UB> Maintenance> Fee Code) to cre-

ate the interest fee code.

l Enter INT in the Fee Code field.

l The interest rate attached to the fee code is not the interest rate that will be used to

factor interest on the customer account deposits. Interest will be factored using the

interest rate attached to the fee code used to create the deposit (UB> Maintenance>

Fee Code> Select a deposit fee code> Percent Amount field).

l For specific information on the journal entries created by the Refunds process or the

Factor Deposit Interest process, refer to the documents that describe those pro-

cesses.

4     Create the deposit adjustment type code. 

l The deposit adjustment type code is used to set up the GL type that will be used to

create journal entries on deposits.

l Create an adjustment type code using the Adjustment Type Maintenance window

(UB> Maintenance> Adjustment Type> Create icon).

l The only field that matters is the GL Type field. Most organizations select Cash.

l The GL type determines which GL accounts attached to service rates and

deposit fee codes will be used to generate the journal entries to record the
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deposit or interest amount.

l For specific information on how the GL Type affects each step of the deposit

process (generate the deposit, factor interest and refunds the deposit), refer

to the documents that describe those processes.

l After the deposit adjustment type code has been created, it will be selected in the

Setup window (UB> Utilities> Setup> General tab> Apply Deposit Adjustment

Type field).

5     Set up the Utility Billing module. 

l Open the General tab of the UB Setup window (UB> Utilities> Setup> General tab).

l Check the Charge for Deposit toggle if your organization charges a deposit on

some or all customer accounts.

l If you check this toggle, the final and new billing statements will display the

payment and billing transactions that create a deposit on the account.

l Select the deposit adjustment type code that you just created in the Apply Deposit

Adjustment Type field.

l Click the Save icon to save the new settings.

6     The Utility Billing module is now set up to create deposits on customer accounts.
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Utility Billing Module

Receipt and Account Alerts

Summary

Alert messages are information windows that display when an UB customer account is

opened (UB> Maintenance> Account> Open an account) or a receipt is generated (Cash

Entry window). Alert messages can be used to alert users about past due charges or spe-

cial customer service instructions.

An alert can be attached to a UB customer account in two ways: adjustment type codes or

comment statuses. An alert is attached to an adjustment type code by checking the

Account alert or Receipt alert toggles on the Adjustment Type Code Maintenance win-
dow (UB> Maintenance> Adjustment Type> Open an adjustment type). When a customer

account is charged using the adjustment type code, the alerts will display on the customer

account. For example, if you attach an account and receipt alert to an adjustment type

used to generate past dues penalties (UB> Past Dues> Generate> Adjustment Type for

New Charges section), the alert will display on the customer account when the Past Dues

batch is committed. You can also use the Miscellaneous Charges process (UB> Adjust-

ments and Fees> Miscellaneous Charges) to generate charges on customer accounts

using an adjustment type code. When those charges are committed, the alerts will display

on the customer accounts.
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An alert is attached to a comment status by checking the Account alert or Receipt alert

toggles on the Comment Status Maintenance window (UB> Maintenance> Comment

Status). When a comment is attached to a customer account (UB> Maintenance>

Account> Open an account> Comments tab), select a comment status that is set up as an

alert. The alert window will display on the customer account.
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Utility Billing Module

Net Metering

Summary

UB net metering functionality enables customers to utilize solar panels or other types of

power regeneration systems to apply locally-generated power towards their power con-

sumption bill.

Set up the UB Electric Meter Device Types

Two meters will be required to set up an account for net metering. One for the main meter

feeding electricity to the customer from the grid and one for the solar power generated at

account location. The solar meter must first be set up with "KWH" selected as the Electric

Type on the Electric tab. This will enable the “Solar received meter” toggle which will then

need to be checked.

Meter Reads and Billing

Once the device types have been properly set up on the relevant accounts, meter reads

and billings proceed as usual. The kWh generated by a solar meter will be subtracted from

the primary electric meter's total consumption, resulting in a reduced bill for the billing
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cycle. If the solar meter generates more kWh than the primary electric meter's consumption

for a reading period, a $0.00 bill will be generated for the account and the excess power will

be added to the Banked Consumption column on the account. This banked consumption

will then be applied to the account for the next billing cycle.

Reset Net Meter Banks

Organizations have the option to reset all net meter banks as frequently as they desire.

This process (UB> Adjustments and Fees> Reset Net Meter Banks) will zero out the

banked consumption and apply that amount to the included accounts. This process also

allows organizations to credit accounts at a wholesale kWh rate rather than the standard

rate.
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UB> Statement Settings> Bill To Report

Bill To Report

Summary

The Bill To report is an optional report that provides a snapshot of the type and number of

statements that will be generated in a New Billing, Final Billing, or Past Dues batch.

Each entry in the report will include the Customer Account Number, Service Address, Hold

Status, Charges, Send Paper Statement setting, and Amount. Under the Send Paper State-

ment column, the accounts will be sorted by Paper or Paperless and the report will provide

a total for each. The report will also provide a total for all statements and a total amount.

Unlike the other reports in Springbrook, the Bill To report will not automatically display once

it is generated. You can access the report via the Jobs Viewer.

Step by Step

l Open the Statement Settings window (UB> New Billing/Final Billing/Past Dues> Statement

Settings).

l Use the Bill To drop-down to select which type of Bill To report you would like to generate.

l You can generate either a PDF or Excel version of the report. PDF is selected by

default.
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l Once all the Statement Settings have been set, click the Confirm icon to complete the

Statement Settings step.

l The system will generate the Bill To report but WILL NOT open the report. In order to view

the report, open Jobs Viewer and click UB Bill To Report.

BILL TO REPORT 119



UB> Adjustments and Fees> Bill Service
Requests

Bill a Service Request

Summary

Some organizations charge for certain types of service requests such as the installation of

a new device. To create a billable service request, create a service request code (UB>

Maintenance> Service Request Code) that is attached to a fee code. The fee code will

determine the billable amount and the general ledger accounts used to create the journal

entry when the service request is billed. The fee code will also display on the billing state-

ment line item as the description of the charge.

After the service request code has been set up, create a service request using the billable

service request code. Service requests can be created using the Service Request Input

Wizard and it can be launched from the Service Requests window (UB> Service Requests>

Input) or from the Service Requests tab of a customer account (UB> Maintenance>

Account> Service Requests tab> Create icon).

Close the service request after the service has been performed and commit the service

request (UB> Service Requests> Commit). If there is a meter reading on the service
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request, the meter reading will display on the device after the service request has been

committed. Closing and committing the service request will not create an uncommitted

transaction on the customer account.

After the billable service request has been closed and committed, the billing can be gen-

erated on the Bill Service Requests window (UB> Adjustments and Fees> Bill Service

Requests). The Bill Service Request window will display all committed service requests

attached to a fee code. Select the billable service requests you would like to process in the

Bill Service Request window. This will create an uncommitted billing type transaction on

the customer account using the fee code that was attached to the billable service request

code. Print the Proof List and GL Distribution on the UB Adjustments and Fees batch to

commit the billing. The journal entry created will debit the accounts receivable account and

credit the revenue GL account set up on the fee code (UB> Maintenance> Fee Code> AR
Account and Revenue Account fields). Commit the UB Adjustments and Fees batch to

commit the journal entry.

When a New Billing batch is created on the customer account, the fee code attached to the

billable service request will display on the billing statement if the billing statements are set

up to display the line item detail of the billing. If the billing statement does not display line

item detail, the billed service request code amount will be included in the service that is

attached to the fee code.

Step by Step

1     Set up the UB module to process billable service requests. 
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l In order to create billable service requests, a service request code must be attached

to a fee code. No other set up is necessary.

l Create a fee code to bill with the service request on the Fee Code Maintenance

window (UB> Maintenance> Fee Code).

l If the billing statements generated in the New Billing process are set up to dis-

play line item detail, the description of the fee code will display on the billing

statement.

l The description of the fee code is entered in the Description field on the Fee Code

Maintenance window.

l Enter the amount to charge for the service request in the Flat Amount field.

l The amount charged for the service request can be modified when the service

request is generated using the Service Request Input Wizard. If the billable amount

of the service request is changed zero in the Service Request Input Wizard, the ser-

vice request will still display in the Bill Service Requests window (UB> Adjustments

and Fees> Bill Service Requests), but the customer account will not be charged for

the service.

l The service selected in the Service to Charge field must be attached to the

customer account that is billed for the service request. If the service is not

attached to the customer account, you will receive an error message in the

Jobs Viewer window when you try to generate the billing (UB> Adjustments

and Fees> Bill Service Requests).

l If the line item detail does not display on the billing statement, the billed service

request amount will not display are a line item on the statement and will be included

in the billed amount of the Service to Charge.

l Select the GL accounts to be used in the transaction.
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l The GL account in the AR Account field will be debited and the GL account in the

Revenue Account field will be credited when the billing is generated (UB> Adjust-

ments and Fees> Bill Service Requests).

l Attach the fee code to the service request code on the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code> Fee Code field).

l The Default Charge will default to the flat amount entered on the Fee Code

Maintenance window (UB> Maintenance> Fee Code> Flat Amount field).

l If you change the Default Charge field to zero, you can still add a billable amount to

the service request when it is created using the Service Request Input Wizard, but

this will change how the Bill Service Requests window will function. If the Default

Charge is left blank, and a zero is entered on the Charge field when the service

request is created, the service request will not display on the Bill Service Requests

window.

2     Create a service request for a UB account using the Service Request Input Wizard. 

l Service requests are created using the Service Request Input Wizard which can be

launched from the Service Requests window (UB> Service Requests> Input) or dir-

ectly from a UB customer account (UB> Maintenance> Account> Service Request

tab> Create icon).

l Select the billable service request code in the Request Code field on the first step

of the wizard.

l The Charge field will populate with the flat amount set up on the fee code attached

to the service request code.
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l Modify the amount in the Charge field to change the amount of the billing.

l If you change the Charge amount to zero, the service request will still display

in the Bill Service Requests window (UB> Adjustments and Fees> Bill Service

Requests), but the customer will not be charged.

3     Close and commit the service request after the service has been performed on the UB customer
account. 

l Closing and committing the service request will not create the billing. The billing will

not be generated on the UB customer account until the service request has been

processed (UB> Adjustments and Fees> Bill Service Requests).

l Close the service request by either manually changing the status of the service

request to Closed (Service Request Input Wizard> Status field) or by highlighting

the service request and clicking the Close icon from the Service Request win-

dow (UB> Service Requests> Input).

l Service requests are committed on the final step of the Service Requests batch pro-

cess (UB> Service Requests> Commit).

4     Create a UB Adjustments and Fees batch. 

l Select the Adjustments and Fees palette (UB> Adjustments and Fees). This will

expand the Adjustments and Fees palette and display the steps of the Adjustments
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and Fees process.

l Select New from the batch number drop-down menu. This will open the New Batch

window.

l The Bill Service Requests process will overwrite the transactions entered into

an existing batch, so you must create a new Adjustments and Fees batch.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year and are used for reference only. The batch month

and batch year do not affect the transaction or journal entry date of the transactions

in the batch.

l The fiscal period the transactions in the batch are posted to is determined by

the Journal Entry date entered when creating the GL Distribution report (UB>

Adjustments and Fees> GL Distribution).

l Enter a Batch Number or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

l If you enter a batch number, click the Save icon to create the batch.

5     Select the service requests to bill. 
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l After a service request has been created, closed and committed, it can be billed.

l Open the Bill Service Requests window (UB> Adjustments and Fees> Bill Service

Requests).

l The Bill Service Requests window will display service requests attached to billable

service request codes that have been committed (UB> Service Requests> Commit).

l Use the fields in the Settings section to filter the service requests that display in the

window.

l The Request Code drop-down menu will filter the service requests that dis-

play in the window by service request code. Select a service request code

from the drop-down menu.

l Service request codes are created and maintained on the Service

Request Maintenance window (UB> Maintenance> Service Request

Code).

l The Request From and Request To fields are used to filter the service

requests by request date. The request date defaults to the current date when

the service request is created.

l The Account Number field is used to filter the service requests in the window

by UB customer account. Click on the label of the Account Number field to

select a UB account from a list.

l The Closed From and Closed To fields are used to filter the service requests

by the closed date on the service request. The Closed Date defaults to the cur-

rent date when the status of the service request is changed from Active to

Closed.

l Click the Refresh icon after filter information has been entered into the window

to display the service requests in the window.
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l If you click the Refresh icon without entering any filter information the win-

dow will display all billable service requests that have been closed and com-

mitted but not already billed. Service requests being processed in other

Adjustments and Fees batches will not display in the window.

l If you created a service request and it does not display in the window, make

sure the service request has been closed and committed. If the service

request has been closed and committed and still does not display in the win-

dow make sure the service request code attached  to the service request is

set up as billable (UB> Maintenance> Service Request Code).

l Modifications to a service request code will not affect service requests

that have already been created. If the service request is closed, you can

change the status back to active and modify the service request. If the

service request is committed, you will have to create a new service

request in order to bill the customer account.

l If the service request still does not display in the window make sure the

Default Amount on the service request code is not set up as zero on the

Service Request Maintenance window (UB> Maintenance> Service

Request Code> Default Amount field).

l Check the toggle in the Selected column of the service requests you would like to

include in the batch.

l Click the Select All icon to check the Selected toggle of all of the service

requests included in the window.

l Press ENTER or click the Confirm icon after the service requests you would like

to include in the batch have been selected. This step will be processed on the
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server as soon as the resources become available. You can view the progress of

the step in the Jobs Viewer window.

l After the service requests have been processed, a history line item will display on

the UB accounts that are attached to the service requests included in the batch. The

line item will be a billing type transaction.

6     Commit the Adjustments and Fees batch. 

l The Input Step will display the service requests that have been processed in the

batch.

l Print and review the Proof List.

l Select Proof List from the Adjustments and Fees palette. There are no print

options for this report so the Printer Selection window will open.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Proof List will display the amount of the service request charge and will bill the

service that is attached to the fee code.

l The service that will be charged displays in the Service to Charge field on

the Fee Code Maintenance window (UB> Maintenance> Fee Code).

l Print and review the GL Distribution report.

l Once transactions have been committed, they cannot be uncommitted. The

GL Distribution step allows you to view the journal entry created by the pro-

cess and make changes before the batch is committed.

l Select GL Distribution from the Adjustments and Fees palette. This will open

the GL Distribution window.

l Enter a Journal Entry Date. The journal entry date will determine the batch

month and batch year that the journal entry will be posted to the general

ledger, but it does not affect the transaction date of the billing transactions.

l Select the level of detail you would like to include in the report in the Report

Type drop-down menu.

l The Detail version of the report will display the customer, service and

fee code information. The Summary version of the report will not display

the line item detail, only the net credit and debit amounts.
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l The Summary version will display the general ledger account number,

description, debit and credit.

l The Detail report will display all the information from the summary

report plus the customer number, service number and fee code for each

transaction line.

l Both versions of the report will also be grouped and totaled by fund and

display a report total.

l The general ledger accounts used in the transaction are the accounts receiv-

able and revenue GL accounts set up on the fee code attached to the service

request code.

l The AR GL account will be debited and the Revenue GL account will be

credited.

l If you would like to recreate the GL Distribution Report after the batch has

been committed, you can create a Transaction by Date Report (UB> Reports>

Transaction by Date) for the committed Adjustments and Fees batch. Select

the committed batch (UB> Reports> Transaction by Date> Batch Number

field), include all cycles and make sure the date filter includes all of the trans-

actions in the batch.

l Commit the batch.

l After the Proof List and GL Distribution Report have been reviewed you can

commit the batch. The Commit step is only enabled after you have generated

all of the required reports on the  Adjustments and Fees palette.

l Select Commit from the Adjustments and Fees palette. This will open the

Commit window.
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l Press ENTER to commit the batch. The server will process the step as soon

as the resources are available.

l The transactions created by this process will display on the billing statements the

next time a New Billing batch is generated (UB> New Billing).
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UB> Adjustments and Fees>
Miscellaneous Billing

Miscellaneous Charges

Summary

The Miscellaneous Charges window is used to create a billing on all Active status UB cus-

tomer accounts within selected billing cycles using an adjustment type code. The billing will

default to the flat amount attached to the fee codes of the selected adjustment type, but

you can modify the billing from the default amount. If you would like to create a billing using

a fee code rather than an adjustment type code, create the billing in the Input Billing win-

dow (UB> Adjustments and Fees> Input> Create icon> Select billing).

If there is a receipt or account alert set up on the adjustment type code used to create the

charge (UB> Maintenance> Adjustment Type> Account alert or Receipt alert toggles),
the alert will be attached to the UB customer accounts when the charges are committed.

The alert windows will display when either the account is opened (UB> Maintenance>

Account) or a receipt is entered (Cash Entry window). For example, if you are charging

NSF fees on customer accounts, you can add alerts to the NSF adjustment type code to

create an alert on the UB customer accounts processed in the batch. If you process the

billing using the Input Billing window (UB> Adjustments and Fees> Input> Create icon>

Select billing) instead of the Miscellaneous Charges window, you will not be able to add

alerts to the customer accounts in the batch. The Input Billing window creates a billing

using a fee code and alerts are attached to adjustment types.
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After the miscellaneous charges have been generated on UB customer accounts they will

display on billing statements the next time a New Billing batch (UB> New Billing) is run on

the billing cycles included in the Miscellaneous Charges process. The miscellaneous billing

will create adjustment type transactions on the statements and UB customer accounts.

After the miscellaneous charges have been generated in the Miscellaneous Charges win-

dow, you can delete or modify the charges on each UB customer account using the Input

step of the Adjustments and Fees process (UB> Adjustments and Fees> Input).

Step by Step

1     Create an Adjustments and Fees batch. 

l If you generate miscellaneous charges on UB customer accounts using an open

Adjustments and Fees batch, the existing transactions in the batch will be over-

written by the miscellaneous charges.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the Adjustments and Fees batch number drop-down menu. This

will open the New Batch window.

l Enter a Batch Month and Batch Year. These will default to the current calendar

period and year. The fiscal period the transactions in the batch are posted to is
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determined by the Journal Entry date entered when creating the GL Distribution

report in UB> Adjustments and Fees> GL Distribution.

l Enter a Batch Number or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month and year.

2     Create a miscellaneous charge. 

l Select the cycles you would like to apply the miscellaneous charge to in the Cycle

field.

l The miscellaneous charge will be applied to all Active status customer

accounts in the selected billing batches.

l Press CTRL+A to highlight all of the billing cycles. Press SPACE to check or

uncheck the selected cycles.

l After the miscellaneous charges have been created they will display in the

Input step of the Adjustments and Fees palette. From the Input and Display

window you can delete and modify the miscellaneous charges applied to each

UB customer account.

l The Transaction Date field is used to enter the transaction date of the mis-

cellaneous charges.
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l The journal entry date of the transactions in the batch will be assigned during

the GL Distribution step (UB> Adjustments and Fees> GL Distribution).

l The post date of the transactions in the batch will be assigned to the current

date when the batch is committed in UB> Adjustments and Fees> Commit.

l The Adjustment Type field is used to select the adjustment type code that will be

used to generate the charges.

l Adjustment type codes are created and maintained on the Adjustment Type

Code Maintenance window (UB> Maintenance> Adjustment Type Codes).

l The service in the Charge This Service field on the fee codes attached to the

adjustment type code (UB> Maintenance> Fee Code> Charge This Service

field) must be attached to the UB customer accounts selected in the Cycles

field. If the service is not attached to a UB customer account included in the

batch you will receive an error message in the Jobs Viewer window (Jobs

Viewer icon on the main application window) and no transactions will be

display in the Input step (UB> Adjustments and Fees> Input).

l After the adjustment type code has been selected the fee codes attached to

the adjustment type code will populate in the Fee field.

l The Description field is used to add a description to the adjustment transactions

created by the process.

l The Fees field will display the fees attached to the adjustment type code selected in

the Adjustment Type field.

l Fees are attached to adjustment type codes in the Adjustment Type Main-

tenance window (UB> Maintenance> Adjustment Type> Fee Code field).
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l The fee codes attached to the adjustment type will determine the GL accounts

used to assess the charges.

l The Amount field will default to the flat amount set up on the fee code.

l Click in the Amount field to change the amount of the miscellaneous

charge.

l Click the Confirm icon to generate the transactions. Open the Jobs Viewer win-

dow (Jobs Viewer icon on the main application window) to view the progress of

the generate step.

3     Delete or modify the miscellaneous charges using the Input step of the Adjustments and Fees
palette. 

l Open the Input and Display window (UB> Adjustments and Fees> Input). This win-

dow will display all of the charges generated by the Miscellaneous Charges pro-

cess.

l Select a charge and press DELETE to remove the charge from the UB customer

account.

l Select a charge and press ENTER to modify the charge amount. This will open the

Cash Receipt Maintenance window and display the charge information.

l Modify the amount in the Amount column in the Details section to change the

charge amount. Changing the charge on one UB customer account will not affect

the charges on the other customer accounts in the batch.

l Click the Save icon when complete.
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4     Commit the Adjustments and Fees batch. 

l Run the Proof List, GL Distribution, and then commit the batch.

l The Post Date of the transactions in the batch will be the current date when

the Commit step is processed.

5     Bill the miscellaneous charges. 

l Create a New Billing batch on the billing cycle that miscellaneous charges were

applied to in UB> New Billing.

l When a New Billing is processed, the miscellaneous charges will display on the

billing statements as adjustment type transactions.
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UB> Adjustments and Fees> Redistribute
Credit Balances

Redistribute Credit Balances

Summary

The Redistribute Credit Balances process is used to move overpayments or credit bal-

ances on services to unpaid balances on other services on a customer account. This

ensures that credit balances on the customer account will be used to pay the balance on

services that are unpaid. The process creates a credit and debit within the applicable ser-

vices, creating a wash transaction (a transaction that does not affect the balance of the cus-

tomer account). If there are UB customer accounts with deposits, the deposit amounts will

not be redistributed to services with an unpaid balance.

The redistribute credit adjustment type set up in the Setup window (UB> Utilities> Setup>

Payment tab> Redistribute Adjustment Type field) affects the GL accounts used when
redistributing credits. The GL Type attached to the redistribute adjustment type will redis-

tributed the balances as cash type transactions.

The following journal entry will be created when credits are redistributed:

Description Debit Credit
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AR account attached to credit balance service (service with the

credit balance being redistributed)
XXX

Cash account attached to credit balance service XXX

AR account attached to debit balance service (service with a debit

balance being reduced by the redistribution of credits)
XXX

Cash account attached to debit balance service XXX

Step by Step

1     Create a new Adjustments and Fees batch. 

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the batch number drop-down menu. This will open the New Batch

window.

l The Redistribute Credit Balances process will overwrite any transactions that

have already been entered into the Adjustments and Fees batch, so you must

run the process in a new batch.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year, and are used for reference only. The fiscal period

the transactions in the batch are posted to is determined by the Journal Entry date

entered when creating the GL Distribution report in UB> Adjustments and Fees> GL

REDISTRIBUTE CREDIT BALANCES 139



Distribution. The transaction date of the adjustment transactions created by the pro-

cess is set up in the Redistribute Credit Balances window.

l Enter a Batch Number, or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. Batch numbers are limited to five digits and must be unique

within each batch month of the batch year.

2     Redistribute Credit Balances. 

l Select Redistribute Credit on the Adjustments and Fees palette to open the Redis-

tribute Credit Balances window.

l Select the customer accounts to process in the batch.

l Select the billing cycles in the Cycle section if you would like to run the redis-

tribute credits process by billing cycle.

l Press CTRL+A to highlight all of the billing cycles in the window. Press

SPACE to check or uncheck all of the highlighted toggles.

l Click the Account Number field label to select an account from a list to redis-

tribute credits for a single account. This will open the Account Master Search

window to select a customer account. If you enter a UB customer number in

the Account Number field, you do not have to select a billing cycle in the Cycle

field or an account status in the Status field.

l Select the services to redistribute in the Services section.

REDISTRIBUTE CREDIT BALANCES 140



l You must select each service you would like to include in the redistribution. For

example, if you would like to redistribute a credit balance in the WATER service to a

debit balance in the GAS service, both of those services must be selected in the Ser-

vices field.

l Press CTRL+A to highlight all of the billing cycles in the window. Press

SPACE to check or uncheck all of the highlighted toggles.

l You must select at least one service in the window.

l Services with the Exclude from Redistribute toggle checked (UB> Main-

tenance> Account> Services Tab) will not be included in the batch. This

toggle is commonly used to exclude specific services from the redistribution

process as is often required in energy assistance programs.

l Enter a Transaction Date. This is the date that will be assigned to the adjustment

transactions created by the redistribute credit balances process.

l Select the account statuses of the accounts you would like to include in the redis-

tribute credit balances process in the Status field. If you entered a UB customer

number in the Account Number field you do not have to select the status of the

selected account to include it in the batch. You can leave this field blank.

l Press CTRL+A to highlight all of the account statuses in the window. Press

SPACE to check or uncheck all of the highlighted toggles.

l Check the Shift Credits on Negative Balance Accounts toggle if you would like

to process accounts that have a negative balance on all services. The credit bal-

ances will be distributed to the services on the UB customer account based on the

overpayment percentages set up on the services.

l Overpayment percentages are set up on services using the Service Main-

tenance window (UB> Maintenance> Service> Overpay Percent field).
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l Press ENTER to run the process immediately or enter a date and time in the field

next to the Confirm icon to schedule the redistribution process to run at a later

time.

l You can view the progress of the process on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs). If the process has been scheduled to run at a

later time, you can view the scheduled date and time in the Scheduled

Date/Time field.

l You cannot schedule the process to run on a date and time that has already

passed. If you want the process to run later in the evening, enter a PM in the

AM/PM portion of the date field before entering the hour.

3     Commit the UB Adjustments and Fees batch. 

l Print a Proof List Report.

l Generate the Proof List (UB> Adjustments and Fees> Proof List).

l Click the Print icon to process the report immediately or enter a date and

time in the field next to the Print icon to schedule the report to generate at a

later time. You can view the progress of the report on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to pre-

view the report before printing.

l Click the Print icon drop-down menu and select Excel to export the

report data to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to

export the report data to an Excel spreadsheet that includes much of

the Springbrook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the

View Reports window (SS> Utilities> View Report).

l The Proof List will display the service balances being redistributed on each

UB customer account included in the batch.

l The services with a positive adjustment are the service balances that are

being increased (reducing the negative balance) and the services with a neg-

ative adjustment are the service balances being reduced.

l Print a GL Distribution Report.

l If you would like to recreate the GL Distribution Report after the batch has

been committed, you can create a Transaction by Date Report (UB> Reports>

Transaction by Date) for the committed Adjustments and Fees batch. Select

the committed batch (UB> Reports> Transaction by Date> Batch Number

field), include all cycles, and make sure the date filter includes all of the trans-

actions in the batch.

l Commit the batch (UB> Adjustments and Fees> Commit).

l The Commit step is only enabled after you have generated all of the required

reports on the Adjustments and Fees palette.
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UB> Adjustments and Fees> Remove
Budget Accounts

Remove Budget Accounts

Summary

The Remove Budget Accounts process is used to remove UB accounts from the Budget

Billing process. Organizations can also use this process to generate adjustments to clear

underpayment or overpayments on Budget Billing accounts.

Step by Step

1     Create a UB Adjustments and Fees batch. 

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the Adjustments and Fees batch number drop-down menu to cre-

ate a new batch. This will open the New Batch window.

l If there are open batches in the Adjustments and Fees process, you can cre-

ate a new batch without affecting the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report in UB> Adjustments

and Fees> GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Remove the Budget Accounts.

l Open the Remove Budget Accounts window (UB> Adjustments and Fees>

Remove Budget Accounts).

l Select the billing cycles you would like to include the process in the Cycles field.

l Press CTRL+A to highlight all of the toggles in the fields. Press SPACE to

check or uncheck the highlighted toggles.

l Check the toggle for each Account Status you would like to include in the batch.

l The Transaction Date field is used to enter the transaction date of the budget

account removal.
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l The Transaction Date field will default to the current date, but you can modify

the date if you would like to set the budget account removal to a different date.

l Select an Adjustment Type for the removal transaction.

l Only adjustment types set up as Bill distribution adjustment types can be

selected.

l The Started Before field is used to limit the accounts included in the batch to those

that were part of the budget billing prior to the date entered.

l This can help filter out those accounts that may have only been recently

added to the budget billing process.

l Check the Keep on Budget toggle if you would like the accounts included in the

batch to remain on budget billing.

l Many organizations will use the Remove Budget Accounts process on an

annual basis to address any differences between the budget billing amount

and the actual consumption amount. When this toggle is checked, the system

creates an adjustment on the account to either debit any underpayments or

credit any overpayments.

l Included accounts will have their Budget Deferred Balance value cleared and

the Recalculation Date field on the account will display the date the Remove

Budget Accounts batch was committed.

l Click the Create icon to select a specific account for the batch. This can be used

multiple times to add multiple accounts tot he batch.

l When individual accounts are added to the batch, the Billing Cycle, Account

Status, and Started Before filters above will be ignored and only the accounts

added to this field will be processed.
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l Press ENTER or click the Confirm icon to begin the remove budget accounts

process.

l You can view the progress of the process on the Job Viewer window in SS>

Utilities> Show Scheduled Jobs.

3     Confirm the Budget Accounts for removal. 

l Open the Input step (UB> Adjustments and Fees> Input). This is an optional step.

l After the Remove Budget Accounts step is complete, the Input window will display

all the accounts included in the batch.

l Highlight an included account and click the Modify icon to edit the adjustment

details.

l If you would like to add additional miscellaneous adjustments to the batch, click the

Create icon drop-down and select the desired adjustment type.

l You cannot add additional remove from budget adjustments on this step. If

there are additional accounts that need to be added to the batch, they must be

added via the Remove Budget Accounts step.

4     Print a Proof List. 
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l Open the Proof List window (UB> Adjustments and Fees> Proof List) and print the

Proof List Report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print a General Ledger Distribution Report. 

l Open the GL Distribution window and print a GL Distribution report.

l Select a detailed option in the Report Type drop-down menu if you would like

to display the journal entry line item created by each customer account in the

batch.
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l Select a summary option if you would like to display the net journal entry cre-

ated by all the transactions in the batch.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the batch. 

l Open the Commit window (UB> Adjustments and Fees> Commit) and commit the

batch.
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UB> Adjustments and Fees> Factor
Deposit Interest

Factor Interest on Deposits

Summary

The Factor Deposit Interest feature is used to accrue interest on customer deposits. The

interest rate used to calculate the accrued interest is the interest rate attached to the

deposit fee code used to generate the deposit (UB> Maintenance> Fee Code> Per-
centage Amount field). If you do not want to factor interest using the interest rate attached
to the deposit fee code used to generate the deposit, you can select a different deposit fee

code. The factored interest on the deposits can be applied to the deposits (increases the

deposit amount), or it can be applied to the customer account (lower the customer account

balance). This will affect the journal entry generated by the process.

Before you use the Factor Deposit Interest feature, you must have the following set up: a

deposit adjustment type in the Setup window (UB> Utilities> Setup> General tab> Apply
Deposit Adjustment Type field), a fee code labeled INT and interest rates attached to the
deposit fee codes you would like to factor interest on (UB> Maintenance> Fee Code> Per-
centage Amount field). The charge service on the deposit fee codes must also be
attached to the UB customer accounts you would like to factor interest on (UB> Main-

tenance> Fee Code> Select a deposit fee code> Service to Charge field).
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The deposit adjustment type selected in the Setup window affects the journal entries cre-

ated in the factor deposit interest process. The GL accounts attached to the INT fee code

will be used to record the interest amount if you choose to decrease the UB customer

account balance. And the interest rate attached to the deposit fee codes you would like to

factor interest on will be used to calculate interest on the deposit amounts.

The process will create the following journal entry based on how the interest will be

applied:

Increase the Deposit Amount

GL Account used in transaction Debit Credit

Revenue account attached to INT fee code XXX

Cash account attached to INT fee code XXX

Cash account attached to Deposit fee code XXX

Revenue account attached to Deposit fee code XXX

Decrease the Customer Account Balance

GL Account used in transaction Debit Credit

Revenue account attached to the INT fee code XXX

Cash account attached to the INT fee code XXX

Cash account attached to the service rate on the customer account

that is being reduced (The service rate will display on the GL Dis-
XXX

FACTOR INTEREST ON DEPOSITS 151



tribution Report)

AR account attached to service rate XXX

If the deposit adjustment type selected in the Setup window (UB> Utilities> Setup> General

tab> Apply Deposit Adjustment Type field) is set up as a Bill rather than Cash type (UB>
Maintenance> Adjustment Type> Select the deposit adjustment type> GL Type drop-down
menu) the Revenue account on the service rate will be debited instead of the cash account

attached to the service rate.

Interest can also be factored when the deposit is being refunded (UB> Refunds).

Step by Step

1     Create a UB Adjustments and Fees batch. 

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the Adjustments and Fees batch number drop-down menu to cre-

ate a new batch. This will open the New Batch window.

l If there are open batches in the Adjustments and Fees process, you can cre-

ate a new batch without affecting the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report in UB> Adjustments

and Fees> GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Factor interest on selected customer accounts. 

l Open the Factor Deposit Interest window (UB> Adjustments and Fees> Factor

Deposit Interest).

l Select the billing cycles you would like to include the process in the Cycles field.

You can also accrue interest on a single UB customer account by using the

Account Number field.

l Press CTRL+A to highlight all of the toggles in the fields. Press SPACE to

check or uncheck the highlighted toggles.
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l Select the deposit codes you would like to factor interest on in the Deposit Codes

field.

l There must be an interest rate attached to the deposit fee code before it will

display in the field. Interest rates are attached to deposit fee codes in the Fee

Code Maintenance window (UB> Maintenance> Fee Code> Select the

deposit fee code> Percentage Amount field).

l Click the Account Number field label to accrue interest on a single customer

account. This will open a window to select a customer account. Leave this field

blank if you would like to accrue interest on customer accounts by billing cycles.

l The Transaction Date field is used to enter the transaction date of the interest

factored on the deposits.

l If you select Calculate Interest Since Last Time in the Calculate Interest

Range drop-down menu, the date entered in this field will determine how

interest will be calculated on the customer accounts.

l For example, if interest was last calculated on a customer account on

06/01/2019 and 08/15/2019 is entered in the Transaction Date field,

interest will be calculated on the account for 06/01/2019 to 08/15/2019.

l The Transaction Date field will default to the current date, but you can modify

the date if you would like to factor interest to a different date.

l The Use Alternate Interest Rate drop-down menu is used to select a deposit fee

code that contains the interest rate you would like to apply to the deposits. If there

are multiple deposit fee codes selected in the Deposit Codes field, the selected

interest rate will be applied to all of the deposit codes.

l Select None if you would like to apply the interest rate attached to the deposit

fee code. Interest rates are attached to deposit fee codes using the Fee Code

FACTOR INTEREST ON DEPOSITS 154



Maintenance window (UB> Maintenance> Fee Code> Percentage Amount

field). If there are multiple deposit fee codes selected in the Deposit Codes

field, the interest rate attached to each fee code will be used to calculate the

interest on the deposits.

l The GL accounts used to create the interest on the deposit codes will be

pulled from the GL accounts attached to the deposit fee codes. If you do not

want to use the GL accounts attached to the deposit fee codes, create a new

deposit fee code with the correct GL accounts and select it in the Use Altern-

ative Interest Rate drop-down menu.

l The Calculate Interest Range drop-down menu is used to select how you would

like to calculate interest on the customer accounts in the batch.

l Select Calculate Interest For One Year to accrue interest for an entire year.

l Select Calculate Interest Since the Last Time toggle to accrue interest

since the last time interest was calculated on the deposit fee codes included

in the batch.

l Check the Apply the interest to accounts toggle if you would like to apply the

interest to the customer account rather than the deposit. This will lower the cus-

tomer account balance, rather than increase the deposit amount.

l The selection in this toggle will affect the journal entry created by this process.

l Press ENTER to factor the interest immediately or enter a date and time in the field

next to the Confirm icon to schedule the process to run at a later time.

l You can view the progress of the process on the Job Viewer window in SS>

Utilities> Show Scheduled Jobs. If the process has been scheduled to gen-

erate at a later time, you can view the scheduled date and time in the Sched-

uled Date/Time field.
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l Once the process is complete, the interest transactions will display in the

Input window (UB> Adjustments and Fees> Input).

3     View the interest transactions. 

l After the Factor Deposit Interest process is complete, the interest transactions will

populate in the Input and Display window (UB> Adjustments and Fees> Input).

l Open the Input and Display window to view the interest transactions.

l Highlight a transaction and press DELETE to delete the selected transaction.

l Highlight a transaction and press ENTER to open the selected transaction. This will

open the Cash Receipt Maintenance window.

l The Cash Receipt Maintenance window will display the detail line items

attached to the transaction.

4     Print a Proof List. 

l Open the Proof List window (UB> Adjustments and Fees> Proof List) and print the

Proof List Report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show
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Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Proof List will display the amount of the interest.

l If the interest was applied to the customer account balance, the interest

amount will display attached to the service that will be credited.

l If the interest was applied to the deposit amount, the interest amount will not

be attached to a service on the Proof List. The interest amount will not be

applied to a service because the amount is increasing the deposit amount.

5     Print a General Ledger Distribution Report. 

l Open the GL Distribution window and print a GL Distribution report.

l Select a detailed option in the Report Type drop-down menu if you would like

to display the journal entry line item created by each customer account in the

batch.
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l Select a summary option if you would like to display the net journal entry cre-

ated by all the transactions in the batch.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The journal entry created by this process will vary depending on how the factored

interest is applied.

l If you are applying the factored interest to the deposit amount the following journal

entry will be created.

GL Account used in transaction Debit Credit

Revenue account attached to INT fee code XXX

Cash account attached to INT fee code XXX
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Cash account attached to Deposit fee code XXX

Revenue account attached to Deposit fee code XXX

l XXX - The debit and credit amounts will be the amount of interest factored on

the accounts pulled into the batch. This amount will vary based on the interest

rate (rate), the deposit amounts (principal amount), and length of time that

you are generating interest on.

l The GL accounts are not affected by the GL type of the deposit adjustment

type code selected in the Setup window (UB> Utilities> Setup> General tab>

Apply Deposit Adjustment Type field). The GL type of an adjustment code

is set up using the Adjustment Type Maintenance window (UB> Main-

tenance> Adjustment Type> Select the deposit adjustment type> GL Type

field).

l If you are applying the factored interest to the accounts, the following journal entry

will be created.

GL Account used in transaction Debit Credit

Revenue account attached to the INT fee code XXX

Cash account attached to the INT fee code XXX

Cash account attached to the service rate on the cus-

tomer account that is being reduced (The service rate

will display on the GL Distribution Report)

XXX

AR account attached to service rate XXX
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l If the deposit adjustment type selected in the Setup window (UB> Utilities>

Setup> General tab> Apply Deposit Adjustment Type field) is set up as a

Cash rather than Bill type (UB> Maintenance> Adjustment Type> Select the

deposit adjustment type> GL Type drop-down menu) the Revenue account

on the service rate will be debited instead of the cash account attached to the

service rate.

l XXX - The debit and credit amounts will be the amount of interest factored on

the accounts pulled into the batch. This amount will vary based on the interest

rate (rate), the deposit amounts (principal amount), and length of time that

you are generating interest on.

6     Commit the batch. 

l Open the Commit window (UB> Adjustments and Fees> Commit) and commit the

batch.

7     View a customer account processed in the batch. 

l Open a customer account processed in the batch (UB> Maintenance> Account> His-

tory tab> select Deposit History in the drop-down menu).
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l If you applied the factored interest to the balance of the customer account, there will

be only one interest line item. The single line item records the interest on the

account and has a transaction type of Interest. Select Account History from the

drop-down menu at the top of the window to view the Adjustment transaction line

item than reduces the balance of the customer account.

l Click on the Overview tab of the Account Master Maintenance window to view

how the interest transaction has affected the Ending Balance on the customer

account.

l If you did not apply the factored interest to the balance of the customer account,

there will be two new line items in the Deposit History.

l The first line item records the interest factored on the deposit and has a trans-

action type of Interest.

l The second line item in the increase in the deposit and it has a transaction

type of Deposit.

FACTOR INTEREST ON DEPOSITS 161



UB> Adjustments and Fees> Reset Net
Meter Banks

Reset Net Meter Banks

Summary

The Reset Net Meter Banks process is used to reset the banked consumption values and

credit those values to the accounts.

Step by Step

1     Create a UB Adjustments and Fees batch. 

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the Adjustments and Fees batch number drop-down menu to cre-

ate a new batch. This will open the New Batch window.

l If there are open batches in the Adjustments and Fees process, you can cre-

ate a new batch without affecting the open batches.

RESET NET METER BANKS 162



l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report in UB> Adjustments

and Fees> GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

2     Reset the net meter banks.

l Open the Reset Net Meter Banks window (UB> Adjustments and Fees> Reset Net

Meter Banks).

l Select the billing cycles you would like to include the process in the Cycles field.

You can also reset the net meter banks on a single UB customer account by using

the Account Number field.

l Press CTRL+A to highlight all of the toggles in the fields. Press SPACE to

check or uncheck the highlighted toggles.
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l Click the Account Number field label to reset net meter banks on a single customer

account. This will open a window to select a customer account. Leave this field

blank if you would like to reset net meter banks on customer accounts by billing

cycles.

l Check the toggle for each Account Status you would like to include in the batch.

l The Transaction Date field is used to enter the transaction date of the reset.

l The Transaction Date field will default to the current date, but you can modify

the date if you would like to reset net meter banks to a different date.

l Select an Adjustment Type for the reset transaction.

l Only adjustment types set up as Bill distribution adjustment types can be

selected.

l The optional Service and Service Rate fields are used to select the service and the

service rate that will be credited the amount of the banked consumption.

l These fields allow organizations to control the rate used when applying credit

for banked consumption. For example, if an organization credits customer

banked consumption at the wholesale rate rather than the standard rate, the

wholesale rate should be selected here.

l Press ENTER to factor the interest immediately or enter a date and time in the field

next to the Confirm icon to schedule the process to run at a later time.

l You can view the progress of the process on the Job Viewer window in SS>

Utilities> Show Scheduled Jobs. If the process has been scheduled to gen-

erate at a later time, you can view the scheduled date and time in the Sched-

uled Date/Time field.
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l Once the process is complete, the interest transactions will display in the

Input window (UB> Adjustments and Fees> Input).

3     View the reset net meter banks. 

l After the Reset Net Meter Banks process is complete, the accounts that include

meters that will have their net meter banks reset will populate in the Input and Dis-

play window (UB> Adjustments and Fees> Input).

l Highlight a transaction and press DELETE to delete the selected transaction.

l Highlight a transaction and press ENTER to open the selected transaction. This will

open the Cash Receipt Maintenance window.

l The Cash Receipt Maintenance window will display the detail line items

attached to the transaction.

4     Print a Proof List. 

l Open the Proof List window (UB> Adjustments and Fees> Proof List) and print the

Proof List Report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show
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Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Proof List will display the adjustment details associated with all of the accounts

that will have their net meter banks reset.

5     Print a General Ledger Distribution Report. 

l Open the GL Distribution window and print a GL Distribution report.

l Select a detailed option in the Report Type drop-down menu if you would like

to display the journal entry line item created by each customer account in the

batch.

l Select a summary option if you would like to display the net journal entry cre-

ated by all the transactions in the batch.
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the batch. 

l Open the Commit window (UB> Adjustments and Fees> Commit) and commit the

batch.
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UB> Adjustments and Fees> Import

Import an Adjustment

Summary

The Import step of the UB Adjustments and Fees process is an optional step used to import

a group of adjustment fees. For example, an organization that outsources garbage col-

lection could import a set of fee adjustments to bill for garbage contractor services.

Step by Step

1     Create an Adjustments and Fees batch. 

l Additional billings are generated using the Adjustments and Fees palette.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the UB Adjustments and Fees batch number drop-down menu.

This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year, and are used for reference only.
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l The transaction date of the miscellaneous billing is set up in the Input Billings

window when the billing is generated (UB> Adjustments and Fees> Input>

Select Billing from the Create icon drop-down> Transaction Date field).

l The fiscal period the journal entry created is set up during the GL Distribution

report (UB> Adjustments and Fees> GL Distribution> Journal Entry Date

field).

l Enter a Batch Number, or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Import the fee adjustments. 

l Open the Adjustments and Fees Import window (UB> Adjustments and Fees>

Import).

l Select the Configuration of the import file.

l The Configuration drop-down field will display all of the import configurations

created in the application.

l Import configurations are customized import layouts that will take the

data from an from a third-party application export file and reconfigure it

to meet Springbrook layout requirements.
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l Import file configurations are created and maintained on the Import Con-

figuration Maintenance window (SS> Maintenance> Import Con-

figuration).

l Once a configuration is selected, you can click the Layout icon to display

additional information about the expected layout of the import file.

l If the import file does not match the expected configuration, the import

process will encounter an error and the file will not be imported.

l Enter the File Name or click the field label to browse to the desired import file.

l The Tran Date field is used to assign a specific transaction date to all records

included in the import file. This will override any transaction date previously asso-

ciated with those records.

l Check the Use record Date toggle to use the transaction date associated with each

record in the import file.

l When this toggle is checked, the import will ignore the Tran Date field above.

l An error message will display if this toggle is checked and any of the records

in the import file do not include a transaction date.

l Click the Confirm icon to import the file.

3     Commit the Adjustments and Transactions. 

l After the fee adjustments have been imported into the Adjustments and fees batch,

print the Proof List and GL Distribution reports and commit the batch to commit the
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billings on the UB customer accounts.

l The Commit step is only enabled after you have generated all of the required

reports on the Adjustments and Fees palette.
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UB> Adjustments and Fees> Input

Input a Billing

Summary

The Input Additional Billings process is used to apply manual billings to Utility Billing cus-

tomer accounts using a fee code and/or service rate. The Input Billings process is generally

used to create billing transactions that are not applied through the regular billing process

(UB> New Billing).

You can only bill a fee code if the charge service on the fee code (UB> Maintenance> Fee

Code> Service to Charge field) is attached to the customer account (UB> Maintenance>
Account> Service Rates tab). You can also only bill service rates that are attached to the

customer account.

Use the Miscellaneous Charges process (UB> Adjustments and Fees> Miscellaneous

Charges) if you would like to assess charges on UB customer accounts using an adjust-

ment type code. Alerts and credit information attached to the adjustment type code will be

applied to the customer accounts processed in the Miscellaneous Charges process.
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After charges have been created using the additional billings process, generate a New

Billing batch on the accounts to bill the charges. Depending on how the billing statements

are set up, the additional billings created by this process will display as individual lines

items on the billing statement.

Step by Step

1     Create an Adjustments and Fees batch. 

l Additional billings are generated using the Adjustments and Fees palette.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the UB Adjustments and Fees batch number drop-down menu.

This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year, and are used for reference only.

l The transaction date of the miscellaneous billing is set up in the Input Billings

window when the billing is generated (UB> Adjustments and Fees> Input>

Select Billing from the Create icon drop-down> Transaction Date field).

l The fiscal period the journal entry created is set up during the GL Distribution

report (UB> Adjustments and Fees> GL Distribution> Journal Entry Date

field).
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l Enter a Batch Number, or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Create the billing. 

l Select Input from the Adjustments and Fees palette. This will open the Input and Dis-

play window.

l The Input and Display window will display all of the transactions in the batch.

Highlight a transaction and press ENTER to open the selected transaction.

l Click the Create icon drop-down menu and select Billing. This will open the

Input Billings window.

l Select the customer account in the Account Number field. Enter an account num-

ber or click the Account Number field label to select the account from a list.

l The service rates attached to the customer account will populate in the win-

dow. The service rates populate in the window so that you can create a billing

using a service rate.

l The Transaction Date field will determine the transaction date of the billing.

l Check the Tax transactions toggle if you would like to tax the billing amounts.
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l This only applies to billings generated using a service rate. The tax code

attached to the service rate will be applied to the billing entered on the service

rate. Tax codes are attached to service rates using the Service Rate Main-

tenance window (UB> Maintenance> Service Rates> Winter Average/Taxes

tab> Tax Code field). The tax amount will be applied using the target service

on the tax code (UB> Maintenance> Tax Code> Target Service field).

l Check the Save fee codes toggle if you are generating billings on multiple cus-

tomer accounts using the same fee codes. When this toggle is checked, the fee

codes added to the Input Billings window will stay in the window after the billing has

been created on a customer account. This reduces the data entry of adding the fee

code to each customer account in the billing.

l Enter a description of the billing in the Description field.

3     Enter the charges. 

l The Charges section is used enter the billing amount. The service rates attached to

the customer account selected in the Account Number field will populate in the

Charges section.

l Enter the billing amount on a service rate line item in the Charges section to create

a billing on a service rate. Enter a billing amount in the Amount column and enter a

multiplier in the Multiplier column.

l If the Tax transactions toggle is checked, the tax codes attached to the ser-

vice rates will be applied to the billing. Tax codes are attached to service rates
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using the Service Rate Maintenance window (UB> Maintenance> Service

Rates> Winter Average/Taxes tab> Taxes field).

l Press INSERT to create a billing using a fee code. This will open the Fee Code

Selection window. Select a fee code and the fee code will populate on the Input

Billings window.

l The charge service on the fee code (UB> Maintenance> Fee Code> Service

to Charge field) must be attached to the customer account selected in the

Account Number field.

l Services are attached to customer accounts using the Account Master

Maintenance window (UB> Maintenance> Account> Service Rates tab).

l The flat amount attached to the fee code will populate on the billing line item

created by adding the fee code. Modify the amount in the Amount column to

change the amount of the billing.

l Enter a multiplier in the Multiplier column. The value in the Multiplier column

will be multiplied by the Amount to calculate the value in the Bill Amount

column.

l Enter 1 if the value in the Amount column should be billed.

l Press ENTER to create the billing. The Input Billings window will reload and the

billing will populate on the Input and Display window. If the Save fee codes toggle

was checked, the fee codes attached to the saved billing will populate in the Input

Billings window.

4     Commit the Adjustments and Transactions. 
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l After the billings have been entered into the Adjustments and Transactions batch,

print the Proof List and GL Distribution reports and commit the batch to commit the

billings on the UB customer accounts.

l The Commit step is only enabled after you have generated all of the required

reports on the Adjustments and Fees palette.
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UB> Adjustments and Fees> Input

Payment Adjustment

Summary

The Adjustment Input Wizard is used to create adjustments on meter readings or trans-

actions and can be used to adjust a payment made on a UB customer account. Payment

adjustments are used to adjust a committed payment transaction on a UB customer

account created in the Cash Receipts module or in the Import process (UB> Adjustments

and Fees> Import). If you would like to adjust an uncommitted payment line item, delete the

payment transaction in the open batch and regenerate the payment transaction.

Payment adjustments can be used to shift the payment made from one service to another.

For example, if the customer paid $25 on their WATER service and $50 on their GAS ser-

vice, you can create a payment adjustment to shift the $25 from the WATER service to the

GAS service. You cannot add services to a payment adjustment that were not part of the

original payment, so if you would like to shift the payment from one service to another,

make sure both services are on the payment that is being adjusted.

Payment adjustments can also be used to move the payment made on one account

sequence to another. For example, if a customer made a payment on UB account 000001-

000 but would like the payment to go to their other UB account (000001-001), create a pay-
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ment adjustment to remove the payment from UB account 000001-000. Then create a Pay-

ment adjustment on UB account 000001-001 and increase the amount of a payment trans-

action.

If you adjust a payment transaction created in the Cash Receipts module, the UB customer

account balance will be updated, but the receipt amount in the Cash Receipts module will

not be adjusted. For example, if a customer makes a payment of $100 on their UB account

and you create an adjustment that reduces the payment to $75, the receipt will still display

as $100 in the Cash Receipts module.

Step by Step

1     Create or open an Adjustments and Fees batch. 

l Adjustment transactions added to an existing batch will not overwrite the trans-

actions already entered into the batch, but the batch will return to the Input step if a

Proof List or GL Distribution report has been created.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the Adjustments and Fees batch number drop-down menu. This

will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year, and are used for reference only. The fiscal period
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the transactions in the batch are posted to is determined by the Journal Entry date

entered when creating the GL Distribution report in UB> Adjustments and Fees> GL

Distribution.

l Enter a Batch Number, or click the Generate icon to create a batch using the next

available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Create a new adjustment transaction. 

l Open the Input and Display window (UB> Adjustments and Fees> Input). The

Input and Display window will display all of the transactions in the Adjustments and

Fees batch.

l Highlight an existing transaction and click the Delete icon to delete the

transaction.

l Highlight an existing batch and click the Modify icon to open the trans-

action.

l Click the Create icon drop-down menu to create a new adjustment.

l Select Adjustment from the drop-down menu. This will open the Adjust-

ment Wizard.
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3     Create an adjustment. 

l The Adjustment Input Wizard is used to create adjustments on UB customer

accounts.

l Enter an account number or click the Account Number field label to select the cus-

tomer account from a list.

l This will populate the Reference Number, Customer Name and Service

Address with the information attached to the selected customer account.

l Select Payment in the Transaction Type drop-down menu.

l The selection in the Transaction Type drop-down menu will determine which

adjustment types will display in the Adjustment Type drop-down menu. When

you select Payment, only cash type adjustment types will display in the Adjust-

ment Type drop-down menu.

l Select an adjustment type in the Adjustment Type drop-down menu. The selected

adjustment type will be attached to the adjustment type transaction line created by

the Adjustment Input Wizard.

l Only cash type adjustment types will display in the drop-down menu when

Payment is selected in the Transaction Type drop-down menu.

l Adjustment types are set up as bill types using the Adjustment Type Main-

tenance window (UB> Maintenance> Adjustment Type> GL Type drop-

down> Select Bill).

l Modify the date in the Transaction Date field to change the transaction date of the

adjustment. This field will populate with the current date.

l Enter a description of the adjustment in the Description field if you would like to

add a description to the adjustment transaction.
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l The description will display on the History tab of the Account Master Main-

tenance window (UB> Maintenance> Account> History tab> Description

column).

l The Customer Name and Service Address fields will populate after you select a

customer account in the Account Number field.

l Click the Next button after you have entered the information on the first step.

4     Select a payment line item to adjust. 

l The second step of the Adjustment Input Wizard will display all of the committed pay-

ment line items on the customer account selected in the first step. Uncommitted pay-

ment line items cannot be adjusted.

l If you would like to adjust an uncommitted payment, delete or modify the pay-

ment in the uncommitted batch. For example, if the payment you would like to

modify is in an open Cash Receipts batch (CR> Cash Receipts), void or

modify the receipt.

l Select the payment line item you would like to adjust. You can select only one pay-

ment transaction to adjust.

l Check the Reverse Transactions toggle if you would like to reverse the selected

transaction. This will populate the next step with the adjustment amounts required

to reverse the payment amount.

l For example, if you check the Reverse Transactions toggle and select a line

item of $100, the next step will reverse all of the line items on the payment to
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create a -$100 adjustment.

l Click the Next button when the billing is selected.

5     Enter the adjustment. 

l The payment line items associated with the payment selected in the last step will

populate in the window. All of the service rates and fee codes paid on the payment

line item will display. Enter an adjustment amount in the Adjustment Amount

column to create the adjustment. Positive amounts will reduce the amount of the

payment and negative amounts will increase the amount of the payment.

l For example, if you would like move a payment of $15 from a fee code to a ser-

vice rate, enter $15 on the fee code to reduce the payment amount and enter -

$15 to increase the payment on the service rate.

l When creating a positive amount adjustment, the AR account on the service

rate or fee code will be debited and the Cash account will be credited (reduce

the amount in the cash account).

l If you enter 0 in the Adjustment Amount column, an adjustment will be created

but it will have a zero amount. If you would like to reduce the payment down to

zero, enter a negative amount to offset the payment.

l The GL accounts used in the journal entry created by the adjustment trans-

action will be pulled from the service rates or fee codes being adjusted. For

example, if you reduce the payment on the WT1 service rate, the GL accounts
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attached to service rate WT1 will be used to create the adjustment journal

entry.

l If you checked the Reverse Transaction toggle on the previous step, the

Adjustment Amount column will populate with the adjustment amounts to

reverse the payment.

l Click the Finish button when complete to adjust the billing.

6     Commit the payment adjustment. 

l Once the adjustment has been created, you can view the adjustment on the UB cus-

tomer account using the Account Master Maintenance window (UB> Main-

tenance> Account> History tab).

l The adjustment transaction will display in red as it is still uncommitted.

l Print a Proof List.

l Generate the Proof List (UB> Adjustments and Fees> Proof List).

l Click the Print icon to process the report immediately or enter a date

and time in the field next to the Print icon to schedule the report to gen-

erate at a later time. You can view the progress of the report on the Job

Viewer window (SS> Utilities> Show Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to

preview the report before printing.
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l Click the Print icon drop-down menu and select Excel to export

the report data to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted)

to export the report data to an Excel spreadsheet that includes

much of the Springbrook formatting found on the printed version

of the report.

l Once the report is generated, you can also display the report

using the View Reports window (SS> Utilities> View Report).

l The Proof List will display the adjustment amount, the service being adjusted

and the customer account information.

l Print a GL Distribution report.

l Enter the journal entry date and generate the GL Distribution Report (UB>

Adjustments and Fees> GL Distribution).

l The GL Distribution Report will display the journal entry created by the adjust-

ment.

l The GL accounts attached to the service rates or fee codes on the payment

line items being adjusted will be used in the journal entry. The AR and cash

accounts attached to the fee code or service rates will be used in the journal

entry.

l If the adjustment was a positive amount (reduce the payment), the

adjustment will debit the AR account (increase the amount expected

from the customer in the future) and credit the cash account (decrease

the cash account balance).
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l If the adjustment was a negative amount (increase the payment), the

adjustment will debit the cash account (increase the cash account bal-

ance) and credit the AR account (decrease the amount expected from

the customer in the future).

l Commit the adjustments.

l Open the Commit window (UB> Adjustments and Fees> Commit).

l The Commit window will display the journal entry date of the journal entry cre-

ated by the process.
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Adjustment Input Wizard

Billing Adjustment

Summary

The Adjustment Input Wizard is used to create adjustments on meter readings or trans-

actions and can be used to create a billing adjustment on a committed billing transaction.

Billing adjustments are used to adjust a committed billing transaction on a UB customer

account created in the New Billing, Final Billing, Miscellaneous Billing or Additional Billing

process. If you would like to adjust an uncommitted billing line item, delete the billing trans-

action in the open batch and regenerate the billing transaction.

To create a billing adjustment, open the Adjustment Input Wizard, select the billing to

adjust on the customer account and then modify the line items that displayed on the ori-

ginal billing. The billing adjustment will not adjust any meter readings that resulted in the

billing. For example, if a leak has caused a high billing, reducing the billing with a bill adjust-

ment will not reduce the meter readings on the account. The bill adjustment will just modify

the billing transaction on the customer account. If you would like to adjust the billed meter

readings on a customer account, use the Adjustment Input Wizard to create a leak or con-

sumption adjustment.

Step by Step
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1     Create a new Adjustments and Fees batch. 

l Adjustment transactions added to an existing batch will not overwrite the trans-

actions already entered into the batch, but the batch will return to the Input step if a

Proof List or GL Distribution report has already been created.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the UB Adjustments and Fees batch number drop-down menu.

This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year and are used for reference only. The fiscal period

the transactions in the batch are posted to is determined by the Journal Entry date

entered when creating the GL Distribution report (UB> Adjustments and Fees> GL

Distribution).

l Enter a Batch Number or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Create a new adjustments transaction. 
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l Open the Input and Display window (UB> Adjustments and Fees> Input). The

Input and Display window will display all of the transactions in the Adjustments and

Fees batch.

l Highlight an existing transaction and click the Delete icon to delete the

transaction.

l Highlight an existing batch and click the Modify icon to open the trans-

action.

l Click the Create icon drop-down menu.

l Select Adjustment from the drop-down menu. This will open the Adjust-

ment Wizard.

3     Create an adjustment on an account. 

l Enter an account number or click the Account Number field label to select the cus-

tomer account from a list.

l This will populate the Reference Number, Customer Name and Service

Address with the information attached to the selected customer account.

l Select Billing in the Transaction Type drop-down menu.

l An error icon will display next to the Transaction Type drop-down menu if

there are no committed billing transactions on the customer account.

l Select an adjustment type in the Adjustment Type drop-down menu. The selected

adjustment type will be attached to the adjustment type transaction line.
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l Only bill type adjustment types will display in the drop-down menu when

Billing is selected in the Transaction Type drop-down menu.

l Adjustment types are set up as bill types using the Adjustment Type Main-

tenance window (UB> Maintenance> Adjustment Type> GL Type drop-

down> Select Bill).

l Modify the date in the Transaction Date field to change the transaction date of the

adjustment. This field will populate with the current date.

l The Consumption Adjustment Type drop-down menu is used to create a leak,

meter read, or consumption adjustment. Select N/A unless you would like to adjust

the meter readings that resulted in the billing line item.

l There is a separate document that describes leak and meter read adjust-

ments.

l Enter a description of the adjustment in the Description field if you would like to

add a description to the adjustment transaction.

l The description will display on the History tab of the Account Master Main-

tenance window (UB> Maintenance> Account> History tab> Description

column).

l The Customer Name and Service Address fields will populate after you select a

customer account in the Account Number field.

l Click the Next button after you have entered the information on the first step.

4     Select a billing line item to adjust. 

BILLING ADJUSTMENT 190



l The second step of the Adjustment Input Wizard will display all of the billing line

items on the customer account selected in the first step. The window will only dis-

play committed billing line items. Uncommitted billing line items cannot be adjusted.

l If you would like to adjust an uncommitted billing, delete or modify the billing

in the uncommitted batch. For example, if the billing you would like to modify

is in a New Billing batch, delete the New Billing batch, modify the customer

account, and then regenerate the New Billing batch. You can also commit the

New Billing batch and then adjust the billing.

l Select the billing line item you would like to adjust. You can select only one billing to

adjust.

l Check the Adjust Actual Amounts - Budget Bills toggle to adjust the Budget

Deferred amount on an account set up for budget billing. If this toggle is left

unchecked, the adjustment will be made to the account balance.

l Check the Reverse Transaction toggle if you would like to reverse the selected

transaction. This will automatically create adjustment amounts on the next step of

the wizard that reverse the selected transaction.

l Click the Next button when the billing is selected.

5     Adjust the billing detail line items. 

l The billing line items associated with the billing selected in the last step will populate

in the window. Enter an adjustment amount in the Adjustment Amount column to

create the adjustment.
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l For example, if you would like to reduce the billing on a billed service rate by

$15, enter -$15 on the line item of the service rate you would like to reduce.

l If you enter 0 in the Adjustment Amount column, an adjustment will be cre-

ated but it will have a zero amount. If you would like to reduce the billing down

to zero, enter a negative amount to offset the billing.

l The GL accounts used in the journal entry created by the adjustment trans-

action will be pulled from the service rates or fee codes being adjusted. For

example, if you reduce the billing on the WT1 service rate, the GL accounts

attached to service rate WT1 will be used to create the adjustment journal

entry.

l If the Reverse Transaction toggle was checked on the previous step, the

Adjustment Amount column on the line items will populate with the values to

reverse the transaction.

l Click the Finish button when complete to adjust the billing.

6     Commit the billing adjustment. 

l Once the adjustment has been created, you can view the adjustment on the UB cus-

tomer account using the Account Master Maintenance window (UB> Main-

tenance> Account> History tab).

l The adjustment transaction will display in red as it is still uncommitted.

l Print a Proof List.
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l Generate the Proof List (UB> Adjustments and Fees> Proof List).

l Click the Print icon to process the report immediately or enter a date

and time in the field next to the Print icon to schedule the report to gen-

erate at a later time. You can view the progress of the report on the Job

Viewer window (SS> Utilities> Show Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to

preview the report before printing.

l Click the Print icon drop-down menu and select Excel to export

the report data to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted)

to export the report data to an Excel spreadsheet that includes

much of the Springbrook formatting found on the printed version

of the report.

l Once the report is generated, you can also display the report

using the View Reports window (SS> Utilities> View Report).

l The Proof List will display the adjustment amount, the service being adjusted

and the customer account information.

l Print a GL Distribution report.

l Enter the journal entry date and generate the GL Distribution Report (UB>

Adjustments and Fees> GL Distribution).

l The GL Distribution Report will display the journal entry created by the adjust-

ment.

l The GL accounts attached to the service rates or fee codes on the billing line

items being adjusted will be used in the journal entry. The revenue and cash
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accounts attached to the fee code or service rates will be used in the journal

entry.

l Commit the adjustments.

l Open the Commit window (UB> Adjustments and Fees> Commit).

l The Commit window will display the journal entry date of the journal entry cre-

ated by the process.
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Adjustment Input Wizard

Misread, Leak and Consumption Adjustments

Summary

The Adjustment Input Wizard is used to create adjustments on meter readings or trans-

actions and can be used to create a billing adjustment, such as a misread, leak, or con-

sumption adjustment. These billing adjustments are used to adjust a committed billing

transaction on a UB customer account created in the New Billing, Final Billing, Mis-

cellaneous Billing, or Additional Billing process. If you would like to adjust an uncommitted

billing line item, delete the billing transaction in the open batch and regenerate the billing

transaction.

To create a leak, misread, or consumption adjustment, open the Adjustment Input Wizard,

select the transaction to adjust on the customer account and then modify the line items

attached to the original billing.

Step by Step

1     Create a new Adjustments and Fees batch. 
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l Adjustment transactions added to an existing batch will not overwrite the trans-

actions already entered into the batch, but the batch will return to the Input step if a

Proof List or GL Distribution report has already been created.

l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the UB Adjustments and Fees batch number drop-down menu.

This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year and are used for reference only. The fiscal period

the transactions in the batch are posted to is determined by the Journal Entry date

entered when creating the GL Distribution report (UB> Adjustments and Fees> GL

Distribution).

l Enter a Batch Number or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Create a new adjustments transaction. 

l Open the Input and Display window (UB> Adjustments and Fees> Input). The

Input and Display window will display all of the transactions in the Adjustments and
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Fees batch.

l Highlight an existing transaction and click the Delete icon to delete the

transaction.

l Highlight an existing batch and click the Modify icon to open the trans-

action.

l Click the Create icon drop-down menu.

l Select Adjustment from the drop-down menu. This will open the Adjust-

ment Wizard.

3     Create an adjustment on an account. 

l Enter an account number or click the Account Number field label to select the cus-

tomer account from a list.

l This will populate the Reference Number, Customer Name and Service

Address with the information attached to the selected customer account.

l Select Billing in the Transaction Type drop-down menu.

l An error icon will display next to the Transaction Type drop-down menu if

there are no committed billing transactions on the customer account.

l Select an adjustment type in the Adjustment Type drop-down menu. The selected

adjustment type will be attached to the adjustment type transaction line.
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l Only bill type adjustment types will display in the drop-down menu when

Billing is selected in the Transaction Type drop-down menu.

l Adjustment types are set up as bill types using the Adjustment Type Main-

tenance window (UB> Maintenance> Adjustment Type> GL Type drop-

down> Select Bill).

l Modify the date in the Transaction Date field to change the transaction date of the

adjustment. This field will populate with the current date.

l The Consumption Adjustment Type drop-down menu is used to create a leak,

meter read, or consumption adjustment. Select N/A unless you would like to adjust

the meter readings that resulted in the billing line item.

l Select Leak to adjust a consumption value that was inflated by a leak.

l Select Misread to correct an incorrect committed meter reading.

l This will only adjust the most recent committed meter reading. If the mis-

read meter is discovered after a subsequent, accurate meter reading

and billing, use the Consumption type adjustment.

l Select Consumption to adjust the current consumption value.

l Consumption adjustments are meant to adjust a current consumption

value if a misread is discovered prior to the last committed billing.

l Enter a description of the adjustment in the Description field if you would like to

add a description to the adjustment transaction.

l The description will display on the History tab of the Account Master Main-

tenance window (UB> Maintenance> Account> History tab> Description

column).
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l The Customer Name and Service Address fields will populate after you select a

customer account in the Account Number field.

l Click the Next button after you have entered the information on the first step.

4     Select a billing line item to adjust. 

l The second step of the Adjustment Input Wizard will display all of the billing line

items on the customer account selected in the first step. The window will only dis-

play committed billing line items. Uncommitted billing line items cannot be adjusted.

l If you would like to adjust an uncommitted billing, delete or modify the billing

in the uncommitted batch. For example, if the billing you would like to modify

is in a New Billing batch, delete the New Billing batch, modify the customer

account, and then regenerate the New Billing batch. You can also commit the

New Billing batch and then adjust the billing.

l Select the billing line item you would like to adjust. You can only select one billing

line item at a time.

l When creating a Misread adjustment, only the most recent committed billing

line item can be adjusted.

l Check the Reverse Transaction toggle if you would like to reverse the selected

transaction. This will automatically create adjustment amounts on the billing adjust-

ment step of the wizard that reverse the selected transaction.

l Click the Next button when the billing is selected.
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5     Adjust the device consumption. 

l The third step in the Adjustment Input Wizard will display the available devices on

the account and the current reading on those devices.

l If you are creating a Misread adjustment, the Consumption Adjustment Type

column will display "Correct Reading". Enter the new reading in the Corrected Read

column and the Adjusted Consumption column will display the difference between

the original and corrected readings.

l Misread adjustments will change the Meter History reading totals on the UB

Account Devices tab (UB> Maintenance> Account> Devices tab> Meter His-

tory).

l If you are creating a Leak adjustment, the Consumption Adjustment Type column

will display "Leak Adjustment". Enter a new value in the Consumption Adjustment

column.

l Unlike the Misread adjustment, the Leak adjustment will not change the Meter

History reading totals on the UB Account Devices tab. It will, however, create

a Meter History line item on the Devices tab. The Description field on that line

item will display "Leak Adjustment" and the total value of the adjustment.

l Leak adjustments are primarily used to adjust a customer's billing totals

because of a leak.

l If you are creating a Consumption adjustment, the Consumption Adjustment Type

column will display "Consumption Credit". Enter a new value in the Consumption

Adjustment column.

l Like the Leak adjustment, the Consumption adjustment will not change the

Meter History reading totals on the UB Account Devices tab. It will create a

Meter History line item on the Devices tab. The Description field on that line
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item will display "Consumption Adjustment".

l Consumption adjustments are primarily used to adjust a customer's billing

totals because of an incorrect consumption value.

6     Adjust the billing detail line items. 

l The billing line items associated with the billing selected previously will populate in

the window. Enter an adjustment amount in the appropriate column to create the

adjustment.

l For example, if you would like to reduce the billing amount on a billed service

rate by $15, enter -$15 on the line item of the service rate you would like to

reduce.

l If you enter 0 in the Adjustment Amount column, an adjustment will be cre-

ated but it will have a zero amount. If you would like to reduce the billing down

to zero, enter a negative amount to offset the billing.

l The GL accounts used in the journal entry created by the adjustment trans-

action will be pulled from the service rates or fee codes being adjusted. For

example, if you reduce the billing on the WT1 service rate, the GL accounts

attached to service rate WT1 will be used to create the adjustment journal

entry.

l If the Reverse Transaction toggle was checked on the previous step, the

Adjustment Amount column on the line items will populate with the values to

reverse the transaction.
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l Click the Finish button when complete to adjust the billing.

l Repeat this process to add additional adjustments to the batch.

7     Commit the billing adjustment. 

l Once the adjustment has been created, you can view the adjustment on the UB cus-

tomer account using the Account Master Maintenance window (UB> Main-

tenance> Account> History tab).

l The adjustment transaction will display in red as it is still uncommitted.

l Print a Proof List.

l Generate the Proof List (UB> Adjustments and Fees> Proof List).

l Click the Print icon to process the report immediately or enter a date

and time in the field next to the Print icon to schedule the report to gen-

erate at a later time. You can view the progress of the report on the Job

Viewer window (SS> Utilities> Show Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to

preview the report before printing.

l Click the Print icon drop-down menu and select Excel to export

the report data to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted)

to export the report data to an Excel spreadsheet that includes
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much of the Springbrook formatting found on the printed version

of the report.

l Once the report is generated, you can also display the report

using the View Reports window (SS> Utilities> View Report).

l The Proof List will display the adjustment amount, the service being adjusted

and the customer account information.

l Print a GL Distribution report.

l Enter the journal entry date and generate the GL Distribution Report (UB>

Adjustments and Fees> GL Distribution).

l The GL Distribution Report will display the journal entry created by the adjust-

ment. The detail and sort options are determined by the Report Type drop-

down menu.

l The GL accounts attached to the service rates or fee codes on the billing line

items being adjusted will be used in the journal entry. The revenue and cash

accounts attached to the fee code or service rates will be used in the journal

entry.

l Commit the adjustments.

l Open the Commit window (UB> Adjustments and Fees> Commit).

l The Commit window will display the journal entry date of the journal entry cre-

ated by the process.

l Click the Confirm icon to commit the batch.
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UB> Adjustments and Fees> Input

Contra Revenue Adjustment

Summary

A contra revenue account is a revenue account that is expected to have a debit balance

instead of the usual credit balance. This debit balance is contrary to the credit balance com-

monly carried by a revenue account.

A contra revenue adjustment allows you to enter negative billing transactions. Follow these

steps to create a contra revenue adjustment.

Step by Step

1     Create a new Adjustments and Fees batch. 

l Adjustment transactions added to an existing batch will not overwrite the trans-

actions already entered into the batch, but the batch will return to the Input step if a

Proof List or GL Distribution report has already been created.

CONTRA REVENUE ADJUSTMENT 204



l Select the Adjustments and Fees palette in UB> Adjustments and Fees. This will

expand the Adjustments and Fees palette and display the steps of the Adjustments

and Fees process.

l Select New from the UB Adjustments and Fees batch number drop-down menu.

This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields will default to the current cal-

endar period and calendar year, and are used for reference only. The fiscal period

the transactions in the batch are posted to is determined by the Journal Entry date

entered when creating the GL Distribution report in UB> Adjustments and Fees> GL

Distribution.

l Enter a Batch Number, or click the Generate icon to create a batch using the

next available batch number.

l The batch number is used to identify a specific batch within a batch month

and batch year. They are limited to five digits and must be unique with the

batch month of the batch year.

2     Create a new Contra Revenue Adjustment Transaction. 

l From the Adjustments and Fees Input and Display window (UB> Adjustments

and Fees> Input), click the Create icon drop-down menu and select Contra Rev-

enue Adjustment to open the Contra Revenue Adjustment window.

l Enter an account number or click the Account Number field label to select the cus-

tomer account from a list.
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l Select an adjustment type in the Adjustment Type drop-down menu. The selected

adjustment type will be attached to the adjustment type transaction line.

l The Service, Fee Code, Description and Amount associated with the selected

adjustment type will populate a line item in the lower section of the window.

The Amount field on this line item can be edited.

l Adjustment Types are created and maintained on the Adjustment Type Main-

tenance window (UB> Maintenance> Adjustment Type).

l The description associated with the selected adjustment type will auto-

matically populate in the Description field.

l Modify the date in the Transaction Date field to change the transaction date of the

adjustment. This field will populate with the current date.

l Enter a description of the adjustment in the Description field if you would like to

add a description to the adjustment transaction.

l If a description is attached to the selected adjustment type, that description

will automatically populate in the Description field. This description can be

edited.

l The description will display on the History tab of the Account Master Main-

tenance window (UB> Maintenance> Account> History tab> Description

column).

l Click the Save icon to return to the Adjustments and Fees Input and Display

window.

3     Commit the Contra Revenue Adjustment. 
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l Once the adjustment has been created, you can view the adjustment on the UB cus-

tomer account using the Account Master Maintenance window (UB> Main-

tenance> Account> History tab).

l The adjustment transaction will display in red as it is still uncommitted.

l Print a Proof List.

l Generate the Proof List (UB> Adjustments and Fees> Proof List).

l The Proof List will display the adjustment amount, the service being adjusted,

and the customer account information.

l Click the Print icon to process the report immediately or enter a date and

time in the field next to the Print icon to schedule the report to generate at a

later time. You can view the progress of the report on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to pre-

view the report before printing.

l Click the Print icon drop-down menu and select Excel to export the

report data to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to

export the report data to an Excel spreadsheet that includes much of

the Springbrook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the

View Reports window (SS> Utilities> View Report).

l Print a GL Distribution report.

l Enter the journal entry date and generate the GL Distribution Report (UB>

Adjustments and Fees> GL Distribution).

CONTRA REVENUE ADJUSTMENT 207



l The GL Distribution Report will display the journal entry created by the adjust-

ment.

l The GL accounts attached to the service rates or fee codes on the billing line

items being adjusted will be used in the journal entry. The revenue and cash

accounts attached to the fee code or service rates will be used in the journal

entry.

l Commit the adjustments.

l Open the Commit window (UB> Adjustments and Fees> Commit).

l The Commit window will display the journal entry date of the journal entry cre-

ated by the process.
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UB> Budget Billing

Process a Budget Billing Batch

Summary

The Budget Billing process is used to calculate a budget billing amount on the customer

accounts included in the batch. When the customer accounts are processed in a New

Billings batch, the customers will be billed using the calculated budget billing amount rather

than the consumption on meter.

There are two ways to process budget billing:

l Once a year

l Multiple times a year

Once a Year

If you process budget billing once a year, there is no special setup required for the Budget

Billing process. Just select a billing cycle and the process will calculate a budget billing

amount on those customer accounts.

Multiple Times a Year
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If you process budget billing more than once a year, you should probably set up a separate

billing cycle to process budget billings. When a billing cycle is processed in the Budget

Billing process, all of the budget billing information on the customer accounts in the batch

will be overwritten. So if you would like to calculate budget billings on some accounts in a

billing cycle, but keep the budget billing amounts on the other accounts in the batch, you

will have to create a separate billing cycle and assign the customers you would like to pro-

cess Budget Billing to that billing cycle. Once the customer accounts have been processed

in the Budget Billing process, you can return the customer accounts to their original billing

cycles.

Step by Step

1     Create a list of accounts that you would like to move to budget billing. 

l Having a list of customer accounts that you would like to change to budget billing

will allow you to check the proof list created during the budget billing process for

accuracy. If for some reason the Budget Billing process does not generate a budget

amount for a customer account you will be able to identify and fix the issue.

l If one of the selected accounts is using winter averaging, the winter average

will not be used when calculating the budget billing.

l The list of customer accounts is usually stored on a spreadsheet or text editor pro-

gram and should include the original billing batch of the customer accounts.

2     Select the services on the budget billing customer accounts that need to be budgeted. 
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l When a Budget Billing batch is processed, the system will check through all of the

services attached to the customer accounts in the budget billing cycle. If the Budget

Service toggle is checked on a service on the customer account, that service will be

included in the Budget Billing process. This needs to be set up on each customer

account individually and is not set up on the service.

l Open a customer account that you would like to add to the budget billing batch (UB>

Maintenance> Account).

l Click on the Service Rates tab to view all of the service rates attached to the

account.

l The third Create icon will display Budget bill all active rates when the mouse

pointer is hovered over it. Click this icon to open the Add To Budget window.

l Select a Start Date from the drop-down menu. This field will default to the cur-

rent date.

l Check each Services to Budget toggle associated with the service you

would like to include in the budget billing process.

l Once you check a Services to Budget toggle, the service on the customer

account will bill using the budgeted amount, not the actual consumption on

the account. Click the Confirm icon to return to the Service Rates tab.

l Click the Save icon when complete.

3     Assign the budget billing customer accounts to the budget billing cycle. 
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l When processing a Budget Billing batch, all customer accounts within a selected

billing cycle will be processed, overwriting any previous budget information on the

customer accounts in that billing cycle. If you are processing customer accounts in

the Budget Billing process throughout the year, the Budget Billing batch will act as a

temporary place to process the budget billing customer accounts without changing

the budget information on other customer accounts in the same billing cycle.

l Assign the budget billing customer accounts to the budget billing cycle by opening

the Account Maintenance window (UB> Maintenance> Account).

l Open the Account tab and click the Billing Cycle field label to assign the account to

the budget billing cycle.

l Click the Save icon when complete.

4     Create a Budget Billing batch or open an existing batch. 

l Select the Budget Billing palette in UB> Budget Billing. This will expand the Budget

Billing palette and display the steps of the batch process.

l Modify an existing batch or create a new Budget Billing batch.

l Select a batch number from the drop-down menu at the top of the Budget

Billing palette to select an existing batch.

l Select New from the Budget Billing batch number drop-down menu to create a

new batch. This will open the New Batch window.

l The Batch Month and Batch Year of the Budget Billing batch is used

for reference only and is not necessarily the fiscal month and year the
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transactions in the batch will be posted to.

l Click the Generate icon to save the batch.

5     Generate the budget billing amounts. 

l Open the Generate/Budget Billing window (UB> Budget Billing> Generate).

l Select the Budget Services that will be included in the batch.

l Select a generation method from the Generate By drop-down menu. Your choice in

this field will determine if the Billing Cycle or Accounts fields are active.

l If you chose Billing Cycle for the Generate By field, select the desired Billing

Cycle. Click the drop-down menu to select the Budget Billing batch that you

attached to all of the customer accounts you would like to process in this

Budget Billing batch.

l The budget information on all of the customer accounts in the selected

billing cycle will be affected by the Budget Billing process. If there are

customer accounts in the selected billing cycle that you do not want to

process in the Budget Billing cycle, remove them from the billing cycle

or create a new billing cycle and move all of the customer accounts you

would like to process to that billing cycle.

l If you chose Select Accounts for the Generate By field, select the

desired Accounts by clicking the field label and choosing which
accounts you would like to include in the budget billing batch.
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l Select how you would like to calculate the budget information in the Calculate

Using drop-down menu.

l The Account History option will use the billings that have occurred in the

date range specified in the Billing History From and To fields to calculate an

average amount.

l The Consumption History option will use the meter history that was read dur-

ing the date range specified in the Billing History From and To fields.

l Some organizations that generate budget billing information once a

year will use this method once the service rates have be revised in

order to use last year's consumption amounts and the new service rate

structure. This will create a more accurate Budget Billing/Level Pay

amount for the coming year because it will be based on the new rate

structure.

l Enter an Adjustment if you would like to increase or decrease the budget total gen-

erated by a multiplier.

l The Adjustment field can be used to alter the budgeted amounts if con-

sumption is forecasted to increase or a decrease.

l The Precision field is used to define the number of decimal places that will be used

when the budget is generated.

l If the budget calculation results in a budget of $15.22, a precision set to zero

will round the budget amount to $15.00. If the precision was set to 1, the

budget amount will be $15.20.

l Select a Conversion To from the drop-down menu. If you are calculating the

budget billing amounts using the Consumption History of the customer account, the
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Conversion To field will convert the history to the desired unit of measure before

applying the amounts to the rate tiers.

l The date range entered in the Billing History From and To fields will define which

meter reads or billing history will be used in the budget billing calculation.

l Enter a date in the Last Calculated Before field if you would like to exclude service

rates with Start Dates or Recalculation Dates that fall after the date specified in the

field.

l Service rate Start Dates and Recalculation Dates are specified on the Service

Rates Maintenance window (UB> Maintenance> Service Rate)

l Enter a Number of Billings value.

l The value in this field will generally be used to divide the total billings/meter

histories.

l In the Generate For field select which budgets will be included in the batch.

l Enter a Low Percentage and a High Percentage.

l If the new calculated amount falls between these high and low percentages of

the previous budget amount, the budget amount will not be adjusted for the fol-

lowing period.

l Check the Include YTD Difference toggle to include a% Difference column on the

Modify screen. This column will display the difference between the current and the

proposed budgets.

l Click the Confirm icon to generate the batch.

6     Check for Exceptions. 
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l Open the Exceptions window (UB> Budget Billing> Exceptions).

l The Exceptions window will display any exceptions that resulted from the batch gen-

erate step.

l If the generate step did not produce any exceptions, an information window will

appear.

7     Modify the proposed budgets. 

l Open the Modify window (UB> Budget Billing> Modify).

l The Modify window will display all of the accounts included in the budget billing

batch.

l To remove an account from the budget billing batch, highlight the account and click

the Delete icon .

l Each account will display the account number, customer name, total current budget

and total proposed budget. The percentage difference will display the difference

between the current and proposed budgets if the Include YTD Difference toggle

was checked during the Generate step.

l Click the Expand button next to an account to view the account details.

l Make any desired adjustments to the Proposed Budget column.

l Click the Save icon when complete.

8     Print the Budget Billing Proof List. 
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l Open the Budget Billing Proof List window (UB> Budget Billing> Proof List).

l The Proof List will display the proposed budget amount and the current budget

amount of each service attached to the customers in the budget billing cycle.

l If a customer account or service on a customer account does not display on the

proof list, make sure that the service is set up as a budget service on the customer

account and the service is included on the Generate step of the Budget Billing pro-

cess.

l The proposed budget is the amount that will be used on each billing and is the

budget amount that will display on the billing statement.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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9     View the Proposed budget on the customer accounts. 

l After the budgets have been generated on the customer accounts in the Budget

Billing cycle, you can view the proposed budget on the customer accounts on the

Service Rates tab of the Account Maintenance window (UB> Maintenance>

Account> Service Rates tab> Customer Information section> Proposed Budget

field).

l Click the Modify icon to manually modify the new proposed budget amount.

After all changes have been made rerun the report.

10     Print the optional Budget Billing Letters. 

l Open the Letters window (UB> Budget Billing> Letters).

l Select a Form from the drop-down menu.

l The format and information included in the Budget Billing letters is determined

by which form is selected.

l Forms are created and maintained on the Forms Maintenance window (UB>

Maintenance> Form).

l The Billing History From and Billing History To fields are used to filter the letters

to those budget billing accounts with history that falls between the two specified

dates.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.
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l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l Click the Print icon to process the letters immediately or enter a date and time in

the field next to the Print icon to schedule the letters to generate at a later time. You

can view the progress of the letters on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Once the letters are generated, you can also display the letters using the View

Reports window (SS> Utilities> View Report).

11     Commit the Budget Billing batch. 

l After the Proof List has been reviewed and any changes have been made, select

Commit from the Budget Billing to commit the Budget Billing batch. This will open

the Commit Budget Billing window (UB> Utility Billing> Commit).

l Click the OK button to commit the Budget Billing batch.

12     View the current budget on the customer account. 

l Open the Account Maintenance window (UB> Maintenance> Account> Service

Rates tab) to view the new budget information on the account.

l The new budget information will be in the Current Budget field in the Customer

Information window.
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13     Change the customer accounts back to their original billing cycles. 

l Open the Account tabs of the customer accounts that have been processed in the

Budget Billing batch in the Account Maintenance window (UB> Maintenance>

Accounts> Account tab).

l Change the value in the Billing Cycle field back to the original billing cycle.
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UB Module

Collections Setup

Summary

In order to process a Collections batch, you must create a collections adjustment fee code.

The collections adjustment fee code will determine which GL accounts attached to the ser-

vice rates and fee codes on the UB customer accounts in the Collections batch will be used

in the journal entry.

After a collections adjustment type has been created, select the adjustment fee code in the

Setup window (UB> Utilities> Setup> General tab> Collections Adjustment Type field).

Step by Step

1     Create a Collections adjustment code. 

l The collections adjustment type will affect the general ledger accounts used in the

journal entry created in the Collections process (UB> Collections).

l Open the Adjustment Type Maintenance window (UB> Maintenance> Adjustment

Type> INSERT).
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l Create an adjustment type.

l The selection in the GL Type field will determine which GL accounts attached to a

service rate or fee code will be used to create the journal entry in the Collections pro-

cess.

l Select Bill if you would like the Revenue general ledger account attached to

the service rates and fee codes to be used in the journal entry created by the

Collections process. This will create the following journal entry:

Description of GL Account Debit Credit

AR account attached to service rate or fee code XXX

Revenue account attached to service rate or fee

code
XXX

l The revenue account is attached to a service rate on the Service Rate

Maintenance window (UB> Maintenance> Service Rate> General tab>

Revenue Account field).

l The revenue account is attached to a fee code on the Fee Code Main-

tenance window (UB> Maintenance> Fee Code> Revenue Account

field).

l Select Cash if you would like the cash account attached to the service rates

and fee codes to be used in the journal entry created by the Collections pro-

cess. This will create the following journal entry:

Description of GL Account Debit Credit
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Cash account attached to service rate or fee code XXX

AR account attached to service rate or fee code XXX

l The cash account is attached to a service rate on the Service Rate Main-

tenance window (UB> Maintenance> Service Rate> General tab> Cash

Account field).

l The cash account is attached to a fee code on the Fee Code Main-

tenance window (UB> Maintenance> Fee Code> Cash Account field).

l Attaching a fee code to the Collections adjustment type code has no effect of the

functionality of the Collections process.

l Complete the Credit History Days and Credit Value fields if you would like the Col-

lections adjustment type code to generate credit line items on the customer

accounts processed in a Collections batch.

l Credit line items will display in the Credit History section on the Account

Master Maintenance window (UB> Maintenance> Account> Overview tab).

2     Select the collections adjustment type code in the Setup window. 

l Open the UB Setup window (UB> Utilities> Setup> General Tab).

l Select the collections adjustment type code in the Collections Adjustment Type

Code field. The adjustment type code selected in this field will be attached to all
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adjustment transactions created in the Collections process.

l Click the Save icon when complete.
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UB> Collections

Collections

Summary

The Collections process is used to write off the balance of selected UB customer accounts

and will create an adjustment type transaction on the accounts. The Generate step (UB>

Collections> Generate) of the process is used to select the customer accounts to process

in the batch. The balance of the customer accounts will be written off using the general

ledger accounts attached to the service rates and fee codes being written off. The Col-

lections adjustment type code (UB> Utilities> Setup> General tab> Collections Adjust-
ment Type field) determines which general ledger accounts attached to the service rates
and fee codes on the customer accounts will be used in the journal entry created by the Col-

lections process. The collections adjustment type code will also display on the transaction

line item created on the customer account.

After the batch has been generated, the Exceptions step (UB> Collections> Exceptions)

will display the UB customer accounts that have been selected during the Generate step

but have not been included in the Collections batch. Customer accounts with a credit bal-

ance on a service will not be included in the Collections batch. For example, if a customer

has a balance due of $10.00 on the Water service but a $5.00 credit balance on the Waste

Water service, the customer account will not be included in the Collections batch even if it

is selected during the Generate step. If you would like to include the account in the Col-

lections batch, run the redistribute credit balances process (UB> Adjustments and Fees>
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Redistribute Credit Balances) on the customer account to redistribute the credit balance.

For example, if the Water service balance is $-10.00, but the Waste Water service balance

is $54.00, you can include the customer account in the Collections process by running the

redistribute credits process. The $10.00 credit balance will be used to reduce the balance

of the Waste Water service and the customer account will be included in the Collections

batch with a balance of $44.00.

The Select step (UB> Collections> Select/Update) is used to select the customer accounts

included during the Generate step. This step is generally used to remove specific UB cus-

tomer accounts from the Collections batch.

The GL Distribution report will display the journal entry created by the Collections process

to write off the balance of the UB customer accounts included in the batch. If the Col-

lections adjustment type code is set up as a Bill type adjustment (UB> Maintenance>

Adjustment Type> GL Type drop-down> Bill), the following journal will be created.

Description of GL Account Debit Credit

AR account attached to service rate or fee code XXX

Revenue account attached to service rate or fee code XXX

If the Collections adjustment type code is set up as a Cash type adjustment (UB> Main-

tenance> Adjustment Type> GL Type drop-down> Cash), the following journal will be cre-
ated.

Description of GL Account Debit Credit
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Cash account attached to service rate or fee code XXX

AR account attached to service rate or fee code XXX

The Commit step is used to commit the transactions in the batch. The day the Commit step

is process will be the post date of the transactions in the batch.

Step by Step

1     Create a Collections batch. 

l Select the Collections palette in UB> Collections. This will expand the Collections

palette and display the steps of the Collections process.

l Select New from the Collections batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Collections process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are for reference only. The fiscal period of the transactions in the batch

is determined by the Journal Entry Date entered during the Generate step.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.
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l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate the collections. 

l Open the Generate/Collections window (UB> Collections> Generate).

l The Generate step is used to select which customers will be included in the Col-

lections batch. After the Collections batch has been generated, individual accounts

can be removed from the batch using the Select/Update window (UB> Collections>

Select/Update). After the Collections batch has been generated, returning to the

Generate step and regenerating the batch will overwrite the customer accounts

already included in the batch.

l Select the cycles you would like to include in the Collections batch in the Cycles

field.

l Click the Select All icon to select all of the cycles in the Cycles field.

l Click the Deselect All icon to deselect all of the cycles in the Cycles field.

l Press CTRL+A to select all of the cycles in the field. Press SPACEBAR to

check or uncheck the highlighted toggles.

l Hold down SHIFT and press an arrow key to select a range of cycles. Press

SPACEBAR to check or uncheck all of the highlighted toggles.
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l Select the services you would like to include in the Collections batch in the Services

field.

l Use the same keys as above to select multiple Services.

l The balance on any service that is not included in the Collections batch will

not be included in the Collections amount.

l You can view the balance of a service on a customer account from the

Account Master Maintenance window (UB> Maintenance> Account> Over-

view tab> Account Balance section).

l Click the Account Number field label to include a single customer in the batch.

This will open the Account Master Search window in order to select a customer

account.

l When filtering by account number, the Past Dues Batch, Account Status and

Final Date filters below will be ignored.

l Click the Past Dues Batch field label to include the customer accounts in a com-

mitted Utility Billing Past Due batch. This will open a selection window that displays

all committed UB Past Due batches.

l When filtering by Past Dues batch number, the Account Status and Final Date

filters below will be ignored.

l Check the toggles of the account statuses that you would like to include in the batch

in the Account Status field.

l Press CTRL+A to select all of the account statuses in the field. Press

SPACEBAR to check or uncheck all of the highlighted toggles.

l The Final Date Prior or Equal To field will only be active if Delete is selected in the

Account Status field. Select a date from this drop-down menu to filter the deleted

accounts included in the batch by final date.
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l The Due Date Prior or Equal to field is used to filter the transactions included in

the batch by due date.

l Only those transactions that have due dates that fall before or on the spe-

cified date will be included in the batch. Transactions that do not have due

dates will be filtered by the other parameters on the window.

l If no date is selected, this functionality will not be used.

l The Journal Entry Date field will default to the current date. The journal entry date

is the date that the journal entries created by the Collections process will be posted

to the general ledger.

l The Journal Entry Date will also be used as the Transaction Date.

l The journal entry date is different than the Post date in the UB module. The

Post Date is the date that the transactions are committed in UB> Collections>

Commit.

l The journal entry date will also display when you are creating the GL Dis-

tribution Report during the GL Distribution step.

l Enter an amount in the Debt Greater Than field to include only customer accounts

with a balance greater than the value entered in the field. The value entered in this

field represents the minimum value of the balances that will be included in the

batch.

l Enter an amount in the Debt Less Than field to include only customer accounts

with a balance less than the value entered in the field. The value entered in this field

represents the maximum value of balances that will be included in the batch.

l The Debt Greater Than and Debt Less Than fields can be used together if you

would like to create a range of accounts to pull in into the batch.
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l TheWrite off to AR field, AR Billing Cycle field and the Use AR revenue

account toggle are only used when writing off the balance of UB customer accounts

to the AR module.

l Press ENTER to generate the bills immediately or enter a date and time in the field

next to the Confirm icon to schedule the bills to generate at a later time.

l You cannot schedule a report to print on a date and time that has already

passed. If you want the report to print later in the evening, enter a PM in the

AM/PM portion of the date field before entering the hour.

l You can view the progress of the Generate step on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs). If the Collections batch has been

scheduled to generate at a later time, you can view the scheduled date and

time in the Scheduled Date/Time field.

l The Generate step will select the general ledger accounts used in the process. If

you get to the GL Distribution step of the Collections process and realize that the GL

accounts used on the journal entry are incorrect, you will have to rerun the Generate

step after you change to GL accounts attached to the fee code.

3     The Exceptions step displays the customer accounts not included in the batch due to exceptions or
errors. This is an optional step. 

l Open the Exceptions/Collections window (UB> Collections> Exceptions). If no

exceptions were generated in the batch, an information window will open.

l The UB customer accounts that display in the Exceptions window will not be pro-

cessed in the Collections batch.
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l The most common exception that will display in the window is “Found credit balance

in Service XX for the amount of XXX.” This message will display if there is a credit

balance in a service included in the Collections batch.

l This message will even display if there is a debit balance on another service

on the customer account. If the customer has a debit balance on one service

and a credit balance on another service you should run the redistribute credits

process (UB> Cash Receipts> Redistribute Credit) in order to redistribute the

credit balances on the services.

l Press ESC when complete to exit the window.

4     The Select/Update step is used to select which customer accounts to include in the batch. 

l The Update/Collections window will display the customer information and account

balance.

l The Amount column displays only the balance on services that have been

included in the batch.

l You can edit the value displayed in the Amount column.

l The services included in the Collections batch were set up during the

Services field of the Generate step.

l Uncheck the Selected toggle to remove the customer account from the Collections

batch.

l Click the Select All or Deselect All icons to affect all of the Selected

toggles of all of the customer accounts that display in the window.
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l Use the ARROW keys to move between the rows and columns in the window.

l Press SPACEBAR to check or uncheck the Selected toggle.

l Press ENTER when complete to save the changes in the window.

5     Print a Proof List. 

l The Proof List will display all of the customer accounts included in the Collections

batch and the collection amount of each service included in the batch.

l Open the Proof List/Collections window in UB> Collections> Proof List.

l Select how you would like the report to sort and order the data in the Sort By drop-

down menu.

l The Reference Number field is generally used to store the customer number

from previously used software. The reference number is set up on each cus-

tomer account in UB> Maintenance> Account> Account tab> General sec-

tion> Reference Number field.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Proof List will display the customer information and the collections balance on

each service included in the Collections batch. The report will also include a batch

total by service and a batch total of the entire collections amount.

6     Print a Turnover report. 

l The Turnover Report will display the customer information and the total amount sent

to collections. This report is typically given to an outside agency for collection pro-

cessing.

l Select how you would like to sort the information that displays on the report in the

Sort By drop-down menu.

l Select Account Number if you would like to sort the report by UB customer

account number.

l Select Reference Number if you would like to sort the report by the reference

number attached to the UB customer account.

l The Reference Number field is generally used to store the customer

number from previously used software. The reference number is set up
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on each customer account (UB> Maintenance> Account> Account tab>

General section> Reference Number field).

l Select Last Name if you would like to sort the accounts that display on the

report by last name.

l Select which information you would like to display in the Display drop-down menu.

l Select Tenant information if you would like the tenant or primary customer

information to display on the report.

l Select Owner Information if you would like the owner attached to the lot to dis-

play on the report.

l Select the Report Type you would like to generate.

l The Summary report will display the Account Number, Reference Number,

Tenant Name, Tenant Phone Number, Tenant Mailing Address, Service

Address, Social Security Number, Driver's License Number, Tax Lot, Last Bill

Date, Last Bill Amount and Amount to Collections. The report also provides

batch totals for Last Bill Amount and Amount to Collections.

l The Detail report will display everything included in the Summary report as

well as the Service Code, Rate Code, Tax Code, Fee Code and Description

for each line item.

l Check the Group details by service group toggle to group the line items on the

report by the service group the services are assigned to.

l This toggle will only be enabled when generating the detailed version of the

report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

7     Export the collections data. 

l Generate an export file if your organizations sends collections information to a third-

party agency.

l The exported collections file will include the Account Number, Account Balance, Ser-

vice Code and Service Description for each account included in the batch.

l Select a Configuration for the export file.

l The Configuration drop-down menu will display the standard Springbrook

export format as well as any custom export formats that have been created for

the Collections process.
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l Select (Standard) to generate the a basic export file based on standard

Springbrook parameters.

l Custom export configurations are created and maintained on the Export Con-

figuration Maintenance window (SS> Maintenance> Export Configuration).

l Please work with your third-party agency when creating and testing a

custom export configuration.

l Check the Group details by service group toggle to group the line items in the

export file by the service group the services are assigned to.

l The export file must be in comma-separated value (.csv) format.

l Click the Confirm icon to export the collections data file.

8     Print a GL Distribution report. 

l The GL Distribution Report will display the journal entry created by the Collections

process. The GL accounts selected by the process are determined during the Gen-

erate step. If you would like to modify the GL account used in the transaction, you

will have to change the GL accounts attached to the fee codes and then regenerate

the Collections batch.

l The GL Distribution step will only display on the Collections palette if the General

Ledger module is set up to interface with the Utility Billing Module.

l The Journal Entry Date field will populate from the Journal Entry Date field in UB>

Collections> Generate> Journal Entry Date field. The Fiscal Period and Fiscal
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Year fields will populate with the fiscal period and year based on the journal entry

date.

l The Journal Entry Date field will not be enabled. If you would like to modify the

journal entry date of the transactions in the Collections batch, you will have to

regenerate the batch and enter a new date in the Journal Entry Date field in

UB> Collections> Generate.

l Select the level of detail you want to include in the report and how it will sort in the

Report Type drop-down menu.

l The detail version of the report will display the journal entry line item on each

customer account. The summary version will only display the transactions

totaled by general ledger account and exclude the customer information.

l The detail version of the report will display the general ledger account num-

ber, customer number, service code, rate code, description, and the debit and

credit amounts. The report will also group by fund and display a report total.

l The summary version of the report will display the net transaction on each

general ledger account. The report will display the general ledger account,

general ledger account description, and the debit and credit amount. The

report will also group by fund and display a report total.

l Select how you want to sort the information on the report.

l If you sort the report by general ledger accounts, the report will sort by gen-

eral ledger accounts.

l If you sort the report by transaction type, the transactions will sort by AR

adjustments and billing adjustments. The report will also sort by general

ledger account within the AR adjustments and billing adjustments.
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The journal entry created by the process will vary depending on how the Collections

adjustment type code is set up (UB> Utilities> Setup> General tab> Collections

Adjustment Type field).

l If the Collections adjustment type code is set up as a Bill type adjustment

(UB> Maintenance> Adjustment Type> GL Type drop- down> Bill), the fol-

lowing journal will be created.

Description of GL Account Debit Credit

AR account attached to service rate or fee code XXX

Revenue account attached to service rate or fee

code
XXX
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l If the Collections adjustment type code is set up as a Cash type adjustment

(UB> Maintenance> Adjustment Type> GL Type drop-down> Cash), the fol-

lowing journal will be created.

Description of GL Account Debit Credit

Cash account attached to service rate or fee code XXX

AR account attached to service rate or fee code XXX

9     Commit the Collections batch. 

l After the Proof List and GL Distribution Report have been reviewed, the Collections

batch is ready to commit. Once a Collections batch has been committed, you cannot

roll the transactions back, so make sure the transactions in the batch are correct.

l Open the Commit window (UB> Collections> Commit).

l The Batch Number field will display the batch number of the batch being created. If

you have several open Collections batched, make sure you are committing the cor-

rect Collections batch.

l The Journal Entry Date field will display the journal entry date entered during the

Generate step of the Collections process.

l The Fiscal Period and Fiscal Year field will populate based on the journal

entry date.
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l The journal entry date cannot be modified from the Commit window. In order

to change the journal entry date, you will have to regenerate the Collections

batch and enter a different date in the Journal Entry Date field in UB> Col-

lections> Generate.

l Press ENTER when complete to commit the batch.
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Utility Billing Module

Final an Account Process Overview

Overview

When setting up how accounts will be finaled, there are two decisions to make.

l Will the final meter read and forwarding address of a customer account be entered using a

final account service request?

l Will final billings be processed during the regular billing cycle in UB> New Billing, or should

the final billings be processed outside the regular billing cycle in UB> Final Billing?

Final account service requests can be used to enter the final readings on the devices on

the account, and enter the forwarding address on the account. Once the final account ser-

vice request has been closed and committed, the Final Account Wizard can be run on the

UB account using the device readings and forwarding address on the final account service

request. Generally, final account service requests are only used by larger organizations.

Small organizations do not like to use the final account service request because they would

rather just enter the final meter readings on the Final Account Wizard.

If the Bill Finals with cycle toggle is checked in UB> Utilities> Setup> Billing tab, the final
billing for the account will be processed in UB> New Billings when the cycle of the finaled

account is billed. If the Bill Finals with cycle toggle is not checked, the finaled account will

be billed in UB> Final Billing.
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Final an account using the Final Billing process

This is a summary of the final account process if final account service requests are not

used, and UB account final billings are processed in UB> Final Billing.

Final Account Wizard –

UB> Maintenance>

Account> Delete icon

The Final Account Wizard will calculate a final billing on the

account based on the device readings entered into the Final

Account Wizard. Some organizations enter an estimated read-

ing in the Final Account Wizard rather than waiting for the

actual meter reading. The Final Account Wizard will create a

new meter read line item on the device. The Final Account Wiz-

ard will change the status of the UB account to Final.

Create the Final Billing

in UB> Final Billing

The Final Billing batch will create a final billing statement for

each UB account selected in UB> Final Billing> Select

Account. Final Billing batches are not processed by billing

cycle. All UB accounts with a Final status will display in the

Select Accounts/Final Billing window. When the batch is com-

mitted, the status of the customer account will change from

Final to Delete.

Receive payment on the

final billing

Payment on the final billing can be received in the UB or CR

module.

Final an account using the New Billing process
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This is a summary of the final account process if final account service requests are not

used, and UB account final billings are processed in UB> New Billing.

Final Account Wizard –

UB> Maintenance>

Account> Delete icon

The Final Account Wizard will calculate a final billing on the

account based on the device readings entered into the Final

Account Wizard. Some organizations enter an estimated read-

ing in the Final Account Wizard rather than waiting for the

actual meter reading. The Final Account Wizard will create a

new meter read line item on the device. The Final Account Wiz-

ard will change the status of the UB account to Final.

Create the Final Billing

in UB> Final Billing

Receive payment on the

final billing

Payment on the final billing can only be received in the CR mod-

ule.

Final an account using a service request and the Final Billing process

This is a summary of the final account process if final account service requests are used

and UB account final billings are processed in UB> New Final Billing.

Create a final account

service request

The service request is used to initiate the final process. The ser-

vice request code on the service request must be set up as a

final account type.

Close and commit the

final account service

After the devices on the account have been read, the service

request is closed and committed. The committed service
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request request will add the device reading line items to the devices on

the UB account. The status of the UB account will not change

to final until the account has been process in the Final Account

Wizard.

Final Account Wizard –

UB> Final Billing > Final

Accounts

The Final Account Wizard will calculate a final billing on the UB

account based on the device readings from the final account

service request. The Final Account Wizard will change the

status of the UB account to Final and add “Final Billing” to the

description of the device reading line items from the final

account service request.

Create the Final Billing

in UB> Final Billing

The Final Billing batch will create a final billing statement for

each UB account selected in UB> Final Billing> Select

Account. Final Billing batches are not processed by billing

cycle. All UB accounts with a Final status that have been pro-

cessed in the Final An Account Wizard will display in the Select

Accounts/Final Billing window. When the batch is committed,

the status of the customer account will change from Final to

Delete.

Receive payment on the

final billing

Payment on the final billing can be received in the UB or CR

module.

Final an account using a service request and the New Billing process

This is a summary of the final account process if final account service requests are used,

and UB account final billings are processed in UB> New Billing.
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Create a final account

service request

The service request is used to initiate the final process. The ser-

vice request code on the service request must be set up as a

final account type.

Close and commit the

final account service

request

After the devices on the account have been read, the service

request is closed and committed. The committed service

request will add the device reading line items to the devices on

the UB account. The status of the UB account will not change

to final until the account has been process in the Final Account

Wizard.

Final Account Wizard –

UB> Final Billing> Final

Accounts

The Final Account Wizard will calculate a final billing on the

account based on the device readings from the final account

service request. The Final Account Wizard will change the

status of the UB account to Final, and add “Final Billing” to the

description of the device reading line items from the final

account service request.

Create the Final Billing

in UB> New Billing

The Final Billing will be generated from a UB> New Billing

along with the rest of the billing cycle.

Receive payment on the

final billing

Payment on the final billing can be received in the UB or CR

module.
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UB> Final Billing

Final Billing

Summary

The Final Billing Palette is used to create the final billing statement for UB customer

accounts that have been processed using the Final Account Wizard. When a customer

account is processed in the Final Account Wizard, the status of the account will change to a

Final status. When the final billing is generated on the customer account in the Final Billing

process, the status of the customer account will change to a Delete status.

The Final Billing process also allows you to run the Final Account Wizard on UB customer

accounts that have been processed using a final account service request. The Final Billing

palette is an optional palette and will only be used if you do not process the final bills using

the New Billing palette. The final bills are set up to be processed in the New Billing batch

using the Setup window (UB> Utilities> Setup> Billing tab> Bill finals with cycle toggle).

The Final Billing of a customer account is generated by the Final Account Wizard, but the

Final Billing palette is used to generate the billing. If there is bank account information

attached to the customer account a “Do Not Pay” message will print on the final billing state-

ment. Bank account information is attached to a customer account on the Account Master

Maintenance window (UB> Maintenance> Account> Account tab> ACH Info sub-tab). After

the Final Billing batch has been committed, process the Direct Debits batch (CH> Direct

Debits).
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Step by Step

1     Create a Final Billings batch in UB> Final Billing. 

l Select the Final Billing palette in UB> Final Billing. This will expand the Final Billing

palette and display the steps of the Final Billing process.

l Select New from the Final Billing batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Final Billing process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report in UB> Final Billing>

GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .
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l Press DELETE to delete a Final Billing batch. The customer accounts selected in

the batch will be unselected, but the final billing will not be deleted. If you would like

to delete the final billing on a customer account, highlight the customer account and

press DELETE in the Select Accounts window (UB> Final Billing> Select Accounts).

2     Run the Final Account Wizard on customer accounts that have been finaled using a final account
service request. 

l The Final Accounts step is used to run the Final Account Wizard on customer

accounts that have been processed using a final account service request. Skip this

step of the process if you do not final accounts using final account service requests.

l Select Final Accounts from the Final Billing palette. This will open the Final

Accounts window.

l Only customer accounts with a final account service request that has been closed

and committed will display in the window.

l If a customer account does not display in the window make sure that the final

account service request has been closed and committed.

l Open the customer account (UB> Maintenance> Account).

l Open the Service Request tab on the Account Master Maintenance win-

dow to view the service requests on the account.

l The Service Type column should display Final Account, the Status

column should display Closed and the toggle in the Committed column

should be checked.
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l Select a UB customer account to final and press ENTER. This will launch the Final

Account Wizard.

l As you final UB customer accounts using the Final Account Wizard the

accounts will be removed from the window.

l Leave customer accounts in the window if you do not want to process final

bills for them in the current batch.

l Exit the window after you have processed the UB customer accounts in the Final

Account Wizard.

3     Select customer accounts to be processed in this final billing batch. 

l The Select Accounts step is used to select the customer accounts to process in the

Final Billing batch. The Select Account is also used to delete the final billing

attached to a customer account and remove the account from the batch.

l Open the Select Accounts step on the Final Billing palette. This will open the Select

Accounts window.

l The Select Accounts window will display all customer accounts that have been pro-

cessed through the Final Account Wizard and have a final status.

l Highlight a customer account and press DELETE to delete the final billing on the

customer account. This will remove the UB customer account from the Final Billing

batch and reactivate the UB customer account on the lot. If a new customer has

moved onto the lot attached to the customer account, you will not be able to delete

the final billing.
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l Select the customer accounts you want to include in the Final Billing batch by check-

ing the Selected toggle.

l Click the Select All or Deselect All icons at the top of the window to

select/deselect all of the customer accounts in the window.

l You can process final bills on a customer account even if there are out-

standing transactions on that account.

l Press ENTER after the customer accounts have been selected.

l You can return to this window to change the customer accounts being pro-

cessed in the batch as long as the batch has not been committed. If you

change the customer accounts selected in this batch you will reset the batch

and be forced to rerun any steps in the process you have already completed.

4     Print a billing register. 

l Select Register from the Final Billing palette. This will open the Register window.

l The Minimum Amount and Maximum Amount fields are used to filter activity that

displays in the report by current billing amount.

l Current billing amounts greater than the value in the Maximum Amount or

lower than the value in the Minimum Amount field will not display on the

report.

l Select which consumption you would like to include on the report in the Con-

sumption drop-down menu.
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l Select Actual if you would like the consumption that displays on the report to

match the consumption that displays on the Devices tab of the customer

accounts in the batch. The consumption multiplier and divisors will not be

included in the consumption calculation.

l Select Billable Only if there are meters in the billing batch that have a con-

sumption multiplier or divisor attached to them. This will display the modified

consumption amount on the report ( (consumption multiplier/consumption

divisor) * consumption).

l The consumption that will display on the Billing Register will not match

the consumption that displays on the Devices tab of the customer

account. The consumption that displays on the Meters tab does not cal-

culate based on the consumption multipliers.

l You can view the meter readings on a customer account using the

Account Master Maintenance window (UB> Maintenance>

Account> Devices tab> Meter History sub-tab).

l Consumption multipliers and devisors are attached to Water Device

types using the Water Mater Device Maintenance window (UB> Main-

tenance> Water Device Type> Water tab).

l Select the sort order of the report in the Sort Order field.

l The Reference number on a customer account in pulled from UB> Main-

tenance> Account> Account tab.

l Select the information you would like to include on the report in the Report Type

drop-down menu.

l The Detail report will display a separate line for each service rate on the cus-

tomer account with activity during the current billing. The detail version of the
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report includes the UB account number, Reference number, customer name,

account status, service, code, consumption, balance forward, current billing,

and  account balance. The report will also total by customer account number

and report total. A report summary will print at the end of the report and will

display the services billed, consumption, and current billing accounts of the

billing batch.

l The Summary report will display eight services per row and include the bal-

ance and consumption lines just below the rate code lines. The report

includes the UB account number, reference number, customer name, lot

address, service codes of each service, current bill by service and con-

sumption by service. The report will also display the balance forward, total bill,

account status and account balance of each UB account on the report. A

report summary will print at the end of the report and will display the services

billed, consumption and current billing accounts of the billing batch.

l Select Summary if you would like to include manual billings or com-

press the services on the report. These options are only enabled when

generating the report in summary format.

l Check the Display History with Zero Amounts toggle to include all services that

are attached to the customer accounts even if there is no activity for those services.

l Check the Include Manual Bills toggle to include committed manual billings on the

report.

l Manual billings are created from the Adjustments and Fees palette (UB>

Adjustments and Fees> Input> Select Billing from the Create drop-down

menu).
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l The Include Manual Bills toggle will only be enabled if you select Summary

from the Report Type drop-down menu.

l Check the Compress Services toggle to suppress the summary report lines for the

services 9 thru 20 if the services on those lines do not have rate codes, balances or

consumption.

l The Compress Services toggle will only be enabled if you select Summary

from the Report Type drop-down menu.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print a Trial Balance report. 
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l Select the Trial Balance from the Final Billing palette. This will open the Trial Bal-

ance window.

l Select how you would like the report to sort in the Sort Order drop-down menu.

l The Reference Number selection refers to the reference number attached to

the UB customer account.

l The reference number is attached to UB customer accounts (UB> Main-

tenance> Account> Account tab> Account sub-tab> General section>

Reference Number field).

l Select what information you would like to include on the report in the Report Type

drop-down menu.

l The Detail version will display the service description, consumption amount,

beginning balance, adjustments during the period, payments during the

period, other billings, current billings and balance of each service attached to

the UB customer accounts in the batch.

l The Summary version of the report will not include the service information on

the report. The report will display a single line for each UB customer account

included in the batch.

l Check the toggle box Show zero balance deleted accounts with no activity if

you want the report to include these types of accounts in the report.

l The Trial Balance report will display reference number, customer number, begin-

ning balance, other billing, adjustments this period, payments this period, current

billing, balance forward and account status.

l Other billings will include billable service request codes that have been closed

and committed and processed in UB> Cash Receipts> Bill Service Requests.
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l Depending on your settings in UB> Utilities> UB Setup> Billing Settings, if the

toggle Bill finals with cycle is not checked, accounts in Final Status will show on this

report with a current billing of zero.  These accounts will have to processed in UB>

Final Billing.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Set up the statements that will be generated by the Final Billing palette. 

l Open the Statement Settings window (UB> Final Billing> Statement Settings).

l The sort order of the Final Billing statements is set when the statements are gen-

erated from the Statements window (UB> Final Billing> Statements).
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l Enter the due date of the final billings in the Due Date field.

l The Due Date field will default to the current date plus 15 days.

l The Due Date will display on the History tab of the Account Master Main-

tenance window (UB> Maintenance> Account> History tab).

l The optional Additional Date field is used to add an additional, user-configured

date field to the statement.

l This field will only be enabled if the Additional Date Label field is set up on the

Statement Setup window (UB> Utilities> Statement Setup> Billing Options

tab) and only displays on standard, full-page billing statements.

l This date will display on the full-page billing statement next to the Additional

Date Label set up on the Statement Setup window.

l Enter the transaction date of the transactions generated in the Final Billing palette in

the Transaction Date field.

l The Minimum and Maximum fields are used to filter the statements that will be gen-

erated during the Statements step (UB> Final Billing> Statements). If a customer is

attached to a statement that is excluded from the batch, they are still processed in

the batch but a statement is not generated for them.

l Enter a value in the Minimum or Maximum field to exclude Final Billing state-

ments from the batch.

l Select a billing statement to generate in the batch in the Statement drop-down

menu.

l Billing statements are generated in the Statement Setup Selection window

(UB> Utilities> Statement Setup).
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l The Bill To drop-down menu is used to specify the format for the optional Bill To

Report.

l The Account Status field displays the status of the customer accounts included in

the Final Billing batch.

l Enter text that you would like to display on the Final Billing statements in the Mes-

sage 1 and Message 2 fields.

l Click the Message 1 or Message 2 field labels to select a message from a list.

l Messages are created and maintained using the Statement Message Main-

tenance window (UB> Maintenance> Statement Message).

l Press ENTER to save the statement settings.

7     The Export Addresses and Import Addresses steps allow you to certify the customer addresses in
the Final Billing batch and generate the relevant bulk mailing documents and tray tags. 

l The Export Addresses step is used to generate an email containing the addresses

to be certified and the dimensions of the mailing.

l The Drop Date field is used by those users who would like to specify a mail-

ing date that will populate the Mailer's Mailing Date field on the postage state-

ment. If no date is specified, the field will default to the current date.

l The Include drop-down menu is used to select the statements you would like

to include in the mailer export.

l Select All Statements if you would like to include all statements in the

Final Billing batch.

FINAL BILLING 258



l Select Hold Status Only if you would like to include only those state-

ments for customer accounts that have a hold status. This will include

temporary and permanent hold status accounts on the mailer export.

l Select No Hold Status Only if you would like to include only those state-

ments for customer accounts that DO NOT have a hold status.

l UB customer accounts are assigned a hold status using the Account

Master Maintenance window (UB> Maintenance> Account> Account

tab> Account sub-tab> General section> Hold Status drop-down

menu).

l The exported addresses will be processed by a Springbrook Software server

that will certify the addresses against a large, regularly updated database.

l After the addresses have been certified, the certified addresses will be sent

back to the email address included on the Export Addresses step. Also

included in the email with be all the relevant documents and tray tags for the

bulk mailing as well as the calculated postage amount.

l Import Addresses step is used to import the addresses that have been certified into

the New Billing batch.

l After the exported addresses have been processed and the return email has

been received at the email addresses entered on the Export Addresses step,

you can import the certified addresses into the New Billing batch.

8     Print statements. 
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l Select Statements from the Final Billings palette. This will open the Statement win-

dow.

l Enter a UB customer account number in the Account Number field to generate a

statement for a single account.

l Click the Account Number field label to select a UB customer account from a

list.

l The Mail Type drop-down menu is used to select the statements to print.

l Select Certified Bills if the addresses on the customer accounts have been

certified using the Export Addresses and Import Addresses steps on the Final

Billing palette.

l If you select this option but have not certified the addresses on the state-

ments, no statements will be generated.

l Select the order you would like the bills to print in the Sort drop-down menu.

l Select Auto Presort to sort the bills in preparation for a bulk mailing.

l Select Reference Number to sort the billing by UB customer account ref-

erence number.

l The reference number is attached to UB customer accounts in UB>

Maintenance> Account> Account tab> Account sub-tab> General sec-

tion> Reference Number field.

l The Include drop-down menu is used to select the statements you would like to

include in the printing.

l Select All Statements if you would like to print all statements that have been

included in the Final Billing batch.
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l Select Hold Status Only if you would like to generate statements only for cus-

tomer accounts that have a hold status. This will include temporary and per-

manent hold status accounts on the report.

l UB customer accounts are assigned a hold status using the Account Master

Maintenance window (UB> Maintenance> Account> Account tab> Account

sub-tab> General section> Hold Status drop-down menu).

l Press ENTER to process the statements immediately or enter a date and time in the

field next to the Print icon to schedule the statements to generate at a later time.

l You can view the progress of the statements on the Job Viewer window (SS>

Utilities> Show Scheduled Jobs. If the statements have been scheduled to

generate at a later time, you can view the scheduled date and time in the

Scheduled Date/Time field).

l If bank account information is attached to the customer account the “Do Not Pay

message will print on the statement.

l Bank account information is attached to a UB customer account in UB> Main-

tenance> Account> Account tab> ACH sub-tab.

9     Export Statements. 

l The Export step is an optional step used to create an export file of the Final Billing

statements. This option is generally used by Springbrook customers that outsource

the printing and sorting of their billings.

l Select Export from the Final Billing palette. This will open the Export window.
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l Enter an account number in the Account Number field if you would like to export

the statement of a single customer. Click the Account Number field label to select a

customer account from a list. This will open the Account Master Search window.

l The Mail Type field is used to select the mail type of the statements that should be

exported.

l Select Certified Bills to export the bills that have been certified using the

Export Addresses and Import Addresses steps on the Final Billing palette.

l If the statements have not been certified, no statements will be included

in the export.

l Select Non-Certified to export statements that have not been certified using

the Export Addresses and Import Addresses steps. If you skipped the Export

Addresses and Import Addresses step on the Final Billing palette, you should

select this option.

l The Sort drop-down menu is used to select how the statements on the export file

will be sorted.

l Select Auto Presort to sort the statements on the export file by the sort order

created by the address certification feature.

l The Layout drop-down menu is used to select the format of the export file gen-

erated by the Export process. Click the Format icon at the top of the window to

display the format of the export file.

l The Include drop-down menu is used to select the Final Billing statements you

would like to include in the export.

l Click the Confirm icon when complete to create the export file.
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l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the statements.

l Check the Open toggle if you would like to open the exported file after it is saved loc-

ally.

l Enter the export path location and click the Save icon to export the file to the

local path.

10     Print out the Summary by Rate report. 

l Select Summary by Rate on the Final Billing palette. This will open the Summary by

Rate Code window.

l Select the level of detail you would like to display on the report in the Report Type

drop-down menu.

l Select Detail if you would like the base (minimum/flat amount) and con-

sumption billing amounts to be separated on the report. The detail version will

also display the description of the rate codes included on the report and tiered

consumption data, including tier level number, tier billing amount, and total

tier consumption.

l Select Summary if you would like the consumption and base amounts to be

combined on the report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

11     Print the GL Distribution Report. 

l The GL Distribution step will use the fund balancing accounts set up on the SS

Setup window (SS> Utilities> System Setup> Transfer Accounts tab).

l Select GL Distribution from the Final Billing palette. This will open the GL Dis-

tribution window.

l Enter the journal entry date of the transactions in the batch in the Journal Entry

Date field. The date entered in this field will determine the fiscal period and fiscal

year of the journal entries created by the process.

l The Fiscal Period and Fiscal Year fields will populate based on the value

entered in the Journal Entry field.
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l Select the Report Type for the report.

l The summary report will display the general ledger account number, the gen-

eral ledger account description and debit and credit amounts created by the

process. The report will also total by fund and report. The summary report will

total journal entry lines by general ledger account. If there are journal entry

line items that wash within general ledger account that information will not dis-

play in this report. Print the detail version of the report if you would like every

journal entry line item to display. It can be sorted by GL Account or by Trans-

actions Type.

l The detail report will display the same information as the summary report but

will also include the customer number, service and service code. Every line

item of the journal entry will also be included in the report rather than a total

by general ledger account. It can be sorted by GL Account or by Transactions

Type.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

12     Commit the Final Billing batch. 

l Select Commit from the Final Billing palette. This will open the Commit window.

l When the Final Billing batch is committed, the status of the customer accounts pro-

cess in the batch will change from Final to Delete (UB> Maintenance> Account>

Account tab> Account sub-tab> Account Status field).

l Press ENTER to commit the final billing transactions or enter a date and time in the

field to schedule the statements to be committed.

l You can view the progress of the Commit step on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs). If the Commit step has been sched-

uled to generate at a later time, you can view the scheduled date and time in

the Scheduled Date/Time field.
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UB> Maintenance> Account Maintenance

UB Account Maintenance

Summary

The Account Master Maintenance window is the primary window used to update and/or

view any information on a Utility Billing customer account. The Account Master Main-

tenance window can be used to view the balance of a customer account, change the billing

address, attach a service rate, view the meter readings, create a service request, view the

transaction history on the account or attach a comment to the customer account.

Step by Step

1     View the Utility Billing customer accounts. 

l Open the Account Master Search window (UB> Maintenance> Account).

l Enter information in the Search Criteria fields and click the Refresh icon to filter

the customer accounts that display in the window.
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l Each tab displays a different set of search criteria fields.

l The orange Incomplete icon will display in the bottom right corner of the

window if customer accounts that meet the search criteria have not been dis-

played in the window. Click the orange Incomplete icon if you would like

all of the customer accounts that meet the search criteria to display in the win-

dow. If the search criteria are very broad or no search criteria have been

entered the window may take a while to load.

l The green Complete icon will display in the bottom right corner of the win-

dow if all customer accounts included in the search criteria have been dis-

played in the window.

l Springbrook Cloud users will need to refine their search criteria in order

to display all applicable accounts. However, Springbrook Cloud users

can generate a .csv file that includes all the records in the database that

meet the specified filter criteria via a data grid export.

l The Account Master Search window allows you to launch the New Accounts Wiz-

ard, Final Account Wizard and modify existing customer accounts.

l Press INSERT or click the Create icon to launch the New Account Wizard. The

New Account Wizard is used to create and set up new Utility Billing customer

accounts.

l Highlight a customer account and press DELETE or click the Delete icon to

launch the Final Account Wizard. The Final Account Wizard is used final a Utility

billing customer account.
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l Highlight a customer account and press ENTER or click the Modify icon to open

the selected customer account. This will open the Account Master Maintenance win-

dow.

l Click the Expand button next to the customer number to view all sequences

attached to the customer account.

l If you press ENTER on a customer record without selecting a customer

sequence, the lowest sequence number will open.

l If the account is part of an open batch, you may be limited in the fields that

you can modify until the batch has been committed.

2     Transmit Customer or Lot data to a web site.

l Click the Launch URL icon drop-down menu and select a URL type code to

transmit data from the customer or lot records associated with the account to the

web site attached to the URL type code.

l This icon is accessible from any tab on the Account Maintenance window.

l If your organization uses third-party web sites for tasks such as lot mapping or utility

billing background checks, URL type codes can help improve efficiency by reducing

data entry.

l For example, Springbrook offers an interface between the UB account and

the bad-debt management tool from Online Utility Exchange (OUE). This inter-

face allows Springbrook users to log into the OUE tool and immediately pop-

ulate the tool with the relevant UB data, directly from the UB Account
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Maintenance window. Please contact Springbrook Support for more inform-

ation on this premium feature.

l URL type codes are created and maintained on the URL Setup window

(SS> Maintenance> URL Setup).

3     Complete the Overview tab. 

l The Overview tab displays the account balance by service, the service rates

attached to an account and the Credit History on the account.

l The Account Balance section will display the balances on the services on the

account. Services will only display in the Account Balance section if there has been

activity on that service. Use the Service Rates tab if you would like to view all of the

services attached to the customer account.

l All of the columns that display in the Account Balance section are required, so

you cannot change any of the columns that display in this section.

l The Beginning balance will be the balance on the service before the current

billing. If there is not a current billing on the account, it will display the balance

on the service before the last billing.

l The Adjustments column will display adjustment transactions.

l Adjustment transactions are created by the redistribute credit process

and the Adjustment Input Wizard (UB> Adjustments and Fees> Input).

l The Payments column will display payments made on the account.
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l Payments can be entered in the Cash Receipts step (CR> Cash

Receipts).

l The Billing column will display billing generated in UB> New Billing or UB>

Final Billing. If there is a deposit on the customer account, the billing line item

that creates the deposit amount will be included in the Billing column.

l The End Balance column will display the ending balance of a service.

l If there are deposits on the customer account, the deposit amount will

not be included in the End Balance column. The billing and payment

line items will display in the Billing and Payments columns, but the

deposit balance will not be included in the End Balance column.

l The Service Rates section of the Overview tab will display the service rates

attached to the account.

l The Credit History section will display adjustment transactions processed using an

adjustment type that is attached to credit history information. This section is an

optional feature that allows you to create a credit score for customer accounts

based on the type of activity on the account. For example, customer accounts pro-

cessed in the Past Dues or Collections process can be assessed credit values and

those values can be reviewed to assess the credit risk of a customer.

l Any adjustment that is created using an adjustment type code that has credit

information attached (credit value and credit history days) will display in this

section. Credit information is attached to an adjustment type using the Adjust-

ment Type Maintenance window (UB> Maintenance> Adjustment Type>

Select an adjustment type> Credit History Days and Credit Value fields).

l For example, if the Collections adjustment type code (UB> Utilities> Setup>

General tab> Collections Adjustment Type field) has a credit value of 100
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(UB> Maintenance> Adjustment Type> Credit Value field), any customer

account processed in a Collections batch will have a credit score of 100.

l The credit transaction line item will be removed from the customer account

when the credit history day limit is exceeded. For example, if the customer

account was processed in a Past Dues batch 121 days ago and the credit his-

tory limit on the transaction (UB> Maintenance> Adjustment Type> Credit

History Days field) is 120 days, the credit transaction will be removed from

the account. This will lower the credit score on the customer account.

l Right click on the Credit History section and select Export to MS Excel to cre-

ate a spreadsheet of a customer’s credit history.

l The Create Letter icon is used to generate a form letter from the Account Main-

tenance window. This icon will launch the Word Merge Form Selection window.

l When a merge form is generated, it will automatically be saved as an attach-

ment on the account.

l Word merge forms are created and maintained on the Forms Maintenance

window (UB> Maintenance> Forms).

4     Generate a billing preview. 

l The Preview Billing icon is used to open the Billing Preview window. This icon

is only accessible from the Overview tab.

l The Billing Preview window provides a detailed preview of the customer’s

billing based on the current meter readings. This window provides a forecast
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of what the next billing generated for the customer might be and does not

update or modify the account. The services attached to the account are listed

and totaled in the Preview section of the window.

l Select a date from the Period End Date drop-down menu to modify the

period end date used on the billing preview. The default date in this field is

determined by the period begin date on the attached billing cycle and the num-

ber of days in the period.

l Change the date and click the Refresh icon to generate the preview.

l Click the Expand button next to a service to display the service billing

details.

l The Exceptions section will display any errors that could prevent the preview

from being accurately generated.

l Click the Print icon to generate a Statement of Account report.

l The Statement Date field will appear on the report but will not affect the

data displayed. This field will default to today's date.

l The report will display the customer information and the account activ-

ity, including the Beginning Balance, Current Activity and Estimated Bal-

ance.

5     Complete the Account tab. 
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l The Account tab will display the general information on an account such as

account status, billing cycle and ACH information.

l The Account tab has Account, ACH Info and Payment Plan sub-tabs. The

Account sub-tab will display the general information on the account. The ACH Info

sub-tab is used to enter the bank information if the customer is using the Direct

Debit process to pay for billings.

l Open the Account tab.

l The Account Number field will display the customer account number and

sequence number, but you will not be able to edit the value in this field.

l The Reference Number field is generally used to store the account number

of customer accounts that have been converted from a different software

application.

l You can filter customer accounts by the Reference number in all cus-

tomer account search windows.

l The format of the reference number is set up in the UB setup process

(UB> Utilities> Setup> General tab> Reference Format field). The

format established in the Setup window only applies when new

accounts are created using the New Account Wizard. You can change

the format of the reference number using the Account Master Main-

tenance window so that it does not match the reference number format.

l The Billing Cycle field is used to attach the customer account to a billing

cycle. The billing cycle is attached to a customer account when it is created

using the New Account Wizard.

l Click the Billing Cycle field label to select a billing cycle from a list. This

will open the Billing Cycle Maintenance window. You will be able to
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create, delete, modify or select a billing cycle from this window.

l Billing cycles are also created and maintained on the Billing Cycle Main-

tenance window (UB> Maintenance> Cycles).

l The Account Status field will display the status of the customer account.

l Accounts will change to Final status if they are finaled using the Final

Account Wizard.

l If you just change the status of the account to Final, the account

will display in the Final Billing window (UB> Final Billing> Select

Accounts), but there will be no final readings, final date or final

billing calculated on the account.

l The Vacation status is used to prorate a customer's account when they

are on vacation. If you would like the customer account to automatically

return to Active status and prorate the billing based on the length of the

vacation, use the Vacation Begin and Vacation End fields in addition

to the Account Status field.

l If you process a Winter Average (UB> Winter Averaging) batch

while the customer account has a Vacation status, the customer

account will not be included in the batch.

l If the customer is part of a Final Billing batch you will not be able to

change the status of the account from Final. In order to change the

account status you will have to open the account in a Final Billing batch,

deselect the account, and click the Save icon .

l A delete status UB customer account is an account that has been

finaled (processed in the Final Account Wizard) and the final billing has

been committed using either a New Billing or Final Billing batch.
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Customer accounts with a Delete status can still have an outstanding

balance because the account changes to a Delete status before pay-

ment is received on the final billing.

l If you would like to change a UB customer account to a delete

status, you should process the account in the Final Account Wiz-

ard (generates the final billing) and then commit the final billing in

either the Final Billing or New Billing process. The customer

account will change to a Delete status once the final billing has

been committed.

l If you change the account to delete status without processing the

account in the Final Account Wizard, the final bill on the account

will not be billed.

l The Connect Date is the date entered in the Connect Date field on the first

step of the New Account Wizard. The connect date is generally the date that

the customer has moved into the lot or service has been activated on the

account.

l Individual services and service rates attached to the customer account

can have different connect dates. You can view the connect date of a

specific service or service rate on the Service Rates tab of the Account

Master Maintenance window.

l The Final Date is the date that the customer account is finaled. This field will

be populated if the customer account has been processed through the Final

Account Wizard.

l The final date on an account is entered in the Final Date field on the first

step of the Final Account Wizard.
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l The Vacation Begin and Vacation End fields allow you to prorate a cus-

tomer billing if the service rate on the customer account is set up to prorate.

The Vacation Begin and Vacation End fields will not affect proration unless

Vacation is selected in the Account Status drop-down menu.

l In order to prorate an account, change the Account Status field from Act-

ive to Vacation and enter the length of the vacation in the Vacation

Begin and Vacation End fields. If a New Billing is processed on the cus-

tomer account during the vacation date range, the billing will be pro-

rated.

l If the Vacation Begin date occurs between the Period Begin

Date and Period End Date of the New Billing batch, the customer

billing will prorate if the service rate on the customer account is

set up to prorate the consumption or minimum amount (UB> Main-

tenance> Service Rate> Prorate Minimum and/or Prorate Con-

sumption toggles).

l If the Vacation End date has passed when the New Billing batch

is committed, the customer account will change to Active status.

The Transaction Date of the New Billing batch does not affect

how the vacation will prorate or be applied.

l The Vacation Begin and Vacation End dates must occur in dif-

ferent billing periods. If the vacation date range takes place within

a single billing period, the amount billed will be ZERO and the

status of the account will change back to Active when the billing is

committed.
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l The customer account bill will only prorate if the service rates

attached to the customer account are set up to prorate.

l The status of the customer account will stay in Vacation status until a

New Billing batch is processed on the customer account that is after the

Vacation End date.

l The Hold Status drop-down menu is used to add a hold status to a customer

account.

l The Hold Status field is generally used to keep certain statements from

being generated in a New Billing batch. When billing statements are

generated (UB> New Billing> Statements), there is an Include drop-

down menu that allows you to remove hold status accounts from the

billing. This will remove both temporary and permanent hold status cus-

tomers from the batch.

l The Hold Status of a customer account is not modified by any Utility

Billing module process, and there is no functional difference between a

temporary hold and permanent hold account.

l The Combined Statement toggle has not yet been implemented.

l The Enrolled in CivicPay Auto Pay toggle will automatically be checked if

the account owner has signed up for auto pay through the CivicPay Online

website.

l The Description field is used to enter a description on the account.

l The Description field can be included in a QBE report (UB> Main-

tenance> QBE Builder). The Description field is in the Account Master

table.
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l The Miscellaneous Fields section is used to enter information on the account

sequence that is outside the scope of the current Springbrook version. If you

would like to track information on the customer number rather than the spe-

cific customer sequence, attach the information to the Customer Mis-

cellaneous sub-tab on the People tab.

l The fields in the Miscellaneous Fields section can be included in QBE

reports (UB> Maintenance> QBE Builder). The miscellaneous fields are

on the Account Master table.

l The field labels of the miscellaneous fields can be modified using the

Miscellaneous Field Labels window (SS> Utilities> Miscellaneous Field

Labels).

l The Categories section is used to attach an account class to a customer account.

l Categories are user-defined groups used to group accounts together for use

on some reports.

l Click the Create icon to add a new category code to the customer

sequence. This will add a new line item in the Category section.

l Click the Ellipsis icon in the Code field to select the category from a list.

l The Category Description field will populate with the description of the cat-

egory once a category code has been selected.

l Highlight an account class and press DELETE or click the Delete icon to

remove the account class from the account. This will not delete the account

class, it will only remove the account class from the customer account.

l Click on the ACH Info tab to view the bank account information attached to the

account.
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l Bank account information is attached to a customer account in order to use

the Direct Debit process in the Clearing House module.

l The Bank Account section of the window displays the bank information on the

customer account. In order to enter bank account information on a customer

account, the customer’s bank must be set up as a bank code on the Bank

Maintenance window (SS> Maintenance> Bank). The bank code will determ-

ine the routing number on the bank account.

l Enter the customer’s bank account number in the Account Number

field.

l This field is limited to 60 digits.

l For security purposes, only the last four digits of the account num-

ber will be displayed once a bank account is entered and saved.

The rest of the account will be displayed as a series of 12 aster-

isks - "************1234" - regardless of the actual length of the

account number.

l Click the Bank Code field label to select a bank code from a list.

l Select checking or savings in the Account Type drop-down menu.

l Select None if no bank information should be entered on the cus-

tomer account. If an account type is selected you will be required

to enter a bank code and bank account number.

l The ACH Type drop-down menu is used to specify the account as a

consumer or business account.

l Check the Clearing House Pre-Note toggle to indicate that the bank

account information has been included in a Direct Debit pre-note batch.
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l This toggle will be checked if you process the customer account

during the Pre-Note batch process (CH> Direct Debit> Create a

Pre-note Batch). If this toggle is checked the customer account

will not be pulled into a pre-note batch.

l You can manually check this toggle if you do not want to process

the bank account information in a pre-note batch.

l Click on the Payment Plans tab to view the payment plans that have been set up on

the account.

l Any existing payment plan entries will display in the Plans section of the win-

dow. Click on an existing payment plan or installment entry and the entry

information will populate in the maintenance section below.

l Click the Create icon to create a new payment plan entry. This will create

a new parent payment plan and a new child installment.

l Highlight and edit the parent payment plan.

l Check the Print on statement toggle to include the payment plan

information on UB statements.

l Displayed payment plan information will include due dates

and amount due for the next few installments.

l This information will only display in the Special Messages

section on the 8.5x11 billing statement.

l Use the Payment Plan Description field to specify a name for

the payment plan.
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l Highlight and edit the installment.

l Enter a Promise Date for the new installment. This is the date

that the customer is expected to make the payment.

l The Promise Date field will populate to today's date. You

cannot specify a payment date that occurs before the Entry

Date.

l Enter an Amount for the payment plan installment.

l The Amount field will populate with the outstanding bal-

ance on the account. The amount entered must be

between $0.01 and the total outstanding balance. Over-

payments will result in an error and prevent the pay-

ment plan entry from being saved.

l Select a Status for the payment plan installment. Payment
plans can be filtered by status when generating reports. This

status will default to Active.

l When a customer successfully pays the account balance,

the payment plan status will update to Closed when the

receipts batch is committed.

l If an account misses a payment on the payment plan,

all payment plan entries for that account will update to

Failed when past dues are committed.

l If a payment is due on the day that past dues are pro-

cessed, that payment plan status will update to Failed.

Springbrook recommends setting the due date of the
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payment plan to the day after you intend to process

past dues.

l The Entry Date and Entered By fields will automatically
populate with today's date and the current user's login

name. These fields cannot be edited.

l Enter an optional Installment Description for the Payment
Plan installment. This field can accommodate up to 256 char-

acters.

l Once a payment plan has been created, it will appear on the Pay-

ment Plans report (UB> Reports> Payment Plans).

l Click the Save icon if there were any changes made to the Account tab that

should be saved.

6     Complete the People tab. 

l The People tab of the customer account maintenance window has several sub-tabs

that display the customer information, co-applicant information, bill to information,

alternative address and the miscellaneous fields associated with customer account.

The People tab will also display the owner information if the owner of the lot is dif-

ferent than the customer on the lot.

l By default, the Summary sub-tab will display when you click on the People tab. This

tab provides a summary of customer, owner and co-applicant information.
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l The Customer sub-tab will display the information attached to the customer record

such as the customer name and social security number. Changes to the Customer

sub-tab will modify the customer record information and update all of the account

sequences the customer is attached to. Customer records are used in almost every

module in the Springbrook application and changes to the customer record will

update to all of those modules.

l The Social Security field will display the Social security number of the cus-

tomer.

l You can set up security on the Social Security field on the DB Security

window (SS> Security> DB Security). The DB Security feature allows

you to remove the field from the window. If you set database security on

the field using the DB Security feature, all windows that display the

same field will also be affected.

l The Social Security Number field is labeled SSN in the Customer

table of the System Wide Access group of tables.

l The Description field displays the description on the customer number.

Changes to the Description field will update back to customer number.

l You can view the customer description from the customer number in

Customer Master Search window (Customer Icon > Customer tab>

Description field).

l The Contact Information section displays the mailing address and contact

information for the customer account. The mailing address is the address that

will display on the billing statements and is the address that will be certified in

the New Billing, Final Billing or Past Dues process.
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l When a customer account is processed in the Final Account Wizard, the

forwarding address will populate in these fields.

l The mailing address is not necessarily the address of the lot attached to

the customer account sequence.

l The Carrier Route and Delivery Point fields will populate with information

when you certify the address on a customer account using the Address Cer-

tification process.

l The Customer Miscellaneous sub-tab will display the miscellaneous account inform-

ation attached to the customer record. Modifications to the miscellaneous inform-

ation on the customer record will update on all accounts attached to the customer

record. The information on this tab is not unique to the customer sequence number.

l The miscellaneous fields are generally used to enter customer information

that is outside the scope of the current Springbrook version.

l The labels of the miscellaneous fields can be set up on the Miscellaneous

Field Labels window (SS> Utilities> Miscellaneous Field Labels).

l You can view the miscellaneous fields on a customer record from Customer

Master Search window (Customer icon > Customer Miscellaneous tab).

l The Co-Applicant and Co-Applicant Misc sub-tabs will display the co-applicant

information attached to the account. These are optional sub-tabs and are identical

to the Customer and Customer Misc sub-tabs.

l The Owner sub-tab will only display if the owner of the lot is not the customer on the

lot. The Owner sub-tab will display the owner on the lot if the owner is different than

the customer. This tab is identical to the Customer sub-tab.
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l Changes to the Owner sub-tab will update back to the lot owner customer

record.

l The Owner Miscellaneous sub-tab will only display if the owner of the lot is not the

customer on the lot. The Owner Miscellaneous sub-tab is identical to the Customer

Miscellaneous sub-tab and is used to enter the owner information that is outside the

scope of the current Springbrook version.

l The labels of the miscellaneous fields are set up in the Miscellaneous Field

Labels window (SS> Utilities> Miscellaneous Field Labels).

l Changes to the Owner Miscellaneous sub-tab will update back to the Lot

owner customer record.

l The Bill To sub-tab is used to create additional copies of statements on the cus-

tomer account when statements are generated. The statement copies will be

addressed to a selected customer account.

l By default, four line items will display on the Bill To sub-tab.

l There will be a separate line item for billing statements, delinquent

notices, past dues and door hangers.

l Press INSERT or click the Create icon to add a new customer to the sub-

tab. This will create a new line item in the window.

l Select the customer account that should receive the copy of the statement in

the Customer Number field.

l All customer accounts will display on the list, not just Utility Billing cus-

tomer accounts.

l The Customer Name field will populate after the Customer Number has been

selected.
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l If the Paper Bill toggle is unchecked, the Web Payments user has

opted not to receive a paper statement. Springbrook users cannot

uncheck this toggle, but can check the toggle if necessary.

l Select the statement you would like to create a copy of in the Statement

column.

l When the statement selected in the drop-down menu is generated, a

copy of the statement will print with the information of the customer

selected in the Customer Number field.

l Door Hangers will display in the Statement drop-down menu, but the

feature has not been implemented. A copy of the door hanger will not

print out when door hangers are generated (UB> Service Requests>

Door Hangers).

l The Logical 1 toggle is a user-defined field that can be edited on the Mis-

cellaneous Field Label Maintenance window (SS> Utilities> Miscellaneous

Field Labels). Because this is an editable field, the column heading may not

read Logical 1.

l The Message column is used to enter a message that will display on the

copied statement. This field may not display on custom statements.

l The message entered in this field will not affect the Message 1 and Mes-

sage 2 field entered on during the Statements step of the New Billing

process.

l The Message field will only display on a statement if the Display bill to

message toggle is checked on the Statement Setup Maintenance win-

dow (UB> Utilities> Statement Setup> Select a statement> Mis-

cellaneous tab).
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l The Alternative Address sub-tab is used to enter an alternative address on the cus-

tomer account. The address entered on this sub-tab will be used when statements

are printed on the customer account.

l The Begin Date and End Date fields are used to specify a date range when

the alternate address should be used. If a begin date is specified but an end

date is not, statements will be sent to the alternate address indefinitely.

l Click the Save icon if there is information on the People tab that should be

saved.

7     Complete the Service Rates tab. 

l The Service Rates tab of the Account Master Maintenance window is used to view

the services and service rates attached to the customer account.

l The Service Rates tab displays all of the services and service rates attached to the

customer account. Click the Expand button next to a service to view the service

rates attached to the selected service. Highlight a service rate and the information

attached to the service rate will populate in the Rate Maintenance section.

l There are four Create icons and four Delete icons on the Service Rates tab.

The Create and Delete icons to the left are used to add or remove a service from the

account. The second set of Create and Delete icons are used to add and remove a

service rate from the account. The third set of Create and Delete icons are used to

add or remove services from the Budget Billing process. The last set of Create and
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Delete icons are used to add or remove override tax codes to the service and will

only be enabled if the Override the tax codes for this rate toggle is checked below.

l Click the first Create icon to add a service to the account. This will create a new

line item in the window. Select the service you would like to add to the customer

account using the drop-down menu.

l Check the Exempt From Past Dues toggle if you do not want this service to

be pulled into a Past Dues batch. When you generate a Past Dues batch (UB>

Past Dues> Generate), the customer account will not be pulled into the batch

even if it meets the requirements entered in the Generate step.

l Check the Exclude from Redistribute toggle if you do not want this service

to be pulled into an Adjustments and Fees> Redistribute Credit Balances

batch. When you generate an Adjustments and Fees> Redistribute Credit Bal-

ances batch (UB> Adjustments and Fees> Redistribute Credit Balances), the

customer account will not be pulled into the batch even if it meets the batch

requirements. This toggle is often used to exclude specific services from the

redistribution process in order to meet energy assistance program require-

ments.

l When this toggle is checked, this service will also be ignored when the

Past Due process applies credits to past due services. This will prevent

any energy assistance program credits that exist on this service from

being applied to other services.

l Click the first Delete icon to delete a selected service.

l The Delete icon will not be enabled if there are history items on the high-

lighted service.
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l Select a service and click the second Create icon to add a service rate to the

customer account. This will create a new line item below the selected service. Enter

the service rate information in the Rate Maintenance section.

l Click the Service Code field label to select the service rate from a list.

l Most of the fields on the service rate line item will populate after you have

selected a service rate.

l The Special Multiplier field is used to specify a multiplier for the service rate.

This will default to 1.

l The Special Multiplier field will only affect the service rate if the Use

special multiplier toggle is checked on the Service Rate Maintenance

window.

l The Connect Date field will default to the current date.

l The Promotion Amount and Promotion End Date fields are used to create a pro-

motion.

l The value in the Promotion Amount field will replace the flat or minimum

amount associated with the service rate selected in the right section of the win-

dow. If there is more than one service rate attached to a single service on the

account, each service rate can have a separate promotion. When the pro-

motion amount is billed, the consumption will not be affected but the minimum

or flat amount on the service rate will be replaced by the promotion amount.

l If the Multiply Flat by Special Multiplier toggle (UB> Utilities> Setup>

Billing tab) is checked, then the promotion amount will be multiplied by

the value in the Special Multiplier field on the service rate.
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l The Promotion End Date field is used to enter the promotion end date. If the

Promotion End Date occurs between the period begin and period end date of

a New Billing, the promotion amount will be used instead of the minimum/flat

amount on the service rate. The promotion amount will not prorate, even if the

minimum/flat amount on the service rate is set up to prorate. If the promotion

is active during the billing, the entire promotional amount will be used. If the

promotion end date occurs prior to the period begin date of a New Billing

batch, the promotional amount will not be used and the billing will be cal-

culated as usual.

l The Attached Meter drop-down field is used to select the meter attached to the

account.

l The Extended Description field is used to add an optional additional description to

the selected service rate. This additional description will appear immediately after

the service rate description in the Current Charges section of the billing statement.

l This field is limited to 10 characters.

l The Override the tax codes for this rate toggle is used to enable a tax code over-

ride for the selected service code.

l Override tax codes are used when an organization wants to control tax codes

at the customer level. A common example would be overriding the standard

tax code for a tax exempt customer. As tax codes are controlled at the service

rate level, this functionality allows customers with special tax considerations

to be set up with the same service rate as other customers. Those special tax

considerations can then be addressed on a customer-by-customer basis.

l Once the toggle is checked, click the last Create icon to add an override

tax code to the selected rate.
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l This will open the Tax Code Selection window. Select the override tax

code and click the Confirm icon to attach the code to the account.

The selected tax code will now display in the Tax Codes section to the

right.

l When the account is added to a billing batch, the specified override tax

code will be the tax code that is billed. All other tax codes associated

with the rate will be ignored.

l The Discount (%) field is used to apply a percentage discount to the highlighted ser-

vice code.

l The specified discount will only apply to the service code on the current cus-

tomer's account. The customer's bill will still display a primary bill detail line

for the standard service rate, but it will also include a second bill detail line

with a negative amount that represents the percentage of the service rate dis-

counted.

l Specify a discount amount between 0.0000 (0%) and 1.0000 (100%).

l The Vacation Begin and Vacation End fields are used to put individual service

rates into vacation status.

l These fields work in the same manner as the vacation begin and end fields on

the Account tab, but only apply to selected service rate.

l The Tax Codes field will populate with the tax codes attached to the selected ser-

vice rates.

l Tax codes are attached to service rates using the Service Rate Maintenance

window (UB> Maintenance> Service Rate> Winter Average/Taxes tab>

Create icon).
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l If you would like to add or remove a service or service rate from a large number of

accounts, use the Add/Remove Service feature (UB> Utilities> Add/Remove Ser-

vices).

l Click the third Create icon to Budget Bill all the active rates attached to the

account.

l The Budget Rate toggle will be checked if the currently selected rate is part

of a budget billed account.

l The values in the Budgeted Amount, Start Date, Final Date and Recal-

culation Date fields are determined by the Budget Billing process (UB>

Budget Billing).

8     Complete the Winter Average tab. 

l TheWinter Average tab is used in conjunction with the Winter Averaging process

(UB> Winter Averaging).

9     Complete the Lot tab. 

l The Lot tab displays the lot attached to the customer account.
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l Lots are used in several modules in the Springbrook application. Changes to the lot

from the Account Master Maintenance window will affect the lot record in all of those

modules.

l The Lot sub-tab displays the general information attached to the lot.

l The Lot Number field displays the lot number of the lot attached to the cus-

tomer account. You cannot change the value in this field.

l The Status field displays the status of the lot.

l Lots are given an Active status when they are created using the New

Account Wizard.

l The status of the lot will not affect any process in the Utility Billing mod-

ule.

l The Owner’s Customer Number field is used to set the owner of a lot.

l Click the Owner’s Customer Number field label if you would like to

change the owner of the lot. This will open a customer account selection

window.

l Once an Owner's Customer Number is selected, the customer inform-

ation fields below will automatically populate.

l The Lot Details section allows you to provide specific details on the selected

lot. These are not required fields.

l The Master Account field is used when the current account is assigned to a

tenant rather than the lot owner.

l Master Accounts can be used when an account will always take

responsibility of a property once a tenant moves out. The master

account does not have to match the owner account. For example,
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a property owner that uses a realty company to manage the prop-

erty can use the realty company’s account rather than the owner’s

account.

l To add a Master Account, select the account from the drop-down

list. To be selected as a Master Account the account must already

exist on the lot and be in Suspended status. If no accounts are dis-

played in the Master Account drop-down, verify the desired

account is on the correct lot and in Suspended status.

l When the current tenant has their Final Billing committed, which

changes the tenant to Delete status, the Master Account will

change from their Suspended status to Active status.

l When the Master Account has their Final Billing committed the

Master Account will be changed into Suspended status rather

than Delete status.

l The Balance field displays the outstanding balance, across all associated

Springbrook accounts, for the lot attached to the UB account.

l The Number of Units field can be used as a multiplier when bills are cal-

culated on a customer account.

l If the Use Lot Units toggle is checked on the Service Rate Main-

tenance window (UB> Maintenance> Service Rates> General tab), the

Number of Units on the lot will be multiplied by the minimum amount

and/or the consumption on the customer account.

l The In City toggle is used by some reports to group the consumption on the

meter attached to the lot. This is not a required field.
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l For example, the Consumption by Type Report groups the consumption

on meters by meter size and displays the consumption separated by in

city and out of city.

l The Description field is a large field that can be used to store special notes or

information on the lot. The information entered in this, like all the other inform-

ation on the lot record, is available in all Springbrook modules that use lot

information.

l The Miscellaneous sub-tab will display the miscellaneous fields attached to the cus-

tomer lot.

l The labels of the miscellaneous fields are set up in the Miscellaneous Field

Labels window (SS> Utilities> Miscellaneous Field Labels).

10     Complete the Devices tab. 

l The Devices tab displays the devices attached to the lot on the UB customer

account, the meters that are attached to devices (for example, a subtraction meter),

and the meter readings on those meters.

l The Devices tab can also be used to create service requests that add, remove or

change-out the devices on the lot. If you would like to modify the meter readings on

a device or attach a meter to a device, you can open the Device Maintenance win-

dow of a meter from this tab to perform those tasks.

l The Devices section will display the devices attached to the customer account.
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l An Expand button will display next to a device if there is an exempt meter (a

meter than either adds to or subtracts from the consumption on the meter)

attached to the device. Click the Expand button to view the attached meter

information. Highlight the attached meter and the Meter History and Meter

Detail sub-tabs will populate with the information attached to the meter.

l Once the exempt meter is expanded, you can right-click on the row of

columns to select additional details you would like to display. For example, by

adding the Attached Devices> Add/Subtract column, you would be able to

quickly see how an attached exempt meter will affect billing.

l Select a device in the Devices section, and the Meter History and Meter Details tabs

will populate with the information attached to the selected meter.

l If you would like to manually modify the meter reading on an account, open

the Device Maintenance window by highlighting a device and clicking the

Modify icon . You can create or modify a meter reading using the Con-

sumption tab of the Device Maintenance window.

l Highlight a device and click the Modify icon to open the Device Maintenance win-

dow of the selected device.

l The Device Maintenance window contains all the information attached to the

device and can be used to enter manual meter readings on meter devices or

attach a meter to the device (for example a subtraction meter).

l You can also open the Device Maintenance window in UB> Maintenance>

Device.

l The Create icon , Change-Out icon , and Delete icons are used to create

service requests.
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l Click the Create icon to create add a device to the customer account. This

will launch the Service Request Input Wizard to create an add device service

request.

l Highlight a device in the Devices section and click the Delete icon to

remove a device from the customer account. This will launch the Service

Request Input Wizard to create a remove device service request.

l If there is a default remove device service request code set up on the

device type of the device selected in the Devices section, the Service

Request Input Wizard will populate with the default service request

code.

l Service requests codes are attached to device types in order to set a

default service request code. Service request codes are attached to

device types using the device type maintenance window (UB> Main-

tenance> Open a device type maintenance window – water, gas, elec-

tric> General tab> Default Remove field).

l Highlight a device and click the Change-Out icon to create a change out

service request. This will launch the Service Request Input Wizard with the

customer information populated on the wizard.

l If there is a default change-out service request code set up on the

device type of the device selected in the Devices section, the Service

Request Input Wizard will populate with the default service request

code.

l Service request codes are attached to device types using the device

type maintenance window (UB> Maintenance> Open a device type
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maintenance window – water, gas, electric> General tab> Default

Change-out field).

l The Meter History sub-tab will display the meter reading on the device highlighted in

the Devices section of the window.

l All of the meter readings will display in the window, including those that were

made while the device was attached to another UB customer account.

l The Account Number field displays the account that was attached to the lot

when the readings were made.

l The Consumption column displays the actual consumption on the meter

reading and the Calc Consumption column displays the calculated con-

sumption after the actual consumption is recalculated with the multiplier or

divisor attached to the meter.

l The Read Period/Year column displays the reading period and reading year

attached to the meter reading. If the New Billing process is set up to only bill

readings of a certain period rather than all unbilled readings (UB> Utilities>

Setup> Billing tab> Meter Reads to Bill drop-down menu), the period and

year of the reading are important when generating bills.

l There will be a check in the New column if the meter read was entered manu-

ally.

l Manual meter readings are readings that are either entered directly on

the device (UB> Maintenance> Device> Consumption tab) or on the

Input New Meter Readings window (UB> Meter Management> Input

New).

l The Billed toggle will be checked if the meter reading has been billed using
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the UB New Billing process.

l The Estimate toggle will be checked if the meter reading was an estimate.

l The Meter Details sub-tab will display the basic meter information. If you would like

to modify the information that displays on this tab, you will have to open the device

in the Device Maintenance window (click the Modify icon at the top of the win-

dow).

l Many of the fields on the Meter Details sub-tab can be edited on the Device

Maintenance window. Specific device details, such as the manufacturer and

serial number, can be edited on the Meter tab of the Device Maintenance win-

dow.

l Installation specific information, such as latitude, longitude or location, can be

edited on the Connections tab of the Device Maintenance window.

l Not all editable fields will be initially displayed on the Connections tab.

To display additional fields, right-click in the data grid and check each

field you would like to edit.

11     Complete the Container tab. 

l The Container tab is used to add and maintain the containers attached to a cus-

tomer account.

l The upper section of the window displays the containers attached to the customer

account. Highlight a container and the fields in the Container Info section will pop-

ulate with the information attached to the selected container.
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l Click the Create icon or press INSERT to add a new container to the lot. This will

add a line item to the upper section of the window. Highlight the new line item and

enter the container information into the Container Info section.

l The Route field is used to enter the route number of the container. Routes are cre-

ated and maintained using the Route Maintenance window (UB> Maintenance>

Route).

l The Sequence field is used to enter the container sequence on the route.

l The Serial field is used to enter the serial number of the container. This is not a

required field.

l The Lot field displays the active lot on the account, which is also the lot where the

container resides. This field is never enabled on this tab. If you would like to change

the active lot on the customer account, you can use the Lot tab to change the active

lot.

l The Service field is used to attach a service to the container. For example, if you

have a separate service for garbage collection titled GARBAGE, select GARBAGE

in the drop-down menu.

l The selection in this field will affect the functionality of the Service Code field.

Only service rates of the service selected in this drop-down menu can be

attached to the meter.

l The service attached to the container should also be attached to the customer

account using the Service Rates tab.

l Services are created and maintained using the Service Maintenance window

(UB> Maintenance> Service).

l The Service Code field is used to attach a service rate to the container.

l The Status drop-down menu is used to select the status of the container.
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l Meters with an inactive, missing or destroyed status will not be included in a

billing.

12     Complete the History tab. 

l The History tab displays the committed and uncommitted transaction line items on

the customer account.

l Uncommitted transactions will display in red and committed transactions will display

in black. Committed transactions will also have a date in the Post Date column.

l The Post Date column displays the date that the transaction has been com-

mitted. This is the date the batch was committed, it is not necessarily the

same as the date the transactions are posted to the general ledger or the

transaction date.

l There are two fields that filter the transactions that display on the History tab: His-

tory From field at the bottom of the window and the Account History/Deposit His-

tory/History Balance drop-down at the top.

l History line items prior to the date in the History From field will not display on

the History tab. Modify the date in the History From field to filter the history

line items that display in the window.

l The Account History/Deposit History/History Balance drop-down menu at the

top of the tab is used to change how the account history is displayed.

l Select Account History to display a chronological history of transactions

on the account.
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l Select Deposit History if you would like to view the deposit transactions

on a customer account.

l Select History Balance to display the account balance at each point that

it was affected by a transaction.

l There are three dates associated with each transaction line item: journal entry date,

post date and transaction date. The journal entry date is the date the journal entry

created by a batch process is posted to the general ledger. The journal entry date

generally determines the fiscal period and fiscal year the journal entry is posted to.

Many reports in the Utility Billing module can be filtered by journal entry date. The

transaction date is generally the date of the transaction. For example, the trans-

action date of a payment entered in the Cash Receipts module is the receipt date on

the payment. The post date is the date the batch process used to generate the trans-

action was committed.

l Click the Expand button to view the transaction line item detail of a transaction.

l You can export the transactions that display in the window to a MS Excel spread-

sheet by right clicking on the data in the tab and selecting Export grid contents to

Excel. All transaction line items will display on the export, even line items that have

not been expanded. This feature allows you to create a quick report of the history of

a customer account.

l Click the Print icon to print the Account History report for the account.

l This will launch the Account History Report window where you will be able to

specify which transactions and meters are included in the report, how the

report is sorted, and the date range for the report.

l The report will display the Transaction Date, Transaction Type, Description

and Amount for each included transaction. The report will also include the
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Description, Read Date, Reading and Consumption values for each meter

included in the report.

l Click the View Report icon to view a copy of the statement associated with a

selected billing transaction.

l Only statements from committed billing transactions can be viewed.

13     Complete the Services Request. 

l The Services Requests tab will display all active, closed and committed service

requests that have been created on the customer account.

l The Service Rates tab can also be used to create and open service requests.

l Click the Create icon to create a new service request on the account. This will

open the Service Request Input Wizard with the customer information populated on

the wizard.

l Highlight a service request on the tab and click the Modify icon to open or

modify the selected service request. This will open the Service Request Input Wiz-

ard.

l Highlight a service request and click the Delete icon to delete the selected ser-

vice request.

l If there are meter readings attached to the deleted service request, those

meter readings will not be posted to the meter.
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l If you would like to delete a committed service request, delete the service

request from the Service Request Input window (UB> Service Requests>

Input).

l Deleting a committed service request will not delete the meter readings

made on the service request from the meter. The meter readings are

posted to the devices when the service request is committed, and delet-

ing the service request will not remove those meter readings from the

meters.

l The Current Account/Current Lot drop-down menu is used to display service

requests associated with either the current account or the current lot.

l The Request Description and Service Description fields will populate with the

information from the service request highlighted on the Service Request tab.

l You cannot modify the information in these fields from the Service Rates tab.

If you would like to modify the information in these fields, click the Open tab to

open the Service Request Input window and then modify the information in

the fields.

l The Status column will display the status of the service request. The service

request will either be active or closed.

l When a service request is created, it will have an active status. After the ser-

vice request has been completed, the status of the service request will gen-

erally be changed to closed.

l Service requests are closed from the Service Request window using the

Close icon (UB> Service Requests> Input) or from the Service

Request Input Wizard by changing the Status field to Closed.

l A service request must be closed before it can be committed.

UB ACCOUNT MAINTENANCE 305



l The Committed column will be checked if the service request has been committed.

l You cannot check the Committed toggle on this tab to commit the service

request. The Committed toggle is just displaying if the service request has

been committed (UB> Service Requests> Commit).

14     Complete the Comments tab. 

l The Comments tab is used to attach and display comments on the customer

account.

l Comments are attached to customer accounts using a comment status. You can cre-

ate a comment status using the Comment Status Maintenance window (UB> Main-

tenance> Comment Status), or you can use a comment status that has already

been programmed into the application (Active, Alert, Attention, Closed and Prom-

ise).

l Click the Create icon to add a comment to the customer account. This will cre-

ate a new line item in the Comment section and enable the Status, Creation Date

and Close Date columns.

l After specifying the comment details, enter the comment in the Comment Body

section below. This field can accommodate up to 512 characters.

l Highlight a comment and click the Delete icon to delete a comment.

l If a comment is accidentally deleted and the changes to the window have not

been saved, exit the tab without saving the changes. This will open an inform-

ation window describing that there have been changes to the information on
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the Account Master Maintenance window that have not been saved. Click the

OK button to process without saving. If the changes to the window were never

saved, the erroneously deleted comment will still display on the Comment tab

of the Account Master Maintenance window when it is reopened.

l Click the Print icon to print the account comments. This will open the Print

Account Comments window.

l Use the Comment Status toggles, Creation Date range fields and Close Date

range fields to filter the comments that you would like to include in the report.

l The header of the report will display the User that generated the report, the

Print Date, the Account Number, the Customer Name, the Service Address,

and the Phone Number for the selected UB account. The body of the report

will display the Creation Date, Close Date, Comment Status and full Comment

text for each comment included.

l Click the Save icon when complete.

15     Track any changes made to the account record. 

l Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit history.

l The Audit Trail section will provide details about any changes made to an account

record including the date of the change, type of change made, user that made the

change, and data table that was edited.
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UB> Maintenance> Account

Account Master Search Window

Summary

The Account Master Search window (UB> Maintenance> Account) is used to open, create

or final a Utility Billing module customer account. The window will display all customer

records with a UB module account as well as all of the UB customer accounts associated

with each customer record. Enter information into the Search Criteria section and click the

Refresh icon to filter the customers that display in the window. The customer records

that are attached to a UB module account and that match the search criteria will load in the

window. Click the Expand button next to each customer record to view the UB module

accounts attached to a customer record. Highlight a UB customer account and click the

Modify icon to open the account in the Account Master Maintenance window.

You can modify the lot and customer record information associated with a UB customer

account using the Account Master Maintenance window and the changes will update to the

entire database. You can also modify a customer record using the Customer window (Cus-

tomer icon on the main desktop) or the Lot window (Lot icon on the main desktop).

Changes to the Customer or Lot window will update all UB customer accounts attached to

the customer record or the lot.
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Click the Create icon to launch the New Account Wizard. The New Account Wizard is

used to create new UB module customer accounts.

Highlight a UB module account (not the customer record) and press DELETE to final the

account. This will launch the Final Account Wizard and calculate the final billing on the UB

customer account.

Right click in the window and select Export grid contents to Excel if you would like to create

an MS Excel spreadsheet of the information that displays in the window.

Step by Step

1     Open the Account Master Search window (UB> Maintenance> Account).

2     Filter the displayed accounts. 

l Enter information in the Search Criteria fields and click the Refresh icon to filter

the customer accounts that display in the window.

l Each tab displays a different set of search criteria fields.

l For example, the Driver's License field on the Customer tab is used to filter

the customer records that display in the window by a drivers’ license number.

A drivers’ license number is attached to a UB customer account using the
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Account Master Maintenance window (UB> Maintenance> Account> People

tab> Customer sub-tab> Driver's License Number field).

l Depending on the number of customer records that match the search criteria, all

customer records may not load in the window.

l The orange Incomplete icon will display in the bottom right corner of the

window if customer accounts that meet the search criteria have not been dis-

played in the window. Click the orange Incomplete icon if you would like

all of the customer accounts that meet the search criteria to display in the win-

dow. If the search criteria are very broad or no search criteria have been

entered the window, this may take time to load.

l The green Complete icon will display in the bottom right corner of the win-

dow if all customer accounts included in the search criteria have been dis-

played in the window.

l Springbrook Community users will need to refine their search criteria in

order to display all applicable accounts. However, Springbrook Cloud

users can generate a .csv file that includes all the records in the data-

base that meet the specified filter criteria via a data grid export.

l The Account Master Search window allows you to launch the New Accounts Wiz-

ard, Final Account Wizard and modify existing UB customer accounts.

l Click the Create icon to launch the New Account Wizard. The New Account Wiz-

ard is used to create and set up new Utility Billing customer accounts.

l Highlight a customer account and click the Delete icon to launch the Final

Account Wizard. The Final Account Wizard is used final a Utility billing customer

account. 
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l Click the Expand button next to a customer record to view the UB module customer

accounts attached to the customer record.

l Highlight a UB customer account and click the Modify icon to open the selected

customer account. This will open the Account Master Maintenance window.

l If you highlight a customer record and press ENTER without selecting a UB

customer account, the UB customer account with the lowest sequence num-

ber will open.
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UB> Maintenance> Account History
Report

Account History Report

Summary

The Account History Report is launched from the Account Maintenance window (UB> Main-

tenance> Account> History tab> Print icon ). The report displays the Transaction Date,

Transaction Type, Description and Amount for each included transaction. The report will

also include the Description, Read Date, Reading, and Consumption values for each meter

included in the report.

Step by Step

1     Open the Account History window (UB> Maintenance> Account> History tab> Print

icon ).

2     Configure the report. 
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l Select the account transaction types you would like to include in the history report.

l Press CTRL+A to select all transaction types. Press SPACE to check or

uncheck the highlighted toggles.

l Hold down SHIFT to select a range of billing cycles. Press SPACE to check or

uncheck the highlighted toggles.

l Use the Sort By drop-down menu to specify whether you want the report to be sor-

ted by post date or transaction date.

l Use the Meter Info drop-down menu to specify which (if any) meters you would like

included in the report.

l Enter a date range in the Date From and Date To field to filter the account trans-

actions that display in the report.

l Check the Only display meter usage history toggle to generate a meter usage

report that excludes all other account history.

l When this toggle is checked, the transactions and Sort By fields will be dis-

abled. The No Meters option under the Meter Info drop-down menu will also

be disabled.

l The report will display the Transaction Date, Transaction Type, Description and

Amount for each included transaction. The report will also include the Description,

Read Date, Reading, and Consumption values for each meter included in the

report.

l When the Only display meter usage history toggle is checked, the report

will only display the Description, Read Date, Reading, and Consumption val-

ues for each meter included in the report.
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3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Maintenance> Account Template

Account Template Maintenance

Summary

Account templates are used in the New Account Wizard to quickly add a group of services,

service rates, fee codes and service request codes to a new customer account. This

reduces data entry when creating customer accounts because all of the information on the

account template will populate in the New Account Wizard. Many Springbrook users create

an account template for each standard grouping of services/service rates (residential, com-

mercial, industrial or housing developments) they generally add to new customer accounts.

Step by Step

1     Open the Account Template Selection window (UB> Maintenance> Account Template). 

l The Account Template window will display all of the account templates that have

been created.

l Click the Delete icon to delete a template. There is no validation when deleting

templates.

l Click the Modify icon or press ENTER to modify an existing template.
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l Click the Create icon to create a new Account Template. This will open the

Account Template Maintenance window.

2     Create a new account template. 

l Enter a Group Name. The group name will display in the drop-down menu on the

New Account Wizard when you are attaching account templates to a customer

account. After the account template has been saved you cannot modify the value in

this field.

l The Group Name field can be up to 30 characters in length.

l Enter a Description of the account template. The account template description can

be up to 50 characters in length.

l The Create icon has four functions in the Account Template Maintenance win-

dow: add services, add service rates, add service requests and add fee codes. Click

the Create icon drop-down menu to select what you would like to add to the account

template.

l The End Date field in the Service section is used to enter the end date of a pro-

motion and will only be enabled if you add a service or service rate to the account

template.

3     Attach a service rate to the account template. 
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l When attaching a service rate to the template, the service attached to the service

rate will also be attached to the customer account. You do not have to attach the ser-

vice to the template separately.

l Click the Create icon drop-down menu and select service rate from the menu.

This will open the Service Rates Selection window.

l The Service Rates Selection window will display all of the service rates and rate

revisions that have been created.

l Service rates and rate revisions are created on the Service Rates Main-

tenance window (UB> Maintenance> Service Rates).

l Click the Expand button next to a service to view all of the service rates attached to

a service.

l Click on the Expand button to view the revisions attached to a service rate.

l Highlight a service rate and press ENTER to add the service rate and attached ser-

vice to the account template.

l The Services section will populate with the service rate selected in the Service

Rates window.

l The End Date field in the Services section is used to enter a promotion end date on

the service rate and should be used in conjunction with the Amount field.

l The Amount and End Date fields in the Services section are used to create a

promotion.

l The value in the Amount field will replace the flat or minimum amount asso-

ciated with the service rate when a billing is generated. The consumption on a

device attached to the service rate will not be affected by the promotion

amount.
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l If the Multiply Flat by Special Multiplier toggle (UB> Utilities> Setup>

Billing tab) is checked, then the promotion amount will be multiplied by

the value in the Special Multiplier field on the service rate.

l The End Date field is used to enter the promotion end date. If the Promotion

End Date occurs between the period begin and period end date of a New

Billing, the promotion amount will be used instead of the minimum/flat amount

on the service rate. The promotion amount will not prorate, even if the min-

imum/flat amount on the service rate is set up to prorate. If the promotion is

active during the billing, the entire promotional amount will be used. If the pro-

motion end date occurs prior to the period begin date of a New Billing batch,

the promotional amount will not be used and the billing will be calculated as

usual.

l The Amount and End Date fields will populate in the Promotion Amount

and Promotion End Date fields on the Service Rates tab of the new cus-

tomer account (UB> Maintenance> Account).

l If the service rate on the account template will be used to bill the consumption on a

meter, make sure the bill type on the service rate matches the bill type on the

device. When a billing is generated, the consumption on a meter will be billed using

all of the service rates on the customer account that have the same bill type as the

device.

l You can view the bill type of a device type on the Device Type Maintenance

window (UB> Maintenance> (water, electric, gas) Device Type> General

Tab> Bill Type field).

l You can view the bill type of a service rate on the Service Rate Maintenance

window (UB> Maintenance> Service Rate> General tab> Bill Type field).
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4     Attach a service request to the account template. 

l Select Special Request Code from the Create icon drop-down menu. This will

open the Service Request Code window.

l Click the right border of the window to view the information attached to a service

request code. This will change the window so that the Maintenance section will dis-

play.

l When the Maintenance section is displayed you will be able to modify the ser-

vice request codes.

l Select a service request code from the window and press ENTER to add the service

request code to the account template.

l If you add a billable service request code to the account template, the service

request can be billed (UB> Adjustments and Fees> Bill Service Requests) after it

has been closed and committed (UB> Service Requests> Commit).

l A service request code is set up as billable if there is a fee code attached to it.

Expand the Service Request Code window so the Maintenance section dis-

plays and look in the Fee Code field to see if the service request code is set

up as billable.

5     Attach a fee code to the account template. 

l Select Fee Code from the Create icon drop-down menu. This will open the Fee

Code Selection window.
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l Just like the Service Request window, click the right border of the window to view

the information attached to a fee code. This will change the window so that the Main-

tenance section will display.

l When the Maintenance section is displayed you will be able to modify the fee

codes.

l Select a fee code from the window and press ENTER to add the fee code to the

account template.

l The service that is charged for the fee code amount will need to be attached

to the account. You can view the service attached to the fee code on the Fee

Code Maintenance window (AP> Maintenance> Fee Code> Service to

Charge field).

6     Attach a service to the account template. 

l When you add a service rate to the template, the services attached to that service

rate will also be added to the account template. This option will add only a service

to a customer account and is generally used when deposits or penalties are applied

to a service that is separate from the standard water, electricity or gas services.

l Select Service from the Create icon drop-down menu to add a service to the

account template. This will open the Service Selection window.

l Click the right border of the Service Selection window to view the information

attached to the services in the window. This will expand the window to include

the Maintenance section.
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l Services are created on the Service Maintenance window (UB> Main-

tenance> Service). The only information contained on a service is the pay-

ment and budget priority settings.

l Highlight a service and press ENTER to select a service. This will close the Service

Selection window and add the service to the account template.

7     Save the account template when complete. 

l Click the Save icon when complete to save the account template.
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UB> Maintenance> Account

Add Bank Account Information to a UB Account

Summary

Add a bank account to a UB customer account to process the account in a Direct Debits

batch (CH> Direct Debits). Billing statements generated on the customer account will dis-

play as paid because payment will be received using a Direct Debits batch.

In order to add bank information to a customer account the bank must be set up in the Bank

Maintenance window (SS> Maintenance> Bank).

Step by Step

1 Open a UB customer account (UB> Maintenance> Account> Open an account).

2 Enter a bank account on the customer account. 
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l Bank information is maintained on the Account tab> ACH sub-tab.

l Enter bank account information on the customer account.

l Enter the bank account number in the Account Number field.

l Only the last four digits of the bank account number will display on the

Account Master Maintenance window after the bank information has

been entered and saved.

l Click the Bank Code field label to select a bank. The routing number will be

pulled from the bank record.

l Banks are created and maintained on the Bank Maintenance window

(SS> Maintenance> Banks).

l Select a type of bank account in the Account Type drop-down menu.

l After the bank account has been processed in a Direct Debits pre-note batch

(CH> Direct Debits> Generate Pre-Note) the Clearing House Pre-Note

toggle will be checked. Customer accounts that have this toggle checked will

not be included in a pre-note batch. You can manually check this toggle if you

do not want to process the bank account information through a pre-note

batch.

l A pre-note batch is used to verify that the bank account information is

correct before transactions are processed on the customer bank

account.

l Click the Save icon to save the changes to the window.
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UB> Maintenance> Account> Open an
Account> Comment Tab

Add a Comment to a UB Customer Account

Summary

Comments are an optional feature that can be used to add comments to UB customer

accounts to track customer communications or customer service issues. For example,

"09/15/10-Customer called regarding their past due balance." Comments can also be used

to add alerts to UB customer accounts that will display when the account is opened in

either the Cash Entry window (CR> Cash Receipts) or the UB module (UB> Maintenance>

Account). The alert will display as an information window and it will display the description

of the comment. For example, "Only accept cash from this customer."

Comments are entered on UB customer accounts using the Comment tab of the Account

Master Maintenance window (UB> Maintenance> Account> Comment tab). When entering

a comment on a UB customer account, you must select a comment status. The comment

status groups and classifies the comments on reports and can be used to add the alert to

the customer account. Comment statuses are created and maintained on the Comment

Status Maintenance window (UB> Maintenance> Comment Status).
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After comments have been attached to customer accounts, you can run the Comments by

Status Report (UB> Reports> Comments by Status) to view a list of comments that have

been added to customer accounts.

Comments can also display on the Aging, Proof List and Shut Off Report generating in the

Past Dues process (UB> Past Dues).

Step by Step

1     Open the Account Master Maintenance window of the customer you would like to add the com-
ment to (UB> Maintenance> Account). 

l Open the Comment tab. The Comments tab is used to add and display the cus-

tomer comments on the UB customer account.

2     Create a comment. 

l Click the Create icon to add a new comment to a UB customer account. This will

create a new line item in the Comments section of the window.

l You can also create a new comment by pressing INSERT.

l Select a Status from the drop-down menu.
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l Only comment statuses that have been created on the Comment Status Main-

tenance window (UB> Maintenance> Comment Status) will display in the

drop-down menu.

l The comment status will determine if the comment status will create an alert

window.

l After a status is selected, the Status Description field will populate with the

value entered in the Description field of the comment (UB> Maintenance>

Comment Status> Description field).

l The Status will default to the comment status with the lowest value sorted

alphabetically. This will be the Active status unless you have created a com-

ment status that precedes it.

l The Creation Date field will populate with the current date and cannot be modified.

l When running the Comments by Status report (UB> Reports> Comments by

Status), the report can be filtered by the Creation Date if you enter a date in

the Entry Date From and/or Entry Date To fields.

l The Close Date is used to enter the date a comment is closed. This date will pop-

ulate with the current date if you select the Closed comment status from the Status

drop-down menu.

l Entering a close date will not change the status of the comment status to

Closed.

l The Creator field will populate with the username of the Springbrook Application

user that is creating the comment.

l Enter the comment in the Comment Body section of the window.
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l You can paste the text from a document into the Comment Body section by

right clicking the mouse inside the section.

l You can also paste text into the section by pressing CTRL+V.

l The right click feature also allows you to cut and copy the text in the Comment

Body section.

l Click the Save icon when complete.

3     Change the status or close a comment. 

l If you change the status of an existing comment, the alerts attached to the status

will no longer apply and the popup windows will not display.

l Select Closed from the drop-down menu to close a comment. This will populate the

Close Date field with the current date. Once a comment has been closed, you can fil-

ter comments by close date in the Comments by Status Report in UB> Reports.

l If you enter a date in the Closed Date field that is in the future but you do not

change the comment status to Closed, the comment will not automatically

close when the close date is reached.

l Click the Save icon when complete to save the changes to the Comment tab.
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UB> Maintenance> Adjustment Type

UB Adjustment Type Maintenance

Summary

Adjustment types are collections of fee codes used to create adjustments on UB customer

accounts. The function of the adjustment type code and the fee codes attached to the

adjustment type code will vary depending on the type of adjustment being created. For

example, the fee codes attached to a Past Due adjustment type are used to assess pen-

alties and will determine which general ledger accounts will be used in the journal entry cre-

ated by the Past Due process. Conversely, the fee codes attached to a Collections

adjustment have no function. A Collections adjustment type is only used to determine

which general ledger accounts attached to service rates and fee codes being written off will

be used in the journal entry generated by the Collections process. For information on how

to set up an adjustment type for a specific process, refer to the documentation on that pro-

cess.

Adjustment codes can also be used to assess charges on customer accounts using the Mis-

cellaneous Charges process (UB> Adjustments and Fees> Miscellaneous Charges). If

there are account or receipt alerts attached to the adjustment type code used to assess the

charge, those alerts will be added to the customer accounts when the batch is committed.
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Adjustment type codes are also used to create credit scores on customer accounts. For

example, customer accounts processed in the Past Dues or Collections process can be

assessed a credit value, and those values can be reviewed to assess the credit risk of a

customer.

Step by Step

1     Open the Adjustment Type Selection window (UB> Maintenance> Adjustment Types). 

l The Adjustment Type Selection window will display all of the adjustment types

that have been created.

l Right click in the left section of the window and select Export grid contents to Excel

if you would like to create an MS Excel spreadsheet of the information that displays

in the window.

l Highlight an adjustment type and click the Delete icon to delete the selected

adjustment type.

l You will not be able to delete an adjustment type that is attached to a UB his-

tory record.

l Click the Create icon to create a new Adjustment Type. This will open the Adjust-

ment Type Maintenance window.

2     Create a new adjustment type. 

UB ADJUSTMENT TYPE MAINTENANCE 329



l Enter an Adjustment Code.

l The adjustment code can be up to eight alphanumeric characters long.

l You cannot modify the adjustment code once an adjustment code has been

created and saved.

l Enter a Description of the adjustment code.

l The description can be up to 20 alphanumeric characters long.

l Select Bill or Cash in the GL Type drop-down menu.

l If this adjustment type is used in the Adjustments and Fees palette, the selec-

tion in this field determines which types of adjustments can be created from

the Adjustments Input Wizard (UB> Adjustments and Fees> Input).

l If Bill is selected, the adjustment type will be available for billing, bill

adjustment, Past Due, Collections and Refund adjustments.

l If Cash is selected, the adjustment type will be available for payment

and cash adjustments.

l Select the process that will use the adjustment type in the Process drop-down

menu. This allows you to categorize your adjustment types so that they are not used

incorrectly.

l Select Adjustments and Fees if you would like to use the adjustment type

code to create adjustments in the Adjustments and Fees palette. This

includes misread, leak, and consumption adjustments on meters, billing and

payment adjustments, and any other type of adjustment created using the

Adjustments Input Wizard. This also includes adjustment type codes used to

create miscellaneous charges (UB> Adjustments and Fees> Miscellaneous

Charges).
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l Select Collections if you would like to use the adjustment type code in the Col-

lections process. The adjustment type code used in the Collections process is

entered in the Setup window (UB> Utilities> Setup> General tab> Collections

Adjustment Type field).

l Select Past Dues if you would like to use this adjustment type code to assess

penalties on UB customer accounts in the Past Dues process. The fee codes

attached to the adjustment type will be used to assess penalties on the UB

customer accounts included in a Past Dues batch.

l Select Refunds to use the type code in the Refunds process. The Refunds

adjustment type is selected in the Setup window (UB> Utilities> Setup> Gen-

eral tab> Check Refund Adjustment Type field) and will be used on all check

refund transactions.

l The Alert Days field is used to set a limit on the number of days an alert generated

on a UB customer account will display. This field is used in conjunction with the

Account Alert and Receipt Alert toggles at the bottom of the window.

l For example, if you are creating a Past Dues adjustment type and have

checked the Account Alert toggle, the alert window will open with the Account

Master Maintenance window as long as the alert days have not expired.

l Enter 999 if you would like the account alert to display on the customer

account for the maximum amount of time.

l The Credit History Days and Credit Value fields are used to create a credit history

on customer accounts.

l The Credit History Days field is used to select the number of days a credit line

item created by this adjustment type code will display on a customer account.
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l For example, enter 120 if you are creating a Past Dues adjustment type

code and the credit line created by the transaction should only display

on the customer account for 120 days.

l The Credit Value field is used to enter the credit value of the credit transaction

line item.

l For example, enter 500 if you are creating a Collections adjustment

type code. The value of the credit value field is user defined and relative

based on the credit values you assign to other adjustment type codes.

For example, a Collections adjustment type code would probably have

a higher value than a Past Dues adjustment type code.

l The Trigger Code field is used to specify an adjustment type with a fee code

attached to be charged automatically when the adjustment type is utilized. This

must be a Bill adjustment type.

l For example, an adjustment type used to reverse payments may have a

trigger code of an adjustment type that has your organization’s Non-Suf-

ficient Funds fee code attached to it. When using the adjustment type to

reverse a payment a billing of the NSF fee code attached to the trigger

code adjustment type will also be charged.

l The Service Request Code field is used to specify a UB reconnect service request

that can be automatically launched when the adjustment type is used in the Past

Dues process.

l This feature is meant to automate part of the reconnection process. When a

customer makes a counter payment in order to get their disconnected service

reconnected, this Past Dues adjustment type will generate a message for the

cashier asking if the service should be reconnected. If the cashier selects

"Yes", the service request code specified here will be automatically triggered.
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If the cashier selects "No", the process continues as usual.

l This field is only enabled if the Prompt for service requests toggle is

checked below.

l Check the Account Alert or Receipt Alert toggle to create an alert on all customer

accounts charged this adjustment type. For example, check the Account Alert

toggle if you are creating a Past Dues adjustment type and would like an alert win-

dow to display on the Account Master Maintenance window of each customer

account that has been charged this adjustment type.

l Check the Account Alert if you would like an alert window to open when the

Account Master Maintenance window is opened (UB> Maintenance>

Account).

l Check the Receipt Alert toggle if you would like an alert window to open when

the receipt is being entered on the UB customer account.

3     Add fee codes to the adjustment type code.

l If you are creating a Collections type code, there is no reason to attach a fee code to

the adjustment type code.

l If you are creating a Past Dues adjustment type code, the fee codes attached to the

adjustment type will be used to assess the penalties on the customer accounts.

l Click the Create icon to add a fee code to the adjustment type. This will open a

list of fee codes.
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l Fee codes are created and maintained in Fee Code Maintenance window

(UB> Maintenance> Fee Code), but can also be created from the Fee Code

Selection window.

l If you would like to view the information attached to the fee codes and the

Maintenance section does not display in the Fee Code Selection window,

move the mouse to the right border of the window. When the border changes

color (generally from blue to orange), right click the mouse. This will expand

the Maintenance section and display it in the window.

l Highlight a fee code in the window and click the Confirm icon to select a

fee code.

l Click the Save icon when complete to save the adjustment type code.
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UB> Maintenance> Bill Type

Bill Type Maintenance

Summary

Bill types determine what service and service rate will be used to bill the consumption on a

meter. When a bill is generated on a customer account, the consumption on a meter will be

billed using the service rate with the same bill type as the meter. For detailed information

on how bill types are used see the Bill Type Overview help document.

Step by Step

1     View the bill types that have been created. 

l Open the Bill Type Maintenance window (UB> Maintenance> Bill Type).

l Select a bill type in the left section of the window and the fields in the Maintenance

section will populate with the information of the selected record.

l Highlight a bill type and click the Delete icon to delete a bill type. You will not be

able to delete a bill type that is attached to a device type.
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l Click the Create icon to create a new bill type. This will add a new line item to

the left section of the window and the fields in the Maintenance section will be active

in order to enter the new bill type information.

2     Create a new bill type. 

l Enter a Bill Type.

l The bill type can be up to 16 alphanumeric characters long.

l Once a bill type code has been saved, it cannot be modified.

l Enter a bill type Description.

l The Description field can be up to 50 alphanumeric characters long.

l Select a Device Type from the drop-down menu.

l The Device Type drop-down menu refers to the kind of devices that can be

created in the Utility Billing module (water, gas, electric, etc.). These are not

the same device types created on the Device Type Maintenance window

(UB> Maintenance> Device Type (water, gas, electric, etc.)).

l You will only be able to add the bill type to the devices of the device type selec-

ted in the drop-down menu. For example, if you would like to add the bill type

to water meters, select Water Meter. All device types created through UB>

Maintenance> Water Device Type can be attached to the bill type.

l Check the Default for Device Type toggle if the bill type is the default bill type for

the selected device type.
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l If the toggle is checked, by default all device types created of that type will be

assigned the bill type. This will populate the Bill Type field on the General tab

of the Device Type Maintenance window when the device type is created.

3     Click the Save icon to save the bill type.
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UB> Maintenance> Category

Category Code Maintenance

Summary

Category codes are user-defined groupings that can be used to group and filter the inform-

ation on reports. Category codes are attached to UB customer accounts using the Account

Master Maintenance window (UB> Maintenance> Account> Account tab> Account sub-

tab> Categories section).

Step by Step

1     View the categories. 

l Open the Category Maintenance window (UB> Maintenance> Category). The Cat-

egory Maintenance window will display all of the categories that have been created

in the application.

l Highlight a category in the left section of the window and the information attached to

the selected category will populate in the Maintenance section.

l Highlight a category and click the Delete icon to delete the selected category.

l You cannot delete categories that are attached to customer accounts.
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2     Create a new category. 

l Click the Create icon to create a new category. This will add a new line item to

the left section of the window and the fields in the Maintenance section will be blank

to enter the information associated with the category.

l The Code field is used to identify each category. The value in this field must be

unique and can be up to 20 characters long.

l The Description field is used to enter a description of the category. The value in

this field can be up to 50 characters long.

l Press ENTER or click the Save icon when complete to save the category.
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UB> Maintenance> Class

Class Maintenance

Summary

Classes are user-defined groupings that are attached to lots and used to filter and group

the accounts that display on some reports (there are links to the reports that filter by

account class below). Classes are attached to lots using the Lot Maintenance window (Lot

icon > Lot tab> Class field). Classes are very similar to zones.

Classes can also be used when creating Query by Example reports. (The class field is loc-

ated in the Lot master table.)

Step by Step

1     View the classes. 

l Open the Class Maintenance window (UB> Maintenance> Class).

l Select a record in the left section of the window and the Maintenance section will

populate with the information of the selected record.
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l To modify an account class, change the Description field and click the Save

icon . You cannot modify the Class Code once an account class has been

created.

l Highlight a class and click the Delete icon to delete the class.

l You cannot delete classes that are attached to lots.

l Click the Create icon to create an account class. This will create a new line item

in the left section of the window and activate the fields in the Maintenance section to

enter the account class information.

2     Create a new class. 

l Enter a Class Code. The value in the Class Code field can be up to 20 alpha-

numeric characters long.

l Once a class has been saved, you cannot modify the value in the class code

field

l Enter the Description of the Account Class. The Description field can be up to 48

alphanumeric characters long.

l Click the Save icon when complete.

CLASS MAINTENANCE 341



UB> Maintenance> Comment Status

Comment Status Maintenance

Summary

Comments are attached to Utility Billing module customer accounts to track customer com-

munications or customer service issues. Comments can also be used to create alert win-

dows when the UB customer account is opened or a receipt is created in the Cash Receipts

module. For example, you can create a delinquent comment code that creates an inform-

ation window warning users that open the account or receive payments that the account is

delinquent.

When attaching a comment to a customer account, you must select a comment status. The

comment status is used to group and classify comments on reports and add the alert to the

UB account. The comment is attached to the UB customer account, not the customer

record, so the alert window will only open when the UB customer account is opened or a

receipt is generated. The alert windows will not open when the customer record (Customer

Master Search> Open a customer rather than a customer account) is opened or customer

accounts created in other modules are opened.

There are two kinds of alerts that can be created by a comment status: account and

receipt. An account alert will open when the Account Master Maintenance window (UB>
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Maintenance> Account) is opened and will display the information attached to the com-

ment. A receipt alert will open when a receipt is entered on the customer account in either

CR> Cash Receipts or in UB> Cash Receipts.

Comment codes can also be used in conjunction with service requests. The Service

Request Input window (UB> Service Requests> Input) allows you to highlight the service

requests that are attached to UB customer accounts with a specific comment code on their

account. The service request will only be highlighted if a close date has not been added to

the comment.

After comments have been attached to customer accounts, you can run the Comments by

Status Report (UB> Reports> Comments by Status) to view a list of comments on customer

accounts.

You can print a list of comments attached to UB customer accounts in UB> Reports> Com-

ment by Status.

Step by Step

1     Open the Comment Status Maintenance window (UB> Maintenance> Comment Status). 

l The Comment Status Maintenance window will display comment statuses created

by users and preprogrammed into the software. Only comment statuses that have
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been created by Springbrook users can be edited in the Comment Status Main-

tenance window. Comment statuses that have been preprogrammed into the soft-

ware (Active, Attention, Promise, Closed and Alert) will display in the window but

the fields cannot be modified.

l Select a comment status in the left section of the window and the fields in the Main-

tenance section of the window will populate with the information of the highlighted

comment status.

l Click the Delete icon to delete a comment status.

l You cannot delete a comment status that is attached to a comment on a UB

customer account. If the comment status should be deleted, run the Com-

ments by Status Report (UB> Reports> Comment by Status) to create a list of

the comments that are attached to the comment status. Change the comment

status of the comments on the Comments by Status report and then delete

the comment status in the Comment Status Maintenance window.

l The Delete icon will not be enabled if the selected comment status has

been preprogrammed into the software. Preprogrammed comment statuses

cannot be deleted.

2     Create a new comment status. 

l Click the Create icon to create a new comment status. This will open a new line

in the Comment Status Maintenance window.

l Enter a Comment Status.
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l This field can be up to nine alphanumeric characters long and is used to

identify a comment status from a drop-down menu when attaching it to a cus-

tomer account.

l Enter a comment status Description.

l If you are creating a comment status that will create a popup window, the

status Description field will display in the popup window.

l The remaining fields in the window are used if you want a popup window to open

when the comment status is attached to a customer account.

l The Alert Days field is the number of days you want an alert window to open

if this comment is attached to a customer account. The largest number you

can enter in this field is “999”. You can also enter “000” if you want the alert to

display on the account for an infinite amount of time.

l If a comment attached to a customer account is changed to a Closed

status (UB> Maintenance> Account> Comment/Bill tab), the alert win-

dow will no longer display on the customer account.

l Check the Account Alert toggle if you want the alert window to open when

the UB customer account is opened.

l Check the Receipt Alert toggle if you want the alert window to open when the

customer account is selected (UB> Cash Receipts>Input) and (CR> Cash

Receipts> Enter Receipts).

l The alert window will only display on a customer account on the Enter

Receipts step (CR> Cash Receipts> Enter Receipts) when the Utility

Billing account is selected.

l Click the Save icon when complete to save the comment status.
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UB> Maintenance> Consumption
Conversion

Consumption Conversion Maintenance

Summary

The Consumption Conversion Maintenance window is used to create a user defined con-

sumption conversion table. The conversion formulas defined in the conversion table can be

used to convert the units attached to devices to another unit type when bills are generated.

When billing the consumption on a meter, there are no units of measure (gallons, cubic

feet, etc.) attached to the service rate on the account. The service rate will be applied to the

consumption as it was read on the meter. For example, if there were 100 units of con-

sumption read on the meter during the billing period, then the service rate will be applied to

the 100 units regardless of the type of unit the meter was reading (gallon, cubic feet, etc.).

If there are meters of multiple unit types in the same billing batch, or the consumption

should be converted to another unit type as the billing is being calculated, you can convert

the consumption read on the devices to another unit type using the consumption con-

version table (UB> Maintenance> Consumption Conversion).

When new bills are generated (UB> New Billing> Generate), there is a Convert Con-
sumption To drop-down menu that allows you to convert the consumption read on the
meters to a different unit type. The consumption will be converted to the unit type using the
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conversion formula set up in the conversion table (UB> Maintenance> Consumption Con-

version), and the service rate will be applied to the modified consumption on the meter. For

example, if the consumption was read in cubic feet and is changed to gallons, the con-

sumption read on the meter (100) will be multiplied by the conversion amount (7.48000)

and then the service rate will be applied to the modified consumption amount (748).

The consumption read on a meter will be in the unit type attached to the device type it is

associated with. When a device type is created, a unit of measure is specified on the

device type (UB> Maintenance> Water, Gas, Electric Device Type> Meter tab> Unit Type
drop-down menu). All devices attached to that device type will inherit that unit type.

Step by Step

1     View the consumption conversions already created. 

l Open the Consumption Conversion Maintenance window (UB> Maintenance>

Consumption Conversion).

l The Consumption Conversion Maintenance window will display all conversions that

have been set up in the database. Highlight a conversion in the left section of the

window and the conversion information will display in the Maintenance section.

l Right click on the data in the window and select Export grid contents to Excel to cre-

ate an MS Excel spreadsheet of the information that displays in the window. This

allows you to create a report of the consumption conversion table that displays the

unit type and conversion multipliers.
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l Highlight a conversion and click the Delete icon to delete a conversion. There is

not validation on consumption conversion records, so you will be able to delete con-

sumption conversions that you regularly use when generating New Billings.

l Click the Create icon to create a new consumption conversion. This will create a

new consumption conversion line item and activate the fields in the Maintenance

section.

2     Create a consumption conversion. 

l Enter a conversion code in the Code field.

l The consumption conversion code can be up to eight alphanumeric char-

acters and is used to identify a unique consumption conversion.

l Enter a description of the consumption conversion in the Description field.

l The description field will generally contain the convert to and convert from

units. For example, if the conversion converts gallons to cubic feet, the

description might be Gallons to Feet.

l The Description field can be up to 50 characters long.

l Select a device type from the Device Type drop-down menu.

l The types of devices that can be created in the UB module will display in the

drop-down menu.

l If a unit type (feet, gallons, etc.) is attached to a device type (water, gas, elec-

tric), but the unit type is not set up on the conversion table for that device type,

you will receive an error message when you try to convert the consumption on
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the meter. The device type selected in this drop-down menu must match the

type of device where the unit type will be used. If the unit type will be used on

multiple types of devices (water and gas) then the unit type must be set up for

each device type.

3     Set up the conversion formula. 

l When the New Billing is generated, a convert to unit is selected (UB> New Billing>

Generate> Convert Consumption To field). The billing engine will convert the con-

sumption on the devices included in the billing to the unit selected in the Convert

Consumption To field using the consumption conversions in this table.

l You must set up a conversion for each unit type you would like to convert. If

there is a unit type attached to a meter in a billing cycle that is not set up on

the conversion table, you will receive an error message during the Generate

step (UB> New Billing> Generate). Each unit type attached to a device type

should be included in a Convert From field.

l Enter the unit to convert from in the Convert From field. The convert from unit is the

unit that is on the device that will be converted. The spelling of the convert from

should match the spelling of the unit on the device type or the unit will not convert

correctly.

l A unit type is attached to a device type on the Device Type Maintenance win-

dow (UB> Maintenance> (water, gas, electric) Device Type> Meter tab> Unit

field).

l Enter the unit to convert the units on a meter to in the Convert To field.
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l The Conversion Value field is used to enter the value that will be applied to the

amount on the convert from meter read units to the new convert to units.

l Click the Save icon when complete.
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UB> Maintenance> Cycle Code

UB Cycle Code Maintenance

Summary

The Billing Cycle Maintenance window is used to create and maintain billing cycles. A

billing cycle is a group of UB customer accounts that should be billed in the same billing

batch. When billings are generated (UB> New Billings), the new billing is generated by

billing cycle. Billing cycles are also used in Past Dues, Winter Averaging and the Budget

Billing process.

Billing cycles are attached UB customer accounts when they are created using the New

Account Wizard and you can view or modify the billing cycle attached to a UB customer

account in the Account Master Maintenance window (UB> Maintenance> Account>

Account tab> Account sub-tab> Billing Cycle field).

Many of the UB module reports can be filtered by billing batch. The AR Totals by Cycle

Report (UB> Reports> AR Totals By Cycle) and Aging Reports (UB> Reports> Aging) will

display the outstanding balances on customers by billing cycle. The Account Master Report

(UB> Reports> Account Master) and Accounts By Service Report (UB> Reports> Accounts

by Service) will display UB customer information filtered by billing cycle. The Transactions

by Date and Trial Balance by Date reports will display transaction information filtered by

billing cycle.
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Step by Step

1     Open the Billing Cycle Maintenance window (UB> Maintenance> Cycle Code). 

l The Billing Cycle Maintenance window lists all of the billing cycles created in the

application.

l Click the Delete icon to delete a billing cycle. If there are customer accounts

attached to the billing cycle you will not be able to delete it.

l Click the Modify icon to open an existing billing cycle.

l Click the Create icon to create a new billing cycle. This will open the Update

Cycle Code window.

2     Create a new cycle code. 

l Enter a Billing Cycle Code. The billing cycle code can be up to three numeric digits

long. You cannot enter letters into this field.

l Enter a Description that pertains to the billing cycle. The Description can be up to

40 alphanumeric characters long.

l Some customers enter the meter route numbers or section of the town the

billing cycle pertains to in the Description field.

l Enter a Period End Date.
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l The Period End Date will default to the current date when creating a new

cycle code, but it should be the day prior to the start date for the next billing

period.

l For example, if the new cycle is going to start billing on 6/1/2019, the

period end date should be 5/31/2019.

l Once a cycle is billed and committed in the New Billing Process (UB> New

Billing), the Period End Date field will automatically update based on the

Period End Date that was input during the generate step of the New Billing

process.

l Enter the Days in Period.

l The Days in Period field defines the number of days in the billing cycle.

l Click the Save icon to update changes.

3     Add UB customer accounts to the billing cycle. 

l After a cycle code has been created you can add a UB customer to the billing cycle

(UB> Maintenance> Account> Account tab> Account sub-tab> General section>

Billing Cycle field).
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UB> Maintenance> Device

Device Maintenance

Summary

The Device Maintenance window is used to create and maintain devices and add or modify

the meter readings on a device. The Device Maintenance window can be opened from the

Devices tab of the Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Open icon) or from the Maintenance palette (UB> Maintenance> Device Main-

tenance).

Devices are also created using the Add Device service request. Devices created using a

service request will be in pending status until the service request has been closed (UB>

Service Requests> Input> Close icon) and committed (UB> Service Requests> Commit).

You will not be able to modify the information of a device in pending status. If the service

request that is creating a new device is deleted, the device record will also be deleted.

The manufacturer, model number, size, number of digits on the meter, number of usage

periods (used for grouping peak and non-peak usage) and unit type of a specific kind of

device is set up on the device type. In order to create a device you must first create the

device type of the device (UB> Maintenance> Device Types). There is a separate device

type palette option for each device type that can be created.
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Step by Step

1     View all devices in the Utility Billing module. 

l Open the Device Selection window (UB> Maintenance> Device).

l The Device Selection window will display all meters that have been created in the

Utility Billing module. Other devices, such as backflow devices, will not display.

l The Device Selection window will display devices created using the Service

Request Input Wizard and devices created using Device Maintenance.

l The Device Selection window will also display devices that are not installed

on customer accounts.

l Enter information into the Search Criteria section and click the Refresh icon to

update the devices that display in the window.

l If the orange Incomplete icon displays in the bottom right corner of the

search window, all devices in the search have not been included in the win-

dow.

l If the search contains many devices, the window may only display some

of the devices in order to load the window faster.

l Click on the orange Incomplete icon if you would like to load all of

the devices in the window.

l NOTE - Springbrook Cloud users will not be able to use the Incom-

plete icon to display all of the available records. Data grid fil-

ters will need to be refined in order to display all records that meet

DEVICE MAINTENANCE 355



the filter criteria. However, Springbrook Cloud users can generate

a .csv file that includes all the records in the database that meet

the specified filter criteria via a data grid export.

l Right click on the data in the window and select Export grid contents to Excel to cre-

ate an MS Excel spreadsheet of the information that displays in the window. This

allows you to create a report of the filtered devices in the window that includes most

of the important information attached to the device.

l Highlight a device and click the Modify icon to open the selected device.

l Highlight a device and click the Delete icon to delete a device.

l If the device is attached to history records, such as meter readings, you will

not be able to delete the device.

l Use the Create icon drop-down menu to select the type of device you would like

to create. This will open the Device Maintenance window.

l Before creating a new device, make sure that the device type of the device

has been created (UB> Maintenance> Water, Gas or Electric Device Type).

l The device type will determine the manufacturer, model number, size,

number of digits on the meter, number of usage periods (used for group-

ing peak and non-peak usage) and unit type of the device.

2     View the general information on the device. 
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l The Device Maintenance window will vary depending on the type of device being

created (gas, water, electric), and whether the device is installed on a UB customer

account.

l The titles of the tabs and the fields that display in those tabs will vary based

on the type of device being created.

l Additional tabs such as the Connections, Consumption and Attached Devices

tabs will display on the window if the device is installed on a UB customer

account.

l The first tab of the Device Maintenance window is where the device type and device

information is entered and the title of the tab will vary.

l The fields in the Device Type section will not be enabled, but they will populate with

information after the device type has been selected.

l Click the Manufacturer field label to attach a device type to the device.

l Device types are created on the Device Type Maintenance window (UB>

Maintenance> Backflow, Electric, Gas, or Water Device Type).

l After a device type has been selected the fields in the Device Type section will

populate with the information attached to the device type.

l The Device section will display fields that are specific to the device and will vary

based on what kind of device (gas, water, electric, etc.) is displayed in the Device

Maintenance window.

l The Status drop-down menu is the status of the meter and will default to act-

ive when a new device is created using an add device service request. If the

device is created using the Device Maintenance window, the Status field will

default to Inactive.
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l The Status drop-down menu does not directly relate to the connection

status of the device. The connection status is set up on the Connections

tab of the Device Maintenance window.

l The Last Reading field will display the last reading on the device if it has

been removed from a UB customer account.

l The Installed Account and Installed Address fields will display information

if the device is attached to a UB account.

l The Installed Account field will display the active UB customer account

number attached to the lot the device is installed on.

l The Installed Address field will display the address of the lot that the

device is installed on.

l Enter a Serial Number. This is a required field because it identifies unique devices

of the same model and manufacturer.

l The Serial Number can be up to 16 alphanumeric characters long.

l The Register ID field displays on all meter devices and is used to record the

register identification numbers of touch read meters.

l The Register ID field can be up to 16 alphanumeric characters long.

l If the device is a radio read meter, enter an MXU identification number in the

MXU ID field.

l The Purchase Date is used to record the purchase date of the device.

l The MXU ID field displays on all meter devices and is used to report the MXU iden-

tification number of a radio read meter.
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l The MXU ID field can be up to 16 alphanumeric characters long.

l If the meter is a touch read meter, enter a register ID number in the Register

ID field.

l The Inventory Status drop-down menu updates as service requests are processed

on the device.

l The Installed status is for devices that are installed on a UB customer

account. The address of the lot the device is installed on displays in the

Installed Address field and the UB customer account number displays in the

Installed Account field.

l When a remove device service request is processed on the device the Invent-

ory Status will change to Testing.

l The device will have an Inventory Status of Pending if an Add Device service

request has been performed on a customer account but has not been com-

mitted.

l While the device has an inventory status of Pending all of the fields on the Device

Maintenance window will be disabled.

l The Inventory Location field is used to enter the location of the device if it is not

installed on a UB customer account. For example, if the device is located in a ware-

house, you could enter the shelf and row of where the device is located in the ware-

house.

l The Inventory Location field is not the same as the location where the device

was installed on a lot. That information is stored with the connection inform-

ation on the Connections tab in the Location field.

3     The Connections tab displays the UB accounts that a device has been attached to. 
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l This tab will display if the device is currently installed or has ever been installed on a

UB account.

l The Route and Sequence fields display the route and sequence number of the

device.

l The Service Address field displays the address of the lot the device is installed at.

l The Lot Number of the lot where the device is installed is an optional column

in the window.

l The Install Date is the service date entered on the add device service request that

installed the device on the UB customer account.

l The service date is entered in the Service Date field on the first step of the

Service Request Input Wizard.

l The Remove Date column is the date the device was removed from the customer

account using a Remove Device service request.

l The Status drop-down menu displays the Connection Status of the device on the

account.

l The Status column will display Removed if a Remove Device Service Request

has been performed on the customer account attached to the device.

l The Status column will display Active if the device is installed on a customer

account.

l The EDU field displays the EDU units attached to the device. Depending on how the

service rates are set up, the EDU value may affect the calculated billing on a UB cus-

tomer account.
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l To see if the EDU value will be used when calculating a billing, open the Ser-

vice Rate Maintenance window (UB> Maintenance> Service Rates).

l If the Use Lot Units toggle is not checked, and the Multiply minimum,

Multiply consumption or Multiply consumption level toggles are

checked on the Service Rate Maintenance window, the EDU value on

the device will be used when calculating a billing.

l The Lot Number displays the lot number where the device is installed.

l By default this column will not display in the window. You can add the Lot

Number column to the window by right-clicking the mouse on the column

headings.

4     The Consumption tab displays the meter readings on the device. 

l If the device has been attached to multiple accounts, the meter readings of each

account will display in the window. If a meter reading is attached to a service

request, the meter reading will not display on the Consumption tab until the service

request is committed (UB> Service Request> Commit). Meter readings on uncom-

mitted service requests will not display on this tab.

l Highlight a device reading and the fields in the Consumption and Time of Use Peri-

ods sections will display the information attached to the highlighted meter reading.

l You will not be able to modify billed meter readings. If you need to modify a

billed reading, delete the reading and create a new reading.
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l If the Billed, New Read and Estimated toggles display in the window, you will not

be able to change the selection of those toggles from the data display section of the

window. If you would like the change the Billed or Estimated toggle, highlight the

meter reading and change the value in the Consumption section.

l The New Read toggle cannot be changed from the Consumption tab. The

New Read toggle will be checked if the reading was created in UB> Meter

Management> Input New. If the reading was entered on a service request or

from the Device Maintenance window the New toggle will not be checked.

l Highlight a device reading and click the Delete icon to delete the highlighted

meter reading.

l You will be able to delete a billed meter reading. This allows you to modify

billed meter readings.

l Click the Create icon to add a new reading to the device. This will add a new

device line item in the window. You can also enter a meter reading in UB> Meter

Management> Input New.

l The Customer Number field will populate with the customer number that is

active on the lot the device is attached to.

l The Customer Sequence field is the sequence number of the active UB cus-

tomer account attached to the lot where the device is installed.

l The Read Date field will populate with the current date.

l The Reading Year and Reading Period will populate with the current cal-

endar year and month.

l The Reading Period and Reading Year fields are important if you gen-

erate bills based on meter readings of a certain period. The reading
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period and year are selected during the Generate step of the New

Billing process (UB> New Billing> Generate).

l The New Billing process will only generate bills on meter readings

of a certain period if Period is selected in the Meter Reads to Bill

drop-down menu (UB> Utilities> Setup> Billing tab).

l Enter a Description of the meter reading if desired.

l The Description field can be up to 32 alphanumeric characters long.

l Enter the meter reading in the Reading field.

l The consumption on the reading will not automatically calculate based

in the entered meter reading. Do not forget to enter a consumption

amount in the Time Of Use Periods section after entering a meter read-

ing.

l The Power Factor Cons and PF Percent fields are used for power factor cal-

culations.

l The Power Factor Cons field is used to set the consumption level that

will be used if the reading falls below the Power Factor Threshold spe-

cified on the Device Type Maintenance window.

l The PF Percent field will populate with the power factor percent cal-

culated when the reading is imported. This percent is calculated using

the following equation:

l Calculated PFP = COS ( ATAN ( KVAR Cons / KWH Cons ))

l COS=cosine, ATAN=arctangent

l If the PF Percent is greater than the Power Factor Threshold spe-

cified on the Electric Device Type Maintenance window, the stand-

ard demand consumption will be used when the reading is billed.
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l If the PF Percent is less than the Power Factor Threshold spe-

cified on the Electric Device Type Maintenance window, the read-

ing will be billed based on the value in the Power Factor Con field.

l The Banked Cons field displays the total amount of banked consumption for

the reading.

l Banked consumption is a result of a solar meter generating more KWH

than the electric meter billed for a read period. This banked con-

sumption can then be credited towards a subsequent billing.

l Check the Estimated toggle if the meter reading is an estimated reading.

l Check the Billed toggle if the meter reading has already been billed or if you

do not want the reading to generate a billing.

l The consumption on a billed meter reading will not be billed when a

New Billing batch is generated.

l Enter the consumption amount of the meter reading in the Time of Use Peri-

ods section.

l Time of Use Periods is an optional feature used to separate con-

sumption into multiple usage periods and allows you to bill consumption

at different rates. Time of Use Periods are generally used to bill peak

and non-peak rates.

l If you are not using Time of Use Periods, enter the consumption into the

field labeled Consumption Period 1. This will be the only field enabled

if you are not using time of use periods.

l If you are using Time of Use Periods, enter a portion of the consumption

in each usage period that applies.
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l You can view how a service rate will be applied to each usage

period on the Consumption Levels tab of the Service Rate Main-

tenance window (UB> Maintenance> Service Rate).

l Click the Save icon to save the meter reading.

5     The Attached Devices tab displays the devices that are attached to the selected device. 

l The Attached Devices tab will only display if a device is installed on a customer

account.

l Meters are attached to a meter to either subtract or add to the billable consumption

on that meter. The Exempt Meters drop-down menu on the UB module Setup win-

dow (UB> Utilities> Setup> Billing tab) will determine how the consumption on all

attached meters will be billed.

l If Add is selected, the consumption on attached meters will be added to the

consumption on the meter.

l If Subtract is selected, the consumption on the attached meters will be sub-

tracted from the consumption on the meter.

l If the meter opened in the Device Maintenance window is an exempt meter, the

Attached Devices tab will not display the device the exempt meter is attached to.

The Attached Devices tab will only display exempt meters that are attached to the

meter opened in the Device Maintenance window.

l Click the Create icon to add a meter to the device. This will open the Device

Selection window.
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l Highlight a device in the window and click the Delete icon to remove the attached

device from the meter.

l The Service Point column will display the service address of the attached device.

6     The Miscellaneous tab displays the miscellaneous information attached to the device and includes
a Notes field. 

l The fields are used to enter information on the device that is outside the current

scope of the Springbrook version. The information entered into these fields can be

used in reporting by including these fields on a QBE report (UB> Maintenance>

Query by Example).

l These fields will display on the Meter table of the QBE report.

l The labels of the miscellaneous fields can be set up in Miscellaneous Field Labels

Window (SS> Utilities> Miscellaneous Field Labels).

7     Track any changes made to the device. 

l Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit trail.

l The Audit Trail History section will provide details about any changes made to the

device including the date of the change, type of change made, user that made the

change, and data table that was edited.
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UB> Maintenance> Device

Exempt Meters Overview

Summary

An exempt meter is a meter attached to an existing device meter to either subtract or add to

the billable consumption on that meter. You can add a meter to another meter using the

Attached Device tab of the Device Maintenance window (UB> Maintenance> Device).

The exempt meter can be added to the same account as the original device or attached to

a different account. If both meters are attached to the same account, both meter readings

will change to Billed when a New Billing batch is committed. If the meters are attached to

different accounts, only the meter on the customer account included in the New Billing

batch will be changed to Billed. This allows you to subtract the consumption of a subtract-

type exempt meter from a billing so it can be billed separately. If both accounts are in the

same billing cycle, the meter reading on the exempt meter will change to Billed because it

was included in the New Billing batch.

Step by Step

1    Configure the exempt meter consumption option. 
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l Open the UB Setup window (UB> Utilities> Setup> Billing tab) to set up the exempt

meters.

l The Exempt Meters Default drop-down menu is used to set up how you would like

devices attached to a meter to affect a billing.

l Select whether you want to Subtract or Add exempt meter consumption to bil-

lable consumption when a billing is calculated. This is only a default setting

and can be overridden at the device level.

l Click the Save icon when complete to save the exempt meters settings.

2     Select the device attached to the desired UB account. 

l Open the Device Selection window (UB> Maintenance> Device).

l The Device Selection window will display all meters that have been created in the

Utility Billing module.

l The Device Selection window will display devices created using the Service

Request Input Wizard and devices created using Device Maintenance win-

dow.

l The Device Selection window will also display devices that are not installed

on customer accounts.

l Enter information into the Search Criteria section and click the Refresh icon to

update the devices that display in the window.
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l If the orange Incomplete icon displays in the bottom right corner of the

search window, all devices in the search have not been included in the win-

dow.

l If the search contains many devices, the window may only display some

of the devices in order to load the window faster.

l Click on the orange Incomplete icon if you would like to load all of

the devices in the window.

l NOTE - Springbrook Cloud users will not be able to use the Incom-

plete icon to display all of the available records. Data grid fil-

ters will need to be refined in order to display all records that meet

the filter criteria. However, Springbrook Cloud users can generate

a .csv file that includes all the records in the database that meet

the specified filter criteria via a data grid export.

l Highlight a device and click the Modify icon to open the selected device. This

will open the Device Maintenance window.

3     Add an exempt meter to the device. 

l The Device Maintenance window will vary depending on the type of device being

created and whether the device is installed on a UB customer account.

l The Attached Devices tab displays the devices that are attached to the selected

device. The Attached Devices tab will only display if a device is installed on a cus-

tomer account.
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l If the meter opened in the Device Maintenance window is an exempt meter,

the Attached Devices tab will not display the device the exempt meter is

attached to. The Attached Devices tab will only display exempt meters that

are attached to the meter opened in the Device Maintenance window.

l Click the Create icon to add a meter to the device. This will open another

instance of the Device Selection window.

l Use the Search Criteria section to filter the displayed devices.

l Highlight the device that you would like to attach to the account as an exempt

meter. Click the Confirm icon to return the selected device to the Attached

Devices tab.

l Once the exempt meter has been added to the account, you can select either

Add or Subtract in the Add/Subtract column in order to specify how the

exempt meter will affect billing. This field will default to the Exempt Meters

Default specified on UB Setup.

l Click the Delete icon to remove an exempt meter from the open device. This will

only remove the attached meter from the device, not delete the meter from the

application.

l Click the Save icon to save the exempt meter to the UB account.

4     View the exempt meter on the UB customer account. 
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l Open the UB Account Maintenance window (UB> Maintenance> Account) to dis-

play the exempt meter that you attached to a device.

l The Devices tab displays the devices attached to the lot on the UB customer

account, the meters that are attached to devices (such as a subtraction meter), and

the meter readings on those meters.

l The Devices section will display the devices attached to the customer account.

l An Expand button will display next to a device if there is an exempt meter (a

meter that either adds to or subtracts from the consumption on the meter)

attached to the device. Click the Expand button to view the attached meter

information. Highlight the attached meter and the Meter History and Meter

Detail sub-tabs will populate with the information attached to the meter.

l If you would like to manually modify the meter reading on an account, open

the Device Maintenance window by highlighting a device and clicking the

Modify icon .

l The Devices tab can also be used to create service requests that add, remove or

change-out the devices on the lot. If you would like to modify the meter readings on

a device or attach another meter to a device, you can open the Device Maintenance

window of a meter from this tab to perform those tasks.
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UB> Maintenance> Backflow Device
Type

Backflow Device Type Maintenance

Summary

The Backflow Device Maintenance window is used to create and maintain backflow device

types. Device types define the bill type, manufacturer, model number, size and unit type of

a specific kind of device. When a device is created (UB> Maintenance> Device> Create),

the device will populate with the information from the selected device type. Device types

reduce the amount of data entry when creating a new device because the device type func-

tions as a template. You should create a device type for every device model that will be

installed on UB customer accounts.

The bill type attached to the device type determines which service rate will be billed for the

consumption of a device attached to the device type. When a bill is generated on a cus-

tomer account, the consumption on a meter will be billed using the service rate with the

same bill type as the meter. For more information on bill types see the Bill Type Overview

document.

Step by Step

1     Open the Backflow Device Type Selection window (UB> Maintenance> Backflow Device Type). 
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l The Backflow Device Type Selection window will display all backflow device

types that have been created.

l Select a backflow device using the arrow keys on the keyboard or the mouse.

l Click the Modify icon to open the selected device type.

l Click the Delete icon to delete the selected device type.

l You will not be able to delete a device type that is attached to an exist-

ing device.

l Click the Create icon to create a new backflow device type. This will open

the Backflow Device Type Maintenance window.

l You cannot modify any of the fields that display in the Backflow Device Type Selec-

tion window, including the Device Default toggle. You must open the device type

before you can modify it.

2     Complete the General tab. 

l Enter a Manufacturer from the drop-down menu or enter a new one. If you enter a

new manufacturer, it will be available in the drop-down menu the next time you cre-

ate a backflow device type.

l The Manufacturer field can be up to 30 alphanumeric characters long.

l Enter a Model Number from the drop-down menu or enter a new one. If you enter a

new model number, it will be available in the drop-down menu the next time you
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create a backflow device type.

l The Model Number field can be up to 30 alphanumeric characters long.

l Click the Bill Type field label to select a bill type from a list. This will open the Bill

Type Selection window.

l The bill type attached to the device type determines what service rate will be

used to bill for the consumption on a device. When a New Billing is generated,

the billing engine will bill the consumption on a device using the service rates

with the same bill type. The bill type on the device is inherited from the device

type. For example, if there is consumption on a device with a bill type of

BACKFLOW, all service rates with the BACKFLOW bill type will be used to cal-

culate the billing on the device.

l Bill Types are created and maintained on the Bill Type Maintenance window

(UB> Maintenance> Bill Type).

l Select a bill type that is set up to be used by backflow devices.

l Bill types are set up as backflow device bill types in the Device Type

drop-down menu (UB> Maintenance> Bill Type).

l You will receive a validation error when you try to save the device type if

the bill type is not set up as a backflow type.

l The Default Change-out, Default Remove and Default Add fields are used to add

a default service request code to the device type. When a service request is created

on the Account Master Maintenance window (UB> Maintenance> Account> Device

tab> Change-out icon ), the default service request will populate on the Service

Request input Wizard. For example, if you select a backflow device of this device

type on the Device tab of the Account Master Maintenance window and click the

Remove icon, the service request code selected in the Default Remove field will
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populate in the Request Code field of the Service Request Input Wizard that

launches. The default service request code only acts as a default because you will

be able to change the service request code that populates on the Service Request

Input Wizard.

l The Default Change-out, Default Remove and Default Add fields are all

optional.

l You can set up security on the Service Request Code field using the DB

Security feature (SS> Security> DB Security) so that it is read only and users

will be forced to use the default service request code set up on the device

type.

l Click the Default Change-out field label to select the default service request

code for change-out device service requests created on the device type from

the Account Master Maintenance window (UB> Maintenance> Account>

Device tab> Change-out icon ).

l Click the Default Remove field label to select the default service request code

for remove device service requests performed on the device type.

l Click the Default Add field label to select the default service request code for

add device service requests performed on the device type.

l Enter backflow device type notes in the Notes field.

l The Notes field is an optional field. The Notes cannot be included on a QBE

Report.

l Check the Default Type toggle if you are creating the default device type.

l When a new device is created, the information attached to the default device

type will populate on the new device. For example, if you are creating a new

water meter device in the Device Maintenance window (UB> Maintenance>
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Device> Create icon), the water meter default device type information will pop-

ulate on the new device. If the default device information does not apply to the

new water meter, you will be able to select a new device type and overwrite

the default device type information on the device.

l You will not be able to save the device type if there already is a default device

type set up.

3     Complete the Backflow tab. 

l Enter a size or select one from the Device Size drop-down menu.

l The device size field will display the sizes of other backflow devices that have

already been set up (UB> Maintenance> Backflow Device Maintenance).

4     Complete the Miscellaneous tab. 

l The Miscellaneous tab is used to enter information on a backflow device that is out-

side the scope of the current application. Information entered in these fields can be

used in reporting when using the QBE Reporting tool (UB> Maintenance> QBE

Builder).

l The field labels of the miscellaneous fields are set up in Miscellaneous Field Labels

window (SS> Utilities> Miscellaneous Field Labels).
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l Click the Save icon when complete. The Save icon will only be enabled if there

have been changes made to the device type.
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UB> Maintenance> Electric Device Type

Electric Device Type Maintenance

Summary

The Electric Device Maintenance window is used to create and maintain electric device

types. Device types define the bill type, manufacturer and model number of a specific kind

of device. When a device is created (UB> Maintenance> Device> Create), the device will

populate with the information from the selected device type. Device types reduce the

amount of data entry when creating a new device because the device type functions as a

template. You should create a device type for every device model that will be installed on

UB customer accounts.

The bill type attached to the device type determines which service rate will be billed for the

consumption of a device attached to the device type. When a bill is generated on a cus-

tomer account, the consumption on a meter will be billed using the service rate with the

same bill type as the meter. For more information on bill types see the Bill Type Overview

document.

Step by Step

1     Open the Electric Device Type Selection window (UB> Maintenance> Electric Device Type). 
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l The Electric Device Type Selection window will display all electric device types

that have been created.

l Select an electric meter device type using the arrow keys on the keyboard or the

mouse.

l Click the Modify icon to open the selected device type.

l Click the Delete icon to delete the selected device type.

l You will not be able to delete a device type that is attached to an exist-

ing device.

l Click the Create icon to create a new electric device type. This will open

the Electric Device Type Maintenance window.

2     Complete the General tab. 

l Select a Manufacturer from the drop-down menu or enter a new one. If you enter a

new manufacturer, it will be available in the drop-down menu the next time you cre-

ate an electric device type.

l Enter a Model Number. The model number is used to identify unique device types

of the same manufacturer. This is a required field.

l Click the Bill Type field label or press F1 while the curser is in the field to select a

bill type from a list. This will open the Bill Type Selection window.

l The bill type attached to the device type determines what service rate will be

used to bill for the consumption on a device. When a New Billing is generated,
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the billing engine will bill the consumption on a device using the service rates

with the same bill type. The bill type on the device is inherited from the device

type. For example, if there is consumption on a device with a bill type of

ELECTRIC, all service rates with the ELECTRIC bill type will be used to cal-

culate the billing on the device.

l Bill Types are created and maintained on the Bill Type Maintenance window

(UB> Maintenance> Bill Type).

l Select a bill type that is set up to be used by electric devices.

l Bill types are set up as electric device bill types in the Device Type

drop-down menu (UB> Maintenance> Bill Type).

l You will receive a validation error when you try to save the device type if

the bill type is not set up as an electric type.

l The Default Change-out, Default Remove and Default Add fields are used to add

a default service request code to the device type. When a service request is created

on the Account Master Maintenance window (UB> Maintenance> Account> Device

tab> Change-out icon ), the default service request will populate on the Service

Request input Wizard. For example, if you select an electric meter of this device

type on the Device tab of the Account Master Maintenance window and click the

Remove icon, the service request code selected in the Default Remove field will pop-

ulate in the Request Code field of the Service Request Input Wizard that launches.

The default service request code only acts as a default because you will be able to

change the service request code that populates on the Service Request Input Wiz-

ard.

l The Default Change-out, Default Remove and Default Add fields are all

optional.
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l You can set up security on the Service Request Code field using the DB

Security feature (SS> Security> DB Security) so that it is read only and users

will be forced to use the default service request code set up on the device

type.

l Click the Default Change-out field label to select the default service request

code for change-out device service requests created on the device type from

the Account Master Maintenance window (UB> Maintenance> Account>

Device tab> Change-out icon ).

l Click the Default Remove field label to select the default service request

code for remove device service requests performed on the device type.

l Click the Default Add field label to select the default service request code for

add device service requests performed on the device type.

l You can also attach a default device type to a service request code using the

Service Request Code Maintenance window (UB> Maintenance> Service

Request code). When a service request is created using the Service Request

Input Wizard and you select a service request code with a default device type,

the device type will automatically be selected if it is installed on the lot. For

example, a service request is generally performed on a certain type of device

attach that device type to the service request code. When service requests of

that code are processed the device of that type will automatically be selected.

l The Notes field is used to enter notes on the device. This is not the same as the

Notes field that displays on the Device Maintenance window (UB> Maintenance>

Device> Miscellaneous tab> Notes field).

l The Notes field will not display on any reports and does not display in the QBE

Reporting tool.
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l Check the Default Type toggle if you are creating the default device type.

l When a new device is created, the information attached to the default device

type will populate on the new device. For example, if you are creating a new

water meter device in the Device Maintenance window (UB> Maintenance>

Device> Create icon), the water meter default device type information will pop-

ulate on the new device. If the default device information does not apply to the

new water meter, you will be able to select a new device type and overwrite

the default device type information on the device.

l You will not be able to save the device type if there already is a default device

type set up.

l Check the Retain New Reads on Import toggle to prevent imported meter read-

ings from overwriting existing new and unbilled readings on the account.

l This toggle will be unchecked by default as the standard functionality is to

overwrite existing readings on import.

3     Complete the Electric tab. 

l Select a Unit Type from the drop-down menu.

l When consumption is read on devices attached to this device type, the con-

sumption will be read in this unit type. When a New Billing is generated (UB>

New Billing> Generate), the consumption read on the devices can be con-

verted to another unit type using the formulas set up in the conversion table

(UB> Maintenance> Consumption Conversion).
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l Make sure the unit type entered in this field is set up in the consumption con-

version table. If the unit type is not set up in the conversion table and you try

to convert the consumption during the New Billing process, you will receive an

error message during the Generate step.

l Enter a value in the Reading Multiplier and/or Reading Divisor field if you want to

modify the device readings when they are imported (UB> Meter Management>

Readings Import).

l Enter a value in the Consumption Multiplier and/or Consumption Divisor field if

you want to modify the consumption that is billed on the selected meter type.

l When using the consumption multiplier and divider fields, the Meters tab of

the customer account (UB> Maintenance> Account) will display the con-

sumption based on the imported read, not the modified consumption.

l The modified consumption is the consumption that will be billed on the

account when a billing is generated (UB> New Billing).

l The Billing Register (UB> New Billing> Billing Register) can display either the

modified consumption amount (UB> New Billing> Billing Register> Billable

Only toggle) or the consumption read on the meter (UB> New Billing> Billing

Register> Actual toggle.

l The Number of Digits field is used to enter the number of digits on the water meter.

l The value in this field will affect the consumption on a bill when the meter read-

ing cycles back to 000. If the number of digits is entered incorrectly, the con-

sumption on the billing will be incorrect.

l The Number of User Periods field is used to enter the number of use periods on

the device type.
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l Usage periods are generally used to separate consumption into separate

usage periods and charge those usage periods different service rates. (For

example, charging a separate rate for peak and non-peak usage.)

l Check the Automated Read toggle if this device will be read with a handheld

device.

l Check the Incrementing toggle if you are importing meter readings (UB> Meter

Management> Readings Import) and the consumption calculated on the meter

should be based on the previous read. For example, if the previous reading on a

meter was 1000, and the imported reading is 2000, the consumption on the meter

will be the previous read less the current reading, or 1000. If you do not have this

toggle checked the consumption on the meter will be the entire imported meter read-

ing. In the example above, the consumption on the meter would be 2000, or the

entire imported meter reading amount.

l The Gear Ratio, Read Method, KH Per Rev, Volts, Amps, Phase, Wires fields are

used to enter optional informational details on the device type.

l Check the Solar received meter toggle if this device will be used to calculate solar

power generated at the customer site and fed back into the power grid.

l This toggle will only be enabled if the Electric Type field below is set to KWH.

l The Power Factor Threshold field is used to set the point under which standard

demand consumption will be overridden by Power Factor Consumption.

l The Electric Type drop-down menu is used to specify the units that devices

attached to this device type use to measure consumption.

l Leave the field blank if the meter consumption does not need to be specified.

l Select Demand if the meter measures consumption by kilowatts.
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l Select KVAR if the meter measures consumption by kilowatt volt-amperes

reactive.

l Select KWH if the meter measures consumption by kilowatt hours.

4     Complete the Miscellaneous tab. 

l The fields on the miscellaneous tab can be included on a report using the QBE

Reporting tool in the UB module.

l The miscellaneous fields are found in the UB module QBE reporting tool by

selecting the Meters primary table. The miscellaneous fields will display are

primary fields, for example: Char Misc 1 (Device Type).

l Click the Save icon when complete.
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UB> Maintenance> Gas Device Type

Gas Device Type Maintenance

Related Links

The Gas Device Maintenance window is used to create and maintain gas device types.

Device types define the bill type, manufacturer and model number of a specific kind of

device. When a device is created (UB> Maintenance> Device> Create or from the Service

Request Input Wizard), the device will populate with the information from the selected

device type. Device types reduce the amount of data entry when creating a new device

because the device type functions as a template. You should create a device type for every

device model that will be installed on UB customer accounts.

The bill type attached to the device type determines which service rate will be billed for the

consumption of a device attached to the device type. When a bill is generated on a cus-

tomer account, the consumption on a meter will be billed using the service rate with the

same bill type as the meter. For more information on bill types see the Bill Type Overview

document.

Step by Step

1     Open the Gas Device Type Selection window (UB> Maintenance> Gas Device Type). 
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l The Gas Device Type Selection window will display all gas device types that have

been created.

l Select a gas meter device type using the arrow keys on the keyboard or the mouse.

l Click the Modify icon to open the selected device type.

l Click the Delete icon to delete the selected device type.

l You will not be able to delete a device type that is attached to an exist-

ing device.

l Click the Create icon to create a new gas device type. This will open the

Gas Device Type Maintenance window.

2     Create the Device Type. 

l Select a Manufacturer from the drop-down menu or enter a new one. If you enter a

new manufacturer, it will be available in the drop-down menu the next time you cre-

ate a gas device type.

l Enter a Model Number. The model number is used to identify unique device types

of the same manufacturer. This is a required field.

l Click the Bill Type field label or press F1 while the curser is in the field to select a

bill type from a list. This will open the Bill Type Selection window.

l The bill type attached to the device type determines what service rate will be

used to bill for the consumption on a device. When a New Billing is generated,

the billing engine will bill the consumption on a device using the service rates
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with the same bill type. The bill type on the device is inherited from the device

type. For example, if there is consumption on a device with a bill type of GAS,

all service rates with the GAS bill type will be used to calculate the billing on

the device.

l Bill Types are created and maintained on the Bill Type Maintenance window

(UB> Maintenance> Bill Type).

l Select a bill type that is set up to be used by gas devices.

l Bill types are set up as gas device bill types in the Device Type drop-

down menu (UB> Maintenance> Bill Type).

l You will receive a validation error when you try to save the device type if

the bill type is not set up as a gas type.

l The Default Change-out, Default Remove and Default Add fields are used to add

a default service request code to the device type. When a service request is created

on the Account Master Maintenance window (UB> Maintenance> Account> Device

tab> Change-out icon ), the default service request will populate on the Service

Request input Wizard. For example, if you select a gas meter of this device type on

the Device tab of the Account Master Maintenance window and click the Remove

icon, the service request code selected in the Default Remove field will populate in

the Request Code field of the Service Request Input Wizard that launches. The

default service request code only acts as a default because you will be able to

change the service request code that populates on the Service Request Input Wiz-

ard.

l The Default Change-out, Default Remove and Default Add fields are all

optional.
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l You can set up security on the Service Request Code field using the DB

Security feature (SS> Security> DB Security) so that it is read only and users

will be forced to use the default service request code set up on the device

type.

l Click the Default Change-out field label to select the default service request

code for change-out device service requests created on the device type from

the Account Master Maintenance window (UB> Maintenance> Account>

Device tab> Change-out icon ).

l Click the Default Remove field label to select the default service request

code for remove device service requests performed on the device type.

l Click the Default Add field label to select the default service request code for

add device service requests performed on the device type.

l You can also attach a default device type to a service request code using the

Service Request Code Maintenance window (UB> Maintenance> Service

Request code). When a service request is created using the Service Request

Input Wizard and you select a service request code with a default device type,

the device type will automatically be selected if it is installed on the lot. For

example, a service request is generally performed on a certain type of device

attach that device type to the service request code. When service requests of

that code are processed the device of that type will automatically be selected.

l The Notes field is used to enter notes on the device. This is not the same as the

Notes field that displays on the Device Maintenance window (UB> Maintenance>

Device> Miscellaneous tab> Notes field).

l The Notes field will not display on any reports and does not display in the QBE

Reporting tool.
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l Check the Default Type toggle if you are creating the default device type.

l When a new device is created, the information attached to the default device

type will populate on the new device. For example, if you are creating a new

water meter device in the Device Maintenance window (UB> Maintenance>

Device> Create icon), the water meter default device type information will pop-

ulate on the new device. If the default device information does not apply to the

new water meter, you will be able to select a new device type and overwrite

the default device type information on the device.

l You will not be able to save the device type if there already is a default device

type set up.

l Check the Retain New Reads on Import toggle to prevent imported meter read-

ings from overwriting existing new and unbilled readings on the account.

l This toggle will be unchecked by default as the standard functionality is to

overwrite existing readings on import.

3     Complete the Gas tab. 

l Select a Unit Type from the drop-down menu or enter a new one in the drop-down

menu.

l When consumption is read on devices attached to this device type, the con-

sumption will be read in this unit type. When a New Billing is generated (UB>

New Billing> Generate), the consumption read on the devices can be con-

verted to another unit type using the formulas set up in the conversion table
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(UB> Maintenance> Consumption Conversion).

l Make sure the unit type entered in this field is set up in the consumption con-

version table. If the unit type is not set up in the conversion table and you try

to convert the consumption during the New Billing process, you will receive an

error message during the Generate step.

l Enter a value in the Reading Multiplier and/or Reading Divisor field if you want to

modify the device readings when they are imported in UB> Meter Management>

Readings Import.

l Enter a value in the Consumption Multiplier and/or Consumption Divisor field if

you want to modify the consumption that is billed on the selected meter type.

l When using the consumption multiplier and divider fields, the Meters tab of

the customer account (UB> Maintenance> Account) will display the con-

sumption based on the imported read, not the modified consumption.

l The modified consumption is the consumption that will be billed on the

account when a billing is generated (UB> New Billing).

l The Billing Register (UB> New Billing> Billing Register) can display either the

modified consumption amount (UB> New Billing> Billing Register> Billable

Only toggle) or the consumption read on the meter (UB> New Billing> Billing

Register> Actual toggle).

l The Number of Digits field is used to enter the number of digits on the water meter.

l The value in this field will affect the consumption on a bill when the meter read-

ing cycles back to 000. If the number of digits is entered incorrectly, the con-

sumption on the billing will be incorrect.

l The Number of Use Periods field is used to enter the number of use periods on the

device type.
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l Usage periods are generally used to separate consumption into separate

usage periods and charge those usage periods different service rates. (For

example, charging a separate rate for peak and non-peak usage.)

l Check the Automated Read toggle if this device will be read with a handheld

device.

l Check the Incrementing toggle if you are importing meter readings (UB> Meter

Management> Readings Import) and the consumption calculated on the meter

should be based on the previous read. For example, if the previous reading on a

meter was 1000, and the imported reading is 2000, the consumption on the meter

will be the previous read less the current reading, or 1000. If you do not have this

toggle checked the consumption on the meter will be the entire imported meter read-

ing. In the example above, the consumption on the meter would be 2000, or the

entire imported meter reading amount.

l Select a Device Size from the drop-down menu or enter a new size. The meter size

will not affect the billing.

l You can create a report grouping the consumption read on devices by meter

size (UB> Reports> Consumption by Meter Size).

4     Complete the Miscellaneous tab. 

l The fields on the miscellaneous tab can be included on a report using the QBE

Reporting tool in the UB module.
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l The miscellaneous fields are found in the UB module QBE reporting tool by

selecting the Meters primary table. The miscellaneous fields will display are

primary fields, for example: Char Misc 1 (Device Type).

l Click the Save icon when complete.
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UB> Maintenance> Water Device Type

Water Device Type Maintenance

Summary

The Water Meter Device Maintenance window is used to create and maintain water device

types. A device type is used to define a manufacturer, model number and bill type of a spe-

cific kind of device. When a device is created, a specific device type is selected and the

device type information will populate on the device. Device types reduce the amount of

data entry when creating a new device because the device type functions as a template.

You should create a device type for every device model that will be installed on UB cus-

tomer accounts.

The most important information on the device type maintenance window is the bill type.

The bill type will determine what service rates will be used to bill the consumption on all

devices of the device type. When a New Billing is generated, the billing engine will bill the

consumption on a device using the service rates with the same bill type. The bill type of the

device is determined by the bill type on the device type. For more information on bill types

see the Bill Type Overview document.

Step by Step

1     Open theWater Device Type Select window (UB> Maintenance>Water Device Type). 
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l The Water Device Type Select window will display all water device types that have

been created.

l Select a water device type using the arrow keys on the keyboard or the mouse.

l Click the Modify icon or double click to open the selected device type.

l Click the Delete icon to delete the selected device type.

l You will not be able to delete a device type that is attached to an exist-

ing device.

l Click the Create icon to create a new water device type. This will open the

Water Device Type Maintenance window.

2     Create the Device Type. 

l Select a Manufacturer from the drop-down menu or enter a new one. If you enter a

new manufacturer, it will be available in the drop-down menu the next time you cre-

ate a water device type.

l The Manufacturer field can be up to 30 alphanumeric characters long.

l Enter a Model Number. The model number is used to identify unique device types

of the same manufacturer. This is a required field.

l The Model Number field can be up to 30 alphanumeric characters long.
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l Click the Bill Type field label or press F1 while the curser is in the field to select a

bill type from a list. This will open the Bill Type Selection window.

l The bill type attached to the device type determines what service rate will be

used to bill for the consumption on a device. When a New Billing is generated,

the billing engine will bill the consumption on a device using the service rates

with the same bill type. The bill type on the device is inherited from the device

type. For example, if there is consumption on a device with a bill type of

“Water”, all service rates with the “Water” bill type will be used to calculate the

billing on the device.

l Bill Types are created and maintained in UB> Maintenance> Bill Type.

l Select a bill type that is set up to be used by water devices.

l Bill types are set up as water device bill types in the Device Type drop-

down menu in UB> Maintenance> Bill Type.

l You will receive a validation error when you try to save the device type if

the bill type is not set up as a water meter device type.

l The Default Change-out, Default Remove and Default Add fields are used to add

a default service request code to the device type. When a service request is created

on the Account Master Maintenance window (UB> Maintenance> Account> Device

tab> Change-out icon), the default service request will populate on the Service

Request input Wizard. For example, if you select a water meter of this device type

on the Device tab of the Account Master Maintenance window and click the Remove

icon, the service request code selected in the Default Remove field will populate in

the Request Code field of the Service Request Input Wizard that launches. The

default service request code only acts as a default because you will be able to

change the service request code that populates on the Service Request Input Wiz-

ard.
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l The Default Change-out, Default Remove and Default Add fields are all

optional.

l You can set up security on the Service Request Code field using the DB

Security feature (SS> Security> DB Security) so that it is read only and users

will be forced to use the default service request code set up on the device

type.

l Click the Default Change-out field label to select the default service request

code for change-out device service requests created on the device type from

the Account Master Maintenance window (UB> Maintenance> Account>

Device tab> Change-out icon).

l Click the Default Remove field label to select the default service request

code for remove device service requests performed on the device type.

l Click the Default Add field label to select the default service request code for

add device service requests performed on the device type.

l You can also attach a default device type to a service request code using the

Service Request Code Maintenance window (UB> Maintenance> Service

Request code). When a service request is created using the Service Request

Input Wizard and you select a service request code with a default device type,

the device type will automatically be selected if it is installed on the lot. For

example, a service request is generally performed on a certain type of device

attach that device type to the service request code. When service requests of

that code are processed the device of that type will automatically be selected.

l Enter water device type notes in the Notes field. This is not the same as the Notes

field that displays on the Device Maintenance window (UB> Maintenance> Device>

Miscellaneous tab> Notes field).
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l The Notes field will not display on any reports and does not display in the QBE

Reporting tool.

l Check the Default Type toggle if you are creating the default device type.

l When a new device is created, the information attached to the default device

type will populate on the new device. For example, if you are creating a new

water meter device in the Device Maintenance window (UB> Maintenance>

Device> Create icon), the water meter default device type information will pop-

ulate on the new device. If the default device information does not apply to the

new water meter, you will be able to select a new device type and overwrite

the default device type information on the device.

l You will not be able to save the device type if there already is a default device

type set up.

l Check the Retain New Reads on Import toggle to prevent imported meter read-

ings from overwriting existing new and unbilled readings on the account.

l This toggle will be unchecked by default as the standard functionality is to

overwrite existing readings on import.

3     Click on the Water tab in enter information specific to the water device type. 

l Select the Unit Type of the device type in the drop-down menu.

l When consumption is read on devices attached to this device type, the consumption

will be read in this unit type. When a New Billing is generated (UB> New Billing>

Generate), the consumption read on the devices can be converted to another unit
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type using the formulas set up in the conversion table (UB> Maintenance> Con-

sumption Conversion).

l Make sure the unit type entered in this field is set up in the consumption conversion

table. If the unit type is not set up in the conversion table and you try to convert the

consumption during the New Billing process, you will receive an error message dur-

ing the Generate step.

l Enter a value in the Reading Multiplier and/or Reading Divisor field if you want to

modify the device readings when they are imported in UB> Meter Management>

Readings Import.

l Enter a value in the Consumption Multiplier and/or Consumption Divisor field if

you want to modify the consumption that is billed on the selected meter type.

l When using the consumption multiplier and divider fields, the Meters tab of

the customer account in UB> Maintenance> Account will display the con-

sumption based on the imported read, not the modified consumption.

l The modified consumption is the consumption that will be billed on the

account when a billing is generated UB> New Billing.

l The Billing Register (UB> New Billing> Billing Register) can display either the

modified consumption amount (UB> New Billing> Billing Register> Billable

Only toggle) or the consumption read on the meter (UB> New Billing> Billing

Register> Actual toggle.

l The Number of Digits field is used to enter the number of digits on the water meter.

l The value in this field will affect the consumption on a bill when the meter read-

ing cycles back to 000. If the number of digits is entered incorrectly, the con-

sumption on the billing will be incorrect.
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l The Number of User Periods field is used to enter the number of use periods on

the device type.

l Usage periods are generally used to separate consumption into separate

usage periods and charge those usage periods different service rates. (For

example, charging a separate rate for peak and non-peak usage.)

l Check the Automated Read toggle if this device will be read with a handheld

device.

l Check the Incrementing toggle if you are importing meter readings (UB> Meter

Management> Readings Import) and the consumption calculated on the meter

should be based on the previous read. For example, if the previous reading on a

meter was 1000, and the imported reading is 2000, the consumption on the meter

will be the previous read less the current reading, or 1000. If you do not have this

toggle checked the consumption on the meter will be the entire imported meter read-

ing. In the example above, the consumption on the meter would be 2000, or the

entire imported meter reading amount.

l Select a Device Size from the drop-down menu or enter a new one.

l You can create a report grouping the consumption read on devices by meter

size in UB> Reports> Consumption by Meter Size.

4     Click the Miscellaneous tab. 

l The fields on the Miscellaneous tab can be included on a report using the QBE

Reporting tool in the UB module.
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l The miscellaneous fields are found in the UB module QBE reporting tool by

selecting the Meters primary table. The miscellaneous fields will display are

primary fields, for example: Char Misc 1 (Device Type).

l Click the Save icon when complete.
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UB> Maintenance> Fee Code

UB Fee Code Maintenance

Summary

The Fee Code Maintenance window is used to create and maintain fee codes. Fee codes

are used to charge fees, such as billable service requests, or create deposits on UB cus-

tomer accounts.

Fee codes can also be grouped together on an adjustment type code (UB> Maintenance>

Adjustment Types) in order to create an adjustment on a transaction (UB> Adjustments

and Fee> Input), or charge a Past Dues penalty (UB> Past Dues> Generate).

Step by Step

1     Open the Fee Code Maintenance window (UB> Maintenance> Fee Code). 

l The Fee Code Maintenance window is similar to many of the other maintenance

windows in application. Select a record in the left section of the window and the

Maintenance section of the window will populate with the information of the selected

record.
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l Right click on the right section of the window and select Export grid contents to

Excel if you would like to create an MS Excel spreadsheet of the information that dis-

plays in the window. This allows you to create a report of the fee codes including the

fee code amounts and other basic fee code information.

l Select a fee code and click the Delete icon to delete the fee code. You will not

be able to delete a fee code that is attached to the history lines of customer

accounts.

l Click the Create icon to create a new fee code. This will add a line item in the left

section of the window.

2     Create a new fee code. 

l Enter a Fee Code. The fee code can be up to six alphanumeric characters long.

l Enter a Description. The Description can be up to 20 alphanumeric characters.

l Enter a Flat Amount if the fee is a flat amount. Flat amount fee codes can be used

to charge deposits or connection charges. For example, if a customer is charged a

$25 dollar deposit when they establish a new account, enter $25 in this field. You

can apply the deposit to the customer account using the Connection Charges step

of the New Account Wizard. Enter the amount of the deposit or the connection

charge in the Flat Amount field.

l Enter a Percent Amount if the fee should be calculated based on a percentage of

an amount. Enter the percentage amount as a whole number (100% = 100).
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l The Percent Amount field is generally used when assessing Past Due fees

(UB> Past Dues). When Past Dues are generated, the fee code will be

applied based on the percentage of the past due amount. For example, if the

past due amount is $45.00, if the percentage amount is 10.00, the past due

charge will be $4.50.

l If this fee is going to be used in the Past Dues process, the selection in

the Against Balance toggle will affect the functionality of this field.

l The Percent Amount field is also used when factoring interest on deposit fee

codes from the Factor Deposit Interest window (UB> Adjustments and Fees>

Factor Deposit Interest). When interest is factored, the interest on the deposit

amount will be calculated using the value in the Percent Amount field as an

annual percentage rate. For example, if you enter 3.50 in this field and you

are factoring a year of interest on a deposit of $50, the calculated interest on

the deposit will be $1.75 (.035 X $50).

l If you do not enter a value in the Percentage Amount field, the deposit

fee code will not display in the Factor Deposit Interest window (UB>

Adjustments and Fees> Factor Deposit Interest).

l The Past Due Minimum field is used to enter a minimum dollar amount of a past

due before the fee code will be applied.

l Past dues are generated (UB> Past Dues) using an adjustment type that the

fee code is attached to. The fee code will not be applied if the past due

amount does not exceed Past Due Minimum.

l If you would like to assess a minimum charge on all accounts included in a

Past Dues batch, enter a value in the Minimum Charge field on the Generate

window (UB> Past Dues> Generate) when the past dues are generated.
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l The Service to Charge field is used to select the UB service that will be charged

when the fee is assessed.

l If you are modifying an existing fee code, it is recommended that you do not

change the service selected in this field once you have generated trans-

actions on the fee code. Rather than changing the fee code, create a new one

with a different service.

l If this is a deposit fee code, the service selected in the Service to Charge field

must be attached to the customer account the deposit is being created on.

Some customers create a separate service for deposits.

l The Calculate Charges From field is used to select how the fee will be calculated if

it is set up as a percentage amount. This field generally applies to fees that will be

used in the Past Dues process because it also affects which balances will be

included in the Past Dues batch.

l When a Past Dues batch is generated (UB> Past Dues), an adjustment type is

selected to assess the past dues fees. The fee codes attached to the selected

adjustment type define which GL accounts will be used in the transaction and

how penalty charges are assessed on the customer accounts. The fee codes

attached to the adjustment type will also determine which customer accounts

are pulled into the Past Dues batch based on the services attached to the fee

code. Only the balances on UB services that are attached to the fee code will

be included in the Past Dues batch.

l The entire balance of the customer accounts will only be pulled into the Past

Dues batch if all of the services that are attached to the customer accounts

are also attached to the fee code used to assess the penalties. Only the

account balances on services that are attached to the fee code used to

assess the Past Due charges will be pulled into the batch.
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l Enter the GL accounts on the fee code.

l The GL accounts that will be used in a specific transaction are determined by

how the adjustment type is set up.

l Check the Deposit toggle if the fee code is used to create a deposit on UB customer

accounts.

l When a new account is created using the New Account Wizard, attach this fee

code to the new account to create a deposit. When the New Account Wizard

is complete, the fee code will be processed in an Adjustments and Fees batch

(UB> Adjustments and Fees) in order to create the billing line item for the

deposit amount. If the Deposit toggle is not checked on the fee code, the

billing line item will be created in an Adjustments and Fees batch, but when

the money is received it will be processed like a standard fee rather than a

deposit.

l Most organizations will use a deposit liability GL account in the Revenue

Account field when setting up a fee code with the Deposit toggle checked.

l Check the Default Overpayment toggle if overpayments should be applied to this

fee code by default.

l If a customer makes an overpayment to a service that does not have an

attached service rate, the overpayment will be applied to the fee code with the

Default Overpayment toggle checked.

l The Against Balance toggle only applies to percentage based fee codes used to

generate Past Due charges.

l The Against Balance toggle is used to set up how the percentage entered in

the Percentage Amount field will be calculated. If the Against Balance toggle

is checked, the past due penalty amount will be calculated using the balance
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forward on the UB customer account. If the Against Balance toggle is not

checked, the percentage will be applied based on only the past due amount.

l Check the Used in Transfers toggle if the fee code will be used in the transfers pro-

cess.

l The transfers process allows you to transfer an account or deposit balance of

a customer account to the account balance or deposit balance of another cus-

tomer account. Transfer fee codes will display on the generate step of the

transfers process (UB> Transfers> Generate> Cash Adj Type and Bill Adj

Type fields).

l When creating a transfer fee code, you will need to confirm that you have spe-

cified a CASH account in both the Revenue Account and the Cash Account

fields. This will prevent an unnecessary journal entry from being created when

the transfer is committed.

3     Save the Fee Code. 

l Click the Save icon . The fee code has been created.
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UB> Maintenance> Forms

Create a Form in UB

Summary

Forms refer to Microsoft Word documents that, through the use of merge fields, allow users

to pull data from the application and customize how that data is displayed on the forms.

Forms will be saved in the Springbrook folder on your server at the path specified when the

application was installed (SS> Utilities> System Setup> System tab> Archive Directory

field).

The forms will be saved as .sbw files in this folder and should not be edited to avoid cor-

ruption. Forms can be attached to various application elements through the module pro-

cess and maintenance palettes.

Follow this process to create forms to attach to Utility Billing processes. The forms set up in

the UB module will not be accessible in other modules that use forms.

Step by Step

1     View the existing Forms. 
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l Open the Word Merge Form Selection window (UB> Maintenance> Forms).

l The Word Merge Form Selection window will display all of the forms created in the

application. Use the search criteria fields to filter the displayed forms.

l Highlight a form and click the Preview icon to view the selected form. This will

open the MS Word document in a new window.

l Highlight a form and click the Copy icon to copy the selected form. This will cre-

ate a copy of the original form.

l Highlight a form and click the Delete icon or press DELETE to delete the selec-

ted form.

l Highlight a form and click the Modify icon or press ENTER to open and edit an

existing form.

l Click the Create icon or press INSERT to create a new form. This will open the

Word Merge Form Maintenance window.

2     Create a new Form.

l Enter a unique Form Name for the form. The field can be up to 32 characters long.

Once the form has been saved, you will not be able to edit this field.

l Enter an optional form Description.

l After you have entered a form name and description, click the Create icon to cre-

ate the form. This will open a new Word document.
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l Once the Word document is open, use the insert merge fields command in

Word to specify the data fields you want displayed on the form. For instance,

the merge field Cust_No is the customer number. By inserting this merge field

into the Word document, and then attaching the form to a UB process, the

form will display the data found in the customer number field of the UB

account included in the process.

l Images, charts, tables, etc. can also be inserted into the Word document.

l Once you are finished creating/modifying your form, be sure to save the form both

on the Word document (File> Save) and using the Save icon on the Form Main-

tenance window.

l The new form will now be available when creating form letters in the specified BP

process.
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UB> Maintenance> Query by Example

QBE Report Builder Tool

Summary

The QBE Builder reporting tool is used to create customized reports in the Utility Billing

module. Reports are created in the QBE Builder by selecting columns, creating arguments

to remove records (Transaction Date < 01/01/2021), selecting how the report will group

and sort, and then defining the totals that will display on the report. After the report has

been created, it can be printed out or exported into an MS Excel, MS Access, or CSV

format. Reports that have been created using the QBE Builder tool can be saved and gen-

erated at any point.

This document will cover how to create a specific example report that provides an explan-

ation of primary tables, secondary tables, arguments, and totals. When creating your own

QBE reports, it is helpful to know the general structure of the database and how the inform-

ation entered into the fields on a window will be stored in the database fields and tables.

The Table/Field help feature (Help> Table/Field) is designed to be used in conjunction with

database security (SS> Security> DB Security), but it can be helpful when building QBE

Reports to help you determine where the information entered into a field on a window is

stored. This tool will not always be helpful because it will display the exact name of the

table and field where the information is stored, but QBE Builder uses simplified and more

intuitive field and table names. For example, turn on the Table/ Field help and open the
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Account Master Maintenance window (UB> Maintenance> Account). Open the Account tab

and move the mouse over the Billing Cycle field. A bubble will display the following: Table

Name: UB_Master, Field Name: Billing Cycle. On the QBE Maintenance window (UB>

Maintenance> QBE Builder) the UB_Master table has been renamed to Account Master, so

the Billing Cycle field will display in the Account Master primary table.

The example report created in this document will create a list of UB customer account from

meter read route “65” with consumption greater than “100” during meter read period “12”

and meter read year “2020.” You will also add a consumption report total to the report.

Step by Step

1     View the QBE reports. 

l Open the QBE Maintenance window (UB> Maintenance> Query by example).

l The QBE Maintenance window will display all of the reports that have been created

in the UB module. Select a report in the left section of the window and the cus-

tomized report information will populate in the right section of the window just like

many of the other maintenance windows in the application.

l Highlight a report and click the Delete icon to delete the highlighted report.

l Click the Create icon to create a new QBE report.

l Highlight a report and click the Print icon to print an existing QBE report. The

QBE report will be generated as soon as the resources are available on the server.
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You can view the progress of the print job using the Jobs Viewer window (Jobs

Viewer icon on the main application window).

l Highlight a report and click the Export icon drop-down and select Export Report

to export the highlighted report data.

l Highlight a report and click the Export icon drop-down and select Export Defin-

ition to export the report definitions of the highlighted report. This exported report

definition file can then be imported using the Import icon . This allows organ-

izations to share QBE reports.

2     Select the tables that contain the information you would like to include on the report. 

l The first step in creating a customized report is selecting the information you would

like to display on the report. Information in a database is organized into tables and

fields. Fields are used to store specific information, for example a customer name.

Fields are then grouped into tables, for example a customer table that contains all of

the general customer information like address and phone number. When inform-

ation is entered into a window in the application, that information is stored in a spe-

cific field, in a specific table. When creating a QBE report, select the tables that

contain the information you would like to include on the report, and then select the

fields.

l Select a table from the Table Name drop-down menu in the Primary Table section.

The Available Fields section will populate with the fields grouped into that table. For

example, if you select Account Master from the drop-down menu most of the fields
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on the Account Master Maintenance window will display in the Available fields sec-

tion. If the table you select does not contain all of the fields you want to report on

you will have to select a secondary table.

l Some tables in the database are linked together because they share a common

field called a key. The key connects the data in the two tables together and defines

how the data in one table is related to the data in another table. For example, the

Account Master table is linked to the Financial table by the UB customer account

number. When financial data is generated the UB customer account number is also

included so the financial data can be linked to the customer information. If the table

you selected in the Table Name drop-down menu in the Primary Table section is

linked to other tables, you can select a secondary table in the Secondary Table sec-

tion. As you select a secondary table from the Table Name drop-down menu, new

fields will be added at the bottom of the Available Fields section. If you need inform-

ation from two different tables, but those tables are not linked together, you will not

be able to create the report.

l Select Meter in the Primary Table section. The Available Fields section will display

the fields in the Meters table. There will be a green star next to the fields in the

primary table.

l Select Meter History in the Secondary Table section. The fields in the Meter History

table will be added to the bottom of the Available Fields section. There will be a child

field icon next to the fields of the secondary table.

l If you were to select the Meter History table as the Primary table, you would not be

able to select the Meter table in the Secondary Table drop-down menu. These two

tables share a common key, (UB Meter Con ID) but you cannot select the tables in

that order because the Meter History table is a child table of the Meter table.
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3     Select the fields you would like to include in the report. 

l After you have selected the tables you can pull the fields from those tables onto the

report. Check the toggles of the fields you would like to include on the report in the

Available Fields section. Only fields with a check will display on the report.

l Select the Route/Sequence (Meter table), UB Account No, Reading Period,

Reading Year and Consumption 1 fields.

l There are six consumption fields: Consumption 1, consumption 2, con-

sumption 3, etc. Each of the consumption fields represents a consumption

usage period. Consumption usage periods are generally used to separate

usage into peak and non-peak usage so you can charge different rates. If you

are not using consumption usage periods the consumption on a meter will be

stored in the Consumption 1 field.

4     Create a filter argument for the report. 

l The fields below the Table Name drop-down menu are used to create an argument

that will filter the information that will display on the report. For example, if you

would only like to include meters with an install date greater than 06/01/2020.

l These arguments are limited to 2048 characters.

l In this example we will filter the report by route number “65”, meter read period “12”

and meter read year “2020.” Since the Route field is in the Primary table and the

Read Period and Read Year fields are in the Meter History table, the two portions

of the argument will have to be separated. The Route argument will be placed in the
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Primary Table section and the read period and read year arguments will be placed

in the Secondary Table section.

l In the Primary Table section, select Route No from the first drop-down menu below

the Table Name field. The two fields next to this field are used to enter the argu-

ment. Select Equals, and type 65 in the enabled fields. Click the Plus icon in the

Primary Table section to apply the argument to the report. The argument will pop-

ulate in the text field at the bottom of the Primary Table section and will look like

this: UB_Meter_Con.Route_No=”65.”

l You can create a route number argument for any route number format. For

example, if your meter routes are four digits, enter “0001” to include only

meter route 0001 on the report.

l The format of the argument in the text field is: table name.field name. The

table name will generally vary from the table name selected in the Table

Name drop-down menu. The Table Name field generally displays a simplified

and intuitive name rather than the actual table name in order to make the

fields and tables easier to recognize and easier to use. The text field at the

bottom of the Primary Table section will display the actual table, and field

name of the selected tables and fields.

l Click the Test Query icon to confirm that the query is valid.

l Enter the arguments in the Secondary Table section.

l When you enter an argument in the Primary Table and the Secondary Table

section the arguments will be joined with an AND statement, meaning records

must meet the conditions in both section before they will display on the report.

l Select Reading Period in the drop-down menu below the Table Name drop-

down menu in the Secondary Table section. Select Equals and enter “12” in
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the enabled fields. Click the Plus button in the Secondary Table to add the

argument to the report.

l You can also create arguments using other operators. For example, if

you select “<”, all meter periods greater than the entered period will dis-

play on the report. If you select “=>”, all read periods equal to or less

than the entered read period will display on the report.

l The AND and OR buttons will be enabled after you add the argument to the

report. The AND and OR buttons are used to link the conditions of an argu-

ment together so you can build more complicated filtering.

l Click the AND button to add another condition to the argument already

entered. For example, if you would like to filter the report by reading

period and reading year, click the AND button between arguments. Both

conditions will be applied when the report is generated and only records

that match both the read period and read year will be included on the

report.

l Click the OR button if you would like a record that matches either con-

dition to be included on the report. For example, if you would like to

include customer accounts on a report if they have bank information

entered on their account you should join the two conditions with the OR

button.

l The brackets are used to define the order in which the AND and OR

statements will be applied. Arguments within brackets will be calculated

before arguments outside of brackets.  For example, you can create an

OR statement inside an AND statement using the following format:

(statement 1 OR statement 2) AND (statement 3 OR statement 4). The
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OR statements inside the brackets will be processed first, and then the

AND statement will be applied.

l Click the AND button since we want to filter by the read period and the read

year. Select Read Year in the drop-down menu below the Table Name field,

select Equals, and enter “2020”, and then click the Plus button to add the con-

dition to the argument.

5     Set the number of records that will display on the report. 

l The Limit field in the Primary Table section is used to define the maximum number

of records that will display on the report. If you set this value to a very large number

(99,999,999,999) you run the risk of creating a report that will take a long time for

your server to process.

6 Modify the report layout. 

l After the fields have been selected and the arguments have been entered on the

report you are ready to set up the report layout. The report layout allows you to

define how the report will be grouped and totaled, and also allows you to select

which fields will total.

l Click the Modify Report Layout icon to open the QBE Layout window.
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l Move the columns that display in the QBE Report Layout section to change the

order in which the information will display on the report.

l Move column headings to the section above the column headings to change how

the information is grouped on the report. For example, if you modified the argument

to include multiple read periods you can move the Read Period column to the upper

section and group the records that display on the report by read period.

l The Column Totals section is used to select which columns should be totaled on the

report. Check the toggle of the totals you would like to include on the report.

l Only columns that would provide a meaningful total will be available in the

Column Totals section. For example, UB account number will not display in

the Column Totals section because a total of the account number field

wouldn’t have any meaning (000001-000+0000002-000).

l Click the Save icon when complete to save the report layout. The QBE report

will print in the saved format when the report is generated.

7     Save the report. 

l Enter a name for the report in the Report Name field.

8     Print or export the report. 
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l Click the Print icon to process the report immediately. You can view the pro-

gress of the report on the Job Viewer window (SS> Utilities> Show Scheduled

Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Click the Export icon drop-down menu to select the export format. A window will

open allowing you to select the path where the exported file will be created.

l If your report appears to be missing information but your filters seem to be correct,

make sure the Limit field in the Primary Table section contains a large enough num-

ber to contain all of the records you want to include in the report.
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UB> Maintenance> Route

Route Maintenance

Summary

The Route Maintenance window is used to create and maintain meter routes. A meter route

is a group of meters that are read and entered into the application as a batch. When meter

readings are exported to handheld devices (UB> Meter Management> Readings Export) or

manually entered (UB> Meter Management> Input New) they are exported or entered by

meter route.

Meter routes are added to a device when a service request is created to install the device.

The meter route of a meter can also be modified using the Device Maintenance window

(UB> Maintenance> Device, or you can open the window from a customer account in UB>

Maintenance> Account> Devices).

If you would like to split a meter route into two separate meter routes, use the Pad Meter

Sequences utility (UB> Utilities> Pad Meter Sequences).

Step by Step

1     Open the Route Maintenance window (UB> Maintenance> Route). 
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l Highlight a route in the left section of the window and the fields in the Maintenance

section will populate with the information from the selected route.

l When modifying an existing route you will not be able to change the value in

the Route Number field. You cannot modify the route number field once a

route has been saved.

l Click the Delete icon to delete the selected route.

l You cannot delete a route that is attached to a meter.

l Click the Create icon to create a new route. This will create a new line item in

the left section of the window and the fields in the Maintenance section will be blank.

2     Create a new route. 

l Enter a Route number.

l The route number must be unique and match the route number format set up

in UB> Utilities> Setup> Device tab> Route Format field.

l Enter a Description of the route.

l The route description can be up to 40 characters long.

l Click the Save icon to save the meter route.
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UB> Maintenance> Service

Service Maintenance

Summary

The Service Maintenance window is used to create and maintain up to 20 services. When

charges are generated on UB customer accounts, the charges are grouped onto a service.

A service represents a unique balance on the customer account and the balance of each

service will display separately on billing statements. For example, all water service charges

are billed using the WATER service. Charges related to other services, such as ELECTRIC

or CONNECTION, will display separately on the billing statement. Since the total balance

of a UB customer account is divided into separate services, you can have a credit balance

in one service and a debit balance in another. Use the Redistribute Credit Balances pro-

cess (UB> Transactions and Fees> Redistribute Credit) to redistribute the credit balance

on a service to services with a debit balances.

Services are attached to customer accounts when they are created using the New Account

Wizard and can be attached to existing customer accounts using the Service Rates tab of

the Account Master Maintenance window (UB> Maintenance> Account> Service Rates

tab). Each service attached to the customer account will display as a separate balance on

the Overview tab of the Account Master Maintenance window or when reports are gen-

erated. When bills are generated in UB> New Billing, the service rates that will be included

in the billing can be filtered by service.
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Services will also determine how partial payments are applied to outstanding balances.

When partial payments are received, the payment priority set up on the Payment Priority
field on the Payment tab of the Setup window (UB> Utilities> Setup) will determine how the

partial payment is applied. If Age then Priority is selected, the partial payment will be

applied to the oldest debt first. If the partial payment covers all of the old debts, then the par-

tial payment will be applied to the service with the highest priority that has the same age. If

Priority then Age is selected, the partial payment will be applied to the service with the

highest payment priority first.  Payments will be applied to the oldest debts within that ser-

vice first. The payment priority of a service is set up in the Service Maintenance window.

After services have been created in UB> Maintenance> Services, service rates can be

attached to services in UB> Maintenance> Service Rates. The service rates will determine

the rate that will be applied to the consumption on a meter, minimum billing amount, and

how the billing will prorate or average.

Step by Step

1     Open the Service Maintenance window (UB> Maintenance> Service). 

l Select a service in the left section of the window and the fields in the Maintenance

section will populate with the information of the service.

l Modify the fields in the Maintenance section and click the Save icon to

save the changes.
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l The Service Number field will not be enabled on a service that has

already been created. This field will only be enabled when the service is

created.

l Select a service and click the Delete icon to delete a service. You will not be

able to delete a service that is attached to an account.

2     Create a new service. 

l Click the Create icon to create a new service. This will add a new line to the left

section of the Service Maintenance window.

l You are limited to 20 services. If you have already created 20 services you will

not be able to add a new one.

l Enter a Service Number. Service numbers are limited to two digit numeric char-

acters.

l The Service Number must be unique and between 1 and 20 because you are

limited to a total of 20 services. The service number cannot be 00.

l Enter a Service Name that is up to 20 alphanumeric characters long.

l Enter a Service Abbreviation that is up to eight alphanumeric characters. The Ser-

vice abbreviation will show up on some reports instead of the Service Name.

l When partial payments are received the entries in the Payment Priority field and

Pay First toggle will determine how the partial payment is distributed among the ser-

vice rates. The age of the bill is also taken into consideration.
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l Enter a number in the Payment Priority field to prioritize the order that ser-

vices are paid off with partial payments. A service with a Payment Priority of

00 will have partial payments applied to it first if all the other unpaid bills are

the same age.

l Check the Pay First toggle if you want this service to be paid off in full prior to

distributing the remaining dollars of a partial payment to other services. If a

partial payment is being applied to a bill with two services that are both set up

as Pay First, the partial payment will first be applied to the Pay First service

with the lower Payment Priority.

l Enter an Overpayment Percentage amount. The Overpayment Percentage field is

used to distribute overpayments to services based on a fixed percentage. In order

to use this feature, Fixed Percentage must be selected from the Overpayment Dis-

tribution field (UB> Utilities> Utility Billing Setup> Payment tab).

l When an overpayment is entered, the amount of the overpayment will be

applied to the services on the customer account based on the proportion of

the overpayment percentages. For example, if there are two services on the

account (water = .25, electric = .50), 33% of the overpayment will be applied

to the water service and 66% will be applied to the electric service.

l Enter a Service Group or click the field label to select one from a list.

l Service groups are used to group services together and are created and main-

tained on the Service Group Maintenance window (UB> Maintenance> Ser-

vice Group).

l Click the Save icon to save the service.

l Services can be attached to customer accounts using the Account Master

Maintenance window (UB> Maintenance> Account> Service Rates tab).
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Services are attached to new customer accounts when they are created using

the New Account Wizard. You can add the service to an account template

(UB> Maintenance> Account Template) if the service is regularly attached to

new UB customer accounts.
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UB> Maintenance> Service Group

Service Group Maintenance

Summary

Service Groups are used to organize UB services in user-defined groups. These groups

are then used to organize services that are included in the UB Collections process.

Step by Step

1     Open the Service Group Maintenance window. 

l The Service Group Maintenance window (UB> Maintenance> Service Group) will

display all of the service groups that have been created in the application.

l Highlight a service group and click the Delete icon or press DELETE to delete

the selected service group.

l Click the Create icon or press INSERT to create a new service group. This will

create a new line item in the data grid below and enable the Maintenance section to

the right.
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2     Create a new service group. 

l Enter a Code for the new service group.

l This field can accommodate up to 20 alphanumeric characters. Once a Code

is entered, it cannot be edited.

l Enter a Description for the service group.

l The description can be up to 64 characters long.

l Click the Save icon when complete.
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UB> Maintenance> Service Rate

UB Service Rate Maintenance

Summary

The Service Rates window is used to create and maintain service rates and service rate

revisions. Service rates are attached to customer accounts and determine the rate struc-

ture, winter average, taxes, bill type and prorating options of a billing. The service rate will

calculate charges on the consumption on meters with the same bill type and the charges

will be billed to the service attached to the service rate. Once service rates have been cre-

ated they can be attached to customer accounts on the Service Rates tab of the Account

Master Maintenance window (UB> Maintenance> Account> Service Rates tab> Create

icon).

There are no units of measure (gallons, cubic feet, etc.) attached to the service rate. The

service rate will be applied to the consumption as it was read on the meters. For example, if

there were 100 units of consumption read on the meter during the billing period, then the

service rate will be applied to the 100 units regardless of the type of unit the meter was

reading (gallon, cubic feet, etc.). If there are meters of multiple unit types in the same billing

batch, or if the consumption should be converted to another unit type as the billing is being

calculated, you can convert the consumption using the consumption conversion table (UB>

Maintenance> Consumption Conversion).
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When new bills are generated (UB> New Billing), there is a Convert Consumption To
drop-down menu that allows you to convert the consumption read on the meters to a dif-

ferent unit type. The consumption will be converted to the unit type using the conversion for-

mula set up in the conversion table (UB> Maintenance> Consumption Conversion), and

the service rate will be applied to the modified consumption on the meter. For example, if

the consumption was read in cubic feet and is changed to gallons, the consumption read on

the meter (100) will be multiplied by the conversion amount (7.48000) and then the service

rate will be applied to the modified consumption amount (748).

The Service Rate Maintenance window allows you to set up a separate rate structure for

each usage period. Usage periods are typically used to charge UB customers different

rates for peak and non-peak usage. Consumption is generally separated into the usage

periods by the meter and then imported into the Springbrook application as separate con-

sumption values when meter reads are imported (UB> Meter Management> Readings

Import). For example, peak consumption is placed in usage period 1 and non-peak con-

sumption is placed in usage period two. When a billing is generated (UB> New Billing),

charges are applied to the imported consumption based on the unique rate structure of

each usage period set up on the service rate. For example, if peak usage is usage period 1

and non-peak usage is usage period 2, the rate structure for usage period 1 will apply to

usage period 1 consumption and the rate structure for usage period 2 will apply to usage

period 2 consumption.

Step by Step

1     Open the Service Rate Selection window (UB> Maintenance> Service Rate). 
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l The Service Rate Selection window will display all of the service rates and rate revi-

sions that have been created.

l Service Rate revisions are modifications to an existing service rate that will

take effect on a certain date, replacing the previous service rate revision.

l New service rates are neither revisions of previous service rates nor service

rates that have already been created.

l Right click on the window and select Export grid contents to Excel to create an MS

Excel spreadsheet of the information that displays in the window. This will create a

list of service rates and the services they are attached to. You do not have to

expand the services in order for the services attached to a service to display on in

the export.

l The Overpay Percentage column will display the overpayment percentage

amounts set up on the Service Maintenance window (UB> Maintenance> Service).

Overpayments will be applied using these overpayment percentages if the UB mod-

ule is set up to distribute overpayments based on fixed amounts (UB> Utilities>

Setup> Payments tab> Overpayment Distribution field).

l Click on the Expand button next to a service to display the service rates attached to

the selected service.

l Click on the Expand button next to a service rate to view all of the revisions attached

to the selected service rate.

l Select a service and click the Print icon to generate a service report that

includes basic information for the latest revision of each service rate within the selec-

ted service.

l The service report will display the Rate Code, Description, Minimum, Tax

Codes, and GL Accounts for each service rate included in the selected
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service. The report will also display Period, Level, and Rate information for

each rate code.

l Click the Delete icon to delete the selected service rate revision. If you delete all

of the revisions attached to a service rate, the service rate will also be deleted.

l You will not be able to delete a service rate that is attached to customer

accounts.

l The Create icon in the Service Rates window is used to create a service rate or

service rate revision. There is a drop-down arrow next to the Create icon allowing

you to select which you would like to create.

l The service rate option is the default function of the Create icon. Clicking the

Create icon without selecting the service rate revision option will create a ser-

vice rate.

l Pressing INSERT at any time will create a service rate.

l Creating a service rate will also create an initial service rate revision.

l The service rate revision option will only be enabled after a service rate has

been selected in the window. The Revision option will create a service rate

revision of the selected service rate.

l Click the Create icon to create a new service rate. This will open the Service

Rate Maintenance window.

2     Complete the General tab. 
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l The Service Rate Maintenance window is divided into four tabs: General, Cons

Levels, Winter Average/Taxes, and Percentage Based Cons Levels.

l The General tab contains all of the general information on the service rate.

l The Cons Levels tab contains all of the consumption level breaks.

l The Winter Average/Taxes tab contains the winter averaging periods and tax

codes attached to the service rate.

l The Percentage Based Cons Levels tab contains the rate tiers used to base

the service rate on a percentage of Winter Average consumption.

l The Revision Number field will display the revision number of the service rate revi-

sion being created. If you are creating a new service rate, the Revision Number will

be 0, because it is the initial revision number.

l If you are creating a service rate revision, the Revision Number will be one

plus the previous service rate revision on the service rate.

l The value in the Revision Number cannot be modified.

l Enter a Service Code. The service code can be up to six alphanumeric characters

long.

l If you are creating a service rate revision, the Service Code field will be dis-

abled and will display the service rate of the revision that you are creating.

You will not be able to modify the value in this field.

l After a service rate code has been created and saved, you cannot change the

value in the Service Code field. If you want to modify the value in the field, you

will have to create a new service rate code with the desired service code.

l Enter the Description of the service rate code. The description can be up to 32

alphanumeric characters long.
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l Enter the Effective Date of the service rate. The effective date is the date the ser-

vice rate revision will become active. If you are creating a new service rate code, the

effective date is the date the initial revision of the service rate code will take effect.

l Click the drop-down menu to select a date from a calendar.

l If the effective date occurs during a billing, the consumption and minimum

amount on the billing will prorate based on the effective date and the either

the billing dates or the read dates on the account.

l If the Prorate by read date toggle on the Service Rate Maintenance

window is checked the billing will prorate based on the read date of the

meters on the billing. For example, if meters are read on the 15th of

each month and the service rate becomes active on the 11th, only five

days of the billing will be calculated using the new service rate struc-

ture.

l If the Prorate by read date toggle is not checked, the billing will prorate

based on the period begin and period end date. For example, if the

billing is for the 1st to the 30th and the new rate revision becomes active

on the 11th, 2/3 of the consumption and minimum amount will be billed

using the new service rate revision.

l The Prorate consumption and Prorate minimum toggles do not have

to be checked for the minimum and consumption to prorate based on

the effective date of the service rate revision.

l Enter an amount in the Minimum field to specify a base or flat charge on the service

rate.

l If the Flat Rate toggle is not checked, the amount in the Minimum field will be

treated as a minimum amount. This means the minimum amount will be
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charged and meter consumption will be included on the billing. For example, if

$25 is entered in the Minimum field, the billing will charge the $25 as well as

the consumption on the meters.

l If the Flat Rate toggle is checked, the amount in the Minimum field will be

treated as a flat rate. This means that the flat amount will be charged on each

billing and the consumption on the device will be ignored. For example, if $25

is entered in the Minimum field and the Flat Amount toggle is checked, the

consumption on the meter will not be included on the billing.

l The minimum or flat amount will prorate on new and final billings depending

on the other toggles checked on the Service Rate Maintenance window.

l The following toggles affect how the minimum/flat amount will prorate

on a billing:

l Prorate minimum toggle

l Prorate high toggle

l Enter the Unit Size. The consumption on the device will be divided by the value in

the Unit Size field. The modified consumption amount will then be applied to the con-

sumption level breaks.

l The type of units that consumption will be measured in is set up on the device

type of the device that is being used to read consumption (UB> Maintenance>

Device Type> Device tab (For example: Water)> Unit Type field).

l Click the Bill Type field label to select a bill type from a list.

l The Bill Type field is important because it determines which meters on the cus-

tomer account will be billed by the service rate. When bills are generated

(UB> New Billing), the service rate will be applied to all meters on the cus-

tomer account with the same bill type. For example, if you select “WATER” on
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the service rate, the service rate will be applied to the consumption on all

meters set up with the “WATER” bill type on the customer account.

l Attach general ledger accounts to the service rate.

l Click on the field label of the Revenue Account, AR Account or Cash

Account field to select a general ledger account from a list.

l By default, the window will display the general ledger accounts in the current

fiscal year. If you are creating a service rate revision that will not become act-

ive until a future fiscal year, make sure that the selected GL accounts will be

active in the next fiscal year.

l If a selected general ledger account is not active in the next fiscal year,

you may have problems when you try to generate charges on the ser-

vice rate code.

l Attach a Budget Account to the service rate.

l A budget account should be added to service rates that will be used in the

Budget Billing process. This account records the difference between a cus-

tomer's budget billing amount and the actual charge amount.

l This account is intended to act as a liability account, recording the budgeted

payment amounts that are initially higher than the actual bill amounts.

l Define how you would like to round the charges generated on the service rate code

in the Round Amount To field. Rounding options are also set up on the UB module

Setup window (UB> Utilities> Setup> Billing tab). The Setup window is used to

round consumption and the amount billed on a service.

l Enter 1.00 in the field to round the charges to the nearest dollar amount.

l Enter 0.10 to round the charges to the nearest dime.
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l Enter 0.01 to round the charges to the nearest penny.

l By default, 0.00 will be in the field. Since the flat rate cannot be a dollar value

less than a penny and the consumption will round based on Setup window

(UB> Utilities> Setup> Billing> Consumption Rounding field), setting the

Round Amount To field to 0.00 is the same as setting it to 0.01.

l The Convert Cons To field is used to convert the units read on the meter to another

unit set up on a conversion table. For example, if a water meter measures con-

sumption in US gallons, but that consumption amount needs to be converted to

cubic feet, a conversion value of 0.134 needs to be applied to the consumption

value in gallons (1 US gallon = 0.134 cubic feet).

l Select No Conversion to bill the service rate consumption as it is read on the

meter. For example, if 100 units of consumption were read on a meter during

a billing period, the service rate will be applied to those 100 units regardless

of the unit type (gallons, cubic feet, etc.).

l Units are attached to device types using the Water Meter Device Main-

tenance window (UB> Maintenance> Device Type> Device tab> Unit

Type drop-down menu).

l Any conversion that is set up as a convert to value on the conversion table will

display in the drop-down. For example, if Feet is entered in the Convert To

field on the Consumption Conversion Maintenance window (UB> Main-

tenance> Consumption Conversion> Convert To field), the value will display

in the Convert Cons To drop-down menu.

l The Percent Based On field is used to set up the service rate to calculate con-

sumption based on a percentage of the Winter Average value.
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l IfWinter Average is selected, the Percentage Based Cons Levels tab will be

enabled. See step number 5 below for more information on setting up the rate

tiers needed to calculate consumption based on a percentage of the Winter

Average value.

l By default, this field will be set to Not Used in order to prevent any impact on

existing service rates.

l Check the Flat Rate toggle if consumption on the service rate should be ignored

and the value in the Minimum field should be charged as a flat rate. When a bill is

generated on a customer account, the consumption on the meter will not be billed

and only the flat rate amount will display on the billing.

l The function of the Multiply Minimum, Multiply Consumption and Multiply Con-

sumption Level toggles depend on the selection in the Use Lot Units toggle.

l If the Use Lot Units toggle is checked, the consumption or minimum amount

on the service rate will be multiplied by the Number of Units field on the lot.

You can view the Number of Units on the customer account (UB> Main-

tenance> Account> Lot tab> Lot sub-tab> Details section> Number of Units

field).

l If the Use Lot Units toggle is not checked, the EDU field attached to the

meter on the account will be used. The meter EDU field is set up on the Con-

nections tab of the Device Maintenance window (UB> Maintenance> Device>

Connections tab> EDU column).

l By default, the EDU column will not display on the Connections tab.

Right-click a column heading and select the EDU field from the menu to

display the column in the grid.
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l Check the Multiply Minimum toggle if you would like the service rate minimum mul-

tiplied by the Lot EDU value or the Meter EDU value.

l Check the Multiply Consumption toggle if you would like the calculated winter

average consumption to be multiplied by the EDU on the meter or the number of

units on the lot when a billing is generated (UB> New Billing). The winter average

consumption will be multiplied by the EDU/Lot Unit value before the service rate

structure is applied to the consumption when the billing is calculated. For example,

if the EDU is 1.1 and the calculated winter average consumption is 200, the winter

average consumption will be multiplied by the EDU (220). The rate structure on the

service rate will then be applied to the new consumption amount (220).

l If the Use Lot Units toggle is not checked, the calculated winter average will

be multiplied by the EDU value on the meter (UB> Maintenance> Account>

Devices> Connections tab> EDU column). If the Use Lot Units toggle is

checked, the calculated winter average will be multiplied by the number of

units on the lot.

l Check the Multiply Consumption Level toggle if you would like to multiply the con-

sumption amount of each level break on the rate structure of the service rate by the

meter EDU or lot units. For example, if consumption between 0 and 1000 units is

charged $.035 per unit and the meter EDU is 1.25, the rate structure will change to

between 0 and 1250. The rate of $.035 will not change.

l If the Use Lot Units toggle is checked, the rate structure of the service rate

will be multiplied by the lot units.

l If the Use Lot Units toggle is not checked, the rate structure of the service rate

will be multiplied by the meter EDU (UB> Maintenance> Account> Devices>

Connections tab> EDU column).
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l This toggle can be used in conjunction with the Multiply Consumption

toggle if you would like the consumption amount and rate structure both to be

multiplied by the meter EDU or the lot units.

l Check the Prorate Minimum toggle if you would like to prorate the value in the Min-

imum field. This will prorate the amount for final billings or new accounts within the

billing period. This will enable the Prorate High toggle.

l If you backdate a final billing from the Final an Account Wizard, you must

have the Prorate Minimum toggle checked or the minimum amount will not pro-

rate.

l Check the Prorate High toggle if you want to charge the full minimum charge

amount if the consumption is greater than the first level break. If the consumption

falls within the first level break, the minimum charge will be prorated by the per-

centage of the billing period.

l Check the Prorate Consumption toggle if you would like the consumption asso-

ciated with the winter averaging process to be prorated by the percentage of period

the rate was effective for.

l Check the Prorate Steps toggle if you would like the consumption amount level

breaks associated with each tier of the service rate to be prorated by the percentage

that the service rate was effective during the period. This affects the winter average

process.

l Check the Bill greater amount flat or consumption toggle if you would like to bill

the consumption or the minimum amount based on which is larger. For example, if

the minimum amount is $45 and the calculated consumption on the service rate is

$35, the customer account will be billed the minimum amount on the service rate.
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l When this toggle is checked, the customer will only be charged the minimum

or the consumption amount, not both.

l This toggle does not apply when the Flat Rate toggle is checked because con-

sumption does not apply to flat service rates.

l Check the Container Rate toggle if the rate is used for containers. Containers are

attached to accounts using the Containers tab on the Account Master Maintenance

window.

l The Round Consumption toggle has not yet been implemented.

l Check the Group Consumption toggle if all consumption on the service rate

should be billed under the first usage period set up on the Cons Level tab.

l When this toggle is checked, the system will first calculate the total con-

sumption across all time use periods set up on the Cons Levels tab. The

billing engine will then calculate the service rate bill amount based on this

total consumption and the rate specified on the first time use period set up on

the Cons Levels tab.

l This toggle is often used when setting up a taxation service rate.

l Check the Prorate by read date toggle if you would like the service rate to prorate

based on the read date attached to the meter. The function of this toggle will affect

the function of the prorate minimum, prorate consumption and prorate steps

toggles.

l For example, if the meter read date is 06/15/21 and the billing period ends on

07/01/21, the minimum amount or consumption will prorate based on the

days.

l If you do not check this toggle the service rate will prorate based on the con-

nection date of the service rate.

UB SERVICE RATE MAINTENANCE 442



l Check the Use Special Multiplier toggle if you would like the special multiplier

attached to the customer accounts to affect the billable amount calculated on this

service rate.

l When this toggle is checked, the billing engine will look to the Multiply flat by spe-

cial multiplier and Multiply cons by a special multiplier toggles on the Billing

tab of the Setup window to determine how the special multiplier will affect the billing.

l Special multipliers are attached to customer accounts using the Account

Master Maintenance window (UB> Maintenance> Account> Service Rates

tab> Select a service rate> Special Multiplier field).

l Check the Use actual reading if winter average is not available toggle if you

would like to bill the actual consumption on a meter if no winter average has been

calculated on a UB customer account.

l Check the Multiply level by demand toggle if you would like the system to multiply

the consumption level by the demand consumption value.

l The Multiply consumption level toggle must be checked as well in order for

this toggle to affect consumption calculations.

l The Character fields are user-defined miscellaneous fields attached to the service

rate.

l The character field labels are maintained on the Miscellaneous Field Label

Maintenance window (SS> Utilities> Miscellaneous Field Labels).

l Open the Cons Level tab to set up the rate structure of the service rate.

3     Complete the Cons Levels tab. 
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l The Cons Levels tab is used to enter consumption level breaks on the service rate.

This is where the rate structure is set up on the service rate. If you are using multiple

usage periods, you can enter a rate structure on each usage period.

l Usage periods are generally used to charge separate rates for peak and non-

peak usage. Each usage period will display as a separate line item in the win-

dow, and you will be able to enter a level break for each usage period.

l If you are not using usage periods, a single line item labeled “1” will display in

the window. The “1” represents the single usage period that will be used for all

consumption read on the meter. Enter the level breaks in this single usage

period.

l Click the Expand button next to a usage period to display the level breaks set

up on that usage period. The Expand button will only display if level breaks

have already been added to a usage period.

l Press INSERT to create a new consumption level break to the selected usage

period. This will create a new line item under the usage period.

l Enter the consumption level that you would like the level break to begin at in

the Minimum Consumption column.

l Enter the rate that will be applied to the consumption greater than the min-

imum consumption amount in the Rate column. This is the rate that will be

charged on each unit of consumption after the Unit Size field (General tab on

the Service Rate Maintenance window) and consumption multiplier toggles

have been applied to the consumption.

4     Complete the Winter Average/Taxes tab. 
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l Open the Winter Average/Taxes tab. The Winter Average/Taxes tab is used to

attach tax rates to the service rate code and to select the calendar months that

winter averaging will be used.

l Check the periods you would like to bill using the winter average rather than the

actual consumption on the meter. UB customer accounts will be billed using the

winter average amount calculated using the Winter Average process (UB> Winter

Average) rather than the actual consumption on the meter. If a UB customer

account attached to this service rate does not have a calculated winter average, the

customer will only be billed the flat/minimum amount on the service rate.

l Winter averages are generated on accounts by billing cycle in UB> Winter

Averages.

l Check the Cap Consumption toggle to bill the lesser amount of the actual bill or

the winter average consumption.

l The Tax Code field is used to attach taxes to the service rate code.

l Tax codes are created and maintained on the Tax Code Maintenance window

(UB> Maintenance> Tax Code).

l Press INSERT to create a new line item in the Tax Code field and attach a tax

code. This will open a window to select a tax code from a list.

l Click the Save icon when complete to save the new service rate or revision.

l Service rates can be attached to UB customer accounts using the Account

Master Maintenance window (UB> Maintenance> Account> Service Rates

tab).

5     Complete the Percentage Based Cons Levels tab (enabled based on General tab settings). 
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l If the Percent Based On field on the General tab is set to Winter Average, the Per-

centage Based Cons Levels tab will be enabled.

l This tab is used to set up rate tiers based on a percentage of Winter Average con-

sumption. Agencies can use this functionality to encourage or discourage con-

sumption that exceeds winter average levels by reducing or increasing the rate

charged for that consumption.

l Percentage based consumption levels will only be used to calculate billing

amounts when the service rate is set up to use winter averaging AND winter

averaging is being calculated for the current billing period.

l If the service rate is set up to use winter averaging but winter averaging is not

being calculated during the current billing period, the standard Cons Levels

will be used to calculate billing amounts.

l Click the Create icon to add a new consumption level to the data grid below.

l The first consumption level added to the data grid will be assigned level num-

ber 1. Each subsequent level added will be assigned the next available level

number.

l The Minimum Percent and Rate columns can be edited on new or existing

consumption levels.

l Enter the percentage of the winter average value that you would like the

level break to begin at in the Minimum Percent column.

l Enter the rate that will be applied to the consumption greater than the

Minimum Percent value in the Rate column.

l By setting up the appropriate rate tiers, an agency can encourage or dis-

courage usage that exceeds the winter average level.
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l For example, if an agency wanted to discourage citizens from

using more water than the winter average amount, that agency

could set up a very simple set of percentage based cons levels.

l Cons Level Minimum Percent Rate

1 0.00 1.50000

2 100.01 2.00000

3 125.01 3.00000

l In this example, an agency would charge the standard

1.50000 rate for all water usage from 0.00% to 100.00% of

the winter average value.

l Water usage from 100.01% to 125.00% of the winter aver-

age value would be charged the higher 2.00000 rate.

l Any water usage above 125.01% of the winter average

amount would be charged at the 3.00000 rate.

l A standard, single-level consumption rate of 1.50000 is

used in order to provide a simple rate tier example. Organ-

izations that use multiple consumption levels will need to

set up a more complex set of rate tiers.

l Highlight a consumption level and click the Delete icon to delete the selected

row. If the data grid includes any other consumption levels, they will be auto-

matically renumbered if necessary.

l Click the Save icon when complete to save the consumption levels.
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UB> Maintenance> Service Request
Code

Service Request Code Maintenance

Summary

The Service Request Code Maintenance window is used to create and maintain service

request codes. A service request code acts as a template when creating individual service

requests because it defines what type of service is being performed by the service request

(add a new device, device change out, new account, device reading, etc.) and if the service

request is set up as billable.

The information set up on the service request codes are default values and can be

changed on the individual service request. For example, when service requests are cre-

ated using the Service Request Input Wizard, you do not have to enter the same inform-

ation on the service request that is required by the request type (add device, remove

device, read device, etc.). If you are creating an Add Meter service request but you do not

add a device to the service request, the request will be processed like a Show Device ser-

vice request.
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Attach a fee code to a service request code to create a billable service request code (fee

codes are created and maintained in UB> Maintenance> Fee Code). After a billable service

request code has been closed and committed, it can be processed in UB> Cash Receipts>

Bill Service Requests to charge the customer the fee code attached to the service request

code.

Step by Step

1     Open the Service Request Code Maintenance window (UB> Maintenance> Service Request
Code). 

l Service request codes that have already been created will display in the left section

of the window.

l Select a service request code and the fields in the Maintenance section will pop-

ulate with the information of the selected service request code.

l Click the Delete icon to delete a service request code. If there are service

requests attached to the selected service request code you will not be able to delete

it.

2     Create a new service request code or open an existing one. 
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l Click the Create icon to create a new service request. This will create a new

record in the left section of the window and the fields in the Maintenance section will

be blank.

l Enter a Request Code. The Request Code can be up to six alphanumeric char-

acters and must be unique.

l After a service request code has been entered and saved, the value in the

Request Code field cannot be modified.

l Enter a Description to identify the Request Code. The description can be up to 30

alphanumeric characters.

l Select a Service Type from the drop-down menu.

l The service type defines the action that is being performed on the customer

account and acts as a default for how the service request should be pro-

cessed. When service requests are created using the Service Request Input

Wizard, you do not have to enter the same information on the service request

that is required by the service type. For example, if you are creating an Add

Meter service request but you do not add a device to the service request, the

request will be processed like a Show Device service request.

l The request types are preprogrammed into the software and cannot be mod-

ified.

l The Add Device service type is used to install a device on an account.

l The Remove Device service type is used to remove a device on an account.

When the service request is committed, the device will change to Removed

status on the account.
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l In order to reinstall a removed meter on an account you can create a

Reactivate Device service type to change the status of the removed

device from Removed to Installed.

l The Change-out Device service type is used to remove a device on the

account and replace it with a new device.

l The Final Account service type is used to input a final read on a device, enter

the forwarding address on the account, and change the account to Sus-

pended status when the service request is committed in UB> Service

Requests> Commit.

l Once the final account service request has been committed, the

account will can be finaled using the Final Account Wizard (UB> Final

Billing> Final Accounts).

l This is an optional service request because you can run the Final

Account Wizard on an account without processing a Final Account ser-

vice request on the account.

l The New Account service type is used to change the status of an account

from Suspended to Active status. When an account is created using the New

Account Wizard, by default the status of the created account is Suspended

because there can be only one active account on a lot. In order to change the

account to Active status, you can either process a New Account service

request or change the account status manually (UB> Maintenance> Account>

Account tab> Account Status field).

l This is an optional service request because you can manually change

the status of the customer account to Active (UB> Maintenance>

Account> Account tab> Account sub-tab> Status field).

l The Read Device service type is used to enter a meter read on a device.
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l The Show Device service type is similar to a Read Request type but is does

not require you to enter a device reading. This type of service request is gen-

erally used for inspection requests such as water discoloration.

l If you leave the Service Type field blank, no device information such as the

device location will be attached to the service request. The service request

will only include the customer information.

l If you would like the device information to display on the service request

but you do not want to enter a device reading, select Show Device.

l When you are creating service requests in the Service Request Input Wizard

(UB> Service Requests> Input> Create icon) you can select the devices that

are attached to the service request. No matter which service request code

you select, if you do not select a device the service request will be processed

just like a blank request type service code. The service request will only

include the customer account information. It will not include any device inform-

ation such as the device location.

l Create a billable service request. If the service request is billable, complete the Fee

Code and Default Charge fields.

l When creating a service request that is set up as billable, users will have the

option to remove the charges if they do not apply. When the service is created

using the Service Request Wizard the default charge can be changed to zero.

The service request will still display in the Bill Service Requests window (UB>

Cash Receipts> Bill Service Requests) in order to track that the charges have

been zeroed, but not charges will be applied.

l Click the Fee Code field label to select a fee code from a list.
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l The fee code attached to the service request will determine which gen-

eral ledger accounts will be used when generating the service request

fee. Fee codes are created and maintained in UB> Maintenance> Fee.

l If you attach a fee code to the service request code, make sure that the

service charged by the fee code will be attached to the customer

account. If the service is not attached to the customer account, you will

receive an error message when you run the Bill Service Requests pro-

cess (UB> Adjustments and Fees> Bill Service Requests).

l The service request fee will be billed to the service attached to the fee

code in UB> Maintenance> Fee Code> Service to Charge field. This

service will be charged no matter which device types you attach to the

service request.

l Enter a Default Charge.

l The Default Charge field will default with the flat amount on the fee

code.

l Flat Amounts are set up on fee codes in UB> Maintenance> Fee Code> Flat

Amount field.

l If you modify the value in this field from the default amount, the modified

amount will override the flat amount on the fee code when the service

request is billed.

l When a service request is created using the Service Request Input Wiz-

ard, you can modify the charge for a service request from the default

amount.
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l If you do not enter an amount in the Default Charge field, you can enter

the amount on each service request when they are created using the

Service Request Input Wizard.

l If you want to bill customers at different rates for a service request, you

will have to create separate service request codes or just enter the dif-

ferent rates when the service request is created.

l When a service request is closed and committed (via UB> Service Requests>

Commit), the customer will not be billed. The customer account will not be

billed for a service request until it has been processed (UB> Adjustments and

Fees> Bill Service Requests).

l Select a Device Type from the drop-down menu if you would like to attach a default

device type to the service request code. This is not a required field.

l When a service request is created using the Service Request Input Wizard

(UB> Service Request> Input), users select which devices will be included on

the service request. If there is a device on the customer account that is the

same as the default device type on the service request, then the device will be

automatically selected.

l The default device type is only a default process used to reduce data entry on

service requests that are generally performed on a certain type of device type.

If the default device type is not on the customer account being processed,

then no device will be selected and the default device type will not apply. If the

default device is present on the customer account but it should not be used on

the service request, you can deselect the device when the service request is

being created.
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l The default device type on the service request code does not apply to service

requests that create or add a device to an account. When a new device is cre-

ated using the Service Request Input Wizard, the default device type set up

on the service request code will not populate on the service request. The ser-

vice request will populate with the default device type set up in device type

maintenance (For example, if it is a water meter, water meter device types are

set up in UB> Maintenance> Water Device Type).

l All of the default device types attached to the customer account will be selec-

ted on the Service Request Input Wizard. If there is more than one default

device type attached to the customer account, they will all be selected.

l Click theWO Number field to associate a recurring estimate with the service

request code.

l By associating a recurring estimate with a service request code, you can auto-

matically create a new work order to address the needs of the service request

code. For example, your organization may need to create a work order to dis-

patch a technician every time a water meter needs to be changed. In order to

automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.
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l When a service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l A service request code that is associated with a recurring estimate can

be used to create a service request from the Work Order Maintenance

window (WO> Work Orders> Work Orders> Service Requests tab> UB

Service Request icon ).

l Click the Assign To field to assign a default user to the service request code.

l This field is designed to improve efficiency by automatically assigning any ser-

vice requests generated from this service request code to a default Spring-

brook user. The user assigned to the service request can be edited when the

service request is created.

l Check the Emergency Request toggle if you use this toggle in reporting. The selec-

tion in this toggle does not affect how the service request will display or be pro-

cessed. This toggle will only affect custom reports.

l The emergency status will be applied to all service requests attached to this

service request code. You will not be able to uncheck the Emergency toggle

as you create the service request using the Service Request Input Wizard.

l Check the Auto Commit toggle if you would like the service request to become com-

mitted when the status of the service request is changed to Closed. Service

requests processed with this service request code will not have to be committed in

UB> Service Requests> Commit.

l Click the Save icon when complete.
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UB> Maintenance> Statement Message

Statement Message Maintenance

Summary

The Statement Maintenance window is used to create and maintain messages that can be

attached to New Billing and Past Dues statements. Once message statements have been

created, they can be attached to statements using the Statement Setup Maintenance win-

dow (UB> Utilities> Statement Setup). Messages can also be attached to statements when

they are being generated in Past Dues (UB> Past Dues> Statement Settings) and New

Billing (UB> New Billing> Statement Settings).

Step by Step

1     Open the Statement Message Maintenance window (UB> Maintenance> Statement Message). 

l The Statement Message Maintenance window will only display messages that have

been created in the Statement Message Maintenance window. Messages manually

entered into the Message Line fields of the Statement Setup Maintenance window

(UB> Utilities> Statement Setup> Miscellaneous tab) will not display in the window.

l Highlight a message in the left section of the window and the fields in the Main-

tenance section will populate with the information of the selected message.
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l Click the Delete icon to delete the selected message.

l If the message is attached to a statement, the message will stay on the state-

ment (UB> Utilities> Statement Setup> Miscellaneous tab> Message Line

fields), but the message will be removed from the Statement Message Main-

tenance window.

l Click the Create icon to create a new message. This will add a new line item to

the left section of the window and the fields in the Maintenance section will be

empty.

2     Create a new message. 

l Select which kind of statement you would like to attach the message to in the

Attach To drop-down menu.

l Enter a Message.

l The message can be a little over five hundred characters in length.

l You can cut, copy, and paste text into the Message field using the MS Word

shortcut keys or right mouse click menu options.

l For example, if you would like to paste in text that has been copied from

another document press CTRL+V to paste the text into the Message

field. You can also paste text into the field by right clicking on the mouse

and selecting Paste from the menu that pops up.
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l You cannot paste images into the Message field.

l Click the Save icon when complete to save the new message.
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UB> Maintenance> Tax Code

Tax Code Maintenance

Summary

The Tax Code Maintenance window is used to create and maintain tax codes. Tax codes

are attached to service rate codes (UB> Maintenance> Service Rate> Open a service rate

revision> Winter Average/Taxes tab> Create icon) and billed on customer accounts as

charges are generated on the service rate.

Step by Step

1     Open the Tax Code Maintenance window (UB> Maintenance> Tax Code). 

l Select a record in the left section of the window and the Maintenance section of the

window will populate with the information of the selected tax code. Edit any of the

fields in the Maintenance section of the window and click the Save icon to

modify a tax code.

l Right click in the left section of the window and select Export grid contents to Excel

if you would like to create an MS Excel spreadsheet of the information that displays
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in the window. This allows you to create a report that displays all of the tax codes

and level breaks.

l Highlight a tax code and click the Delete icon to delete a tax code. If the tax

code is attached to a service rate or UB Detail history record, you will not be able to

delete the tax code.

l Tax codes are attached to service rates in UB> Maintenance> Service Rates>

Taxes section.

l Click the Create icon to create a new tax code. This will create a new line item in

the left section of the window.

2     Create a tax code. 

l Enter a Tax Code. The tax code can be up to six alphanumeric characters in length.

l Click the Target Service field label to select a service from a list. The selected ser-

vice is the service that will be billed the tax amount.

l If you are modifying an existing tax code, do not change the target service

once you have generated history on the tax code. If you want to change the

target service on a tax code, create a new tax code with the modified target

service.

l Services are created and maintained in UB> Maintenance> Service.

l Enter a tax code Description. The description can be up to 80 characters in length.

l Create the tax schedule.
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l The Level Break fields are used to enter the minimum level amount and the

percentage fields are used to enter the tax rate applied to the level break.

l Define the Level Breaks for the calculated dollar amounts.

l The Level Break fields set the minimum amount of a billing before the

percentage of will be applied. If the dollar amount is greater than or

equal to the amount in the Level Break field, the percentage of that level

break will be applied. If the billing is large enough to fall above the min-

imum of a higher number level break, the percentage of that level break

will be applied.

l Enter the Percentage amount to be used based on the level breaks.

l The percentage entered will be applied once the billable amount falls

within the level break.

l Enter the general ledger accounts that will be used on the transactions to record

and generate taxes on the customer accounts.

l Click a field label to select a general ledger account from a list.

l General Ledger accounts are set up in GL> Maintenance> Chart of Accounts.

l Click the Save icon when complete.

3     Attach a tax code to a service rate. 

l After a tax code has been created, attach it to a service rate code in order to add it

to a billing.
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l Tax codes are attached to service rate codes in UB> Maintenance> Service Rate>

Winter Average/Taxes tab.
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UB> Maintenance> Zone

Zone Maintenance

Summary

Zones are user-defined groupings that allow you to group lots (for example, residential,

commercial, etc.). Zones are attached to lot records using the Lot Maintenance window

(Lot icon> Open a lot> Lot tab> Details section), and can be used when creating Query by

Example reports. (Zones are located in the Lot Master table.)

Zones are structurally very similar to classes, but classes have been integrated with more

standard reports in the UB module.

Zones are also very similar to category codes, which are attached to customer accounts

rather than a lot.

Step by Step

1     View the zones. 
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l Open the Zone Maintenance window (UB> Maintenance> Zone).

l The Zone Maintenance window will display all of the zones that have been created

in the application.

l Highlight a zone in the left section of the window and the fields in the Maintenance

section will populate with the information attached to the selected zone.

l If the Maintenance section does not display in the window, it has been

reduced. Move the cursor to the right border of the window. When the border

changes color, right click the mouse. This will expand the Maintenance sec-

tion.

l Highlight a zone and click the Delete icon to delete the highlighted zone. If the

zone is attached to a lot, you will not be able to delete the zone.

2     Create a new zone. 

l Click the Create icon to create a new zone. This will add a new line item to the

left section of the window and the fields in the Maintenance section will be available

to enter the zone record information.

l The Code field is used to identify a unique zone. The value in the Code field can be

up to 20 characters long and it must be unique.

l The Description field is used to enter a description of the zone. The value in the

Description field can be up to 50 characters long.

l Click the Save icon or press ENTER to save the new zone.
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UB> Meter Management> Input New

Input a NewMeter Reading

Summary

The Input New Meter Readings window is used to manually enter new meter readings on

all of the meters in a meter route. The Input New Meter Readings window also allows you

to generate estimated meter readings on all the meters in a route. After meter readings

have been entered or generated using the Input New Meter Readings window, you can

modify the read date, read year, read period or estimate of each meter reading using the

Edit Meter Reading window (UB> Meter Management> Edit).

If you import meter readings from handheld devices (UB> Meter Management> Readings

Import) you will not use this palette option. If you would like to enter a meter reading on a

single customer account, you can enter a meter reading using the Device Maintenance win-

dow (UB> Maintenance> Device> Consumption tab, or you can access this device from the

Devices tab of the Account Master Maintenance window). You can also enter the reading

by creating a read meter service request using the Service Request Input Wizard (UB> Ser-

vice Requests> Input> Create icon).

Step by Step

1     Select the meters you would like to enter meter readings on. 
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l Open the Input New Meter Readings window (UB> Meter Management> Input

New).

l The Parameters To Generate Readings Input Table section is used to select which

meters you would like to enter a manual meter reading on.

l Enter the type of meter you would like to enter a reading on in the Meter Type drop-

down menu.

l The Route field is used to select a meter route.

l Only meter routes created in Route Maintenance window (UB> Maintenance>

Routes) will display in the drop-down menu.

l The meter route of a meter can be viewed and modified using the Device

Maintenance window (UB> Maintenance> Device> Connections tab> Routes

column).

l The Estimate Method drop-down menu is used to estimate the meter readings on

the meters in the route. Select a method from the drop-down menu if you would like

to apply an estimate to all of the meters in the route. Use the Edit Meter Readings

window (UB> Meter Management> Edit) if you would like to estimate the reading on

a single meter in the route.

l Select Previous Read if you would like to estimate the consumption based on

the last meter reading on the meter. The current reading will be the previous

reading on the device, resulting in a consumption of zero.

l Select Multiply EDU’s if you would like to calculate the consumption based on

the meter EDU’s attached to the meters in the route. When this option is selec-

ted, a field titled EDU Multiplier will become visible.
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l A meter EDU is entered on a device using the Device Maintenance win-

dow (UB> Maintenance> Device> Connections tab> EDU column).

l The Multiply EDU option will multiply the value in the EDU Multiplier

field by the value in the EDU field on the meter to calculate the con-

sumption on the meter. For example, if you enter 100 in the EDU Mul-

tiplier field and the meter has an EDU of 4, the consumption will be

calculated at 400 units.

l Select Previous Reading Period if you would like to estimate the new meter

reading based on the consumption during the last meter read period (con-

sumption will be estimated based on meter read period, not meter read date).

This method will add the consumption during the previous meter read period

to the last meter reading to calculate the new meter reading and consumption.

For example, if the previous period consumption and meter reading was 1000

and 12,000, the estimated reading will be 13,000 with consumption of 1000

units.

l If there are multiple readings during the previous meter read period,

those meter readings will be added together to determine the estimated

amount.

l If a meter was not read during the previous period, the meter reading

will default to the last reading that was read on the meter. If there is not

a meter reading during the previous meter read period, an Expansion

icon will display next to the meter reading.

l If you would like to generate the estimate based on the last read period

rather than the meter read of the last period, select Previous Reading’s

Period in the Estimate Method drop-down menu.
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l Select Same Period Last Year if you would like to use the consumption

of the same period in the previous year as the estimate of the current

reading. If the meter does not have a reading in the same period in the

last year, the reading will default to the prior reading on the meter.

l Select Winter Average if you would like to use the last calculated and

committed winter average on a meter to estimate the consumption. If no

winter average is found on the meter or the calculated winter average

has not been committed, the reading will default to the prior reading on

the account.

l If there are multiple winter averages on the customer account, the

consumption will calculated based on the winter average with the

most recent winter average effective date (UB> Maintenance>

Account> Winter Averages tab> Effective Date field). This

applies even if the winter average effective date is in the future.

This means winter averages that have still not reached their effect-

ive dates will be used to calculate the consumption.

l Enter the default read date in the Default Read Date drop-down menu. The

default date will be used as the read date for all meter readings in the route.

l You will not be able to modify the read date of specific meters from the

Input New Meter Readings window. If you would like to modify the read

date of a specific meter, open the reading in the Edit Meter Readings

window (UB> Meter Management> Edit) after the readings have been

entered.

l Enter the Reading Period and Reading Year of the meter readings.

l You will not be able to modify the reading period or reading year of spe-

cific meters from the Input New Meter Readings window. If you would
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like to modify the reading period or reading year of a specific meter,

open the reading in the Edit Meter Readings window (UB> Meter Man-

agement> Edit) after the readings have been entered.

l Click the Refresh icon once you have select the meter readings you would

like to enter. This will populate the Input New Meter Readings window with the

meters in the selected route. If you have selected an estimate meter readings

option, the meters will populate with the estimated meter readings.

l Meter connections for Active, Suspended and Delete status accounts

will display in the window. Expand a meter reading line to view the Read

Comment field and see the status for the meter connection.

l UB module accounts that have meter readings set up as New will not

display in the window. You can view the New toggle on meter readings

using the Device Maintenance window (UB> Maintenance> Device>

Consumption tab> Select a reading> New toggle).

2     Enter or edit the meter readings. 

l After the meters have populated into the window you can enter the meter readings.

If you selected an estimate method, the estimated meter readings will also populate

in the window.

l An Expand button will display next to any meter reading is an estimate

method was selected, but a meter reading could not be estimated based on
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the selected method. Click on the Expand button next to a meter to view the

reason the meter reading could not be estimated.

l The only column in the window that can be edited is the Reading column. If you

would like to edit any other information on the meter reading, you will have to open

the meter reading in the Edit Meter Readings window (UB> Meter Management>

Input New) after the reading has been entered.

l Click the Clear icon if you would like to erase all of the meter readings you have

entered into the window.

l Click the Save icon when complete to save the meter readings.

l After the meter readings have been saved, open the Edit Meter Readings window to

modify or edit specific meter readings in the route.
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UB> Meter Management> Edit

Edit Meter Readings

Summary

The Edit Meter Readings window is used to edit specific unbilled meter readings by meter

type and route. The Edit Meter Readings window is generally used to modify specific meter

readings in a route after they have been generated or entered using the Input New Meter

Readings window (UB> Meter Management> Input). The Edit Meter Readings window can

be used to modify the read date, meter reading, read period and read year, or calculate an

estimate on a single meter reading in a meter route. If you would like to generate an estim-

ated meter reading on all of the meters in a route, use the Input New Meter Readings win-

dow (UB> Meter Management> Input).

Meter readings can also be modified from the Device Maintenance window (UB> Main-

tenance> Device), but there you will only be able to modify the meter readings for one

device at a time.

Step by Step

1     Open the Edit Meter Readings window (UB> Meter Management> Edit).
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2     Filter the displayed meter readings. 

l Select a Meter Type and Route in the Parameters section and click the Refresh

icon to display the unbilled meter readings in the window. The meter readings

will populate in the window.

l The Update Read Date field is used to set a common read date for all of the

unbilled meter readings displayed in the data grid. This functionality is covered in

the next bullet item.

3     Edit the meter readings. 

l Modify the values in the Read Date, Reading, Read Period, Read Year and/or

Estimated Read field of any of the meter readings in the window.

l Highlight a meter reading and click the Modify icon to open the Account Master

Maintenance window of the customer account attached to the selected meter.

l Highlight a reading and click the Delete icon to delete the selected meter read-

ing.

l Highlight a meter reading and select an estimate option from the Process icon

drop-down menu to generate an estimated meter reading on the selected meter.

l Select Use Prior Year if you would like to use the consumption of the same

period in the previous year as the estimate of the current reading. If the meter

does not have a reading in the same period in the last year, the reading will
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default to the prior reading on the meter.

l Select Use Prior Period if you would like to estimate the new meter reading

based on the consumption during the last meter read period (consumption will

be estimated based on meter read period, not meter read date). This method

will add the consumption during the previous meter read period to the last

meter reading to calculate the new meter reading and consumption. For

example, if the previous period consumption and meter reading was 1000 and

12,000, the estimated reading will be 13,000 with consumption of 1000 units.

l If there are multiple readings during the previous meter read period,

those meter readings will be added together to determine the estimated

amount.

l If a meter was not read during the previous period, the meter reading

will default to the last reading that was read on the meter, and the con-

sumption will default to zero. If there is not a meter reading during the

previous meter read period, an Expand button will display next to the

meter reading.

l If you would like to generate the estimate based on the last read period

rather than the meter read of the last period, select Last Period Read in

the Estimate Method drop-down menu.

l Select Last Period Read if you would like to estimate the consumption based

on the last billed meter reading. This varies from the User Prior Period selec-

tion because this option will use any previous billed meter reading, not just the

meter reading of the previous period.

l For example, if you are in billing period 06 and a meter was not read in

period 05, the consumption will be calculated based on the
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consumption billed during period 04. If the meter had 500 units of billed

consumption in period 04, the consumption in period 06 will be estim-

ated at 500 and the meter reading will be 500 units plus the previous

reading on the meter.

l SelectWinter Average if you would like to use the last calculated and com-

mitted winter average on a meter to estimate the consumption. If no winter

average is found on the meter or the calculated winter average has not been

committed, the reading will default to the prior reading on the account.

l If there are multiple winter averages on the customer account, the con-

sumption will calculated based on the winter average with the most

recent winter average effective date (UB> Maintenance> Account>

Winter Averages tab> Effective Date field). This applies even if the

winter average effective date is in the future. This means winter aver-

ages that have still not reached their effective dates will be used to cal-

culate the consumption.

l Select Multiply EDU’s if you would like to calculate the consumption based

on the meter EDU’s attached to the meters in the route. When this option is

selected, a field titled EDU Multiplier will become visible.

l A meter EDU is entered on a device using the Device Maintenance win-

dow (UB> Maintenance> Device> Connections tab> EDU column).

l The Multiply EDU option will multiply the value in the EDU Multiplier

field by the value in the EDU field on the meter to calculate the con-

sumption on the meter. For example, if you enter 100 in the EDU Mul-

tiplier field and the meter has an EDU of 4, the consumption will be

calculated at 400 units.
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l Click the Recalculate icon after selecting an estimate method to recalculate the

consumption on the meter.

l Click the Set Meter Read Date icon to update the Read Date column for all of the

meter readings in the data grid below. The new read date will be set to the date spe-

cified in the Update Read Date field above. Only unbilled read dates can be

updated.

l The Variance column will display the variance between the consumption on the

new reading and the consumption on the meter reading in the same meter period

during the previous year. The formula for the Variance column is:

(Larger Consumption - Smaller Consumption)
X 100 = Variance %

Smaller Consumption

l Click the Save icon when complete to save the changes to the meter reading.
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UB> Meter Management> Update

Update Meter Read Dates

Summary

The Update Must window allows you to update the read date associated with one or more

previously billed meter readings. This read date update to billed meter readings is limited to

only the most recent billed meter reading. Prior billed meter readings cannot be edited.

Step by Step

1     Open the Update Meter Readings window (UB> Meter Management> Update).

2     Filter the displayed meter readings. 

l Select a Meter Type, Route, Reading Year, Reading Period, Read Date From

and Read Date To in the Parameters section and click the Refresh icon to dis-

play the billed meter readings in the window. The meter readings will populate in the

window.
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l The Update Read Date field is used to set a common read date for all of the billed

meter readings displayed in the data grid. This functionality is covered in the next

bullet item.

3     Edit the meter readings. 

l Modify the values in the Read Date, Read Period, and/or Read Year field of any of

the meter readings in the window.

l Highlight a meter reading and click the Modify icon to open the Account Master

Maintenance window of the customer account attached to the selected meter.

l Click the Set Meter Read Date icon to update the Read Date column for all of the

meter readings in the data grid below. The new read date will be set to the date spe-

cified in the Update Read Date field above.

l Click the Save icon when complete to save the changes to the meter read dates.
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UB> Meter Management> Proof List

Meter Reading Proof List

Summary

The Meter Reading Proof List is used to verify that the current meter readings have been

input correctly on customer accounts. Run this report after meter reads have been manu-

ally input (UB> Meter Management> Input New) or imported (UB> Meter Management>

Readings Import).

Since the Meter Reading palette is not a batch process (for example, like the New Billing

process), the Meter Reading Proof List Report is a filtered report rather than a report that

contains the transactions of a batch. Use the filters to generate a report that contains the

desired meter readings. The only fields that are required are the beginning date and ending

date fields. You should also select the account statuses you would like to include in your

report in the Include section.

Step by Step

1     Open the Meter Management Proof List (UB> Meter Management> Proof List).

2     Configure the report. 
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l Select the meter routes you would like to include on the Proof List in the Route field.

l Press CTL+A to highlight all of the toggles in the field. Press SPACE to check

or uncheck all of the highlighted toggles.

l Select how the report will filter in the Filter By drop-down menu. The selection in

this field will determine which fields are enabled in the Meter Management Proof

List window.

l Select Date if you would like to filter the report by meter read date. This will

enable the Begin Reading Date and End Reading Date field.

l You can view the read date of a meter reading in the Read Date column

on the Devices tab of the Account Master Maintenance window (UB>

Maintenance> Account> Devices tab> Meter History sub-tab).

l Select Period if you would like to filter the meter readings on the report by

meter read period. This will enable the Reading Period and Reading Year

fields on the window.

l To filter the report by read date, enter a Begin Date and Ending Date of the meter

reads you want to include in the report. These fields will only be enabled if Date is

selected in the Filter By drop-down menu.

l Enter the earliest date of meter readings you want to include in the meter read-

ing proof list in the Begin Date field.

l Enter the latest date of meter readings you want to include in the meter read-

ing proof list in the Ending Date field.

l To filter the report by period, enter a Period and Year of the meter readings you

want to include in the meter reading proof list. These fields will only be enabled if

Period is selected in the Filter By drop-down menu.
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l Select the Account Status of the customer accounts you would like to include in

the report. Only meter readings attached to a customer account of a selected status

will display on the report.

l Customers will have a Final status if they have been processed in the Final

Account Wizard.

l The Primary Meter ID field is used to display the selected primary meter ID descrip-

tion associated with the serial number, MXU, or register ID in the report header with

the primary meter ID value displayed in the meter detail row below.

l Check the Display all meter IDs toggle if you would like to display the two primary

meter IDs not chosen above in a second row for the meter. The report header will

also display these other two primary meter ID descriptions below the one selected

above.

l Check the Include reads with zero consumption toggle if you would like to

include meter readings with no consumption on the report.

l The Meter Reading Proof List Report displays the route number, sequence number,

serial/MXU/register numbers, service address, UB customer number, customer

name, read date, meter read period and year, meter status, beginning read (pre-

vious read on the meter), current read, consumption and account status. The total

number of meters read on the route and the total consumption amount is tallied at

the end of the report.

l The Meter Status column will display the connection status of the meter on

the customer account. For example, if the meter has been removed from the

lot, the connection status of the meter will be Removed. You can view the con-

nection status of a meter from the Connections tab of the Device Maintenance

window (UB> Maintenance> Device> Connections tab> Status field).
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3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Meter Management> Change Outs

Meter Change-Out Report

Summary

The Meter Change-Out Report displays a list of meters that have been replaced using a

meter change-out service request. The report will display the device that has been

removed and the new device that was installed on the customer account, but the devices

will not display on the report until the change-out service request has been committed (UB>

Service Requests> Commit). The report can be filtered by meter read route and date range

based on the install date of the new device. The install date of the device is the same as the

service date of the service request that performed the meter change-out.

A meter can be removed from a customer account using a remove device or change out

service request, but only meters removed using a change-out service request will display

on this report. Once a meter change-out service request has been committed (UB> Service

Requests> Commit), the status of the original meter on the customer account will change

from Installed to Removed and the install date of the new meter will be the service date on

the service request.

Step by Step

1     Open the Meter Change Outs window (UB> Meter Management> Change Outs).
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2     Configure the report. 

l Select the meter routes to include on the report in the Route field. When a change-

out service request is performed on a device, the new device on the customer

account will inherit the meter route from the device that is being removed.

l Hold down CTRL+A to select all of the meter routes in the field. Press SPACE

to check or uncheck the selected toggles.

l You can view the meter route attached to a device from the Device Main-

tenance window (UB> Maintenance> Device> Connections tab> Route

column).

l Meter routes are created and maintained in UB> Maintenance> Route.

l Enter a date range in the Begin Meter Install Date and End Meter Install Date

fields.

l The report will be filtered by the install date of the new meter on the account.

You can view the install date of a meter on the account in UB> Maintenance>

Account> Devices tab> Expand a device type> Install Date field. The install

date of the device is the same as the service date on the change-out service

request.

l The Meter Change-Out Report will display the meters that have been removed and

the new meters that have been installed on the customer accounts. The report will

display the route number, sequence number, serial/MXU/register number, service

address, customer number, customer name, period, final read, and consumption for

each meter.
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3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Meter Management> Misread Meters

Misread Meters Report

Summary

The Meter Misread Report displays meters that have an unexpectedly high or low con-

sumption level.  The report will compare the consumption on a current meter reading to the

consumption of the meter reading of the same read period in the previous year and then cal-

culate a variance percentage. If the variance percentage is greater than a user defined

amount, the device will display on the report.

If there are multiple reads during the read period of the previous year such as meter reads

entered on service requests, the consumption of the meter readings of the previous year

with the same read period will be totaled to calculate the variance percentage.

If there are multiple meter readings on a device during the selected meter read date range,

each meter reading will create a separate line item on the report. The meter reading will be

compared to the total meter reading of the same read period.

Step by Step

1     Open the Misread Meters window (UB> Meter Management> Misread Meters).
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2     Configure the report. 

l Select the meter routes to include on the report.

l Press CTRL+A to select all of the meter routes in the field. Press SPACE to

check or uncheck the selected toggles.

l Meter routes are created and maintained in UB> Maintenance> Route.

l Enter a meter read date range in the Begin Reading Date and End Reading Date

fields.

l You can view the meter read date for a meter in the customer account in UB>

Maintenance> Account> Device tab> Expand a device type> Expand a

device> Read Date column.

l Enter a misread Variance Percentage.

l The report will display meter readings that are extraordinary. The Variance

Percentage field defines the range of what is considered ordinary variability in

the meter readings. The variance of each meter reading is calculated by com-

paring the current meter reading to the meter reading of the same read period

in the previous year.

l The Variance field will default to 100%. If you leave the variance at 100%, a

device will display on the report if the consumption on the meter reading

included in the date range is twice or half the consumption during the same

read period of the previous year.

l The formula for the variance is:

( (Larger consumption – Smaller consumption)  /  Smaller con-

sumption )  X  100  =   Variance %
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Larger consumption = Larger of the previous or current consumption

Smaller Consumption = Smaller of the previous or current consumption

If there are multiple readings in the previous year, the consumption on those

meter readings will be totaled.

l If the calculated variance of the current consumption is equal or greater than

the set variance, the current reading is flagged as a possible misread.   For

example, if you set the variance to 100% where last year’s consumption was

500 and the current consumption is 900, the calculated variance would be

80%.

( (900 – 500) / 500 ) * 100 = 80

l The meter will display on the report as a misread meter if the calculated vari-

ance is greater than the value entered in the Variance Percentage field. In

the example above, 80% is less than the set variance of 100% so the reading

is not labeled a misread.

l Check the Include Meter Read toggle to include the current meter reading on the

report.

l Check the Use Annual Average If Last Year's Consumption is Zero toggle to

compare the current consumption to an average consumption if last year's con-

sumption was zero.
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l Check the Exclude Zero Consumption Reads toggle if the report should flag a

reading as a misread if the current consumption is 0.

l The report will display the route number, sequence number, serial/MXU/register

number, customer number, customer name, service address, consumption, prior

consumption and the variance for each meter.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Meter Management> Unread Meters

Unread Meters Report

Summary

The Unread Meters Report displays a list of meters that were not read during a specific

date range using the meter read date. Meters with estimated readings during the selected

period, manual reads (UB> Maintenance> Device> Consumption tab), or readings from ser-

vice requests will not be included on the report. The report will search for meter readings

that have not been billed during the date range, so if there have been meter readings dur-

ing the selected period but those readings have been billed, the device will display on the

report.

Step by Step

1     Open the Unread Meters window (UB> Meter Management> Unread Meters).

2     Configure the report. 
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l Select the meter routes to include on the report.

l Press CTRL+A to select all of the meter routes in the field. Press SPACE to

check or uncheck the selected toggles.

l Hold down SHIFT to select a range of meter routes.

l Meter routes are created and maintained in UB> Maintenance> Route.

l You can view the meter route of a specific device from the Account Master

Maintenance window (UB> Maintenance> Account). Open the Devices tab

and open the Device Maintenance window of the device. Open the con-

nections tab and the meter route of the device will display in the Route

column.

l Enter a date range in the Begin Reading Date and End Reading Date fields.

l The Account Status field is used to filter the meters that display in the report by the

status of the UB customer accounts they are installed on. Select the status of the

accounts you would like to include on the report.

l You can view the status of a customer account in UB> Maintenance>

Account> Account tab> Status field.

l Check the Look for New Reads Only toggle to limit the meters displayed in the

report to those that have a new read in the time period specified.

l Check the Include Zero Reads toggle to include any meters that have a zero read.

This will include meters on the report that do not match the criteria of an unread

meter, but have a zero meter reading during the date range of the report. An

account will still be included on the report if there has been a new meter reading

entered on the account after the zero meter reading.

l Check the Include Meters without an Account toggle to include any unread

meters that are not attached to an account.
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l The Unread Meter Report lists the route, sequence and serial/MXU/register number

on the device, customer account number attached to the meter, service address,

meter location, current read, current read date, prior read, prior read date. The total

number of unread meters displays at the end of the report.

l The Service Address column on the report will display the address where the

device is installed.

l The location column on the report will display the location of the meter. The

location will display on a separate line and will only display on the report if a

location is entered on the device.

l You can view the location of a device in UB> Maintenance> Device>

Connections tab> Location field.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Meter Management> Meter Sheets

Meter Sheets

Summary

Meter Sheets Report is list of meters filtered by meter read route and is used to manually

record meter readings. If meter readings are imported you probably will not use this report.

The Meter Sheets Report displays a list of Active meters that are attached to customer

accounts and is sorted by meter route and route sequence number. A meter will not display

on the report if it has been removed from a UB customer account using a remove meter ser-

vice request.

After meter readings are entered on the meter read sheets, the reading can be manually

entered in UB> Maintenance> Input New.

Step by Step

1     Open the Meter Sheets window (UB> Meter Management> Meter Sheets).

2     Configure the report. 
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l Select the meter routes to include on the report.

l Press CTRL+ A to select all of the meter routes. Press SPACE to check or

uncheck all of the toggles in the field.

l Meter routes are created and maintained in UB> Maintenance> Route.

l Check the status of the accounts you would like to include on the meter sheets.

l You can view the status of an account in UB> Maintenance> Account>

Account tab> Account Status field.

l The Meter sheets will display the route number, sequence number, customer num-

ber, reference number, account status, service address, customer name, meter seri-

al/MXU/register number, begin read, a blank space for new reading, meter location

and a blank area for comments.

l The New Reading and Comments column on the report are used to enter the

meter reading and notes.

l The reference column is pulled from the Reference field found in UB> Main-

tenance> Account> Account tab.

l The location column on the report will display the location of the meter at the

address it is installed at.

l You can view the location of a device in UB> Maintenance> Device>

Connections tab> Location field.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Meter Management> Meter Data
Export

Meter Data Export

Summary

The Meter Data Export window allows users to export meter data in a format that is com-

patible with third-party smart metering systems that provide real-time meter reading data,

such as AMI Technology. This export file includes data related to the connection, customer

account and lot information.

Step by Step

1     Open the Meter Data Export window (UB> Meter Management> Meter Data Export).

2     Complete the Export Settings section. 

l Select the meter read routes that should be included in the data export in the

Routes field.
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l Press CTRL+A to highlight all of the routes. Press SPACE to check or

uncheck all of the highlighted toggles.

l The Configuration drop-down menu is used to select a user-configured data export

file or to select Meter Data to use the standard data export.

l User-configured export files are created and maintained on the Export Con-

figuration Maintenance window (SS> Maintenance> Export Configuration).

l Click the Display Report Layout icon at the top of the window to display

the format of the file that will be created. This will open a window that displays

the fields included in the data export file, the length of each field and the pos-

ition of the field on the data export file.

l Select the status of the customer accounts you would like to include in the data

export file in the Account Status field. Only the meters attached to customer

accounts of the selected statuses will be included on the data export file.

l Meters attached to inactive lots will not be included in the exported meter

information (Lot icon> Open a lot> Lot tab> Status drop-down menu) unless

the Include Inactive Lots toggle is checked below.

l Check the Include Inactive Connections toggle to if you would like to include inact-

ive connections in the export file.

l Connection status is set on the Connections tab of the Device Maintenance

window (UB> Maintenance> Device> Connections tab> Status drop-down

menu).

l Check the Include Inactive Lots toggle to include inactive lots in the data export

file.
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l Click the Confirm icon when complete to generate the data export file imme-

diately or enter a date and time in the field next to the Confirm icon to schedule the

data export file to generate at a later time. You can view the progress of the data

export on the Job Viewer window (SS> Utilities> Show Scheduled Jobs).

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l Enter the export path location and click the Save icon to export the file to

the local path.
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UB> Meter Management> Meter Change
Out Import

Meter Change Out Import

Summary

The Meter Change Out Import window is used to help organizations process a large group

of meter change outs or meter updates. For example, when a city replaces the meters in an

entire neighborhood with new meters, the Meter Change Out Import tool is used to inac-

tivate the old meters and create the new meters on the included Utility Billing accounts.

This tool can also be used to update existing meters with information that was not available

when those meters were first installed, such as latitude or longitude data.

The Meter Change Out Import step is the final step in the mass change out process. Organ-

izations will first need to create the export file with the Meter Data Export tool. Once the

meter data is exported, it can be edited or updated and then imported back into the system.

Step by Step

1     Open the Meter Change Out Import window (UB> Meter Management> Meter

Change Out Import).
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2     Complete the Settings section. 

l The Configuration drop-down menu is used to select a user-configured import file

or to select Non-Configurable if your organization uses a third-party meter layout.

l User-configured import files are created and maintained on the Import Con-

figuration Maintenance window (SS> Maintenance> Import Configuration).

l Select your meter manufacturer from the Layout drop-down menu. This field will

only be enabled is Non-configurable is selected in the Configuration field above.

l Click the Display Report Layout icon at the top of the window to display

the expected file format of the selected manufacturer.

l The File Name field is used to enter the path of the import file. Click the Input File

field label to select the file from a window.

l The Service Request Code drop-down menu is used to select a service request

code associated with the change out process.

l Service request codes are created and maintained on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code).

l Click the Display Report Layout icon to open a window that displays the

required fields and format of the layout selected in the Layout field.

l Click the Confirm icon to import the meter change out file immediately or enter a

date and time in the field next to the Confirm icon to schedule the import to process

at a later time. You can view the progress of the import on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l Any errors that occur during the import process will display in an information

window.
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UB> Meter Management> Readings
Export

Export Meter Reading Information

Summary

The Export Meter Information window is used to export meter reading information from the

Springbrook application to the handheld meter read devices before the meters are read.

The exported information will vary depending on the format, but will generally contain the

meter route, meter sequence and prior reading information. After the meter information has

been imported into the handheld devices and the meter readings have been entered into

the handheld devices, the readings are imported into the Springbrook application using the

Meter Readings Import window (UB> Meter Management> Readings Import).

If meter sequences should be padded or split into new meter read routes (UB> Utilities>

Pad Meter Sequences), make sure you have done this before the meter information is

exported to the handheld devices.

The Export Meter Information window will generate an export file at a specific path. The

format of the export file generated by this process will vary depending on the format of the

handheld devise you are using (Badger, Datamatic, MV-RS, etc.).

Step by Step
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1     Open the Export Meter Information window (UB> Meter Management> Readings

Export).

2     Complete the Export Settings section. 

l Select the meter read routes that should be included in the export in the Routes

field.

l Press CTRL+A to highlight all of the routes. Press SPACE to check or

uncheck all of the highlighted toggles.

l The Configuration drop-down menu is used to select a user-configured export file

or to select Non-Configurable if your organization uses a third-party meter layout.

l User-configured export files are created and maintained on the Export Con-

figuration Maintenance window (SS> Maintenance> Export Configuration).

l If your organization does not use user-configured export files, select the format of

the export file generated by the Export Meter Information window in the Layout

drop-down menu. The selection in this window may change the fields that are

enabled in the window. Your selection may also add a tab to the window. For

example, if you select MV-RS 1.0, an MV-RS tab will be added to the Export Meter

Information window.

l Click the Display Report Layout icon at the top of the window to display

the format of the file that will be created. This will open a window that displays

the fields included in the export file, the length of each field and the position of

the field on the export file.
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l If you are creating an MV-RS export file, make sure to complete the inform-

ation on the MV-RS tab.

l When meter readings are being entered on the handheld devices, most handheld

devices have a feature that will warn a user that the entered meter reading may be

incorrect. The handheld device determines that the meter reading could be incorrect

based on a prior meter reading and a user-defined variance percentage. The Low

% and High % fields are used to enter variance percentages, and the History

Month and History Year fields are used to enter the read period of the prior reading

that will be used to calculate the warning.

l Enter the meter read period and year of the meter reading you would like to

compare to the new meter readings in the History Month and History Year

fields.

l Enter the lowest percentage value the consumption on the new meter reading

can be before the warning is triggered in the Low % field.

l For example, if you enter 50% in this field, the misread warning mes-

sage will display if the new reading results in consumption that is less

than half of what it was during the meter reading selected in the History

Month and History Year field.

l Enter the highest percentage value the new reading can be before the warn-

ing will be triggered in the High % field.

l For example, if you enter 200% in this field, the misread warning mes-

sage will only display if the new reading results in consumption that is

twice as large as the consumption on the meter reading selected in the

History Month and History Year field.
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l Here is another example. Enter 120 in the High% field, 80 in the Low % field,

and assume the consumption on the selected meter reading is 9. The high

and low values of the new meter read are calculated by applying the high and

low variance to the consumption amount, and then rounding the calculated

amount. 120% of the selected consumption is 11 (1.2*9=10.8 and then roun-

ded to 11) and 80% is 7 (.8*9=7.2 and then rounded to 7). The rounded high

and low variance amounts are then applied to the new reading on the meter. If

the new meter reading is 11 units greater than the previous reading, or less

than 7 units greater, the handheld device will display the warning message.

l Select the status of the customer accounts you would like to include in the export

file in the Account Status field. Only the meters attached to customer accounts of

the selected statuses will be included on the export file. Meters attached to inactive

lots will not be included in the exported meter information (Lot icon> Open a lot> Lot

tab> Status drop-down menu).

l Enter a Radio and Tone Frequency. These fields are only active if an MV-RS Lay-

out is selected above.

l Check the Export Unread Meters Only toggle to exclude meters with unbilled

meter readings from the export file.

l For example, if a read device service request is performed on a meter on a

selected route, that meter will be excluded from the export file if that reading

has not been billed. (Meter readings are unbilled until they have been billed in

a New Billing batch.)

l Check the Include Inactive Meters toggle if you would like to include meters with

an inactive status in the export file.
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l The status of a meter displays in the Status field on the Device Maintenance

window (UB> Maintenance> Device> Meter tab> Device section> Status

drop-down menu).

l This toggle will not be enabled on all export formats.

l Check the Include MXU ID toggle if you would like to include the MXU ID attached

to the meters in the export file.

l The MXU ID of a meter can be viewed on the Device Maintenance window

(UB> Maintenance> Device> Meter tab> Device section> MXU ID field).

l Click the Confirm icon when complete to generate the export file immediately or

enter a date and time in the field next to the Confirm icon to schedule the export file

to generate at a later time. You can view the progress of the export on the Job

Viewer window (SS> Utilities> Show Scheduled Jobs).

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l Enter the export path location and click the Save icon to export the file to

the local path.
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UB> Meter Management> Readings
Import

Import Meter Readings

Summary

The Meter Readings Import window is used to upload the meter readings from an import

file to the Springbrook application. Select the format of the file you would like to import in

the window, enter the reading period and reading year of the meter readings in the file and

upload the file. The meter readings in the import file will update the UB customer accounts.

After meter readings have been imported, you can run the Misread Meter Readings Report

to find meter readings that may have been misread.

Step by Step

1     Open the Import Meter Information window (UB> Meter Management> Readings

Import).

2     Complete the Settings section. 

IMPORT METER READINGS 507



l The Configuration drop-down menu is used to select a user-configured import file

or to select Non-Configurable if your organization uses a third-party meter layout.

l User-configured import files are created and maintained on the Import Con-

figuration Maintenance window (SS> Maintenance> Import Configuration).

l Select your meter manufacturer from the Layout drop-down menu. This field will

only be enabled is Non-configurable is selected in the Configuration field above.

l Click the Display Report Layout icon at the top of the window to display

the expected file format of the selected manufacturer.

l The File Name field is used to enter the path of the import file. Click the Input File

field label to select the file from a window.

l Verify that the Reading Period and Reading Year are correct.

l The Reading Period and Reading Year are the meter read period and year

that will be assigned to all of the imported meter readings.

l The Reading Period and Reading Year fields will default to the current cal-

endar month and year.

l The Override Read Date field is used to specify a read date for the imported read-

ings. This read date will override the read date originally associated with the meter

readings.

l The Create Service Requests, Import Meter Location, Import Location Table

and Import Latitude/Longitude toggles will only be active if the Layout selected

above can utilize those options.

l Click the Display Report Layout icon to open a window that displays the

required fields and format of the meter manufacturer selected in the Format field. If
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you are getting errors when you are trying to import your file, check this report to

verify the format of your import file is correct.

l Click the Confirm icon to import the meter readings immediately or enter a date

and time in the field next to the Confirm icon to schedule the import to process at a

later time. You can view the progress of the import on the Job Viewer window (SS>

Utilities> Show Scheduled Jobs).

l Any errors that occur during the import process will display in an information

window.

l After you have imported the meter readings, print a Proof List of the meter readings

(UB> Meter Management> Proof List).
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UB> Meter Management> Resequence

Resequencing Meters

Summary

The Resenquence Meters window is used to update the sequence in which meters are

read. This process can be used to correct sequence entry errors that occurred when the

sequence was first established, to insert new meters into an existing route sequence, and

to update a sequence for efficiency or meter reader preference.

This process is generally run only if the meter reader changed the read sequence while con-

ducting the meter reads. After the new meter reads are imported into the system, the same

meter read file is used to update the meter sequence in the application.

Step by Step

1     Open the Resequence Meter window (UB> Meter Management> Resequence).

2     Resequence the meters. 
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l Select the meter manufacturer layout you would like to resequence from the Layout

drop-down menu.

l Click the Display Report Layout icon at the top of the window to display

the expected file format of the selected manufacturer.

l The Input File field is used to enter the path of the meter reading import file. Click

the Input File field label to select the file from a window.

l Click the Confirm icon to import the meter reading file and update the meter

sequence in the application.

l You can also enter a date and time in the field next to the Confirm icon to

schedule the import to process at a later time. You can view the progress of

the import on the Job Viewer window (SS> Utilities> Show Scheduled Jobs).
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UB> New Billing

New Billing

Summary

The New Billing process is used to calculate charges on UB customer accounts in a selec-

ted billing cycle and generate the billing statements.  The bills will be calculated based on

the Billing tab of the UB Setup window (UB> Utilities> Setup> Billing tab), the service rates

attached to the customer accounts in the batch and the bill types attached to the meters on

those accounts.

Service rates are attached to customer accounts and determine the rate structure, winter

average, taxes, bill type and prorating options of a billing. The service rate will calculate

charges on the consumption on meters with the same bill type and the charges will be

billed to the service attached to the service rate.

Bill types are used to link the consumption on a meter to a service rate on an account.

When a billing is generated the consumption on a meter will be billed using the service

rates attached to the UB customer account with the same bill type. Bill types are attached

to service rates (UB> Maintenance> Service Rates> General tab> Bill Type field) and
device types (UB> Maintenance> Device Type> General tab> Bill Type field).
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When bills are generated, bill types determine what service rate will be used to bill the con-

sumption on a meter. When a bill is generated on a customer account, the consumption on

a meter will be billed using the service rate with the same bill type as the meter. If there are

multiple service rates on the customer account with the same bill type, all of the service

rates will apply.

When billing the consumption on a meter, there are no units of measure (gallons, cubic

feet, etc.) attached to the service rates. The service rate will be applied to the consumption

as it was read on the meter. For example, if there were 100 units of consumption read on

the meter during the billing period, then the service rate will be applied to the 100 units

regardless of the type of unit was read (gallon, cubic feet, etc.). If there are meters of mul-

tiple unit types in the same billing batch, or the consumption should be converted to

another unit type as the billing is being calculated, you can convert the consumption read

on the devices to another unit type using the consumption conversion table (UB> Main-

tenance> Consumption Conversion).

When new bills are generated (UB> New Billing> Generate), there is a Convert Con-
sumption To drop-down menu that allows you to convert the consumption read on the
meters to a different unit type. The consumption will be converted to the unit type using the

conversion formula set up in the conversion table (UB> Maintenance> Consumption Con-

version), and the service rate will be applied to the modified consumption on the meter. For

example, if the consumption was read in cubic feet and is changed to gallons, the con-

sumption read on the meter (100) will be multiplied by the conversion amount (7.48000)

and then the service rate will be applied to the modified consumption amount (748). The

Billing Register will display both the consumption read on the meter and the modified con-

sumption.
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The consumption read on a meter will be in the unit type attached to the device type it is

associated with. When a device type is created, a unit of measure is specified on the

device type (UB> Maintenance> Water, Gas, Electric Device Type> Meter tab> Unit Type
drop-down menu). All devices attached to that device type will inherit that unit type.

The billing transaction created by the New Billing palette will display on the customer

account as soon as the Generate step is complete. You can view the billing using the

Account Master Maintenance window (UB> Maintenance> Account> History tab). Click the

Expand button on the History tab to view the detail line items on the transaction. Each ser-

vice rate on the billing will display as a separate line item.

The statements that will print out during the New Billing process are set up in UB> Utilities>

Setup> Statement Settings. If there is bank account information attached to the UB cus-

tomer account (UB> Maintenance> Account> Account tab> ACH Info sub-tab) a “Do Not

Pay – Automatic Debit” message will display on the statement.

All reports generated in the application are archived on the application server by batch num-

ber. If you would like to reprint a billing statement or the entire billing after the New Billing

batch has been committed, locate the billing statements archived on the application server

and reprint them. The path of the archived billing statements is:  \\server path\version folder

(for example, v7.18)\db\select a database slot (Springbrook0-9) \archive\Reports\calendar

year\UB\New Billing\ .

Step by Step
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1     Create a New Billings batch. 

l Select the New Billing palette in UB> New Billing. This will expand the New Billing

palette and display the steps of the New Billing process.

l Select New from the New Billing batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the New Billing process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report in UB> New Billing>

GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the New Billing palette

and press DELETE to delete a batch. Any uncommitted billing transactions gen-

erated in the batch will be deleted.
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2     Generate bills. 

l Select Generate from the New Billing palette. This will open the Generate/New

Billing window.

l Select the services you would like to include in the billing in the Services field.

l Press CTRL+A to select all of the services in the field. Press SPACEBAR to

check or uncheck the selected toggles.

l The services selected in the Services field determine which service rates will

be included on the billing, not necessarily what meter consumption will be

included.

l The consumption of a meter is attached to a bill type and all service

rates of the same bill type included in the billing and attached to the cus-

tomer account will be included on the bill.

l If the consumption has a bill type that does not match any of the service

rates included in the billing, than the consumption will not be billed.

l You can view the bill type of a meter from General tab of the Device

Maintenance window (UB> Maintenance> Device, this window can also

be opened from the customer account), and you can view the bill type of

a service rate from the General tab of the Service Rate Maintenance

window (UB> Maintenance> Service Rate).

l For detailed information on how the consumption of a meter is attached

to a service and service rate see the Bill Type Overview help document.

l Select the billing cycle you would like to generate charges on in the Billing Cycle

drop-down menu. The Billing Cycle field will not be enabled if charges have already

been generated in the selected batch.
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l Billing cycles are created and maintained in UB> Maintenance> Cycle Code.

You can view the billing cycle attached to a customer account in UB> Main-

tenance> Account> Account tab> Account sub-tab> General section> Billing

Cycle field.

l Meters are read by meter route, but are billed by billing cycle, so the customer

billing cycle is not the same as the meter route.

l If the Billing Cycle field is not enabled and you would like to generate charges

on a difference batch, you will have to create a new batch.

l The Period Begin Date field is disabled and will populate based on the last time the

selected billing cycle was billed.

l The period end date of the previous billing on the cycle will display in the

Period End Date field in UB> Maintenance> Cycle Code.

l After the current New Billing batch is committed, the date entered in the

Period End Date field will be saved on the billing cycle.

l Enter a Period End Date.

l The Period End Date will default to the current date. It is not the number of

days in the billing cycle added to the Period Begin Date.

l Enter a Transaction Date. The transaction date is the date that will be assigned to

all of the bills generated in the batch. The Transaction Date field will default to the

current date.

l You can view the transaction date of a transaction on a customer account in

UB> Maintenance> Account> History tab> Transaction Date column.

l The Billing Period and Billing Year will default to the current calendar month and

year.
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l The selection in the Meter Reads to Bill drop-down menu in UB> Utilities>

Setup> Billing tab determines how the Billing Period field will function.

l If Unbilled is selected in the Meter Reads to Bill drop-down menu, all

unbilled readings on the customer accounts in the batch will pull onto

the billing statements regardless of the read period on the meter read-

ings.

l If Period is selected, only unbilled readings with a reading date that is in

the same period as the billing period will be charged on the billing state-

ments.

l Select a conversion unit in the Convert Consumption To field.

l Select No Conversion to bill consumption as it was read on the devices. For

example, if there was 100 units of consumption read on a meter during the

billing period, the service rate will be applied to those 100 units regardless of

the unit type (gallons, cubic feet, etc.).

l If you do not select a consumption conversion in the Convert Consumption To

drop-down menu, consumption on meters will be billed using the consumption

units read on the device.

l Units are attached to device types using the Water Meter Device Maintenance

window (UB> Maintenance> Device Type> Device tab> Unit Type drop-down

menu).

l Any conversion that is set up as a convert to value on the conversion table will

display in the drop-down. For example, if Feet is entered in the Convert To

field on the Consumption Conversion Maintenance window (UB> Main-

tenance> Consumption Conversion> Convert To field), the value will display

in the Convert Consumption To drop-down menu on the Generate window.
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l Conversions are created and maintained in UB> Maintenance> Consumption

Conversion.

l Select the status of the accounts you would like to include in the batch in the

Account Status field.

l If a customer account status has been changed to Vacation (UB> Main-

tenance> Account> Account tab> Account sub-tab), the account will be pro-

rated based on the dates in the Vacation Begin and Vacation End date

fields.

l You can view the status of an account in UB> Maintenance> Account>

Account tab> Account sub-tab> General section> Account Status field.

l There is no Final status toggle because they will automatically be included in

the New Billing batch. If you bill customer accounts with a Final status in their

normal billing cycles rather than process them separately in the Final Billing

palette (UB> Final Billing), the Final status accounts will be automatically

included in the billing batch.

l Press ENTER to generate the bills immediately or enter a date and time in the field

next to the Confirm icon to schedule the bills to generate at a later time.

l You can view the progress of the Generate step on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l As the new bills are being generated, a clock icon will display next to the Gen-

erate step of the New Billing palette.

3     View the errors generated on the New Billing. 
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l Select Exceptions on the New Billing palette to view the exceptions and errors on

the bills generated in the batch. This will open the Exceptions/New Billing window.

l The Exceptions step is not required to commit a New Billing batch.

l The Exceptions window will display all of the exception messages generated in the

batch.

l If a customer account in the billing cycle has an open service request, the ser-

vice request will display as an exception in the window. Group the exceptions

in the window by sorting the exceptions by the Category column if you would

like to view all of the open service requests on the customer accounts in the

batch. This exception does not keep the customer account from being

included in the New Billing batch (customer accounts can be billed when they

have open service requests), it is only informational.

l The “No consumption found for meter: Route No 39, Sequence Number…”

message will display if there is no consumption on the meter attached to a cus-

tomer account in the billing cycle.

l If there is consumption on the meter but has not been included in the billing, the

billing may be set up to bill only meter readings of a specific reading period.

l The “Unable to find any billable meter history for meter:…” statement will dis-

play if a meter has been removed from a customer account in the billing cycle.

l The “Removing previous pending bill for this account” message will display if

you re-run the generate step. For example, if you run the Generate step and

then re-run the Generate step to regenerate the billing, this message will dis-

play on the Exceptions window.

l The “This account status ( ) does not match one of the statuses chosen for

billing…” message is generated if a customer account in the selected billing
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cycle has an account status not selected during the Generate step (UB> New

Billing> Generate> Account Status field).

4     Preview the billing. 

l Select Preview from the New Billing palette to preview the generated bills. This will

open the Preview/New Billing window.

l The Preview step is not required to commit a New Billing batch.

l The Preview/New Billing window will display the total billing broken down by service

for each customer in the batch, and the service and billing total of the entire batch.

l If your organization uses the billing comparison functionality, any bill line

items that exceed the specified comparison variance will display in red. Billing

comparison functionality is set up on the Billing tab of the UB Setup window

(UB> Utilities> Setup).

l Click on a displayed account number to open the Account Maintenance window.

l If an account is accessed and edited from the Preview window, the new bill

will be recalculated and the New Billing process will be reset to the Billing

Register report step.

5     Print the register. 
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l The billing register displays a summary of the billings in the batch.

l Select Register from the New Billing palette to print the Register Report for the

batch. This will open the Register/New Billing window.

l Filter the billings that display on the report by the current billing amount.

l Enter a value in the Minimum Amount and Maximum Amount fields to cre-

ate a range of billings that will display on the report.

l The Minimum Amount and Maximum Amount fields will filter the billings that

display on the report by current billing amount.

l By default, the Minimum Amount and Maximum Amount fields will be small

and large enough to include all billings.

l Select which consumption you would like to include on the report in the Con-

sumption drop-down menu.

l Select Actual if you would like the consumption that displays on the report to

match the consumption that displays on the Devices tab of the customer

accounts in the batch. The consumption multiplier and divisors set up on the

device type attached to the meter on the account will not be included in the

consumption calculation.

l A consumption multiplier or divisor is attached to a device type using

the device type maintenance window (for example, UB> Maintenance>

Water Device Type> Water tab> Consumption Multiplier and Con-

sumption Divisor fields).

l Select Billable Only if there are meters in the billing batch that have a con-

sumption multiplier or divisor attached to them. This will display the modified

consumption amount on the report.
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l The consumption that will display on the Billing Register will not match

the consumption that displays on the Devices tab of the customer

account. The consumption that displays on the Meters tab does not cal-

culate based on the consumption multipliers.

l You can view the meter readings on a customer account in UB>

Maintenance> Account> Meters tab> Meter History section.

l Consumption multipliers and devisors are attached to Water Device

types in UB> Maintenance> Water Device Types> Water tab.

l The selection in the Consumption drop-down menu does not affect how the

consumption will display on the report when a special multiplier is being

applied to the consumption on a meter. The Billing Register will always dis-

play the read consumption if the consumption is multiplied by a special mul-

tiplier (UB> Utilities> Setup> Billing tab> Multiply consumption by a

special multiplier toggle is checked, UB> Maintenance> Service Rate> Gen-

eral tab> Use special multiplier toggle is checked, and a multiplier is

entered in UB> Maintenance> Account> Service Rates tab> Open a service

rate> Special Multiplier field).

l Select the sort order of the report in the Sort Order field.

l The Reference number on a customer account in pulled from UB> Main-

tenance> Account> Account tab.

l Select the information you would like to include on the report in the Report Type

drop-down menu.

l The Detail report will display a separate line for each rate code on the cus-

tomer account with activity during the current billing. The detail version of the

report includes the UB account number, Reference number, customer name,
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account status, service, code, consumption, balance forward, current billing

and  account balance. The report will also total by customer account number

and report total.

l The Summary report will display eight services per row and include the bal-

ance and consumption lines just below the rate code lines. The report

includes the UB account number, reference number, customer name, lot

address, service codes of each service, current bill by service and con-

sumption by service. The report will also display the balance forward, total bill,

account status, and account balance of each UB account on the report. A

report summary will print at the end of the report displaying the services billed,

consumption, and current billing accounts of the billing batch.

l If there are no services set up for services 9 thru 16, or 17 thru 20 then

those lines will no display on the report. Services are set up in UB>

Maintenance> Service.

l Check the Display History with Zero Amounts toggle to include all services that

are attached to the customer accounts even if there is no activity for those services.

l Check the Include Manual Bills toggle to include committed manual billings on the

report. This toggle will only be enabled if you are generating the Billing Register in

Summary format (you selected Summary in the Report Type drop-down menu).

l The manual billing will display on the report with the service used to create the

manual billing. For example, if you created a manual billing for the WATER

service, the manual billing will be totaled with the current billing in the WATER

service column.

l If you do not check this toggle, manual billings will not be included on the

billing register.
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l Manual billings are created using the Input Billing window (UB> Adjustments

and Fees> Input> Create icon> Select Billing).

l Check the Compress Services toggle to suppress the summary report lines for the

services 9 thru 20 if the services on those lines do not have rate codes, balances or

consumption.

l The Compress Services toggle will only be enabled if you select Summary

from the Report Type drop-down menu.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The report will display the customer accounts and services included in the billing. A

separate service rate line item will display on the customer account for minimum or

flat amounts associated with a service rate.
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l The Consumption column that displays on the Billing Register is the con-

sumption calculated on the meter. If you selected a consumption conversion

during the Generate step (Convert Consumption To field), the conversion

formula will be used to calculate the billing on the consumption, but the Billing

Register will still display consumption as read on the meter rather than the

converted value.

l If no consumption displays on the billing register, but there are unbilled meter read-

ings on the account follow the link below for possible solutions:

6     Print the Trial Balance Report. 

l Select Trial Balance from the New Billing palette. This will open the Trial Bal-

ance/New Billing report.

l The Trial Balance Report will display each employee in the batch and the balance

on those accounts. If you generate the report in detail format, the report will also dis-

play a list of services attached to the customer accounts and the balance inform-

ation on each of those services (beginning balance, adjustments, payments, other

billings, current billings and balance forward). This is similar to the information that

displays in the Account Balance section on the Account Master Maintenance win-

dow (UB> Maintenance> Account> Overview tab> Account Balance section).

l Select how you would like the report to sort in the Sort Order drop-down menu. The

selection in this field determines the order in which the customer accounts will dis-

play on the report.
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l The Reference Number selection refers to the reference number attached to

the UB customer account.

l The reference number is attached to UB customer accounts in UB>

Maintenance> Account> Account tab> Account sub-tab> General sec-

tion> Reference Number field.

l Select what information you would like to include on the report in the Report Type

drop-down menu.

l The detail version will display the service description, consumption amount,

beginning balance, adjustments during the period, payments during the

period, other billings, current billings and balance of each service attached to

the UB customer accounts in the batch.

l The summary version of the report will not include the service information on

the report. The report will display a single line for each UB customer account

included in the batch.

l Check the toggle box Show zero balance accounts with no activity if you want

the report to include these types of accounts in the report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Other Billings column will include billable service request codes that have

been closed and committed and processed in UB> Adjustments and Fees> Bill Ser-

vice Requests.

l The Status column will display the status of the account if the account does not

have an Active status.

7     Select the statement options and customer accounts included on the statements. 

l The Statement Settings step on the New Billing palette is used to select how the

statements will be generated and the customer accounts included on the state-

ments. Customer accounts included in the New Billing batch during the Generate

step will have a billing transaction created, but customers selected in the Statement

Settings step will receive a billing statement. The selections in the Statement Set-

tings window will also affect the customer accounts included in the Export

Addresses step.

l Open the Statement Settings window (UB> New Billing> Statement Settings).

l Enter the due date of the billings on the statements in the Due Date field.

l The value in this field will default to the current date plus 15 days.
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l The optional Additional Date field is used to add an additional, user-configured

date field to the statement.

l This field will only be enabled if the Additional Date Label field is set up on the

Statement Setup window (UB> Utilities> Statement Setup> Billing Options

tab) and only displays on standard, full-page billing statements.

l This date will display on the full-page billing statement next to the Additional

Date Label set up on the Statement Setup window.

l Enter the transaction date of the billings in the Transaction Date field. The Trans-

action Date field will default to the transaction date entered during the Generate

step (UB> New Billing> Generate> Transaction Date field).

l The Minimum and Maximum fields are used to filter the statements generated dur-

ing the Statements step by the account balance forward plus the current billing

amount. For example, if a UB customer account has a balance forward of $1.25 and

a current bill of $2.75, a statement will print for the customer account if the value in

the Minimum field is equal to or less than $4.

l These fields can be used to remove statements with small or excessively

large dollar amounts.

l You can view the balance forward on a customer account using the Overview

tab on the Account Master Maintenance window (UB> Maintenance>

Account> Overview tab> Balance Forward column).

l Select the billing statement you would like to generate in the Statement drop-down

menu.

l Statements are created and maintained using the Statement Setup Main-

tenance window (UB> Utilities> Statement Setup).
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l The Bill To drop-down menu is used to specify the format for the optional Bill To

Report.

l Select the status of the customer accounts you would like to include on the state-

ments in the Account Status field.

l The Message 1 and Message 2 fields are used to add a message to the statements

that has been created using Statement Message Maintenance window (UB> Main-

tenance> Statement Message). Click the Message 1 or Message 2 field labels to

select a message statement from a list.

l Press ENTER when complete to save the statement settings.

8     Complete the Export Addresses and Import Addresses steps. 

l The Export Addresses and Import Addresses steps allow you to certify the customer

addresses in the New Billing batch and generate the relevant bulk mailing doc-

uments and tray tags.

l Addresses are certified using the Springbrook Software Postal Link software. The

Export Addresses step is used to generate an email containing the addresses to be

certified and the dimensions of the mailing.

l The Drop Date field is used by those users who would like to specify a mail-

ing date that will populate the Mailer's Mailing Date field on the postage state-

ment. If no date is specified, the field will default to the current date.

l The Include drop-down menu is used to select the statements you would like

to include in the mailer export.
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l Select All Statements if you would like to include all statements in the

Final Billing batch.

l Select Hold Status Only if you would like to include only those state-

ments for customer accounts that have a hold status. This will include

temporary and permanent hold status accounts on the mailer export.

l Select No Hold Status Only if you would like to include only those state-

ments for customer accounts that DO NOT have a hold status.

l UB customer accounts are assigned a hold status using the Account

Master Maintenance window (UB> Maintenance> Account> Account

tab> Account sub-tab> General section> Hold Status drop-down

menu).

l The exported addresses will be processed by a Springbrook Software server

that will certify the addresses against a large, regularly updated database.

l After the addresses have been certified, the certified addresses will be sent

back to the email address included on the Export Addresses step. Also

included in the email with be all the relevant documents and tray tags for the

bulk mailing as well as the calculated postage amount.

l Import Addresses step is used to import the addresses that have been certified into

the New Billing batch.

l After the exported addresses have been processed and the return email has

been received at the email addresses entered on the Export Addresses step,

you can import the certified addresses into the New Billing batch.

9     Print the billing statements. 
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l The Statements step is used to generate the billing statements based on the state-

ment settings selected on the Statement Settings step (UB> New Billing> Statement

Settings). The statements will be generated in a PDF report. Once the PDF file is

complete, you can print the statements onto your billing statement stock.

l Select Statements from the New Billing palette. This will open the Statements win-

dow.

l The Account Number field is used to print a single statement. Click the Account

Number field label to select a customer account from a list or enter a UB customer

account number.

l Select the Mail Type in the drop-down menu.

l Select Certified Bills if you want the postal bar codes to display on the bills.

Only select this option if you have used the Address Certification feature. If

you have not run the Export Addresses and Import Addresses step and you

select this option, no statements will display on the report.

l Select Non-Certified Bills if you do not want postal bar codes to display on the

bills.

l Select the order you would like the bills to print in the Sort drop-down menu.

l Select Auto Presort if you would like to sort the billing by the sort order gen-

erated by the address certification process so that they can be put into trays.

Only select this option if you used the Address Certification feature to verify

the addresses on the statements in the batch.

l Select Reference Number to sort the billing by UB customer account ref-

erence number.
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l The reference number is attached to UB customer accounts in UB>

Maintenance> Account> Account tab> Account sub-tab> General sec-

tion> Reference Number field.

l The Reference Number will only be displayed on the generated state-

ments if the Reference Number toggle is checked on the UB Statement

Setup window.

l The Include drop-down menu is used to select the statements you would like to

include in the printing.

l Select All Statements if you would like to print all statements that have been

included in the New Billing batch.

l Select Hold Status Only if you would like to generate statements only for cus-

tomer accounts that have a hold status. This will include temporary and per-

manent hold status accounts on the report.

l UB customer accounts are assigned a hold status using the Account Master

Maintenance window (UB> Maintenance> Account> Account tab> Account

sub-tab> General section> Hold Status drop-down menu).

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Clicking the Print icon will only create the PDF report. Once the report is

complete, print the report out to generate the statements.

l If there is bank account information attached to the UB customer account (UB>

Maintenance> Account> Account tab> ACH Info sub-tab) a “Do Not Pay – Auto-

matic Debit” message will display on the statement.

l After the New Billing batch has been committed, a Direct Debits batch can be

processed to remove the billed amount from the customer bank (CH> Direct

Debits).

l When the statements are generated, they are archived on the application server. If

you would like to reprint the billing statements but the New Billing batch has been

committed or you do not want to return to the Statements step, you can locate the

statements in the archive folder and reprint them. The billing statements are

archived at the following path: \\server path\version folder (for example, v7.18)\d-

b\select a database slot (Springbrook0-9) \archive\Reports\calendar year\UB\New

Billing\ .

10     Export Statements. 
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l The Export step is an optional step used to create an export file of the New Billing

statements. This option is generally used by Springbrook customers that outsource

the printing and sorting of their billings.

l Select Export from the New Billing palette. This will open the Export window.

l Enter an account number in the Account Number field if you would like to export

the statement of a single customer. Click the Account Number field label to select a

customer account from a list. This will open the Account Master Search window.

l The Mail Type field is used to select the mail type of the statements that should be

exported.

l Select Certified Bills to export the bills that have been certified using the

Export Addresses and Import Addresses steps on the New Billing palette.

l If the statements have not been certified, no statements will be included

in the export.

l Select Non-Certified to export statements that have not been certified using

the Export Addresses and Import Addresses steps. If you skipped the Export

Addresses and Import Addresses step on the New Billing palette, you should

select this option.

l The Sort drop-down menu is used to select how the statements on the export file

will be sorted.

l Select Auto Presort to sort the statements on the export file by the sort order

created by the address certification feature.

l The Layout drop-down menu is used to select the format of the export file gen-

erated by the Export process. Click the Format icon at the top of the window to

display the format of the export file.
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l The Include drop-down menu is used to select the New Billing statements you

would like to include in the export.

l Click the Confirm icon when complete to create the export file.

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the statements.

l Check the Open toggle if you would like to open the exported file after it is saved loc-

ally.

l Enter the export path location and click the Save icon to export the file to the

local path.

11     Print the General Ledger Distribution Report. 

l If the Utility Billing module is set up to interface with the General Ledger module the

GL Distribution step will display on the palette. The GL Distribution Report will dis-

play the journal entry generated to record the billing.

l Select GL Distribution from the New Billing palette. This will open the UB GL Dis-

tribution/New Billing window.

l Enter a Journal Entry Date. The journal entry date will determine which fiscal

period and fiscal year the journal entries in the batch will be posted to. Verify the

journal entry date is correct.

l The Fiscal Period and Fiscal Year fields will populate based on the date entered in

the Journal Entry field.
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l These fields will not be enabled. The only way to modify the values in these

fields is to modify the journal entry date.

l Select a detail and sort option for the report in the Report Type drop-down menu.

l The detail version of the report displays the line item detail of each general

ledger account. The report will display the fund, general ledger account num-

ber, customer number, service number, service code, general ledger account

description, debit amount and credit amount. The report will also group and

total general ledger accounts by fund. It can be sorted by GL Account or by

Transactions Type.

l The summary version of the report will not display the line item detail of the

general ledger accounts. The report will display the fund, general ledger

account number, GL account description, debit amount and credit amount.

The summary report will also total by general ledger account number, and

fund. It can be sorted by GL Account or by Transactions Type.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l You will receive an error message if the selected fiscal period has been locked

using the Lockout Periods feature (GL> Utilities> Lockout Periods).

l Review the GL Distribution Report before committing the New Billing batch. Once a

batch has been committed it cannot be uncommitted.

l If you would like to recreate the GL Distribution Report after the batch has been com-

mitted, you can generate a Transaction by Date Report (UB> Reports> Transaction

by Date) for the committed New Billing batch. Select the committed batch (UB>

Reports> Transaction by Date> Batch Number field), include all cycles and make

sure the date filter includes all of the transactions in the batch.

12     Print a Summary by Rate Report. 

l The Summary by Rate Code Report displays the billings grouped and totaled by the

rate codes on the billing. The report will display the service totals and the report

totals.

l Select Summary by Rate from the New Billing palette. This will open the Summary

by Rate Code/New Billing window.

l Select the information you would like to display on the report in the Report Type

drop-down menu.

l Select Detail if you would like the report to display a separate minimum/flat

amount billing and consumption amount billing. The detail version of the
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report will display the service rates, number of accounts on each service rate,

minimum/flat amount billing, total consumption billing, actual consumption,

and billable consumption. This report will also display tiered consumption

data, including tier level number, tier billing amount, and total tier con-

sumption.

l Select Summary if you would like the report to display all billings in a single

column titled Total Billing. The minimum/flat amount billing and the billable

consumption amount will be grouped together in the Total Billing column.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

13     Commit the billing batch. 
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l Select Commit from the New Billing palette. This will open the Commit/New Billing

window.

l Press ENTER to commit the batch.
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UB> New Billing

No Consumption in a New Billing batch

Summary

This document describes some basic reasons why the consumption on a meter may not dis-

play on a billing. If a UB customer account has an unbilled meter reading on their account

but that reading is not being included in a New Billing batch, move through the list below to

bill the unbilled meter reading.

Step by Step

1     Verify that the meter reading is unbilled and entered correctly. 

l Open the Devices tab of the Account Master Maintenance window (UB> Main-

tenance> Account> Devices tab).

l Make sure the Billed toggle is unchecked on the meter reading you believe should

be included in the New Billing batch. If the Billed toggle is checked, the meter read-

ing has already been included in a billing and will not be pulled into a New Billing

batch.
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l If you believe the Billed toggle should not be checked, you can open the

Device Maintenance window (select the meter and click the Modify icon

from the Devices tab of the Account Master Maintenance window), delete the

billed meter reading and then create a new meter reading with the Billed

toggle unchecked.

l Make sure the Consumption column displays a valid consumption amount. For

example, an amount greater than zero.

l If the consumption is zero, no consumption will be billed. If the consumption

amount calculated incorrectly, open the Device Maintenance window (select

the meter and click the Modify icon from the Devices tab of the Account

Master Maintenance window) and modify the consumption on the meter read-

ing.

2     Verify the setup of the UB module. 

l There is a UB module setup that determines if all unbilled meter readings or only

meter readings of a specific reading period will be included in a New Billing batch. If

the meter readings have the incorrect read period, or the incorrect read period was

entered during the Generate step of the New Billing batch, the consumption on

those meter readings will not be included in the billing.

l Open the Billing tab of the Setup window (UB> Utilities> Setup> Billing tab).

l The Meter Reads to Bill drop-down menu is used to set up which meter readings

will be included in a New Billing.
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l If Period is selected, only meter readings with a meter read period that is the

same as the billing period will be included in a New Billing batch.

l If Unbilled is selected, all unbilled meter readings will be included in a New

Billing batch.

l If Period is selected, but the meter read period of the unbilled readings do not match

the billing period selected during the Generate step of the New Billing batch (UB>

New Billing> Generate> Billing Period field), the meter readings will not be

included in the batch. You can view the meter read period from the Devices tab of

the Account Master Maintenance window (UB> Maintenance> Account> Devices

tab> Select a meter> Read Period/Read Year column).

l If the meter read period does not match the billing period, open the Device Main-

tenance window from the Devices tab (Click the Modify icon while a device is

selected) and change the Read Period of the meter reading. When you regenerate

the New Billing, the meter reading will be included in the batch.

3     Verify that the meter has the same bill type as the service rate. 

l The consumption of a meter is billed using the service rates that have the same bill

type as the meter. You can view the bill type of a device from the Devices tab of the

Account Master Maintenance window (UB> Maintenance> Account> Devices tab>

Select a meter> Meter Details sub-tab> Bill Type field). You can view the bill type of

a service rate from the Service Rate Maintenance window (UB> Maintenance> Ser-

vice Rates> Open the current revision of a service rate> General tab> Bill Type

field).
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4     Verify that you are not generating bills using a service rate set up to use winter average. 

l Winter Average periods are set up on service rates. During a winter average period,

the calculated winter average consumption will be billed instead of the actual con-

sumption on a meter. If a calculated winter average has not been set up on the UB

customer account, no consumption will be billed on the account.

l You can view the winter average periods of a service rate on the Service Rate Main-

tenance window (UB> Maintenance> Service Rates> Winter Average/Taxes tab>

month toggles).

l If the billing that was missing the consumption is during a winter average period, the

UB customer account will need to have a committed winter average in order to bill

correctly. Open the Winter Average tab of the Account Master Maintenance window

(UB> Maintenance> Account> Winter Average). Uncommitted winter averages will

display in red. To commit the winter average, commit the Winter Average batch

(UB> Winter Average> Commit). When the New Billing is generated, the UB cus-

tomer account will bill using the calculated winter average.

5     Verify that the service rate is not set up as a flat rate. 

l If a service rate is set up as a flat amount service rate, the consumption on a device

will not be included in the billing.

l Open the Service Rate Maintenance window (UB> Maintenance> Service Rates>

General tab).
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l If the Flat Rate toggle is checked, the consumption on meters of the same bill type

will not be billed using the rate structure set up on the Consumption Levels tab.

l To bill the consumption on the meter, you can either add a service rate to the UB

customer account that is of the same bill type as the meter and does not have the

Flat Rate toggle checked, or you can uncheck the Flat Rate toggle on this service

rate.

l Un-checking the Flat Rate toggle on this service rate will affect all UB cus-

tomer accounts attached to this service rate.
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UB> Past Dues

Past Dues

Summary

The Past Due process allows you to pull UB customer accounts into a Past Dues batch

based on billing cycle, age of outstanding transactions and customer account status. Once

customer accounts have been included in a Past Dues batch, penalties are assessed using

an adjustment type code.

Customer accounts can be processed in more than one Past Dues batch at a time, so

make sure when you are assessing penalties that if customers are being processed in

another batch that they are not being double charged.

The adjustment code used to assess the late fees is a collection of fee codes. The fee

codes attached to the adjustment type code determine which GL accounts will be used in

the transaction and how penalty charges are assessed on the customer accounts. The fee

codes on the adjustment code will also determine which customer accounts are pulled into

the Past Dues batch based on the services attached to the fee codes and the minimum

amount of past due balances that the fee code will apply to. If there is credit information

attached to the adjustment type code, a credit history line item will be created on all cus-

tomer accounts processed in the Past Dues batch. Credit history line items display in the

Credit History section on the Account Master Maintenance window (UB> Maintenance>

Account> Overview tab).
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The entire balance of the customer accounts will only be pulled into the batch if all of the

services that are attached to the customer accounts are also attached to the fee codes

used to assess the penalties. Only the account balances on services that are attached to

the selected Past fee codes will be pulled into the batch.

The journal entry created by the Past Dues process will debit the AR account and credit the

revenue account attached to the fee code. The GL type of the adjustment type code will not

affect the journal entry created by the Past Dues process.

After customer accounts have been selected and processed in the Past Dues batch, you

can generate Past Due statements for the customer accounts in the batch. Past due state-

ments are set up in UB> Utilities> Statement Maintenance.

After the Past Dues batch is committed, the past dues will display on the customer account

as an adjustment line item transaction type. The amount of the adjustment line item will be

the amount of the penalties assessed on the account. The adjustments will only display on

the customer accounts when the batch is committed (UB> Maintenance> Account> History

tab). Uncommitted Past Due transactions will not display on the accounts in the batch.

Step by Step

1     Create a Past Dues batch (UB> Past Dues). 
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l Select the Past Dues palette in UB> Past Dues. This will expand the Past Dues

palette and display the steps of the Past Dues process.

l Select New from the Past Dues batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Past Dues process, you can create a new

batch without affecting the open batches. Customer accounts can be pro-

cessed in more than one Past Dues batch at a time, so be careful when select-

ing Past Dues criteria so that customers are not charged twice.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The batch month and batch year do not

affect the transaction or journal entry date of the transactions in the batch.

l The transaction date of the billing is set up in the Generate step and the fiscal

period the transactions are posted to is determined by the Journal Entry

Date entered when creating the GL Distribution Report (UB> Past Dues> GL

Distribution).

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate the Past Dues. 
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l Open the Generate/Past Dues window (UB> Past Dues> Generate).

l The Generate/Past Due window is used to select which customers will be included

in the Past Dues batch. After the Past Dues batch has been generated, the

Select/Update step allows you to remove individual customer accounts from the

Past Dues batch. After the Past Dues batch has been generated, returning to the

Generate step and regenerating the batch will overwrite the customer accounts

already included in the batch.

l Any credits on services that are marked to Exclude from Redistribute (UB>

Maintenance> Account> Service Rates tab) will not be included when apply-

ing existing credits to past due services.

l Select the Billing Cycles you would like to include in the batch in the Cycles field.

l Press CTRL+A to select all of the cycles in the field. Press SPACEBAR to

check or uncheck all of the highlighted toggles.

l Billing cycles are created and maintained in UB> Maintenance> Billing Cycle.

l You can view the billing cycle attached to a customer account in UB> Main-

tenance> Account> Account tab> Account sub-tab> General section> Billing

Cycle field.

l The Balance Date From and Balance Date To fields are used to filter the accounts

that will be included into the Past Dues batch.

l Input the oldest date of the transactions you want to process charges on in the

Balance Date From field.

l Some customers will enter a date 120 days in the past in this field.

l Input the most recent date of the transactions you want to process charges on
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in the Balance Date To field.

l Some customers will enter a date 30 days in the past for this date.

l The Penalty Date field is the transaction date of the late fees generated on the cus-

tomer accounts in the Past Dues batch.

l The IVR Cutoff Date field is not used by the standard UB Past Dues process. Enter-

ing a date in this field will not affect the application.

l This field is used in conjunction with the Springbrook Interactive Voice

Response Application Programming Interface. If your organization uses a

third-party IVR vendor, they may choose to use this field.

l Enter an amount in the Minimum Charge field to assess a minimum charge on all

accounts processed in the batch. This minimum dollar amount will be assessed on

all accounts regardless of the actual penalty.

l For example, if you assess a minimum charge of $10.00 and the late fees gen-

erated on the account during the Past Due process adds up to $8.50, the

account will be assessed the minimum of $10.00.

l If you would only like to assess past dues charges if the past due amount is

greater than a user defined minimum, you can set that up on the Fee Code

Maintenance window (UB> Maintenance> Fee Code> Past Due Minimum

field) of the fees attached to the adjustment type selected in the Adjustment

Type for New Charges section.

l The Payment Plans drop-down menu is used to configure how Payment Plans are

included in the Past Dues batch.

l Select Exclude to exclude all payment plans from the batch. This is the most

common configuration and the default setting.

l Select Include to include payment plans in a standard Past Dues batch.
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l Select Payment Plans Only to generate a Past Dues batch specifically for pay-

ment plans. This can be used to quickly identify all accounts that are asso-

ciated with payment plans and to customize the past due statement

accordingly.

l Select a Service Request Code in the drop-down menu to create a service request

for each customer account included in the Past Dues batch. For example, you can

create service requests to shut off the meters attached to the customer accounts

processed in the batch.

l The service date of the service requests being created will be the date the Commit

step is completed (which is the same as the Post Date of the batch).

l The Service Request Description field will populate with the service request

description as the service request code has been selected.

l The service requests created by the Past Dues process will not display on the

customer account until after the Past Dues batch has been committed.

l Check the Close service request toggle if you would like the service

requests created for the customers in the Past Dues batch to be closed when

the batch is committed. This will close the created service requests, but will

not commit them.

l Service requests created by the Past Dues batch will still have to be

committed (UB> Service Requests> Commit).

l If there is a fee code attached to the selected service request code, the ser-

vice request cannot be billed until the service request has been committed.

l If you would like to create service requests on all customer accounts in

the Past Dues batch, even customer accounts with a zero penalty
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amount, check the Create adjustment history for zero amounts

toggle.

l TheWaive Penalty Fee field is used to allow agencies to waive the first penalty fee

for accounts that meet specified historical requirements.

l By default, No will be selected in this field and the Past Due batch will process

as usual.

l Select Based on Credit History to use credit history to determine if an account

is eligible to have a penalty fee waived.

l This will enable the Credit History Sum Under field below. This value

is dependent upon user-defined credit history adjustment type trans-

actions that some agencies use to help determine the credit worthiness

of a UB account. When this type of credit history system is set up,

accounts can be assessed specified credit values when being pro-

cessed through a Past Due or Collections batch. Any accounts with a

credit history value that falls below the sum entered in this field will have

their Past Due penalty fee waived.

l The account credit history is displayed on the Overview tab of the

Account Maintenance window.

l Select Based on Good Standing to use good standing to determine if an

account is eligible to have a penalty fee waived.

l This will enable the Good Standing Since field below. Good standing

is user-defined status that is based on the presence of an adjustment

type in a specified date range.

l For example, when a penalty adjustment associated with a previous

Past Due batch is present on an account, the good standing status of
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that account could be determined by the date that penalty adjustment

was made. If the most recent Past Due penalty adjustment on an

account was assessed over 60 days ago, and the Good Standing Since

date field is set to a date exactly 60 days ago, the account in question

will be considered in good standing and any penalty adjustments asso-

ciated with this Past Due batch will be waived.

l When waiving fees based on good standing, check the Create adjust-

ment history for zero amounts toggle to the right to ensure the

waived fee will still appear as an adjustment on the account history.

This ensures that the good standing status of the account in question is

updated to reflect a past due adjustment even if that adjustment did not

result in a charged penalty fee.

l Select the status of the accounts you would like to include in the batch in the

Account Status field.

l You can view the status of an account in UB> Maintenance> Account>

Account tab> Account sub-tab> General section> Account Status field.

l Check the Include Budget Services toggle to include services that are set up as

budget services on the customer account (UB> Maintenance> Account> Service

Rates tab> Open a service rate> Budget toggle).

l If you do not check this toggle, budgeted services will not be included in the

Past Dues batch.

l Check the Include Uncommitted Payments toggle to include uncommitted cash

receipts payments when determining the past due amounts. For example, if a cus-

tomer has made a payment and that payment is in an open Cash Receipts batch

(CR> Cash Receipts), check this toggle to reduce the past due amount by the pay-

ment amount.
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l Check the Include Payment Plan Accounts toggle to include accounts with
a payment plan in the batch. This includes payment plans that are in good

status and payment plans that have failed.

l Check the Create adjustment history for zero amounts toggle if you would like to

process customer accounts in the batch even if a penalty is not assessed. This

allows you to create shut off service requests and print past due statements on cus-

tomer accounts not charged a penalty. You can use this toggle if you do not assess

past due penalties but would like to generate past due statements on customer

accounts that have a delinquent balance.

l The selection in this toggle will affect the functionality of the Select Update

window (UB> Past Dues> Select Update). The Select Update window is used

to select the customer accounts that you would like to process in the batch. If

the Create adjustment history for zero amounts toggle is checked, customer

accounts that are not assessed a penalty will be included in the batch if they

are selected. If the Create adjustment history for zero amounts toggle is not

checked, customer accounts that are not assessed a penalty will not be

included in the batch even if they are selected in the window.

l Check the Close service request toggle if you would like the service requests cre-

ated for the customers in the Past Dues batch to be closed when the batch is com-

mitted.

l The Close service request toggle will only be enabled if a service request

code is selected in the Service Request Code field.

l If you do not check this toggle, the service requests created by the Past Dues

batch will have an Active status.
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l The service requests created by the Past Dues process will not display on the

customer account until after the Past Dues batch has been committed.

l Select an adjustment type. The fee codes attached to the selected adjustment type

code will determine the charges applied to the customer accounts included in the

Past Dues batch.

l You can select only one adjustment type. If you would like to apply fee codes

from more than one adjustment type you will have to create a new adjustment

type that contains all of the fee codes you would like to apply.

l Only adjustment type codes set up as Past Due adjustment types will display

in the Adjustment Type for New Charges section.

l Adjustment type codes are created and maintained in UB> Main-

tenance> Adjustment Type Code, and are set up as Past Due adjust-

ment types by selecting Past Due from the Process drop-down menu.

l Click on the Expand button next to the adjustment type code to see the fee

codes attached to the adjustment type.

l The charge this service attached to the fee codes (UB> Maintenance>

Fee Codes> Service to Charge field) must be attached to a customer

account in order to assess penalties. If the charge this service is not

attached to the customer account, an exception will display on the

Exceptions step (UB> Past Dues> Exceptions) and the penalty fees will

not be assessed on the customer account.

l If you modify an adjustment type using the Adjustment Maintenance win-

dow (UB> Maintenance> Adjustment Type) while the Generate window

is open, the Generate window will not update with the modified adjust-

ment type information.
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l Click the Confirm icon to generate the Past Dues immediately or enter a date

and time in the field next to the Confirm icon to schedule the Past Dues to generate

at a later time.

l You can view the progress of the Generate step on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l The adjustment transactions generated by the Past Dues batch will not display on

the customer accounts until the batch is committed (UB> Past Dues> Commit).

Uncommitted past due transactions will not display on the customer accounts (UB>

Maintenance> Account> History tab).

3     Complete the Exceptions step. This is an optional step. 

l The Exceptions step will display errors and exceptions generated on customer

accounts during the Past Dues process.

l Open the Exceptions/Past Dues window (UB> Past Dues> Exceptions).

l The “Found credit balance in Service XX for the amount of XXX,” message will dis-

play if there is a credit balance on a service attached to the account.

l If you would like to process the customer account in the Past Dues batch, run

the Redistribute Credits process (UB> Adjustments and Fees> Redistribute

Credits).

l The “Missing Service XXX. Cannot apply penalty,” message will display if the ser-

vice to charge on a fee code used to assess a past due penalty is not attached to a

customer account. For example, if LATE fee code charges service PENALTY, the
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PENALTY service must be attached to the customer account. You can view the ser-

vice a fee code will charge on the Fee Code Maintenance window (UB> Main-

tenance> Fee Code> Service To Charge field).

l To fix this exception, add the service to the UB customer accounts using the

Service Rates tab of the Account Master Maintenance window (UB> Main-

tenance> Account> Service Rates tab).

l Press ESC when complete to exit the window.

4     Select which customer accounts to include in the Past Dues batch and/or add additional charges.
This is an optional step. 

l Skip this step if you would like to charge all of the customer accounts selected dur-

ing the Generate step.

l The Select/Update step on the Past Dues palette is used to select the customer

accounts that will be included in the Past Dues batch. The Select/Update window

will display the past dues generated based on the selections during the Generate

step. The Select/Update window allows you to select which generate past dues are

processed in the batch, and is also used to modify the past dues amount.

l Open the Select Update window (UB> Past Due> Select/Update).

l The Select Update window will display all of the UB customer accounts included in

the Past Dues batch.

l Use the Select All and Deselect All drop-down menus to select or deselect

all the displayed customer accounts for Print, Select, or IVR Call.
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l Uncheck the Print toggle if you do not want the customer account to print on a Past

Due statement (UB> Past Dues> Statements). Charges will still be applied to the

customer account, but a Past Due statement will not be generated.

l The Print toggle will not apply if the Selected toggle is unchecked. You can-

not print a Past Dues Statement unless the customer account is included in

the batch.

l Uncheck the Selected toggle if you do not want to include the customer account in

the Past Dues batch. No charges will be generated on the customer account.

l If the Selected toggle is unchecked, the selection in the Print toggle will not

apply. You cannot print a Past Dues Statement unless the customer account

is included in the batch.

l Customer accounts with the Selected toggle unchecked will be removed from

the Select/Update window after you click the Save icon. This means if you

uncheck the Selected toggle of a customer account and save the window, you

will have to regenerate the Past Dues batch in order to add that customer

account back into the Past Dues batch.

l Check the IVR Call toggle for each account that should receive an IVR call when

the Past Dues batch is committed.

l Interactive Voice Response (IVR) systems are third-party tools that can be set

up to automatically generate past due courtesy calls when an account is

flagged as past due.

l For more information on implementing an IVR system, please contact Spring-

brook Support at 800-777-0069.

l Click the Expand button to view the fee code amounts that will be applied to the cus-

tomer account.
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l Each fee code that is attached to the adjustment type selected during the Gen-

erate step (UB> Past Dues> Generate> Adjustment Type For New Charges

section) will display as a separate line item.

l The Additional Charges column will displays the charges calculated during the

Generate step based on the fee codes attached to the selected adjustment type.

Modify the amount in the Additional Charges column if you would like to modify the

amount of the fee.

l The selection in the Create adjustment history for zero amounts toggle on the

Generate window (UB> Past Dues> Generate) will affect the functionality of the

Select Update window. If the Create adjustment history for zero amounts toggle was

checked when the batch was generated, customer accounts that are not assessed a

penalty (there is a $0 in the Additional Charges column) will be included in the

batch if they are selected. If the Create adjustment history for zero amounts toggle

was not checked during the Generate step, customer accounts that are not

assessed a penalty will not be included in the batch even if they are selected in the

window.

l Click the Save icon or press ENTER when complete.

5 Print the Aging Report. 

l The Aging Report will display the age of the balances included in the Past Dues

batch and the penalty fees that will be applied. This report can also display com-

ments attached to customer accounts using the Account Master Maintenance win-

dow (UB> Maintenance> Account> Comments tab).
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l Select Aging Report from the Past Dues palette to open the Aging window.

l The Sort By drop-down menu is used to select how the report will sort.

l Select a fee code option (fee code, customer number or fee code, reference

number) to filter the customer accounts that display on the report by the fee

codes used to apply the penalty charges. This will display a total for each fee

code used to charge penalty fees. For example, if penalty fees are applied

using LATE% and LATEFLAT, selecting a fee code option will display a total

of the fees generated using LATE% and LATEFLAT. If you do not select a fee

code option, the report will not display a separate total for each fee code used

to generate penalties.

l The Alert Codes field is used to add the comments attached to the customer

accounts to the report. For example, if you have a comment status used to record

conversations with customers regarding past dues, you can select that comment

status so that those comments will display on the report. The report will display both

the comment status and the comment description (the comment description is the

comment text entered on the customer account in UB> Maintenance> Account>

Comments tab> Select a comment> Comment Body section).

l Select the comment codes you would like to display on the report in the Alert

Codes field. If you do not check any comment codes, the comment will not dis-

play on the report.

l Closed comments will not display on the report. If a date has been entered in

the Close Date column (UB> Maintenance> Account> Comment tab> Close

Date column) the comment is considered closed and will not display on the

report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Aging Report will display the following information: customer information (cus-

tomer name, account number, reference number), fee code, fee code description,

balance forward, past due amount, under 30 days, 30-60 days, 60-90 days, 90-120

days and other.

l The difference between the amount in the Balance Forward column and the

Past Due column is the penalty charge applied to the customer account.

l The Reference Number that displays on the report is the reference number

on the customer account. You can view the reference number attached to a

customer account in UB> Maintenance> Account> Account tab> Account

sub-tab> Reference Number field.

l When the UB module set up to use Days in Period as the aging period (UB

Setup> General tab> Aging Periods field> Days in Period), the report will dis-

play the aging balance by period rather than 30-60-90-120 day range.
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6 Print a Proof List. 

l The Proof List will display the Past Due amount, the penalty charges generated on

the account, and the new balance forward on the account. This report can also dis-

play comments attached to customer accounts using the Account Master Main-

tenance window (UB> Maintenance> Account> Comments tab).

l Select Proof List from the Past Due palette. This will open the Proof List window.

l Select how you would like the report to sort in the Sort By drop-down menu. The

selection in this field will only affect how information is displayed on the report.

l The Alert Codes field is used to add the comments attached to the customer

accounts to the report. For example, if you have a comment status used to record

conversations with customers regarding past dues, you can select that comment

status so that those comments will display on the report. The report will display both

the comment status and the comment description (the comment description is the

comment text entered on the customer account in UB> Maintenance> Account>

Comments tab> Select a comment> Comment Body section).

l Select the comment codes you would like to display on the report in the Alert

Codes field. If you do not check any comment codes, the comment will not dis-

play on the report.

l Closed comments will not display on the report. If a date has been entered in

the Close Date column (UB> Maintenance> Account> Comment tab> Close

Date column) the comment is considered closed and will not display on the

report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

7     Print a Shut Off Listing Report. 

l The Shut Off Listing Report will display the customer information, meters attached

to the account, past due amount, penalties, and the new account balance forward.

This report can also display comments attached to customer accounts using the

Account Master Maintenance window (UB> Maintenance> Account> Comments

tab).

l Select Shut Off Listing from the Past Due palette. This will open the Shut Off Listing

window.

l Select how you would like the report to sort in the Sort By drop-down menu. The

selection in this field will only affect how information is displayed on the report.
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l The Alert Codes field is used to add the comments attached to the customer

accounts to the report. For example, if you have a comment status used to record

conversations with customers regarding past dues, you can select that comment

status so that those comments will display on the report. The report will display both

the comment status and the comment description (the comment description is the

comment text entered on the customer account in UB> Maintenance> Account>

Comments tab> Select a comment> Comment Body section).

l Select the comment codes you would like to display on the report in the Alert

Codes field. If you do not check any comment codes, the comment will not dis-

play on the report.

l Closed comments will not display on the report. If a date has been entered in

the Close Date column (UB> Maintenance> Account> Comment tab> Close

Date column) the comment is considered closed and will not display on the

report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

8     Set up the past dues statements. 

l The Statement Settings window is used to set up the Past Dues statements and

select which customer accounts in the Past Dues batch will receive statements. If a

statement is not generated for a customer account included in the Past Dues batch,

past due penalties will still be assessed on the account.

l Select Statement Settings from the Past Due palette. This will open the Statement

Settings window.

l Enter the due date of the past dues in the Due Date field.

l The value in this field will default to the current date plus 15 days.

l Enter the transaction date of the past dues batch in the Transaction Date field. The

Transaction Date field will default to the transaction date entered during the Gen-

erate step (UB> Past Dues> Generate> Transaction Date field).

l The Minimum and Maximum fields are not used in the Past Dues process.

l Select the past dues statement you would like to print in the Statement drop-down

menu.

l Statements are created and maintained in the Statement Setup Maintenance

window (UB> Utilities> Statement Setup).

l The Bill To drop-down menu is used to specify the format for the optional Bill To

Report.
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l The Account Status field is used to select the status of the customer accounts that

a statement will print for.

l The Message 1 and Message 2 fields are used to add messages to the past due

statements. You can either enter a message in the field, or click the Message 1 or

Message 2 field label to select a message from a list.

l The Statement Message Maintenance window (UB> Maintenance> State-

ment Message) allows you to create and maintain message statements.

l Press ENTER when complete. The statements will be generated after the

addresses of the customer accounts included in the Past Dues batch have been veri-

fied.

9     Certify the addresses of the customer accounts included in the Past Dues batch. 

l The Export Addresses and Import Addresses steps are used to certify the

addresses of the statements generated in the Past Dues batch. Skip to the State-

ments step if you do not use address certification.

l The Drop Date field is used by those users who would like to specify a mail-

ing date that will populate the Mailer's Mailing Date field on the postage state-

ment. If no date is specified, the field will default to the current date.

l The Include drop-down menu is used to select the statements you would like

to include in the mailer export.

l Select All Statements if you would like to include all statements in the

Final Billing batch.
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l Select Hold Status Only if you would like to include only those state-

ments for customer accounts that have a hold status. This will include

temporary and permanent hold status accounts on the mailer export.

l Select No Hold Status Only if you would like to include only those state-

ments for customer accounts that DO NOT have a hold status.

l UB customer accounts are assigned a hold status using the Account

Master Maintenance window (UB> Maintenance> Account> Account

tab> Account sub-tab> General section> Hold Status drop-down

menu).

10     Print the past dues statements. 

l The Statements step is used to generate the past due statements based on the

statement settings selected on the Statement Settings step (UB> Past Dues> State-

ment Settings). The statements will be generated in a PDF report. Once the PDF file

is complete, you can print the statements onto your past dues statement stock.

l Select Statements from the Past Dues palette. This will open the Statements win-

dow.

l Select a customer account in the Account Number field to print a statement for a

single account.

l Click the Account Number field label to select a customer account from a list.

You will only be able to print Past Due statements for customer accounts that

have been included in the batch. If you select a customer account that is not
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in the Past Due batch, the report will not print and the Jobs Viewer will display

an error message (Unable to find any UB Accounts that match the Print

options.)

l This option is generally used to reprint statements.

l Select the order that statements will print in the Sort drop-down menu.

l If the addresses of the customer accounts have been certified, select Auto

Presort. This will select Certified Bills in the Mail Type drop-down menu and

disable the field.

l If the customer accounts in the Past Dues batch have not been certified using

the Export Addresses and Import Addresses steps, do not select Auto Presort

in the Sort drop-down menu. No statements will print and the Jobs Viewer win-

dow will display an error message (Unable to find any UB Accounts that

match the Print options).

l The Mail Type drop-down menu will be enabled if Auto Presort was not selected in

the Sort drop-down menu.

l Do not select Certified Bills if the Export Addresses and Import Addresses

steps on the Past Dues palette have not been used to certify the addresses in

the batch. If this option is selected and the addresses have not been certified,

the Jobs Viewer window will display an error message (Unable to find any UB

Accounts that match the Print options).

l The Include drop-down menu is used to select the past due statements you would

like to include in the printing. This field is disabled for the Past Dues process as all

statements are automatically included.

l A past dues statement will not print for a customer account if the statement is

not attached to the customer account.
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l You can view the statements attached to a customer account on the

Account Master Maintenance window (UB> Maintenance> Account>

People tab> Bill To sub-tab).

l The Past Due Statements are set up and maintained in UB> Utilities> State-

ment Setup. The Statement Name field of the report will display in the drop-

down menu.

l Press ENTER to generate the Statements immediately or enter a date and time in

the field next to the Print icon to schedule the Statements to print at a later time.

l If the Statement selected in the Statement drop-down menu is not attached to any of

the customer accounts included in the batch the Jobs Viewer window will display an

error message (Unable to find any UB Accounts that match the Print options).

l Additional Past Dues statements will print if there are additional customers attached

to any of the customer accounts included in the Past Dues batch.

l Additional customer accounts are attached to the Account Master Main-

tenance window of the account included in the batch (UB> Maintenance>

Account> People tab> Bill To sub-tab).

11     Export Statements. 

l The Export step is an optional step used to create an export file of the Past Due

statements. This option is generally used by Springbrook customers that outsource

the printing and sorting of their billings.

l Select Export from the Past Dues palette. This will open the Export window.
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l Enter an account number in the Account Number field if you would like to export

the statement of a single customer. Click the Account Number field label to select a

customer account from a list. This will open the Account Master Search window.

l The Mail Type field is used to select the mail type of the statements that should be

exported.

l Select Certified Bills to export the bills that have been certified using the

Export Addresses and Import Addresses steps on the Past Dues palette.

l If the statements have not been certified, no statements will be included

in the export.

l Select Non-Certified to export statements that have not been certified using

the Export Addresses and Import Addresses steps. If you skipped the Export

Addresses and Import Addresses step on the Past Dues palette, you should

select this option.

l The Sort drop-down menu is used to select how the statements on the export file

will be sorted.

l Select Auto Presort to sort the statements on the export file by the sort order

created by the address certification feature.

l The Layout drop-down menu is used to select the format of the export file gen-

erated by the Export process. Click the Format icon at the top of the window to

display the format of the export file.

l This field will default to the standard Springbrook export layout. Before using

other options, such as KVS or Shut Off, please confirm that the selected lay-

out includes the data you wish to export.

l The Include drop-down menu is used to select the past due statements you would

like to include in the export.
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l Click the Confirm icon when complete to create the export file.

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the statements.

l Check the Open toggle if you would like to open the exported file after it is saved loc-

ally.

l Enter the export path location and click the Save icon to export the file to the

local path.

12     Print a GL Distribution report. 

l For organizations that have the GL module interfaced with the Utility Billing module,

the GL Distribution step will display on the Past Dues palette. The GL Distribution

step is used to set up the journal entry date and create a GL Distribution Report that

displays the journal entry created by the Past Dues batch.

l Select GL Distribution to open the UB GL Distribution report window.

l Enter a Journal Entry Date. The Journal Entry Date will determine the fiscal year

and period the transactions in the batch will be posted to.

l The Fiscal Period and Fiscal Year fields will populate based on the date

entered in the Journal Entry Date field.

l The Journal Entry Date is not necessarily the same date as the Post Date that

will display on the History tab of the Account Master Maintenance window
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(UB> Maintenance> Account). The post date is the date that the batch is com-

mitted.

l Select the Report Type for the report.

l The summary version of the report will display the net change in the general

ledger accounts. It will not display the fee code and the penalties assessed to

each customer account. It can be sorted by GL Account or by Transactions

Type.

l The detail version of the GL Distribution report will display the transaction line

on each general ledger account. The report will also display the fee code of

each journal entry line item and the penalty assessed on each customer

account. It can be sorted by GL Account or by Transactions Type.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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l The general ledger accounts used to assess the penalties depends on the general

ledger accounts on the fee codes attached to the adjustment type selected during

the Generate step.

l You can view the fee codes used to create the journal entry by generating the

report in detail format, or you can view the fee codes attached to the type

code on the Adjustment Type Maintenance window (UB> Maintenance>

Adjustment Type> Fee Code field).

l The AR GL account on the fee code (UB> Maintenance> Fee Code> AR

Account field) will be debited in the transaction.

l The revenue GL Account on the fee code (UB> Maintenance> Fee Code>

Revenue Account field) will be credited in the transaction.

l The GL Type of the adjustment type code does not affect the journal entry cre-

ated by the Past Dues process. Adjustment types set up as cash or bill will

generate the same journal entry.

l Generate the GL Distribution report in the detail version if you want to view

the fee codes used in the transaction. This will help you track back where the

GL accounts are being pulled from if you are processing a Past Dues batch

that uses more than one fee code to assess penalties.

13     Commit the batch when complete. 

l Select Commit step from the Past Dues palette. This will open the Commit Past Due

Information window.
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l The Commit step generates the history records on the customer accounts for the

assessed penalty charges and the service requests for the customers in the batch if

you selected a service request code during the Generate step.

l If you are creating service requests on the customer accounts in the batch, the Com-

mit step will create the service requests.
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UB> Refunds

Refunds Setup

Summary

You need to set up the UB module before using the Refunds process (UB> Refunds). For

most organizations, this means creating an adjustment type code that will determine the

journal entry created by the refund check. After creating the refunds adjustment type,

attach it to the Setup window (UB> Utilities> Setup).

If you will factor interest on deposits in the Refunds process, you will also need to create a

fee code titled INT, and add interest rates to all of the deposit fee codes you would like to

factor interest on.

Step by Step

1     Add the check refunds adjustment type to the Setup window. 

l Open the General tab of the Setup window (UB> Utilities> Setup> General tab).

l Click the Check Refund Adjustment Type field label to select an adjustment type

code from a list.
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l Press INSERT to create an adjustment type code. This will open the Adjustment

Type Maintenance window.

l The selection in the GL Type drop-down menu will affect the check refund journal

entry line item created by the Refunds process.

l If you select Cash, the Refunds process will create the following journal entry

line item for the amount of the refund check:

Description Debit Credit

AR account attached to service rate XXX

Cash account attached to service rate XXX

l If you select Bill, the Refunds process will create the following journal entry

line item for the amount of the refund check:

Description Debit Credit

AR account attached to service rate XXX

Revenue account attached to service rate XXX

l Click the Save icon or press ENTER to save the adjustment type code.

2     Add an interest rate to the deposit fee codes and create a fee code titled INT if you are factoring
interest on customer accounts. 
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l When deposits are refunded, you have the option of accruing interest on those

deposit amounts. If you would like to accrue interest on deposit amounts, add an

interest rate to all deposit fee codes and create an INT fee code. The interest rate

on the deposit fee code will be used to calculate the factored interest and the INT

fee code will determine the GL accounts used in the interest journal entry.

l Open the deposit fee code using the Fee Code Maintenance window (UB> Main-

tenance> Fee Code).

l Select a deposit fee code.

l Add the interest amount in the Percent Amount field. Interest will be accrued using

the value entered in this field.

l Attach a percentage amount to each deposit fee code you would like to factor

interest on.

l The INT fee code is used to define the GL accounts that will be used to factor

interest.

l Enter INT in the Fee Code field.

l The Service to Charge drop-down on the INT fee code does not affect the journal

entry generated by the Refunds process.

l The service rate used in the journal entry to refund the interest amount is the

lowest number service rate on the lowest numbered service attached to the

customer account.

l Enter the GL accounts to use when factoring interest in the Revenue Account and

Cash Account fields.

l Factoring interest will create the following journal entry:
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Description Debit Credit

Revenue account on INT fee code XXX

Cash account on INT fee code XXX

l Click the Save icon or press ENTER to save the fee code.
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UB> Refunds

Refunds

Summary

The Refunds process is used to refund the credit balance and/or deposit amounts on UB

customer accounts. Accounts that are in open (uncommitted) UB process batches (for

example a New Billing batch) or Final account status cannot be processed in a Refunds

batch. After customers have been processed in a UB Refunds batch the physical checks

can be generated in your Accounts Payable department using the Proof List (UB>

Refunds> Proof List) generated by the process.

The Generate step (UB> Refunds> Generate) is used to select the customer accounts and

the balances to refund in the batch and set the transaction date of the refund transactions

in the batch (UB> Refunds> Generate> Refund Date field). If you are processing multiple
customer accounts in a Refunds batch, you can filter the customer accounts included in the

batch by account status, deposit date, minimum credit amount, billing batch (New or Final

Billing) and/or a specific fee code the account has been charged (for example, customer

accounts that have been assessed Past Dues penalties). You can also filter the customer

accounts by final date if you include Delete status accounts in the batch.

The Exceptions step is an optional step that displays the UB customer accounts that have

been selected during the Generate step (UB> Refunds> Generate) but have not been

included in the Refunds batch due to an error. A typical error that displays on the step is a
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customer account with a debit balance or a customer account being processed in an open

batch. If the UB customer account is being processed in an open batch the batch number

and process (for example, CR Cash Receipt batch number 00001-01-2019) will display on

the Exceptions step.

The Select/Update step is used to select the customer accounts that will be included in the

Refunds batch based on the accounts selected during the Generate step. This allows you

to remove specific customer accounts from the Refunds batch. After the customer

accounts have been selected and the Select/Update step has been saved, the uncom-

mitted refund transactions will display on the customer accounts included in the Refunds

batch.

The Proof List Report is generated after the customer accounts have been selected and is

the report you will hand to the AP department so they can generate the refund checks.

The GL Distribution Report step is used to set the journal entry date of the journal entry gen-

erated by the Refunds batch and generate the GL Distribution Report.

Once the process is complete, the Commit step is used to commit the refund transactions

on the UB customer accounts. The day the Commit step of the Refunds batch is completed

is the post date of the transactions in the batch.

Step by Step

1     Create a Refunds batch (UB> Refunds). 
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l Select the Refunds palette in UB> Refunds. This will expand the Refunds palette

and display the steps of the Refunds process.

l Select New from the Refunds batch number drop-down menu to create a new batch.

This will open the New Batch window.

l If there are open batches in the Refunds process, you can create a new batch

without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The transaction date of the billing is set up in

the Generate step and the fiscal period the transactions are posted to is determined

by the Journal Entry Date entered when creating the GL Distribution Report in

UB> Refunds> GL Distribution.

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2 Generate the refunds. 
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l The Generate step is used to select the customer accounts you would like to include

in the batch and the balances that will be refunded.

l Open the Generate/Refunds window (UB> Refunds> Generate).

l Select how you would like to select customers in the Setup drop-down menu.

l Select List Multiple Accounts if you want to process refund checks on more

than one account at a time.

l Select Accounts if you want to include only selected customer accounts in the

batch. Select the customers to include in the Refunds batch in the Account

Number field.

l Select List By Billing Batch in order to select customer accounts by a com-

mitted New or Final billing batch using the Batch Number field. This option is

used to select customer accounts that have been finaled.

l Select which transactions you would like to refund in the Refund Type drop-down

menu.

l Select Deposits to refund customer deposits.

l If a customer account in the Refunds batch has a positive balance

(owes money on their UB account), the deposit amount will be applied

to their account balance first. For example, if a UB customer account

has a balance of $15 and a deposit of $50, $15 of the deposit will be

applied to the customer account balance and the Refunds process will

generate a refund check for $35 ($50 deposit - $15 account balance).

l Select Credit to refund customer accounts with credit balances. This option

will ignore the deposit amount on the customer accounts.
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l Select Deposits & Credits to refund both customer deposits and credit bal-

ances.

l The Refund Date field is used to enter the transaction date of the refund trans-

actions processed in the batch.

l The Refund Date field will default to the current date.

l Enter an amount in the Minimum Credit Amount field to exclude all refunds from

the batch that are equal to or less than a specific amount. Some Springbrook cus-

tomers enter $1.00 in this field so they do not create refund checks less than $1.

l Select the deposit amount to be refunded in the Apply drop-down menu.

l Select Full Deposit if the entire deposit amount should be refunded.

l Select Before Good Standing Date if you would like to use the Good Standing

section to select the deposit amounts on the customer accounts to include in

the batch.

l The Account Number field is used to include selected UB customer accounts in the

Refunds batch. This field is only enabled if you select Select Accounts in the Setup

drop-down menu.

l Click the Account Number field label to select the UB customer accounts from

a list.

l Click on the Batch Number field label to select the customer accounts to be

included in the batch by committed billing batch. This will open a window listing the

committed New and Final billing batches.

l This field will only be enabled if List By Billing Batch is selected in the Setup

drop-down menu.
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l Select the statuses of the accounts you would like to include in the batch in the

Account Status field.

l This field will only be enabled if List Multiple Accounts is selected in the Setup

drop-down menu.

l If you include Delete status accounts in the batch, the Final Date From and

Final Date To filter fields will be enabled.

l A final status toggle is not included in the Account Status field because final

status accounts cannot be included in a refunds batch. If the final status

account is part of a final billing batch, commit the final billing batch or remove

the account from the batch and then process the refund.

l The Deposit Date From and Deposit Date To fields are used to filter the accounts

included in the Refunds batch by the date a deposit was applied to a customer

account.

l These fields will not be enabled if Credits is selected in the Refund Type

drop-down menu.

l You can view the transaction date of a deposit on the Account Master Main-

tenance window (UB> Maintenance> Account> History tab> Select Deposit

History from the drop-down menu> Expand the deposit fee code> Trans-

action Date column).

l The Final Date From and Final Date To fields are used to filter the accounts

included in the Refunds batch by the date the account was finaled.

l You can view the final date of a customer in UB> Maintenance> Account>

Account tab> Account sub-tab> General section> Final Date field.
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l Check the Factor Interest toggle to accrue interest on customer deposits. This

toggle will only be enabled when you include deposits in the Refunds batch (Depos-

its or Deposits & Credits is selected in the Refund Type drop-down menu).

l Some organizations refund the interest that has accumulated on deposit

amounts. The factor interest toggle allows you to calculate the interest on a

deposit amount and refund that amount. The interest will be calculated using

the interest rate attached to the deposit fee code used to generate the

deposit, and will use the GL accounts attached to the INT fee code to gen-

erate the interest rate journal entry. Interest will be calculated starting at the

deposit date on the deposit to the refund date (Refund Date field on the Gen-

erate window).

l The deposit will calculate the interest based on the interest rate attached to

the deposit fee code. The interest rate is attached to a deposit fee code using

the Fee code Maintenance window (UB> Maintenance> Fee Code> Percent

Amount field).

l The GL account numbers used when factoring interest will be pulled from the

INT fee code (UB> Maintenance> Fee Code). The process will use the rev-

enue and cash account attached to the INT fee code to record the increase in

interest (debit revenue, credit cash). The interest will increase the deposit

amount.

l When factoring interest the process uses the transaction date of the deposit.

You can view the transaction date of the deposit in the History tab of the

Account Master Maintenance window (UB> Maintenance> Account> History

tab> Select Deposit History in the drop-down at the top of the tab). The

deposit date is entered when payment on the deposit. If the deposit is a cash
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deposit, the deposit date is the receipt date on the receipt that created the

cash deposit.

l Check the Suppress refund check toggle to suppress the refund checks gen-

erated in the batch. This option is generally used when refunding deposits and

using the refunded deposit amount to reduce the account balance rather than cre-

ate a refund check. When the Refunds Proof List is generated no check amount will

display on the report.

l Check the Default payee information toggle if you would like the customer name

and address to populate on the Proof List (UB> Refunds> Proof List) and Select/Up-

date window (UB> Refunds> Select/Update> Payee Information section). If you are

handing the Refunds Proof List Report to the Accounts Payable department to pro-

cess the AP checks, you may want to check this toggle to include the customer

name and address on the proof list so the AP department knows who to make the

checks out to and where to send them. The customer name and address will be

pulled from the address on the customer account (UB> Maintenance> Account>

People tab> Customer tab> Contact Information section).

l If you do not check this toggle the Select/Update window will not populate with

the customer account information and the Proof List Report will only display

the payee information if payee information is manually entered on the

Select/Update window (UB> Refunds> Select/Update> Select a customer

account> Payee Information section).

l The Good Standing section allows you to remove accounts from the batch that

have been charged a specific fee code during a period of time.

l The Good Standing section will not be enabled if Select Accounts is selected

in the Setup drop-down menu.
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l Enter a date in the Since field. This is the date the filter will begin searching

for a transaction that is attached to the selected fee codes. For example, if

you would like to remove all UB customer accounts that have been charged a

late fee in the last three months and it is 12/31/21, enter 09/30/21 in the Since

field. All customer accounts that have been charged the fee code selected in

the Fee Codes field since 09/30/21 will not be included in the batch. If the cus-

tomer was charged the late fee prior to 09/30/21, they will be included in the

Refunds batch.

l Select the fee codes to filter the customer accounts that are included in the

Refunds batch. This field is used in conjunction with the Since field. For

example, if you would like to exclude UB customer accounts that have been

charged the Past Due late fee code LATE, select the LATE fee code.

l Press CTRL+A to select all of the toggles in the field. After the toggles

have been selected, check or uncheck a toggle to apply the selection to

all of the highlighted toggles.

l Hold down SHIFT to highlight all of the toggles between two selections.

After the toggles have been selected, check or uncheck a toggle to

apply the selection to all of the highlighted toggles.

l Press ENTER to generate the refunds batch as soon as possible, or enter a date

and time in the field next to the Confirm icon to generate the batch at a later

time.

l You can view the progress of the Generate step on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs). If the refunds have been scheduled to

generate at a later time, you can view the scheduled date and time in the

Scheduled Date/Time field.
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l If you have not set a refunds adjustment type, you will receive an error message

when you try to save the Select step.

l Refund adjustment types are set up in the Setup window (UB> Utilities>

Setup> General tab> Check Refund Adjustment Type field).

3     View the exceptions and errors generated on the Refunds batch. This is an optional step. 

l The Exceptions step of the Refunds palette is displays why UB customer accounts

selected during the Generate step have not been included in the Refunds batch.

l Open the Exceptions/Refunds window (UB> Refunds> Exceptions).

l Here is a list of common exceptions and their solutions.

l “Found uncommitted history in system”

l The most common reason a customer account is not included in a

Refunds batch is that the customer is part of an uncommitted batch. To

process the customer in the Refunds batch, you can either commit the

batch or remove the customer from it. The process and batch number of

the open batch will display on the Exception step.

l “There are no Credit/Deposit amounts to apply”

l This exception will display if there is no balance forward or deposits on

the account.

l This exception message will display the same even if deposits or credit

balances were not included in the Refunds batch.
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l If you fix some of the errors that display on the Exceptions step, you will have to

regenerate the Refunds batch in UB> Refunds to include the modified UB customer

accounts in the batch.

4 Select the generated customer accounts to include in the Refunds batch and modify the payee
information. This is a required step. 

l Open the Select Update/Refunds window (UB> Refunds> Select/Update).

l Check the Selected toggle of each customer account you would like to include the

refunds batch.

l Click the Select All icon to select all of the customer accounts in the Select

window.

l Click the Deselect All icon to deselect all of the customer accounts in the

window.

l The Payee Information section is used to enter the information that should display

on the refund check. Information entered into these fields will display on the

Refunds Proof List (UB> Refunds> Proof List). If you checked the Default Payee

Information toggle on the Generate window (UB> Refunds> Generate) the contact

information of the customer account will display in the Payee Information section

and this information will be included on the Refunds Proof List.

l Select a customer account in the left section of the window and enter the

information you would like to display on the check in the Payee Information

section.
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l Click the Save icon when complete.

l Any UB customer accounts that were not selected will be removed from the

batch. If you return to the Select step, the Select Update window will only dis-

play UB customer accounts that were selected.

l The uncommitted refund transactions will display on the customer accounts after

the Select/Update step has been completed. Before this step is complete the uncom-

mitted transactions will not display on the customer account (UB> Maintenance>

Account> History tab).

5 Print a proof list. 

l Open the Proof List/Refunds window (UB> Refunds> Proof List).

l Check the Print Mailing Address toggle to include the customer mailing address

data in the report.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The Refunds Proof List report will display the customer name, customer number,

service address, customer mailing address, beginning balance, deposit, interest,

apply, refund, transfer and check.

l The Proof List will display the payee name and address if you checked the

Default Payee Information toggle on the Generate step (UB> Refunds> Gen-

erate) or manually entered payee information into the Payee Information sec-

tion on the Select/Update step (UB> Refunds> Select/Update). This allows

you to include the check information on the Proof List if the Accounts Payable

department generates the refund checks based on the Proof List.

l The Check column will display the amount of the refund checks. If you

checked the Suppress Refund Check toggle during the Generate step (UB>

Refunds> Generate), no amount will display in the Check column.

l Review the proof list for accuracy. Once the transactions have been committed,

they cannot be rolled back.

6 Print a GL Distribution list. 
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l The GL Distribution Report will display the journal entry generated by the Refunds

process.

l Select GL Distribution from the Refunds palette. This will open the GL Distribution

Report window.

l Enter the journal entry date in the Journal Entry field. The journal entry date will

determine which fiscal period and fiscal year the journal entry created by the

Refunds process is posted to.

l The Fiscal Period and Fiscal Year fields will populate based on the journal

entry date. The fiscal period and fiscal year is calculated based on the Fiscal

Year and Fiscal Period Starts fields on the System Setup window (SS> Util-

ities> System Setup> Organization tab).

l Select a report detail and sort option in the Report Type drop-down menu.

l The summary report will only display the net effect on the general ledger

accounts. If transaction line items create a wash on a general ledger account

(a GL account is debited and credited for the same amount), that general

ledger account will not display on the report. The summary report will display

the general ledger account number, general ledger account description, debit

amount, and credit amount.

l The detail report will display every line item of the journal entry, not just the

net effect. The detail report will display the account number, customer num-

ber, utility billing service number, special charge code, general ledger account

description, debit amount and credit amount.

l Group the report by transaction type if you would like the journal entry line

items to be grouped by adjustment payment, interest (if you have factored

interest on the deposit amounts), and refund amounts. This option is helpful if
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you are factoring interest on deposit amounts because it groups the journal

entries so they are easier to understand.

l The summary report debit and credit report total amounts may not balance

between the summary by GL account report and the summary by transaction

type report because the summary report only displays the net effect on the

general ledger account in a grouping. Since the two summary reports group

the general ledger accounts differently, certain transactions may not wash in

both reports. The detail report credit and debit report total amounts will always

balance between the two reports.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the journal entry and GL accounts used in the transaction for accuracy.

l The journal entry created to refund the credit balance of a customer account is the

following:
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Description Debit Credit

AR account attached to service rate or fee code XXX

Cash/Revenue account attached to service rate or fee

code (depending on GL type of Refund adjustment type)
XXX

l The GL Type attached to the Refunds adjustment type will affect the journal

entry generated by the process. The Refunds adjustment type is defined in

the Setup window (UB> Utilities> Setup> General tab> Check Refund

Adjustment Type field). If the refund adjustment type is set up as a bill type,

the revenue account will be credited. If the refund adjustment type is set up as

a cash type, the cash account will be credited.

l If you did not run the Redistribute Credits process (UB> Adjustment and

Fees> Redistribute Credits), there may be service rates on the customer

accounts with a positive balance. Those service rates and fee codes will be

reversed by debiting the cash or revenue account on the service rate or fee

code, and crediting the AR account.

l The journal entry created to refund the deposit on a customer account is the fol-

lowing:

Description Debit Credit

Reverse the deposit - Revenue account attached to
deposit fee code

XXX
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Reverse the deposit - Cash account attached to
deposit fee code

XXX

Move deposit amount to service rate - AR account

attached to service rate
XXX

Move deposit amount to service rate - Cash/Revenue
account attached to service rate (depending on GL type

of Refund adjustment type)

XXX

Refund deposit amount - AR account attached to ser-

vice rate
XXX

Refund deposit amount - Cash/Revenue account
attached to service rate (depending on GL type of

Refund adjustment type)

XXX

l The deposit amount is refunded by reversing the deposit amount, crediting a

service rate on the customer account for the deposit amount, and then refund-

ing the deposit amount using the service rate on the customer account.

l If you view the GL Distribution Report in summary format, you will only

see the journal entry line item to reverse the deposit amount since the

other two transactions result in a wash (the service rate is credited and

debited for the same amount).

l Refunding a deposit will create three separate line items on the History tab of

the Account Master Maintenance window (UB> Maintenance> Account> His-

tory tab). The refund process will create a refund transaction to refund the

deposit amount, an adjustment transaction to apply the deposit amount to a
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service rate on the account, and an adjustment transaction for the refund

check amount.

l The following journal entry will be created by the refunds process if you are factor-

ing interest on deposit amounts:

Description Debit Credit

Record the interest amount - Revenue account
attached to INT fee code

XXX

Record the interest amount - Cash account attached
to INT fee code

XXX

Reverse the deposit - Revenue account attached to
deposit fee code

XXX

Reverse the deposit - Cash account attached to
deposit fee code

XXX

Move deposit amount to service rate - AR account

attached to service rate
XXX

Move deposit amount to service rate - Cash/Revenue
account attached to service rate (depending on GL type

of Refund adjustment type)

XXX

Refund deposit amount - AR account attached to ser-

vice rate
XXX

Refund deposit amount - Cash / Revenue account
attached to service rate (depending on GL type of

Refund adjustment type)

XXX
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l The journal entry created by the refunds process will record the interest

amount, reverse the deposit amount (which included the factored interest),

move the deposit amount to a service rate on the customer account and then

refund the deposit and interest amount.

l Factoring interest and then refunding the deposit will create four separate line

items on the History tab of the Account Master Maintenance window (UB>

Maintenance> Account> History tab). The process will create an interest trans-

action to record the interest, a refund transaction to refund the deposit

amount, an adjustment transaction to apply the deposit amount to a service

rate on the account, and an adjustment transaction for the refund check

amount.

l If you would like to recreate the GL Distribution Report after the batch has been com-

mitted, you can create a Transaction by Date Report (UB> Reports> Transaction by

Date) for the committed Refunds batch. Select the committed batch (UB> Reports>

Transaction by Date> Batch Number field), include all cycles, and make sure the

date filter includes all of the transactions in the batch.

7 Commit the refunds. 

l Select Commit from the refunds palette. This will open the Commit Refunds win-

dow.

l If you use the Accounts Payable module, the Batch Number field will display the

AP Invoice batch created by the Refunds process.

REFUNDS 597



l The AP Invoices batch entered in the Batch Number field will be created and

committed by the Refunds process. Use the AP module Computer Checks pro-

cess (AP> Computer Checks) to create the refund checks after committing

the Refunds batch.

l The AP History record created when the Refunds batch is committed will

include a Description field that includes the customer number, customer

sequence, and service address in the following format: "Refund Check cust_

no-cust_seq, service address"

l Press ENTER or click the OK button to commit the Refunds batch immediately or

enter a date and time to schedule the batch to commit later.

l You can view the progress of the Proof List on the Job Viewer window (SS>

Utilities> Show Scheduled Jobs). If the report has been scheduled to gen-

erate at a later time, you can view the scheduled date and time in the Sched-

uled Date/Time field.

l This will post the adjustment transactions to each customer account in the Refunds

batch.
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UB> Reports> Account Master

Account Master Report

Summary

The Account Master report is a list of Utility Billing customer accounts filtered by account

status, billing cycle, connection date and/or final date. The report will display the balance

forward on each customer account. Unbilled meter readings and uncommitted transactions

are not included in the balance forward.

Step by Step

1     Open the Account Master window (UB> Reports> Account Master).

2     Configure the report. 

l Select how you would like the report to sort in the Report Sort drop-down menu.

l Select Account Number to sort the report by the account number.

l Select Customer Name to sort the report by the name associated with the

account. You can view the customer information in UB> Maintenance>

Account> People tab.
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l Select Owner Name to sort the report by the name of the owner on the lot. 

You can view the owner of a lot in UB> Maintenance> Account> Lot tab>

Owner’s Customer Number field.

l Select Reference Number to sort the report by reference number. You can

view the reference number of a customer account in UB> Maintenance>

Account> Account tab> Account sub-tab> General section> Reference Num-

ber field.

l Select Route/Sequence to sort the report by route and sequence number.

This will replace the Reference number column on the report with Route and

Sequence number column.

l Select Service Address to sort the report by the address the UB service is

attached to. The service address will default to the lot address set up on UB>

Maintenance> Account> Lot tab.

l Select a Billing Cycle from the Billing Cycle drop-down menu to filter the report by

billing cycle.

l Select All to include all billing cycles in the report.

l The Billing Cycle drop-down menu will display all billing cycles that have been

created in UB> Maintenance> Cycle Code.

l You can view the billing cycle that is attached to a UB customer account in

UB> Maintenance> Account> Account tab> Account sub-tab> General sec-

tion> Billing Cycle field.

l Select the account statuses that you would like to include in the Account Status

field.

l If you include Delete status accounts on the report, accounts with a zero bal-

ance and a delete status will not be included in the report unless you check
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the Show Delete accounts with zero balances toggle at the bottom of the

window.

l Zero balance accounts of all other account statuses will display on the

report.

l The Connect Date From and Connect Date To fields are used to filter the

accounts included in the report by the account connect date. Press DELETE to

remove a date from a date field.

l You can view the connect date of an account in UB> Maintenance> Account>

Account tab> Account sub-tab> Connect Date field.

l If you enter a value in the Connect Date From or Connect Date To field, the

other field must also be used. Press the Down arrow to insert the current date

into a field.

l The connect date on the account is not the same as the connect date on the

service rate. The connect date on the service rate is the date the service rate

is connected on the account. By filtering the report by connect date, you are

not filtering the services that will be included in the balance of the accounts on

the report. The balance of each account will not be affected by the connect

date filter.

l The Final Date From and the Final Date To fields are used to filter the accounts

that are included in the report by the final date on the account. Press DELETE to

remove a date from a date field.

l You can view the final date on an account in UB> Maintenance> Account>

Account tab> Account sub-tab> General section> Final Date field.
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l If you enter a value in the Final Date From or Final Date To field, the other

field must also be used. Press the Down arrow to insert the current date into a

field.

l The final date on the account is not the same as the final date on the service

rate. The final date on the service rate is the date the service rate is finaled on

the account. By filtering the report by final date, you are not filtering the ser-

vices that will be included in the balance of the accounts on the report. The

final date filter will not affect the balance of the customer accounts on the

report.

l Check the Show Delete accounts with zero balances toggle to include Delete

status accounts with a zero balance on the account.

l If you do not check this toggle, customer accounts with a delete status and

zero balance will not be included in the report.

l Customer accounts of other statuses (active, suspended, vacation, final) with

a zero balance are included on the report even if the Show Delete accounts

with zero balances toggle is not checked.

l The report will display the following information:  customer number, reference num-

ber, customer name, mailing address, business phone, home phone, connect date,

service address, final date and account balance.  The report will also provide a total

number of accounts listed.

l If the report was sorted by Route and Sequence number, the reference num-

ber column will be replaced with a route\sequence number column.

l The Account Balance column on the report displays the Balance Forward and

does not include unbilled meter readings or uncommitted transactions.
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3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Accounts By Service

Accounts by Service Report

Summary

The Accounts by Service Report displays a list of services and service rates filtered by

billing cycle, account status, connect date, service and service rate. The report displays the

customer information, account status, service connect date and service rates attached to

the service. You can view the service and service rates attached to a customer account

using the Account Master Maintenance window (UB> Maintenance> Account> Service

Rates tab).

Step by Step

1     Open the Accounts by Service window (UB> Reports> Accounts by Service).

2     Configure the report. 
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l Select the billing cycles you would like to include in the report in the Cycles field.

l Press CTRL+A to select all billing cycles. With all billing cycles selected,

check or uncheck a toggle to apply the toggle selection to all of the billing

cycles.

l Hold down SHIFT to select a range of billing cycles. When select a range of

billing cycles, make sure to click on the cycle number and not the toggle of the

cycle.

l Enter a date in the Connect From and Connect To field to filter the accounts that

display in the report by service connect date. Press DELETE to remove a date from

a date field.

l You can view the service connect date on an account in UB> Maintenance>

Account> Overview tab> Service Rates section> Connect Date field.

l Select the statuses of the UB customer accounts that you would like to include on

the report in the Account Status field.

l Press CTRL+A to select all of the toggles in the field. When you check or

uncheck a toggle, the selection will be applied to all of the selected toggles.

l Hold down SHIFT to select a range of statuses. When selecting a range make

sure to click on the status description rather than the toggle.

l Select the Service you would like to include on the report in the drop-down menu.

You can select only one service.

l Select the Service Rates you would like to include on the report in the Service

Rates field.

l The service rate field will only display the service rates attached to the service

selected in the Service drop-down menu.
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l Only accounts with the selected service rates will display on the report. If the

account has more than one service rate and only one of the service rates is

included on the report, the account will still display in the report, but only the

selected services rates will display in the Related Service Rates on

Account column.

l Press CTRL+A to select all of the toggles in the field. When you check or

uncheck a toggle, the selection will be applied to all of the selected toggles.

l Hold down SHIFT to select a range of service rates. When selecting a range

make sure to click on the service rate description rather than the toggle.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Accounts By Tax Code

Accounts by Tax Code Report

Summary

The Accounts by Tax Code Report is used to provide a filtered list of accounts based on tax

code. Only those accounts that include a service rate set up to use an override cash

account will be included in the report. Override accounts are set up on the Account Main-

tenance window (UB> Maintenance> Account> Service Rates tab> Override the tax codes

for this rate toggle).

The report will display the Account Number, Customer Name, Service Address, Service,

Rate Code, Rate Code Description, Tax Code, Tax Code Description and Tax Status. The

report will also provide account totals by billing cycle.

Step by Step

1     Open the Accounts by Tax Code window (UB> Reports> Accounts by Tax Code).

2     Configure the report. 
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l Select the billing cycles you would like to include in the report in the Cycles field.

l Press CTRL+A to select all billing cycles. With all billing cycles selected,

check or uncheck a toggle to apply the toggle selection to all of the billing

cycles.

l Hold down SHIFT to select a range of billing cycles. When select a range of

billing cycles, make sure to click on the cycle number and not the toggle of the

cycle.

l Select the account statuses of the UB customer accounts that you would like to

include on the report in the Account Status field.

l Press CTRL+A to select all of the toggles in the field. When you check or

uncheck a toggle, the selection will be applied to all of the selected toggles.

l Hold down SHIFT to select a range of statuses. When selecting a range make

sure to click on the status description rather than the toggle.

l Select the tax statuses you would like to include on the report in the Tax Status

field.

l Check the Standard toggle to include all accounts with a tax code that exists

on both the standard rate and the customer account.

l Check the Override toggle to include all accounts with a tax code that exists

on the customer account but does not exist on the standard rate.

l Check the Exempt toggle to include all accounts with a tax code that exists on

the standard rate but does not exist on the customer account. These accounts

will display in red on the report.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Aging Report

Aging Report

Summary

The Aging Report displays the balance forward on customer accounts, and the age of

those balances. The customer accounts included on the report can be filtered by account

status, billing cycle, balance forward amount and minimum aged balance. The Aging report

can be backdated by entering a date prior to the current date in the Aging Date field.
Uncommitted transactions are not included in the report.

Step by Step

1     Open the Aging Report window (UB> Reports> Aging Report).

2     Configure the report. 

l Select the billing cycles you would like to include in the report in the Cycle field.

l Press CTRL+A to select all toggles in the Cycles field. Press SPACE to check

or uncheck the highlighted toggles.
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l All billing cycles that have been created in UB> Maintenance> Cycle Code will

display in the Cycles field.

l Enter the aging date in the Aging Date field.

l The Aging Date is used to calculate the age of the account balances.

l Balance amounts will be placed in the less than 30 days, 30 to 60 days, etc.

column based on the date entered in the Aging Date field.

l When the aging period is set to Days in Period rather than 30-60-90-120 (UB>

Setup> General tab> Aging Periods field), the report headers will display Bal

Current Period, Bal Period 1 to Period 2, Bal Period 2 to Period 3, etc. The bal-

ance amounts will be placed in the appropriate column based on the date

entered in the Aging Date field.

l Enter an aging date prior to the current date in order to backdate the aging

report.

l Select the date type that will be used when calculating the age of transactions in the

Date Type field.

l Select Journal Entry to age the transactions on the report by the journal entry

date.

l You can view the journal entry date of a transaction on an account in

UB> Maintenance> Account> History tab> JE Date column.

l Select Post if you would like to age the transactions on the report by the date

they were committed.

l The Post Date is the date the batch creating the transaction was com-

mitted. The Post date is not necessarily the same date as the journal

entry date or transaction date.
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l You can view the post date of a transaction on an account in UB> Main-

tenance> Account> History tab> Post Date/Time column.

l Select Transaction Date to age the transactions based on the report by trans-

action date.

l The transaction date is generally a user defined date entered during the

generate step of a process. When generating a New Billing batch, the

transaction date is entered in UB> New Billing> Generate> Trans-

action Date field. When entering a receipt, the receipt date is the trans-

action date.

l You can view the transactions date of a transaction on an account in

UB> Maintenance> Account> History tab> Tran Date column.

l Select the status of the accounts you would like to include on the report in the

Account Status field.

l Select how you would like the report to sort in the Sort Order field. The selection in

this field will affect what information displays on the report.

l Select Customer Number to sort the report by customer number and include

the customer number field on the report.

l Select Reference Number to sort the report by reference number and include

the reference number field on the report.

l If you select reference number, the reference number field will display

on the report instead of the account number.

l The Balance Limits field is used to filter the accounts that display on the report

based on the balance forward on the account.
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l All Accounts - Select All Accounts to include all accounts that have been

included on the report based on the Cycles and Account Status fields.

l Accounts with Balance - Select Accounts with Balance to only include

accounts that have a balance forward of any age on the account. Accounts

with a credit balance will not be included on the report, but accounts with a

zero balance will be included on the report.

l Check the Exclude Zero Balance Accounts toggle if you do not want

zero balance accounts to display on the report.

l Accounts with Balance over 30 days - Select Accounts with Balance over 30

days to only include accounts that have a portion of the balance forward over

30 days old.

l Accounts with Balance over 60, 90, 120 days - These selections function the

same as the Accounts with Balance over 30 days.

l Accounts with Balance over Current Period, 2 Periods, 3 Periods, 4 Periods -

These selections are only displayed when the UB module is set up to use

Days in Period when calculating aging (UB> Setup> General tab> Aging Peri-

ods field).

l Using these selections will place the accounts in the Bal Fwd, Bal Cur-

rent Period, Bal Period 1 to Period 2, Bal Period 2 to Period 3, Bal

Period 3 to Period 4, and Bal Over Period 4 columns.

l The Balance Limits field in the report header will display the selection in

this field.

l The Minimum Balance and Minimum Aged Balance fields are used in con-

junction with the Balance Limits drop-down menu.
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l The Minimum Balance field is used to filter the customer accounts that dis-

play on the report by the balance forward on the account.

l For example, select Account Balances over 60 days in the Balance Lim-

its drop-down menu and enter $100 in the Minimum Balance field to

include customer accounts with transactions older than 60 days and a

balance forward greater than $100. The balance forward amount may

include transaction amounts that are not part of the aged balance. For

example, if a customer has a $25 dollar balance greater than 60 days

old, but also has $100 owed on a new billing, the customer will be

included in the report.

l If you want to filter the aged balance (the amount of the balance greater

than 60 days in this example), then use the Minimum Aged Balance

field.

l Customer accounts with a balance forward that matches the amount

entered in this field will be included on the report.

l The Minimum Aged Balance field is used to filter the customer accounts that

display on the report by the amount of the aged balance.

l For example, select Account Balances over 60 days in the Balance Lim-

its drop-down menu and enter $100 in the Minimum Aged Balance field

to include customer accounts with a balance older than 60 days and

greater than $100.

l Check the Exclude Zero Balance Accounts toggle to exclude any zero balance

accounts from the report. Customer accounts with credit balances will still display

on the report.
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l If you select Accounts with Balance in the Balance Limits drop-down menu,

only credit balance accounts will be filtered from the report. Check the

Exclude Zero Balance Accounts to exclude accounts with a zero balance (no

balance forward).

l The Aging Report will display the following information:  account number, account

status, balance forward, balance under 30 days, balance 30-60 days, balance 60-

90 days, balance 90-120 days and balance over 120 days.  The report also displays

cycle aged totals, cycle credit totals and cycle total in addition to aged grand totals,

credit grand totals and grand total.

l When set up to use Days in Period as the aging period in UB Setup, the report

will display the aging balance by period.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> AR Totals by Cycle Report

Accounts Receivable Totals by Cycle Report

Summary

The A/R Totals by Billing Cycle Report displays a balance forward total of all UB customer

accounts in a billing cycle regardless of the status of the customer account. The report will

display a single line item for each billing cycle included on the report, it will not display a

line item for each UB customer account included in the report. If you would like a report that

will display all of the UB customer accounts in a billing cycle and the balance forward on

the account, create an Account Master Report for a billing cycle (UB> Reports> Account

Master). Both reports pull the amount due from the field Balance_Forward in the UB_Fin-

ancial table.

Unbilled meter readings and uncommitted transactions are not included in the total on the

report. Only committed billings, payments and adjustments made on UB customer

accounts in the selected billing cycles will be included. You can view the history of an

account in UB> Maintenance> Account> History tab. Uncommitted transactions will be in

red.

If you would like to view the balance on AR GL accounts attached to fee codes and service

rates, run the Balance by AR Account Report (UB> Reports> Balance by AR Account). The

transactions that display on the Balance by AR Account Report are filtered by journal entry

date.
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Step by Step

1     Open the AR Totals By Cycle window (UB> Reports> AR Totals By Cycle).

2     Configure the report. 

l Select a billing cycle in the Billing Cycle drop-down menu.

l Select All to include all billing cycles in the report.

l All billing cycles that have been created in UB> Maintenance> Cycle Code will

display in the drop-down menu.

l You can view the billing cycle attached to a specific UB customer account in

UB> Maintenance> Account> Account tab> Account sub-tab> General sec-

tion> Billing Cycle field.

l The report will display a billing cycle and total column, and a Grand Total field for all

of the billing cycles included on the report. The Total column displays the balance

forward of all customer accounts in the billing cycle. You can view the balance for-

ward of a single customer account in Balance Forward column in the Account Bal-

ances section on the Overview tab of the Account Master Maintenance window

(UB> Maintenance> Account> Overview tab). Since the Account Balance field is the

Balance Forward field, the Account Balance field does not include unbilled meter

readings.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Backflow Test Results

Backflow Test Results Report

Summary

The Backflow Test Results report displays a filtered set of backflow meter testing results.

Step by Step

1     Open the Backflow Test Results window (UB> Reports> Backflow Test Results).

2     Configure the report. 

l Select a Report Type from the drop-down menu.

l The Summary report will display the device Serial Number, Status, Test

Period, Service Address, Installed Account number and Current Result.

l The Detail report will display everything included in the Summary report as

well as the Occurrence, Result and any notes included on the test.

l The Backflow Status field is used to limit the report to either Active or Removed

backflow meter status.

l If (All) is selected, both statuses will be included in the report.
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l Select a Test Period from the drop-down menu to filter the report by period.

l If (All) is selected, all periods will be included in the report.

l The Test Status field is used to limit the report to either Pass or Fail status.

l If (All) is selected, both statuses will be included in the report.

l Enter a test date range in the Test Date From and Test Date To to filter the report

by test date.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Balance by AR Account

Balance by AR Account Report

Summary

The Balance by AR Account Report will display the balance of accounts receivable GL

accounts attached to fee codes and service rates. Only committed transactions will be

included in the balances that display on the report and the transactions that are included on

the report can be filtered by journal entry date.

Accounts receivable GL accounts are attached to fee codes using the Fee Code Main-

tenance window (UB> Maintenance> Fee Code> AR Account field), and attached to ser-
vice rates using the Service Rate Maintenance window (UB> Maintenance> Service Rate>

Select a service> Select a service rate> Select a revision> General tab> AR Account field).

Generate the AR Totals by Cycle Report (AR> Reports> AR Totals by Cycle) if you would

like to print the AR balance by billing cycle. The transactions that display on the report can-

not be filtered by date.

Step by Step

1     Open the Balance by AR Account window (UB> Reports> Balance by AR Account).
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2     Configure the report. 

l The AR Account field is used to filter the report by a specific general ledger

account. Click the AR Account field label or enter a GL account number to filter the

report.

l General ledger accounts are created by fiscal year using the Chart of

Accounts Maintenance window (GL> Maintenance> Chart of Accounts>

Select a fiscal year).

l The Balance Date field is used to filter the transactions that display on the report.

l The Balance Date field will filter the transactions that display on the report by

journal entry date. Uncommitted transactions will not display on the report or

be included in the balances.

l The Report Detail drop-down menu is used to select the information that will dis-

play on the report.

l Select Total by GL Account if the report should display a single line item for

each GL account included on the report.

l This is the simplest version of the report.

l Select Show Rate Detail if the report should display the AR balance of each

service rate and fee code attached the AR GL account. The report will display

a line item for each fee code or service rate attached to the AR account and

will display the balance generated by each.

l Select Show Account Detail if the report should display the AR balance of

each service rate or fee code attached to the AR GL account, and the balance

of the UB customer accounts. The report will display a line item for each ser-

vice rate or fee code attached to the AR GL account, and will also display a
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line item for each UB customer account with a balance on those fee codes or

service rates.

l This is the most detailed version of the report. It displays all of the

information that displays on the previous two reports.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Comments by Status

Comments by Status Report

Summary

The Comments by Status Report displays a list of comments attached to UB customer

accounts filtered by comment status, creation date and close date.  The report will display

the entry date, close date, UB customer account number and comment text. The comment

text is the text entered in the Comment Body field when comments are added to a customer

account (UB> Maintenance> Accounts> Comment tab).

Step by Step

1     Open the Comments by Status window (UB> Reports> Comments by Status).

2     Configure the report. 

l Select the status of the comments you would like to include on the report in the Com-

ment Status drop-down menu. You can only print the report for a single comment

status.
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l Comment statuses are created in UB> Maintenance> Comment Status.

l If a comment is closed, select Closed from the Comment Status drop-down

menu to include the comment on the report. If the comment was originally of

another type and changed to Closed when the comment was complete, that

comment will only display on the report when you select Closed from the

drop-down menu.

l The Entry Date of a comment is the date the comment was created on the UB cus-

tomer account (UB> Maintenance> Account> Comment tab). Press DELETE to

remove a date from a date field.

l The entry date displays in the Creation Date field in UB> Maintenance>

Account> Comment tab. The Creation Date field will default to the current

date when the comment is created and cannot be modified.

l The Close Date From and Close Date To fields are used to filter the report by

close date. Press DELETE to remove a date from a date field.

l The close date of a comment is the date the status of the comment has been

changed to a Closed status. The close date of a comment can also be manu-

ally entered if the user does not want to change the status of the comment to

Closed.

l The close date of a comment displays on a UB customer account (UB> Main-

tenance> Account> Comment tab> Close Date field).

l The Comments by Status Report will display the comment status, enter date, closed

date, customer number and comment.

l The Comment field in the report is pulled from the Comment field when the

comment is created in UB> Maintenance> Account> Comments tab> Com-

ment Body section.
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3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption Adjustment

Consumption Adjustment Report

Summary

The Consumption Adjustment Report displays the leak and misread consumption adjust-

ments that have been entered on customer accounts using the Adjustment Input Wizard

(UB> Adjustments and Fees> Input> Adjustment). The consumption adjustments included

on the report can be filtered by meter route or billing cycle of the UB customer account, and

the meter read date, read period, and read year of the consumption adjustment. Con-

sumption adjustments that are in open Adjustments and Fees batches (UB> Adjustments

and Fees) will be included on the report.

Step by Step

1     Open the Consumption Adjustment window (UB> Reports> Consumption Adjust-

ment).

2     Configure the report. 
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l The Route field and Billing Cycle field are used to filter the consumption adjust-

ments that display on the report. You can filter the report by one or the other, but not

both.

l The Route field is used to filter the consumption adjustments that display on

the report by the meter route attached to the meter that was adjusted. You

can view the route attached to a meter on an account using the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab>

Meter Details sub-tab> Route/Sequence field).

l The Billing Cycle field is used to filter the consumption adjustments that dis-

play on the report by the billing cycle attached to the customer account that

was adjusted. You can view the billing cycle attached to a customer account

using the Account Master Maintenance window (UB> Maintenance>

Account> Account tab> Billing Cycle field).

l The Reading Begin and Reading End fields are used to filter the consumption

adjustments that display on the report by the read date of the consumption adjust-

ment. The consumption adjustment is assigned the same meter read date as the

meter reading that is being adjusted.

l The Reading Period and Reading Year fields are used filter the consumption

adjustments that display on the report by the reading period and reading year of the

consumption adjustment. The consumption adjustment is assigned the same read-

ing period and reading year as the meter reading the consumption adjustment was

adjusting.

l The Bill Types field is used to filter the report by the bill type attached to the meter

that was adjusted.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption by Class

Consumption by Class Report

Summary

The Consumption by Class Report displays the consumption of UB customer accounts that

belong to account classes. The report can be filtered by the meter read date and service

(water, electric, etc.). Account classes are user-defined groupings of customer accounts

that are attached to UB customer accounts on the Account Master Maintenance window

(UB> Maintenance> Account> Lot tab> Details section).

The report will only display the consumption on meters that are attached to UB customer

accounts that belong to an account class. The consumption on unbilled meter readings will

be included on the report.

Step by Step

1     Open the Consumption by Class window (UB> Reports> Consumption by Class).

2     Configure the report. 
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l Select the account classes you would like to include in the report in the Class field.

l Press CTRL+A to highlight all of the toggles in the field. Press SPACE to

check or uncheck all of the highlighted toggles.

l All account classes included in the report will create a separate line on the

report.

l Accounts classes are created and maintained in the Account Class Main-

tenance window (UB> Maintenance> Account Class).

l Select the service you would like to include on the report in the Service field.

l Press CTRL+A to highlight all of the toggles in the field. Press SPACE to

check or uncheck all of the highlighted toggles.

l All of the selected services will be grouped together on the report in a single

line item.

l Enter a date range in the Reading Begin Date and Reading End Date fields to fil-

ter the meter readings included on the report by read date.

l The consumption included on the report will be filtered by meter read date.

You can view the meter read date of a read on a customer account from the

Devices tab of the Account Master Maintenance window (UB> Maintenance>

Account> Devices tab> Meter History sub-tab).

l The consumption on unbilled meter readings will be included on the report.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption by Meter
Size

Consumption by Meter Size Report

Summary

The consumption by Meter Size Report will display the consumption on a selected meter

type (water, gas, electric) sorted by meter size. The size of a meter is set up on the device

type attached to the meter and can be viewed on the Device Maintenance window (UB>

Maintenance> Device> Meter tab> Device section> Size field). Electric meters do not have
a meter size, so the consumption on electric meters will be grouped together on a single

line item.

The Meter Status drop-down menu allows you to select the status of the meters you would
like to include on the report. The report will only include devices that are installed on cus-

tomer accounts or are on uncommitted service request. If a meter has an inventory status

of Installed (UB> Maintenance> Device> Meter tab> Device section> Inventory Status
field), but has not been installed on a customer account using a service request the meter

will not display on the report.

The Consumption by Meter Size Report includes a consumption conversion so you can

convert the consumption that displays on the report to the same unit. If you do not use a

consumption conversion, the report will display the consumption on the meter as it was
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read. For example, if there is 100 acre feet of consumption on a meter, and 100 cubic feet

of consumption on another meter on the report, both devices will display 100 units of con-

sumption on the report. In order to use the consumption conversion feature, there must be

a conversion formula set up on the conversion table (UB> Maintenance> Consumption

Conversion) for each unit type set up on a device type. For example, if the meters are read

in cubic feet and acre feet, you will need to create a consumption conversion formula to

change both cubic feet and acre feet into gallons.

The status of the customer account (Active, Suspended, Final, Vacation, Delete) attached

to the device will not affect the devices that display on the report. All active meters in the

route selected to report on will display on the report.

Step by Step

1     Open the Consumption by Meter Size window (UB> Reports> Consumption by Meter

Size).

2     Configure the report. 

l Select the meter routes you would like to include on the report in the Routes field.

l Press CTRL+A to highlight all of the routes in the Routes field. Press SPACE

to check or uncheck all of the selected toggles.

l You can view the route attached to a device in UB> Maintenance> Device>

Connections tab.
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l Select a conversion in the Convert To drop-down menu to convert the consumption

that displays on the report to another unit type. If you do not select a conversion, the

consumption will display on the report as it was read. For example, if there is 100

acre feet of consumption one meter and 100 cubic feet of consumption on another

meter, both devices will display 100 units of consumption on the report. The Convert

To drop-down menu allows you to convert the consumption on both meters to a

single unit type such as acre feet or cubic feet.

l The Convert To drop-down menu will display all Consumption Conversions

created in UB> Maintenance> Consumption Conversions.

l The consumption amount in the report is pulled from the Consumption field

of the Meter History table and is multiplied by the conversion selected in the

Convert To field.

l Enter a Reading Period and Reading Year of the meter reading you would like to

include in the report. This will filter the consumption that displays in the report by

meter read period and year.

l If a meter does not have a reading during the reading period and reading year

it will still display on the report. This filter is used to filter the consumption that

displays on the report, not the meters.

l The Reading Period and Reading Year of a reading are entered when you

import the meter reads (UB> Meter Management> Readings Import> Import

Meter Information window> Read Period and Read Year fields). You can

view the read period of a meter reading from the Device Maintenance window

(UB> Maintenance> Device> Consumption tab> Period column).

l Select the device types you would like to include in the report in the Device Type

drop-down.
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l If you select Electric devices, all devices will be grouped together on the

report since there is not meter size associated with electric meters.

l Select a Meter Status from the drop-down menu to filter the report by the status of

the meter connection.

l Select All to include all meters on the report.

l Meters attached to an uncommitted add device service request will

have a Pending connection status until the service request is committed

(UB> Service Requests> Commit). In order to include meters attached

to uncommitted add device service requests you must select All in the

Meter Status drop-down menu.

l You can view the connection status of a device from the Device Maintenance

window (UB> Maintenance> Device> Connections tab> Status column).

l A meter will have an Active status when it is installed on a customer account.

l The connection status will be set to removed when a remove device service

request has been committed on the customer account.

l The connection status will be inactive if the status was manually changed

from the Device Maintenance window.

l The report will display the following information:  meter size, number of accounts,

consumption and totals of the consumption and number of accounts columns.

l The number of accounts column is the total number of active meters attached

to the route or routes that were selected in the Begin and End Route range

fields. The meter does not have to have consumption during the read period

and year to be included in the number of accounts column.

l The consumption column will display the consumption as it was read on the

meter if a consumption conversion was not selected in the Convert To drop-
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down menu.

l If a conversion was selected in the Convert To drop-down menu, the

consumption on the device will be multiplied by the conversion amount

set up on the conversion table (UB> Maintenance> Consumption con-

version) based on the unit type attached to the device. For example, if

the consumption was read in cubic feet and is changed to gallons, the

consumption read on the meter (100) will be multiplied by the con-

version amount (7.48000) and then the service rate will be applied to

the modified consumption amount (748).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption by Service

Consumption by Service Report

Summary

The Consumption by Service Report displays the total consumption filtered by meter route

and grouped by service. Meters are included on the report by the service rates attached to

the customer account. The consumption on a meter will only be included on the report if

there is an active service rate on the customer account that has the same bill type as the

meter. For example, if a meter has a bill type of WATER, the consumption on that meter will

only be included on the report is the customer account attached to that meter has an active

service rate for the WATER bill type. Bill types are attached to service rates using the Ser-

vice Rate Maintenance window (UB> Maintenance> Service Rates> General tab> Bill
Type field).

The consumption on the meter will display on the report twice if there are two service rates

of the same bill type attached to the customer record attached to the meter. For example, if

a meter has a bill type of WATER and there are two active service rates on the customer

account with a bill type of WATER, the consumption on the meter will display on the report

twice. The consumption on the meter will display on the report even if the service rate is set

up as a flat amount.
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You can generate the report in summary or detailed format. The summary version of the

report will display a separate line item for each service rate attached to the customer

account on the meter that has the same bill type as the device. For example, if you gen-

erate the report for a meter route that only contains WATER bill type meters and all of the

customer accounts attached to those meters have service rate WATER1 (which is set up

as a WATER bill type service rate), all of the meters on the route will be combined into a

single line item that reads WATER1.

The detail version of the report will display each meter separately on the report, including

the meter route, sequence, and serial number and the customer account number.

Step by Step

1     Open the Consumption by Service window (UB> Reports> Consumption by Service).

2     Configure the report. 

l The Route field is used to select the meter routes you would like to include on the

report.

l Press CTRL+A to highlight all of the toggles and then press SPACE to check

or uncheck all of the selected toggles.

l You can view the route of a meter attached to a customer account using the

Account Master Maintenance window (UB> Maintenance> Account> Devices

tab> Meter Details sub-tab> Route-Sequence field).
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l The Report Type drop-down menu is used to select the level of detail you would

like to display on the report.

l Select Summary if you would like all of the meters on the report to be totaled

by the service rate attached to the customer account. Each service rate will

display as a separate line item on the report.

l Select Detail if you would like all of the meters to display on the report. This

will add the meter route, sequence and serial number to the report along with

the customer account number of the customer attached to the meter.

l The Service drop-down menu is used to select the services you would like to

include on the report.

l Select a conversion in the Convert To drop-down menu to convert the consumption

that displays on the report to another unit type. If you do not select a conversion, the

consumption will display on the report as it was read. For example, if there is 100

acre feet of consumption one meter and 100 cubic feet of consumption on another

meter, both devices will display 100 units of consumption on the report. The Convert

To drop-down menu allows you to convert the consumption on both meters to a

single unit type such as acre feet or cubic feet.

l The Convert To drop-down menu will display all Consumption Conversions

created in UB> Maintenance> Consumption Conversions.

l The consumption amount in the report is pulled from the Consumption field

of the Meter History table and is multiplied by the conversion selected in the

Convert To field.

l The Reading Period and Reading Year fields are used to filter the meter readings

that are included on the report.
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l The reading period and reading year of a meter read are set in the Meter

Reading Import window when the meter readings are imported into the applic-

ation (UB> Meter Management> Readings Import> Reading Period and Read-

ing Year fields).

l You can view the read period and read year of a meter reading on a customer

account using the Account Master Maintenance window (UB> Maintenance>

Account> Devices tab> Meter History sub-tab> Reading Period/Year

column).

l The Device Type drop-down menu is used to select the device type you would like

to include on the report.

l Device types are attached to meters when they are created or installed on the

account using the Service Request Input Wizard. You can view the device

type attached to a meter on an account using the Account Master Main-

tenance window (UB> Maintenance> Account> Devices tab> Details section>

Device Type column).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption by Type

Consumption by Type Report

Summary

The Consumption by Type Report allows you to group the meter consumption by meter

size and/or the miscellaneous 1 or miscellaneous 2 fields attached to the lot on the

accounts. The report will group the consumption that displays on the report by con-

sumption inside the city and consumption that is outside of the city. If the In City toggle is
checked on the lot record (UB> Maintenance> Account> Lot tab> In City toggle), the con-

sumption on the meter on that lot will display in the In City column on the report.

Step by Step

1     Open the Consumption By Type window (UB> Reports> Consumption by Type

Report).

2     Configure the report. 

l Select the meter read routes you would like to include in the report in the Route List

field.
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l Press CTRL+A to highlight all of the routes in the field. Press SPACE to check

or uncheck all of the selected routes.

l Meter routes are attached to devices, not UB customer accounts. You can

view the meter route attached to a device on a customer account using the

Account Master Maintenance window (UB> Maintenance> Account> Devices

tab).

l Select the billing cycles you would like to include on the report in the Billing Cycle

field.

l A billing cycle is attached to a UB customer account when the account is cre-

ated using the New Account Wizard. You can view the billing cycle attached

to a UB customer account using the Account Master Maintenance window

(UB> Maintenance> Account> Account tab> Billing Cycle field).

l Press CTRL+A to highlight all of the billing cycles in the field. Press SPACE to

check and uncheck the toggles in the field.

l The Type and Sub Type drop-down menus are used to select the type of con-

sumption that is included on the report.

l Select Meter Size if you would like to group the consumption on the report by

the meter size attached to the device.

l Select Lot Miscellaneous 1 or Lot Miscellaneous 2 if you would like to group

the consumption by the value in the miscellaneous field attached to the lot

record.

l You can view the values in the miscellaneous 1 and miscellaneous 2

fields on the lot attached to a customer account using the Account

Master Maintenance window (UB> Maintenance> Account> Lot tab>

Miscellaneous sub-tab).
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l The label of the miscellaneous 1 and miscellaneous 2 fields will vary

depending on the label set up for those fields using the miscellaneous

fields labels maintenance feature (SS> Utilities> Miscellaneous Fields

Labels).

l The Reading begin and Reading end fields are used to filter the meter reading

included on the report.

l You can view the meter read date on a meter reading using the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab>

Meter History sub-tab). You can also view the meter readings on a device

using the Device Maintenance window (UB> Maintenance> Device> Con-

sumption tab).

l The Reading period and Reading year fields are used to filter the readings that dis-

play on the report by the read period and read year. You can view the read period

and read year of a meter reading using the Account Master Maintenance window

(UB> Maintenance> Account> Device tab> Meter History sub-tab). You can also

view the meter readings on a device using the Device Maintenance window (UB>

Maintenance> Device> Consumption tab).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Consumption Revenue
Report

Consumption Revenue Report

Summary

The Consumption Revenue Report displays a filtered list of the revenue generated by the

consumption on meters grouped by either meter size or lot class.

Step by Step

1     Open the Consumption Revenue window (UB> Reports> Consumption Revenue).

2     Configure the report. 

l The Meter Size field is used to select the meters included in the report by meter

size.

l When a meter is attached to a customer account using a service request, you

must select a device type to attach to the meter (generally the manufacturer

and model of the meter). The device type attached to the meter determines
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the size of the meter. For example, the size of a water meter is determined by

the water meter device type attached to the meter. If you would like to view or

modify the size of a meter device type, use the Water Meter Device Main-

tenance window (UB> Maintenance> Water Device Type> Water tab> Device

Size field).

l The Class field is used to select the classes that will be included in the report.

l Classes are created and maintained using the Class Maintenance window

(UB> Maintenance> Class).

l Class codes are attached to lots using the Lot Maintenance window (Lot icon>

Open a lot> Lot tab> Class field).

l If you would like to sort the report by class code, select class in the Sort

Order drop-down menu.

l The Begin Date and End Date fields are used to filter the transactions that are

included in the report by transaction date.

l In order to prevent the report from negatively impacting system resources, the

date range will be limited to one year.

l The Sort Order field is used to select how the information will be grouped on the

report.

l Select Size if you would like to group the report by meter size.

l Select Class if you would like to group the report by class. The transactions on

the report will be grouped by the classes selected in the Class field.

l The Report Type drop-down menu is used to select the level of detail that will dis-

play on the report.
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l Select Summary if you would like the report to display a single line item for

each sort order grouping. For example, if you select Size in the Sort Order

field, the summary report will display a single line item for each meter size

included on the report.

l Select Detail if you would like the report to display each meter included on the

report. For example, if you select Size in the Sort Order drop-down menu and

Detail in the Report Type drop-down, each meter will be displayed under the

appropriate meter size.

l Check the Break Out Services toggle to first filter all the data in the report by UB

Service.

l When checked, the Sort Order and Report Type settings selected above will

still determine how the data is displayed, but that data will first be broken out

into each relevant UB Service.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Credit Balance by Cycle

Credit Balance by Cycle Report

Summary

The Credit Balance by Cycle Report will display customer accounts with a credit balance or

customer accounts with a credit balance on a service. The report can be filtered by billing

cycle and customer account status. Uncommitted transactions on a customer account will

not be included when calculating the credit balance.

Step by Step

1     Open the Credit Balance by Cycle window (UB> Reports> Credit Balance by Cycle).

2     Configure the report. 

l Select the billing cycles of the customer accounts you would like to include on the

report in the Cycles field.

l Press CTRL+A to highlight all of the toggles in the field. Press SPACE to

check or uncheck the toggles of the selected billing cycles.
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l The Account Status field is used to select the status of the customer accounts you

would like to include on the report.

l The Credit drop-down menu is used to select how customer accounts will be selec-

ted for the report.

l Select Balance if you would only like customer accounts with a credit balance

to display on the report.

l Select Any Service is you would like customer accounts with a credit balance

on a service attached to the account to display on the report. For example, if a

customer account has a credit balance on the Water service but owes money

on their gas service, the customer account will display on the report.

l When a customer account is included on the report, the report will dis-

play the balance on each service.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Deposit Balances

Deposit Balances Report

Summary

The Deposit Balances Report displays the deposit balance on UB customer accounts. The

report can be filtered by billing cycle, deposit fee code and customer account status (Act-

ive, Delete, Final, etc.). The report also includes a Show Refunded Deposits toggle in
order to include refunded deposits on the report.

If you would like a report that displays a list of deposit transactions including interest, gen-

erate a Deposit Transactions Report (UB> Reports> Deposit Transactions Report).

Step by Step

1     Open the Deposit Balances window (UB> Reports> Deposit Balances).

2     Configure the report. 
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l The Billing Cycle field is used to select the customer accounts you would like to

include on the report. Only customer accounts attached to the selected billing

cycles will be included on the report.

l Press CTRL+A to highlight all of the billing cycles in the field. Press SPACE to

check or uncheck the highlighted toggles.

l Filter the transactions included in the deposit balances on the report using the Bal-

ance as of and Date Type drop-down menu.

l The report will display the balance on deposits as of the date entered in the

Balance as of field. The transactions included in the deposit balance will be

filtered by this date.

l The Date Type drop-down menu is used to select the type of date that will be

used by the Balance as of field.

l You can view the journal entry date, post date or transaction date of a

transaction using the History tab of the Account Master Maintenance

window (UB> Maintenance> Account> History tab).

l The post date of a transaction is the date the batch is committed.

l The Fee Code field is used to select the deposit fee codes that will be included on

the report. Only fee codes set up as deposit fee codes will display in the Fee Code

field.

l The Account Status field is used to select the status of the customer accounts that

will be included in the report.

l You can view the status of a UB customer account on the Account Master

Maintenance window (UB> Maintenance> Account> Account tab> Account

sub-tab> Account Status field).

l The Total By drop-down menu is used to select how the report will total.
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l Select Cycle to total the deposit balances in the report by billing cycle.

l Select Fee Code to total the deposit balances on the report by fee code.

l Check the Show Refunded Deposits toggle if you would like to include refunded

deposits on the report.

l Refunded deposits will be totaled separately on the report.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Deposit Transactions

Deposit Transactions Report

Summary

The Deposit Transactions Report displays the deposit and/or interest transactions filtered

by billing cycle, journal entry date, transaction date and fee code. The transactions

included on the report can be totaled by UB customer account or batch number.

If you would like a report that displays the deposit balances, generate a Deposit Balances

Report (UB> Reports> Deposit Balances).

Step by Step

1     Open the Deposit Transactions window (UB> Reports> Deposit Transactions).

2     Configure the report. 

l The Billing Cycle field is used to select the customer accounts you would like to

include on the report. Only customer accounts attached to the selected billing
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cycles will be included on the report.

l Press CTRL+A to highlight all of the billing cycles in the field. Press SPACE to

check or uncheck the highlighted toggles.

l Enter a date range to filter the report by journal entry date or transaction date. You

must filter the report by one or the other.

l The Journal Entry Begin and Journal Entry End fields are used to filter the

deposit transactions that display on the report by the journal entry date. You

must enter a date range in the journal entry or transaction date fields.

l If you would like to filter the deposit transactions by transaction date,

enter a date range in the Transaction Date Begin and Transaction

Date End fields.

l The Transaction Date Begin and Transaction Date End fields are used to

filter the transactions that display on the report by the transaction date of the

deposit transaction. You must enter a date range in the journal entry or trans-

action date fields.

l The Fee Code field is used to select the deposit fee codes that will be included on

the report. Only fee codes set up as deposit fee codes will display in the Fee Code

field.

l Fee codes are set up as deposit fee codes using the Fee Code Maintenance

window (UB> Maintenance> Fee Code> Deposit toggle).

l The Deposit Detail field is used to select the type of transactions that will be

included on the report. You must check one of the toggles in this field.

l Check the Deposit toggle if you would like the creation of the deposit to dis-

play on the report.
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l Check the Interest toggle if you would like interest transactions associated

with the deposit amount to be included on the report.

l Interest can be factored on deposit amounts using the Adjustments and

Fees palette (UB> Adjustments and Fees> Factor Deposit Interest), or

it can be factored when the deposit is refunded using the Generate step

of the Refunds process (UB> Refunds> Generate> Factor Interest

toggle).

l Check the Refund toggle if you would like transactions associated with

deposit refunds to be included in the report.

l Refunds on deposits are processed using the Refunds process (UB>

Refunds).

l The Total By drop-down menu is used to select how the report will total.

l Select Account to total the transactions on the report by UB customer

account.

l Select Batch to total the transactions on the report by batch number.

l You can view the batch number attached to a deposit transaction using

the Account Master Maintenance window (UB> Maintenance>

Account> History tab> Batch column).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Detailed Meter Information

Detailed Meter Information Report

Summary

The Detailed Meter Information Report displays meter and customer information filtered by

route, sequence and/or install date. Only meters with an active connection on a lot will dis-

play on the report. You can view the connection status of a device in UB> Maintenance>

Device> Connections tab> Status column. If the status column is Active, the device will be
included on the report. The value in the Inventory Status field (Meter tab of the Device
Maintenance window) does not determine if the device will display on the report.

The Detail Meter Information Report will only display meter devices, so backflow devices

will not display on the report.

Step by Step

1     Open the Detailed Meter Information window (UB> Reports> Detailed Meter Inform-

ation).

2     Configure the report. 
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l Select the meter routes that you would like to include in the report in the Routes

field.

l Press CTRL+A to select all of the routes in the Routes field. Press

SPACEBAR to check or uncheck the selected toggles.

l Hold down SHIFT to select a range of routes. When selecting a range of

routes with the mouse, make sure you click on the route number not the

toggle.

l Select how you would like the report to sort in the Sort By drop-down menu.

l The sort option selected in the drop-down menu will be used as the primary

sort option. After the records included in the report have been sorted by the

primary sort option, they will be sorted in the following priority: route number,

meter sequence number and device serial/MXU/register number.

l Enter a meter sequence number in the Begin Sequence and End Sequence field

to filter the report by sequence number.

l The route sequence number of a device is entered on the Service Request

Input Wizard when the device is installed.

l You can view the route sequence number of a device in UB> Maintenance>

Device> Connections tab> Sequence column.

l Enter a date in the Begin Install Date and End Install Date fields to filter the

devices that display in the report by install date. Press DELETE to remove a date

from a date field.

l The Install Date of a meter is the service date of the service request that

installed the meter on the account. The Service Date field is entered during

the first step of the Service Request Input Wizard.
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l You can view the install date of a meter in UB> Maintenance> Device> Con-

nections tab> Install Date column.

l If a meter reading is attached to a service request, the meter reading will not display

on the report in the Last Reading and Last Read Date fields until the service

request has been closed and committed in UB> Service Requests> Commit. Meter

readings on uncommitted service requests will not display on the report and will not

display on the Consumption tab of the Device Maintenance window (UB> Main-

tenance> Device> Consumption).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> UB GL Comparison

UB GL Comparison Report

Summary

The UB GL Comparison Report displays the differences between the UB and GL accounts.

If you discover any discrepancies when running the Summary GL Comparison Report, you

can use this report to investigate the individual batches or journal entries where the prob-

lem occurred. You can filter this report by batch number or date and the results will be

organized by GL account. The difference between the UB and GL totals will be printed in

the final column to make spotting discrepancies easier.

Step by Step

1     Open the UB GL Comparison Report window (UB> Reports> UB GL Comparison).

2     Configure the report. 

l Use the Selection drop-down menu to specify how you would like to filter the

accounts that are pulled into the report.
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l Depending on your selection, some of the fields in the window will be dis-

abled.

l To filter the accounts by batch, select Batch from the drop-down menu and then

click the Batch Number field label to open the Batch Selection window.

l The batch type selected in the drop-down menu next to the Batch Number

field will determine what type of committed batches populate the Batch Selec-

tion window.

l Select the desired batch and click the Confirm icon to exit.

l To filter the accounts by journal entry date, select JE Date from the drop-down

menu and specify a date range in the JE Date From and JE Date To fields.

l Select the GL Type your organization utilizes in Utility Billing from the drop-down

menu.

l The report will display the GL Account, Service, Code, Fee Code, Tax Code and

Amount for each line item in the batch or on the JE Date. The UB Total, GL Total

and Difference will also be displayed.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Labels by Zip

Labels by Zip Report

Summary

The Labels by Zip report displays a list of addresses in mailing label format. These address

labels can be filtered by billing cycle and account status.

Step by Step

1     Open the Labels by Zip report (UB> Reports> Labels by Zip).

2     Configure the report. 

l Check the toggle next to each Billing Cycle you would like to include in the report.

Press CTRL+A and then press SPACE to select all billing cycles.

l When more than one billing cycle is included, the address labels will be

grouped by billing cycle and then sorted by zip code.

l Billing cycles are used to group UB customers into sets of accounts that can

be billed in the same batch. Billing cycles are created and maintained on the

Billing Cycle Maintenance window (UB> Maintenance> Cycle Code).
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l Billing cycles are associated with UB accounts when the account is created.

The billing cycle associated with an account can be updated on the Account

Maintenance window (UB> Maintenance> Account> General tab> Billing

Cycle field).

l Check the toggle next to each Account Status you would like to include in the

report. Press CTRL+A and then press SPACE to select all account statuses.

l The account status is set on the Account Maintenance window (UB> Main-

tenance> Account> General tab> Account Status drop-down menu).

l Check the Print service address toggle to print the service address associated

with the lot (when present) rather than the standard address associated with the UB

or customer account.

l The report will display every address in the selected billing cycles that meets the

selected account status. Each page will display 30 addresses in three columns and

10 rows.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Payment Plans

Payment Plans Report

Summary

The Payment Plan Report will display the account information associated with each of the

selected payment plan accounts.

Step by Step

1     Open the Payment Plans Report window (UB> Reports> Payment Plans).

2     Configure the report. 

l Select which payment plans to include in the report.

l Choose a Plan Status from the drop-down menu to filter the report by the pay-

ment plan status.

l Enter dates in the Promise Date From and Promise Date To fields to filter

the report by promise date.

l The Plan Status and Promise Date are both maintained in the Account

Maintenance window (UB> Maintenance> Account> Account Tab>
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Payment Plan Sub-tab> Plan Maintenance Section).

l The report will display the Account Number, Customer Name, Refer-

ence Number, Status, Enter Date, Promise Date, Amount and Entered

By. It will also display Pending and Report Totals.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Payments by Past Due

Payments by Past Due Report

Summary

The Payments by Past Due report is used to report on payments made on UB past due

accounts. The report will display the Cycle, Route Number, Customer Number, Sequence

Number, Reference Number, Serial Number, Service Address, Account Status, Paid

Amount, and Payment Date for the included payments.

Step by Step

1     Open the Payments by Past Due window (UB> Reports> Payments by Past Due).

2     Configure the report. 

l The Batch Number field is used to select the Past Due batch you would like
to report on.

l The Payment Created Date From and Payment Created Date To fields
are used to filter the payments included in the report by the date that the pay-

ment was created.
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l The Sort By field is used to specify how the report will be sorted.

l Users can sort the report by Customer Number, Cycle Route &

Sequence, Reference Number, or Route & Sequence. When sorting by

Route & Sequence, the report can be set up to break by route by check-

ing the Page Break on Route toggle below.

l Check the Include Accounts Without Payments toggle to include past due
accounts that did not have any payments processed during the date range

specified above.

l Check the Include Uncommitted Payments toggle to include past due
accounts with payments created but not committed during the date range spe-

cified above.

l Check the Include All Active Meters toggle to include all active meters for
the past due accounts included in the report.

l Check the Page Break on Route toggle to start a new report page for each

route included in the report.

l This toggle will only be enabled if Route & Sequence is selected in the

Sort By field above.

l The report will display the Cycle, Route Number, Customer Number,

Sequence Number, Reference Number, Serial Number, Service Address,

Account Status, Paid Amount, and Payment Date for the included payments.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Summary by Class

Summary by Class Report

Summary

The Summary by Class Report displays a summary of the billing, adjustment and penalty

activity by class. Classes user-defined groupings that are attached to lots using the Lot

Maintenance window (Lot icon> Lot tab> Class field). The report can also be filtered by ser-

vice (water, electric, etc.) and transaction date.

UB customer accounts on lots that are not attached to a class will not display in this report.

Uncommitted transactions will not be included in the report totals.

Step by Step

1     Open the Summary by Class window (UB> Reports> Summary by Class).

2     Configure the report. 
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l Select the account classes you would like to include in the report in the Class field.

l Press CTRL+A to highlight all of the toggles in the field. Press SPACE to

check or uncheck all of the highlighted toggles.

l Classes are attached to lots using the Lot Maintenance window (Lot icon> Lot

tab> Class field).

l Classes are created and maintained in the Class Maintenance window (UB>

Maintenance> Class).

l Select the service you would like to include on the report in the Service List field.

l Press CTRL+A to highlight all of the toggles in the field. Press SPACE to

check or uncheck all of the highlighted toggles.

l All of the selected services will be grouped together on the report in a single

line item.

l Enter a date range in the History Date From and History Date To fields.

l The transactions included on the report will be filtered by transaction date.

You can view the transaction date of a transaction on a customer account

from the History tab of the Account Master Maintenance window (UB> Main-

tenance> Account> History tab> Transaction Date column).

l Uncommitted transactions will not be included on the report.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Summary GL Comparison

Summary GL Comparison Report

Summary

The Summary GL Comparison Report displays discrepancies between the UB accounts

receivable amount and the GL amount. This report can be filtered by journal entry date and

the results are organized by date and batch number. If there is a discrepancy between the

UB and the GL, it will be noted by a sequence of three asterisks in the final column.

If discrepancies are discovered, you can run the UB GL Comparison report to investigate

the individual batches or journal entries where the discrepancies occurred.

Step by Step

1     Open the Summary GL Comparison Report window (UB> Reports> Summary GL

Comparison).

2     Configure the report. 
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l Select a date range for comparison in the JE Date From and JE Date To fields.

l Select the GL Type your organization utilizes in Utility Billing from the drop-down

menu.

l When Accrual Basis is selected, the report will display the JE Date, Batch

number, AR Amount and GL Amount for each entry.

l When Cash Basis is selected, the report will display the JE Date, Batch num-

ber, Cash Amount, GL Amount and Other Amount for each entry.

l The Out of Balance column at the right side of the report will display a series of

three asterisks if the entries are out of balance.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Top Users

Top Users Report

Summary

The Top Users Report will display a list of the top users of a service. The UB customer

accounts included in the report can be filtered by New Billing batch, service rate, billing

cycle and/or account class. Top users can be ranked by the dollar amount of the bills or bil-

lable consumption.

Step by Step

1     Open the Top Users window (UB> Reports> Top Users).

2     Configure the report. 

l When generating a Top Users report, you must select either a New Billing batch,

billing cycle or account class. You cannot filter the report by more than one of those

options. For example, you cannot filter the report by billing cycle and account class.

l The Service Rates field is used to select the service rates you would like to include

in the report. Only those accounts that include the selected service rates will be
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included in the report.

l This field will display the available service rates associated with the Service

selected to the right.

l All service rates will be selected by default.

l The Batch Number field allows you to filter the accounts in the report by committed

New Billing batch. Click the Batch Number field label to select a committed New

Billing batch from a list.

l The Billing Cycle drop-down menu is used to filter the accounts included in the

report by billing cycle.

l You can view the billing cycle attached to a specific UB customer account on

the Account Master Maintenance window (UB> Maintenance> Account>

Account tab> Account sub-tab> Billing Cycle field).

l The Account Class drop-down menu allows you to filter the report by the class

attached to the lots.

l Account classes are created and maintained in the Account Class Main-

tenance window (UB> Maintenance> Account Classes).

l Account classes are attached to lots using the Lot Maintenance window (Lot

icon> Open a lot> Lot tab> Classes drop-down menu).

l The Service drop-down menu is used to select which service will be used for the top

users report. Consumption or billings on the selected service will be used to gen-

erate a list of the top users.

l Consumption on a meter is associated with a bill type not a service. In order to

calculate the consumption on a service, the report matches the consumption

on meters with the service rates of the same bill type. The service associated
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with those service rates is then used as the service associated with the con-

sumption.

l The History Date To and History Date From fields are used to filter the trans-

actions that display on the report by transactions date.

l You can view the transactions date of a transaction on a customer account on

the History tab of the customer maintenance window (UB> Maintenance>

Account).

l Select how you would like to determine the top users in the Calculate by drop-

down menu.

l Select Billable Consumption if you would like to generate a list of top users by

billable consumption. This option will generate a list of top users by the con-

sumption read on meters during the date range entered in the History Date

From and History Date To fields. The report will include both billed and

unbilled consumption on the report.

l The consumption on the report will be filtered by the read date of the

meter readings. If a meter reading does not fall within the date range

entered in the History Date From and History Date To fields the con-

sumption on that meter reading will not be included on the report.

l Consumption attached to subtract or exempt meters will affect the con-

sumption that displays on the report. For example, if a subtract meter is

attached to a customer account, the consumption on the subtract meter

will be subtracted from the consumption on the meter on the report.

l Select Calculated Consumption if you would like to generate a list of top users

by calculated consumption.
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l Calculated consumption is calculated as: (consumption) x (cons mul-

tiplier or cons divisor on the UB device)

l Select Dollar Amount if you would like to generate a list of top users by the

billed amount on the service selected in the Service drop-down menu.

l Select the number of records you would like to display on the report in the Results

drop-down menu. For example, if you would like to generate a top ten users list,

enter 10 in this field.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Transactions By Date
Report

Transactions by Date Report

Summary

The Transactions by Date Report displays a list of committed or uncommitted transactions

filtered by a date range, batch and/or transaction type. Each transaction line item included

on the report will display as a separate item on the report.

The transactions that will display on the Transaction By Date Report is affected by the

selection of the Charge For Deposit toggle in the Setup window (UB> Utilities> Setup>

General tab). When a deposit is generated, there are three transaction line items created: a

Billing line item to record the obligation of the customer to pay the deposit amount, the Pay-

ment line item to record the payment of the deposit amount and the Deposit line item to

record the obligation to refund the deposit amount. If the Charge for Deposit toggle on the

Setup window is not checked the Payment and Billing transaction lines attached to a

deposit type transaction will not be included on the report. If the toggle is checked, the pay-

ment and billing transaction type associated with the deposit will display on the report.

Step by Step

1     Open the Transactions by Date window (UB> Reports> Transactions by Date).
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2     Configure the report. 

l Select the billing cycles you would like to include in the report in the Cycles field.

l Press CTRL+A to select all billing cycles. Press SPACE to check or uncheck

the highlighted toggles.

l Hold down SHIFT to select a range of billing cycles. Press SPACE to check or

uncheck the highlighted toggles.

l Check the toggles in the Adj Types field to select the adjustment types to include in

the report.

l The Adj Types field will only be active if the Adjustment toggle is checked in

the Tran Types field.

l Press CTRL+A to select all adjustment types. Press SPACE to check or

uncheck the highlighted toggles.

l Hold down SHIFT to select a range of adjustment types. Press SPACE to

check or uncheck the highlighted toggles.

l Enter a date in the Tran Date From and Tran Date To field to filter the transactions

that display in the report.

l The date type that will be used to filter the report is selected in the Date Type

field.

l The Batch Number field is used to filter the transactions included in the report by a

committed batch. Select a process in the drop-down menu and then click the Batch

Number field label to filter the report by the transactions in a batch. This will open

the Batch Selection window.
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l Only committed batches will display in the Batch Selection window.

l If you do not select a batch number, the process selected in the drop-down

menu (Adjustments and Fees, New Billing, etc.) will not affect the transactions

that are included in the report.

l Select a Date Type from the drop-down menu.

l The Journal Entry Date is the date a transaction is posted to the general

ledger. You can view the journal entry date of a transaction on a UB customer

account (UB> Maintenance> Account> History tab> JE Date field).

l The Post Date is the date that a transaction is committed. The Post Date can

vary from the journal entry date since in many UB processes the journal entry

date is manually entered.

l If the transaction has not been committed, it will not have a post date.

l The Transaction Date is generally a user-defined date that is entered when

the transaction is created. When transactions are generated, this date gen-

erally defaults to the current date.

l The Transaction Date of a transaction on a UB customer account can

be viewed in UB> Maintenance> Account> History tab> Transaction

Date field.

l Select the Transaction Types you would like to include in the report.

l You can select all transaction types by pressing CTRL+A. Once all the trans-

action types have been selected, you can check or uncheck a toggle and the

selection will be applied to all the toggles.
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l You can select a range of transaction types by holding down the SHIFT key.

When selecting a range, make sure to click on the transaction type descrip-

tion.

l If you check the Payment toggle the report will include any payments created

in the Central Cash/CR module, and Utility Billing> Adjustments and Fees.

l If you check the Interest toggle, interest transactions created by factoring

interest on deposit amounts (UB> Adjustments and Fees> Factor Deposit

Interest). If you check the Deposit toggle and you apply the factored interest

to the deposit amount (the interest factored on a deposit increases the deposit

amount rather than lower the UB customer account balance), the report will

also display the increase in the deposit amount. For example, if you factor $15

of interest on a deposit, apply that interest to the deposit amount, and check

both the Interest and Deposit toggles on the report, the $15 will display once

on the report to create the interest amount (the interest transaction) and once

to increase the balance of the deposit (the deposit transaction).

l Select how you would like the report to sort in the Sort By drop-down menu.

l Select Adj Type, Cycle, Account Number if you would like to group the trans-

actions by adjustment type, cycle code and the UB customer account number.

l Select Cycle, Adj Type, Account Number if you would like to group and sort

the transactions on the report by cycle code, adjustment type and then the UB

customer account number.

l Check the Display payments as negative toggle to display the net effect of pay-

ments in the report totals.

l For example, assume the report includes $100 in billings and $50 in pay-

ments:

TRANSACTIONS BY DATE REPORT 692



l When this toggle is NOT checked, all transactions will be added to

together and the transactions total will be $150.

l When the toggle is checked, the payment transactions will display as a

negative and the transactions total will be $50.

l The report will display customer number, customer name, transaction type, trans-

action date, currency (check or cash), transaction line number, amount and ser-

vices. The report will be sorted by transaction date and will be grouped by fee code.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Trend Monitoring

Trend Monitoring Report

Summary

The Trend Monitoring Report will display the billed consumption, billings, payments and

adjustments associated with a filtered list of transactions and UB customer accounts.

Uncommitted transactions will not be included in the report.

Step by Step

1     Open the Trend Monitoring window (UB> Reports> Trend Monitoring).

2     Configure the report. 

l Select the cycles you would like to include in the report in the Cycles field.

l Press CTRL+A to highlight all of the billing cycles in the field. Press SPACE to

check or uncheck the highlighted toggles.

l Hold down SHIFT to select a range of routes. Press SPACE to check or

uncheck the highlighted toggles.
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l You can view the billing cycle attached to a customer account on the Account

Master Maintenance window (UB> Maintenance> Account> Account tab>

Account sub-tab> Billing Cycle field.

l Enter a date in the From Date and To Date fields to filter the transactions included

in the report. The type of date that will be used to filter the report is selected in the

Date Type field.

l Select the type of date you would like to use to filter the report in the Date Type

field. This field is used in conjunction with the From Date and To Date fields.

l Only committed transactions will display in the report.

l The journal entry date is the date the journal entry is posted to the general

ledger. The journal entry date is generally entered during the GL Distribution

Report step of a batch process.

l You can view the journal entry date of a transaction on an account in

UB> Maintenance> Account> History tab> JE Date field.

l The post date is the date a transaction was committed and is not necessarily

the same as the transaction or journal entry date.

l You can view the post date of a transaction on an account in UB> Main-

tenance> Account> History tab> Post Date/Time column.

l The transaction date is generally a user defined date entered during the gen-

erate step of a process. When generating a New Billing batch, the transaction

date is entered in UB> New Billing> Generate> Transaction Date field. When

entering a receipt, the receipt date is the transaction date.

l You can view the transactions date of a transaction on an account in

UB> Maintenance> Account> History tab> Tran Date column.

TREND MONITORING REPORT 695



l The Codes field is used to select which transactions you would like to include

on the report. You must check at least one of the toggles in the Codes field.

l Select Services to include all transactions that are associated with a service.

This includes all billings, payments, and adjustments on a service.

l Select Fee to include all transactions that are associated with a fee code.

l Selecting fee will include adjustments made using adjustment type

codes (UB> Maintenance> Adjustment Type) in the Adjustment Input

Wizard. The report will display the fee codes attached to the adjustment

type code; it will not display the adjustment type code associated with

an adjustment.

l Fee codes will be attached to adjustments, deposits, and billed service

requests.

l Select Tax to include all transactions that are associated with a tax code.

l Tax codes are created in Tax Code Maintenance window (UB> Main-

tenance> Tax Code) and are attached to service rates on the Winter

Average/Taxes tab of the Service Rate Maintenance window (UB> Main-

tenance> Service Rate).

l Select the services that you would like to include in the report in the Services field.

l Press CTRL+A to select all the services in the Services field. If you check or

uncheck a toggle, all of the selected cycles will be checked or unchecked.

l Hold down SHIFT to select a range of services. When selecting a range of ser-

vices with the mouse, make sure you click on the service description not the

toggle.

l The Trend Monitoring Report will display a list of UB customer accounts and activ-

ity. The transactions will be grouped and totaled by consumption, billings, payments
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and adjustments.

l The Consumption column on the report will display the billed consumption

that has been committed. Unbilled meter readings will not be included in the

consumption amount. If a consumption conversion multiplier was applied to

the consumption when the billing was generated (UB> New Billing> Gen-

erate> Convert Consumption To field), the report will display the converted

value, not the value on the meter.

l For example, if during the billing the consumption was converted from

feet to gallons, the report will display the consumption on the meter mul-

tiplied by the conversion amount on the conversion table (UB> Main-

tenance> Consumption Conversion).

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Trial Balance by Date
Report

Trial Balance by Date Report

Summary

Trial Balance by Date Report displays the balance of UB customer accounts. The report

will display the billings, adjustments, payments and balance forward for each customer

account included on the report.

Step by Step

1     Open the Trial Balance by Date report (UB> Reports> Trial Balance by Date report).

2     Configure the report. 

l Select the billing cycles that should be included in the report in the Cycles field.

l You can select all billing cycles by pressing CTRL+A. Press SPACE to check

or uncheck the highlighted toggles.
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l You can select a range of billing cycles by holding down the SHIFT key. When

selecting a range, make sure to click on the cycle number rather than the

toggle.

l All billing cycles that have been set up in UB> Maintenance> Cycle Code will

display in the Cycles field.

l You can view the billing cycle attached to a UB customer account in UB> Main-

tenance> Account> Account tab> Account sub-tab> Billing Cycle field.

l Enter a date in the From Date and To Date to filter the transactions on the report.

The type of date used to filter the transactions is selected in the Date Type drop-

down menu.

l Select the type of date that will be used to filter the report in the Date Type drop-

down menu. This field is used in conjunction with the From Date and To Date

fields.

l The Journal Entry Date is the date a transaction is posted to the general ledger. The

journal entry date is generally entered during the GL Distribution Report step of

most batch processes. You can view the journal entry date of a transaction on a UB

customer account in UB> Maintenance> Account> History tab> JE Date field.

l The Post Date is the date that a transaction is committed. The Post Date can

vary from the journal entry date since in many UB processes the journal entry

date is manually entered.

l The Transaction Date is generally a user-defined date that is entered when

the transaction is created.

l The Transaction Date of a transaction on a UB customer account can

be viewed in UB> Maintenance> Account> History tab> Transaction

Date field.
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l Select the Report Type from the drop-down menu.

l The Detail report will display the services attached to every account and the

balance of each service on the account. The services will display on the report

as service abbreviation, not the service name.

l The summary reports will only display the balance of the customer account. 

l Check the Include Uncommitted History toggle to include uncommitted trans-

actions on the report.

l If you are using this report to tie into the GL, you do not want to check this

toggle.

l Do not check this toggle if you selected Post Date in the Date Type drop-

down menu. The post date is not assigned to a transaction line item until the

transaction is committed.

l Check the Show deleted accounts with no balance forward and no activity in

the specified date range toggle if you would like to include those accounts on the

report.

l The Trial Balance by Date report will display the customer information, the services

on the customer account, beginning balance, billings, adjustments, payments and

balance forward filtered by the selected date range.

l If you are balancing UB to the GL, the difference between the Beginning Bal-

ance and the Balance Forward columns on the report should be equal to the

net change of the UB receivable accounts in General Ledger module.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports> Unpaid Deposits

Unpaid Deposits Report

Summary

The Unpaid Deposits Report displays deposits that have been generated on customer

accounts but have not been paid. The report will display the customer information, post

date of the deposit on the customer account, the deposit amount, partial payments made

on the deposit and the outstanding deposit amount.

Deposits are generated on customer accounts by billing a customer account using a

deposit fee code. When a payment is entered on a deposit fee code (Cash Entry window in

the Cash Receipts module), the deposit is paid and will display on the History tab of the cus-

tomer account in the Deposit History section (UB> Maintenance> Account> History tab>

Select Deposit History from the drop-down menu at the top of the window).

Step by Step

1     Open the Unpaid Deposits Report window (UB> Reports> Unpaid Deposits).

2     Configure the report. 
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l The Billing Cycles field is use to filter the customer accounts that display on the

report by the billing cycle attached to the customer account.

l Press CTRL+A to highlight all of the toggles in the field and then press

SPACE to check or uncheck all of the selected toggles.

l You can view the billing cycle attached to a customer account using the

Account Master Maintenance window (UB> Maintenance> Account> Account

tab> Billing Cycle field).

l The Account Status field is used to select the customer accounts that will display

on the report by the account status.

l You can view the account status of a customer account using the Account

Master Maintenance window (UB> Maintenance> Account> Account tab>

Status field).

l The Fee Code field is used to filter the customer accounts that display on the report

by the deposit fee code used to generate the deposit amount. Only deposit fee

codes will display in the fee code field.

l Fee codes are set up as deposit fee codes using the Fee Code Maintenance

window (UB> Maintenance> Fee Code> Select a fee code> Deposit toggle).

l The Post Date column displays the post date of the deposit on the customer

account.

l The Billed Amount column displays the deposit amount that is due on the account.

l The Paid Amount column will display the amount paid on the deposit fee code.

l The Outstanding column will display the amount left to be paid on the deposit.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports Consumption>
Consumption by

Consumption by Report

Summary

The consumption reports process is designed to help users confirm their consumption val-

ues are balanced. The Consumption by report is the first step in the consumption balancing

process.

The Consumption by report is meant to help users validate that all consumption processes

are represented in Springbrook. This report uses the meter history to sort and display all

consumption readings in a specified time period.

Step by Step

1     Open the Consumption by report window (UB> Reports Consumption> Consumption

by).

2     Configure the report. 

CONSUMPTION BY REPORT 706



l Check the toggle next to each Route you would like to include in the report.

l By default, all routes will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed routes. This

applies to all of the following toggle fields as well.

l Routes are created and maintained on the Route Maintenance window (UB>

Maintenance> Route).

l Check the toggle next to each Class you would like to include in the report.

l Classes are created and maintained on the Class Maintenance window (UB>

Maintenance> Class).

l Check the toggle next to each Zone you would like to include in the report.

l Zones are created and maintained on the Zone Maintenance window (UB>

Maintenance> Zone).

l Check the toggle next to each Meter Status you would like to include in the report.

l A specific meter's status can be viewed on the Device Maintenance window

(UB> Maintenance> Device> Electric Meter or Water Meter tab> Device sec-

tion> Status field).

l A meter will have an Active status when it is installed on a customer

account.

l The meter status will be set to Removed when a remove device service

request has been committed on the customer account.

l The meter status will be inactive if the status was manually changed on

the Device Maintenance window.
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l Check the toggle next to each Subdivision you would like to include in the report.

l Subdivisions are created and maintained on the Subdivision Maintenance win-

dow (SS> Maintenance> Subdivision).

l Select a Report Type from the drop-down menu.

l The Brief report type will display the consumption totals within the specified

period or date range for each group selected below. The report will also

provide a total consumption amount for the period or date range.

l The Detailed report type will display everything included in the Brief report as

well as the Route Sequence, Serial/MXU/Register Number, Account Number,

Period, Year, Read Date, Multiplier, Divisor, and Original Reading.

l Specify a reading period range for readings included in the report with the Reading

Period From, Reading Year From, Reading Period To and Reading Year To

fields.

l If a reading period range is not specified, a read date range must be specified

below.

l Specify a read date range for the readings included in the report with the Read Date

From and Read Date To fields.

l If a read date range is not specified, a reading period range must be specified

above.

l Select a Device Type from the drop-down menu.

l Select a conversion unit from the Convert To drop-down menu if you would like to

convert the read units to a different display unit on the report.

l Conversion units are created and maintained on the Consumption Conversion

Maintenance window (UB> Maintenance> Consumption Conversion).
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l Select the report sorting options from the Group One and Group Two drop-down

menus. This will determine how the report is sorted and displayed.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports Consumption>
Consumption by Service Rate

Consumption by Service Rate Report

Summary

The consumption reports process is designed to help users confirm their consumption val-

ues are balanced. The Consumption by Service Rate report is the second step in the con-

sumption balancing process. This report provides details regarding consumption billing

distribution.

Step by Step

1     Open the Consumption by Service Rate report window (UB> Reports Consumption>

Consumption by Service Rate).

2     Configure the report. 

CONSUMPTION BY SERVICE RATE REPORT 710



l Check the toggle next to each Route you would like to include in the report.

l By default, all routes will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed routes. This

applies to all of the following toggle fields as well.

l Routes are created and maintained on the Route Maintenance window (UB>

Maintenance> Route).

l Check the toggle next to each Class you would like to include in the report.

l Classes are created and maintained on the Class Maintenance window (UB>

Maintenance> Class).

l Check the toggle next to each Zone you would like to include in the report.

l Zones are created and maintained on the Zone Maintenance window (UB>

Maintenance> Zone).

l Check the toggle next to each Meter Status you would like to include in the report.

l A specific meter's status can be viewed on the Device Maintenance window

(UB> Maintenance> Device> Electric Meter or Water Meter tab> Device sec-

tion> Status field).

l A meter will have an Active status when it is installed on a customer

account.

l The meter status will be set to Removed when a remove device service

request has been committed on the customer account.

l The meter status will be inactive if the status was manually changed on

the Device Maintenance window.
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l Check the toggle next to each Subdivision you would like to include in the report.

l Subdivisions are created and maintained on the Subdivision Maintenance win-

dow (SS> Maintenance> Subdivision).

l Check the toggle next to each Service Rate you would like to include in the report.

l Service rates are created and maintained on the Service Rate Maintenance

window (UB> Maintenance> Service Rate).

l Select a Report Type from the drop-down menu.

l The Brief report type will display the consumption totals within the specified

period or date range for each included Service Number. The report will also

provide a total consumption amount for the period or date range.

l The Summary report will display everything included in the Brief report as well

as the Service Rate and Description.

l The Detailed report type will display everything included in the Summary

report as well as the Account Number, Route Sequence, Serial/MXU/Register

Number, Original Consumption and Subtract Consumption.

l Specify a reading period range for readings included in the report with the Reading

Period From, Reading Year From, Reading Period To and Reading Year To

fields.

l If a reading period range is not specified, a read date range must be specified

below.

l Specify a read date range for the readings included in the report with the Read Date

From and Read Date To fields.

l If a read date range is not specified, a reading period range must be specified

above.
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l Select a Device Type from the drop-down menu.

l Select a conversion unit from the Convert To drop-down menu if you would like to

convert the read units to a different display unit on the report.

l Conversion units are created and maintained on the Consumption Conversion

Maintenance window (UB> Maintenance> Consumption Conversion).

l Check the Include subtract meters toggle if you would like to include those meters

set up to reduce consumption in the report.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports Consumption> Summary by
Service Rate

Summary by Service Rate Report

Summary

The consumption reports process is designed to help users confirm their consumption val-

ues are balanced. The Summary by Service Rate report is the third step in the consumption

balancing process.

This Summary by Service Rate report is used to confirm that the consumption amounts dis-

played in the Consumption by Service report were processed through the billing process.

These two reports should be carefully compared in order to confirm that consumption val-

ues are balancing correctly.

Step by Step

1     Open the Summary by Service Rate report window (UB> Reports Consumption>

Summary by Service Rate).

2     Configure the report. 
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l Check the toggle next to each Cycle you would like to include in the report.

l By default, all cycles will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed cycles. This

applies to all of the following toggle fields as well.

l Cycles are created and maintained on the Cycle Code Maintenance window

(UB> Maintenance> Cycle Code).

l Check the toggle next to each Class you would like to include in the report.

l Classes are created and maintained on the Class Maintenance window (UB>

Maintenance> Class).

l Check the toggle next to each Zone you would like to include in the report.

l Zones are created and maintained on the Zone Maintenance window (UB>

Maintenance> Zone).

l Check the toggle next to each Tax Code you would like to include in the report.

l Tax codes are created and maintained on the Tax Code Maintenance window

(UB> Maintenance> Tax Code).

l Check the toggle next to each Subdivision you would like to include in the report.

l Subdivisions are created and maintained on the Subdivision Maintenance win-

dow (SS> Maintenance> Subdivision).

l Check the toggle next to each Service Rate you would like to include in the report.

l Service rates are created and maintained on the Service Rate Maintenance

window (UB> Maintenance> Service Rate).
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l Select a Report Type from the drop-down menu.

l The Summary report will display the Service Number, Service Code, Service

Description, Consumption Amount, Flat Amount, Tax Amount, Total Amount

and Billable Consumption. The report will also provide report totals for each of

those columns.

l The Detailed report type will display everything included in the Summary

report as well as the Account Number for each consumption line item and

tiered consumption data, including tier level number, tier billing amount, and

total tier consumption.

l Use the Date Type drop-down menu to specify whether the report will filter by trans-

action date, journal entry date or post date.

l Specify a date range for the report in the Date From and Date To fields.

l A date range must be specified in order to run the report unless running the

report for a single batch.

l The Batch Number field is used to generate the report for a specific committed or

uncommitted New Billing or Final Billing batch.

l When a specific batch is selected, the Cycle, Date Type, Date From, and Date

To print options will be disabled.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports Consumption> Sub Meter
Listing

Sub Meter Listing Report

Summary

The consumption reports process is designed to help users confirm their consumption val-

ues are balanced. The Sub Meter Listing report is the final step in the consumption bal-

ancing process, and will help organizations that use subtraction meters gain a better

understanding of how they affect consumption balancing.

Step by Step

1     Open the Sub Meter Listing report window (UB> Reports Consumption> Sub Meter

Listing).

2     Configure the report. 
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l Check the toggle next to each Route you would like to include in the report.

l By default, all routes will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed routes. This

applies to all of the following toggle fields as well.

l Routes are created and maintained on the Route Maintenance window (UB>

Maintenance> Route).

l Check the toggle next to each Device Type you would like to include in the report.

l Device types are created and maintained on the Device Type Maintenance

window (UB> Maintenance> Device Type).

l The report will display the Device Type, Route Sequence, Serial/MXU/Register

Number, Connection Status, Account Number, Service Point, Sub Route Sequence,

and Serial/MXU/Register Number.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Reports Consumption> Account by
Service Rate

Account by Service Rate Report

Summary

The Account by Service Rate report is designed to help users identify inconsistencies in

standard service and rate combinations in order to better utilize the Consumption by Ser-

vice Rate report. For example, if the Consumption by Service Rate report displays different

consumption values for two service rates that should correspond, the Account by Service

Rate report could be used to determine where these inconsistencies are occurring.

A user could enter the water service in the Filter field and the corresponding sewer service

in the Check field in order to confirm that each account with water service does in fact have

a corresponding sewer service. Any accounts that do not have both services would be dis-

played in the report, thereby identifying the cause of the inconsistent consumption.

Step by Step

1     Open the Account by Service Rate report window (UB> Reports Consumption>

Account by Service Rate).
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2     Configure the report. 

l Check the toggle next to each Cycle you would like to include in the report.

l By default, all cycles will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed cycles. This

applies to all of the following toggle fields as well.

l Cycles are created and maintained on the Cycle Code Maintenance window

(UB> Maintenance> Cycle Code).

l Check the toggle next to each Class you would like to include in the report.

l Classes are created and maintained on the Class Maintenance window (UB>

Maintenance> Class).

l Check the toggle next to each Zone you would like to include in the report.

l Zones are created and maintained on the Zone Maintenance window (UB>

Maintenance> Zone).

l Check the toggle next to each account Status you would like to include in the

report.

l The account status is specified on the UB Account Maintenance window (UB>

Maintenance> Account> Account tab> Account Status drop-down menu).

l Check the toggle next to each Subdivision you would like to include in the report.

l Subdivisions are created and maintained on the Subdivision Maintenance win-

dow (SS> Maintenance> Subdivision).

l Select a Report Type from the drop-down menu.

l The Summary report will include each account that is missing the service or

service rate specified in the Check field. The report will display the Account
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Number, Customer Name, Service Address, Tag, Service Number, Service

Name, Service Rate and Service Description for each of these accounts.

l The Detailed report type will display everything included in the Summary

report as well as the corresponding service or service rate specified in the Fil-

ter field. For example, a user could enter a water service in the Filter field and

the corresponding sewer service in the Check field. The Summary report will

display the missing service or service rate for each account. The Detail report

will display the missing service or service rate as well as the specified filter

service or service rate. This is helpful when generating the report with multiple

filters or checks.

l Specify a connect date range for the report in the Connect Date From and Con-

nect Date To fields to filter the accounts by the date they were initially connected.

l The account connect date can be found on the Account Maintenance window

(UB> Maintenance> Account> Account tab> Connect Date field).

l The Filter field is used to filter the accounts included in the report by service and ser-

vice rate.

l Click the Create icon drop-down menu and select Filter Services or Filter

Service Rates to add one of these filters to the report.

l This will launch either the Service or Service Rate Selection windows. Select

the desired service or service rate and click the Confirm icon to add the fil-

ter to the report.

l This filter field works in conjunction with the filters toggled to the left.

l The Check field is used to determine which services or service rates the report will

be checking for.

ACCOUNT BY SERVICE RATE REPORT 723



l Click the Create icon drop-down menu and select Check Services or

Check Service Rates to add one of these checks to the report.

l This will launch either the Service or Service Rate Selection windows. Select

the desired service or service rate and click the Confirm icon to add the

check to the report.

l The generated report will display any accounts that include the services or ser-

vice rates specified in the Filter field but do not include the services or service

rates specified in the Check field.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Service Requests> Input

Service Request Input

Summary

The Service Request window (UB> Service Requests> Input) is used to create, view and

close service requests. The window can display open, closed and committed service

requests.

Press INSERT from the Service Request window to launch the Service Request Input Wiz-

ard. If there is a default device type attached to the service request code (UB> Main-

tenance> Service Request Code> Select a service request code> Default Type field)
selected on the Service Request Input Wizard and that device type is attached to the UB

customer account, the device will be automatically attached to the service request code. If

there are default service request codes set up on device types (UB> Maintenance> Device

Type> General tab> Default Change - out, Default Remove, Default Add fields) those
service request codes will not be used when creating service requests from this window.

Default service request codes set up on device types will only affect service requests cre-

ated from the Account Master Maintenance window (UB> Maintenance> Account> Service

Requests tab).
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Highlight a service request and click the Close icon to close a service request. This will

populate the close date on the service request with the current date. After a service request

has been closed, you can commit the service request using the Commit window (UB> Ser-

vice Requests> Commit).

Service requests can be printed from the Service Request Input Wizard as the service

request is input, or it can be printed from the Service Requests window (UB> Service

Requests> Service Requests).

Step by Step

1     Open the Service Requests window (UB> Service Requests> Input).

2     Filter the displayed service requests. 

l Use the Search Criteria section to filter the service requests that display in the win-

dow and then click the Refresh icon to update the window.

l The Request Code field is used to filter the service requests that display in the win-

dow by the service request code attached to the service request.

l Select All to include all service requests. You can also press ALT+A to high-

light all of the request codes in the field, and then press SPACE to check or

uncheck the highlighted toggles. This allows you to select all of the service

requests and then remove a few that you do not want to display in the window.
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l The Alert Codes field is used to highlight service requests for UB customer

accounts that are attached to a selected comment code. Comment codes are cre-

ated and maintained in the Comment Status Maintenance window (UB> Main-

tenance> Comment Status), and are attached to customer accounts on the Account

Master Maintenance window (UB> Maintenance> Account). All of the service

requests attached to customer accounts with the selected comment status will dis-

play in red. If the comment has been closed on the UB customer account, the ser-

vice request will not be highlighted. For example, if you would like to highlight

service requests on UB customer accounts with a past due alert, select the past due

comment status in the Alert Codes field. All service requests attached to customer

accounts with that comment code open on their account will display in red.

l The Alert Codes field will display all comment statuses, not just comments

that are set up as account or receipt alerts (UB> Maintenance> Comment

Status> Account Alert and Receipt Alert toggle).

l If there is a date in the Closed Date field on the Account Master Maintenance

window (UB> Maintenance> Account> Comments tab> Comments section),

the comment is considered closed. You do not have to change a comment to

the Closed comment status code to close the comment.

l The Assigned To field is used to filter the displayed service requests by the Spring-

brook user the service requests are assigned to.

l Springbrook user accounts are created and maintained on the User Main-

tenance window (SS> Security> User).

l The Status drop-down menu is used to filter the service requests that display in the

window by the status.
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l Select All to display all service requests in the window.

l Select Active to display service requests with an active status in the window.

l Select Cancel to display canceled service requests with a canceled status in

the window.

l Select Closed to display service requests with a closed status. Service

requests that have been closed and committed will not display in the window

unless you check the Include Committed toggle below.

l Select Void to display service requests with a void status in the window.

l The Account Number field is used to filter the service requests that display on the

window by the UB account they are attached to. Enter an account number or click

the field label to select an account from a list.

l The Street Number field is used to filter the service requests that display on the win-

dow by the street number associated with the lot. Enter a street number or click the

field label to launch the Lot Selection window.

l The Street Directional and Street Name fields are used to filter the service

requests by additional street details.

l Check the Include Committed toggle to include committed service requests in the

window.

l This toggle will only be enabled if Closed is selected from the Status drop-

down menu because a service request must be closed before it can be com-

mitted.

l Click the Refresh icon or press ENTER to filter the service requests in the win-

dow.
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3     Select a service request. 

l Click the Create icon or press INSERT to launch the Service Request Input Wiz-

ard.

l Highlight a service request and click the Delete icon or press DELETE to delete

the selected service request. You can delete service requests of any status, includ-

ing closed and committed service requests.

l Deleted service requests will be removed from the UB customer account

(UB> Maintenance> Account> Service Request tab).

l If there are meter readings on the deleted service request, the meter readings

will not post to the devices. If the service request has already been com-

mitted, the meter readings on the service request have already been posted

to the devices and will not be removed from the device when the service

request is deleted.

l Highlight a service request and click the Modify icon press ENTER to open the

selected service request.

l Select a service request and click the Close Request icon to close a service

request. A service request must be closed before it can be committed using the

Commit window (UB> Service Requests> Commit).

l Click the Print icon to print the selected service request.

l The printed service request will include the Service Request Number,

Account Number, Account Status, Name, Address and Phone of the attached

customer, Service Request Date and Service Request Description.
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l Click the Assign User or the Unassign User icons to assign or unassign a

Springbrook user to the selected service requests.
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UB> Service Requests> Input

Close and Commit a Service Request

Summary

You can close a service request using the Close icon on the Service Requests window

(UB> Service Requests> Input), or you can open the service request and manually change

the status to close. If you close the service request using the Close icon, the Close Date of

the service request will be set to the current date. The advantage of manually changing the

service request status is that you can modify the close date of the service request from the

current date.

The Close Date on a service request is used for reference only and does not affect how the

meter reads on the service request will prorate. The meter readings will be added to the

device and billed on the customer account using the meter read date entered on the read-

ing.

A service request must be closed before you can commit it (UB> Service Requests> Com-

mit).

If the service request is billable, you cannot charge the customer account for the service

request (UB> Cash Receipts> Bill Service Requests) until the service request has been

closed and committed.

CLOSE AND COMMIT A SERVICE REQUEST 732



When a service request has an active status, meters attached to the service request will

display as Pending on the customer account, and meter readings will not display on the

meters.

When a service request has been closed, devices attached to the service request will still

have a pending status and meter reading will not display on the meters.

When a service request has been committed, the Pending devices attached to the service

request will be installed on the account and become Active status devices. Meter readings

on the service request will be applied to meter and will display on the Consumption tab of

the Device Maintenance window (UB> Maintenance> Device) and will display on the

Devices tab of the Account Maintenance window (UB> Maintenance> Account).

Step by Step

1     Close a service request. 

l Open the Service Requests window (UB> Service Requests> Input).

l If you are manually closing the service request, you can open the service

request from the customer account (UB> Maintenance> Account> Service

Requests tab).
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l The Service Requests window will display all of the service requests that have been

created.

l Enter information into the filter fields in the Search Criteria section and press

ENTER to filter the service requests that display in the window.

l You can filter the service requests that display in the window by status using

the Status filter field.

l Committed service requests will only display in the window if the Include

Committed toggle is checked. If the Include Committed toggle is not

checked, the Service Requests window will only display uncommitted service

requests of the status selected in the Status drop-down menu.

l Highlight the service request you would like to change to a Close status. You can

close only one service request at a time.

l Click the Close icon .

l An information window will open confirming that you would like to close the

service request. The Close Date assigned to the service request is the current

date.

l The Close icon will only be enabled if the highlighted service request has

an Active status.

l Service requests can be closed after they have been committed.

2     Commit a service request. 
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l In order to complete a service request and update the account information (includ-

ing billable fees) the service request must be committed.

l Open the Commit Service Requests window (UB> Service Requests> Commit).

l Only closed service requests that have not been committed will display in the Com-

mit Service Requests window. If the service request you would like to commit is not

in this window it has either already been committed or has not been closed.

l You can check on the status of a service request on the Input window. Check

the Include Committed toggle to include committed service requests in the

Service Requests window.

l Check the Commit toggle of the service requests you would like to commit.

l Press ENTER when all of the service request codes have been selected or

enter a date and time in the field next to the Confirm icon to schedule the

process to complete at a later time.
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UB> Service Requests> Door Hangers

Service Request Door Hangers

Summary

The Door Hangers Report is used to generate door hangers for all of the service requests

of a selected date range. The date range used to filter the Door Hanger Report is the ser-

vice request date. Only Active status service requests will display on the Door Hangers

Report. Closed or committed service requests will not display on the report because ser-

vice requests are generally moved to a closed status after the work has been completed.

Step by Step

1     Open the Service Request Door Hangers window (UB> Service Requests> Door

Hangers).

2     Configure the report. 

l Enter a date in the Service Requests From and Service Requests To field to filter

the service requests that display in the report by service request date.

SERVICE REQUEST DOOR HANGERS 736



l The service request date is entered in the Request Date field on the first step

of the Service Request Wizard.

l You can view the request date of a service request UB> Service Requests>

Input> Request Date column.

l Use the Service Request Code drop-down menu to filter the service requests

included on the door hangers by the service request code attached to the service

request.

l Select All to include all service request codes.

l Service request codes are created and maintained in UB> Maintenance> Ser-

vice Request Code. You can generate a list of service requests of a certain

service request code using the Service Request Proof List (UB> Service

Requests> Proof List).

l The Door Hanger will display the customer name, customer number and service

address of the service request.

l The organization name that displays at the top of each door hanger is set up

in SS> Utilities> System Setup> Organization tab> Name field.

l The service address will default to the lot address when the service request is

created.

l You can view the service address of a specific service request in UB>

Service Requests> Input> Open a service request. The service address

will display in the Service Address field on the first step of the Service

Request Input Wizard.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Service Requests> Service
Requests

Service Requests

Summary

The Service Requests window is used to print a filtered list of active, canceled, closed and

void status service requests. Service requests that have been committed (UB> Service

Requests> Commit) will display on the report if you include closed status service requests.

Each service request included in the standard report will display on a separate page with

space for the technician to manually enter comments and information on the report. Ser-

vice requests can also be printed during the last step of the Service Request Input Wizard.

Step by Step

1     Open the Service Request window (UB> Service Requests> Service Requests).

2     Configure the report. 

l The Request Code field is used to filter the service requests included on the report

by the service request codes attached to the service requests.
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l Check the toggle next to each Request Code to include that service request

code in the report.

l Service request codes are created and maintained in the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code), and

are attached to service requests in the Service Request Code Input Wizard

(UB> Service Requests> Input> INSERT).

l The Report Type drop-down field is used to specify the type of Service Requests

report that will be printed.

l Select One Request Per Page to print the standard report with a separate

page for each service request. This is the default report type.

l Select Service Request List to print a report that lists every included service

request as a single line item. This report type is useful when you need to print

a more compressed list of service requests that a technician can use in the

field to record information such as meter reads.

l This selection will enable the Meter Identifier 1-3 fields below.

l The Request Date From and Request Date To fields are used to filter the service

requests that display on the report by the request date attached to the service

request. You do not have to enter a date in both fields.

l The request date is entered in the Request Date field on the first step of the

Service Request Input Wizard. You can view the request date of a service

request from the customer account in UB> Maintenance> Account> Service

Requests tab> Request Date column.

l The Service Date From and Service Date To fields are used to filter the service

requests that display in the window by the service date attached to the service

request.
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l The service date is entered in the Service Date field on the first step of the

Service Request Input Wizard. You can view the request date of a service

request from the customer account in UB> Maintenance> Account> Service

Requests tab> Service Date column.

l The Request Status field is used to filter the service requests in the report by the

status of the service request.

l Select Active to include active status service requests.

l Select Canceled to include canceled status service requests.

l Select Closed to include closed status service requests in the report.

l Committed service requests will be included on the report if you include

closed status service requests on the report.

l Select Void to include void status service requests.

l The Sort drop-down menu is used to select the sort option of the report.

l Select Request Number if you would like the service requests to sort by the

service request number. The service requests that were created the earliest

(the service request number is assigned when the service request is created,

so older service requests will have a lower number) will print first.

l Select Route Sequence to print the service requests by the route and

sequence number attached to the meters on the service requests. Service

requests without a meter attached will print before service requests with

meters.

l Select Service Address to print the service requests by service address. This

option is only available when printing the Service Request List report type.
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l Use the Assigned To field to filter the service requests included in the report by the

Springbrook user the service request is assigned to.

l The six request number fields (Request Number From, Request Number To,

Request Month From, Request Month To, Request Year From and Request

Year To) are used to filter the report by the service request number assigned when

it is created.

l The service request number is made of three parts: request number, request

month and request year. The request number starts at 000001 at the begin-

ning of every request month, so the request number is not unique. The ser-

vice request numbering system is similar to the batch numbering system for

most Springbrook batch processes.

l In order to locate a specific service request you will also have enter a request

month and request year.

l The Request Number From and Request Number To fields are used to

enter the request number portion of the service request number. For example,

if the service request number is 000001-06-2021, the request number is

000001.

l The Request Month From and Request Month To fields are used to enter

the service request month. For example, if the service request number is

000001-06-2021, the request month is 06.

l The Request Year From and Request Year To fields are used to enter the

service request year. For example, if the service request number is 000001-

06-2021, the request year is 2021.

l The Meter Identifier 1-3 fields are used to include a dash-delimited combination of

the Route, Sequence, Serial Number, MXU ID, or Register ID information for each
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meter included in the report. These fields are only enabled when printing the Ser-

vice Request List report.

l Check the Include Reference Number toggle users to include the UB Account

Reference Number on the printed service request.

l If you have selected a valid service request but the report prints out a blank, the ser-

vice request you are trying to create may be closed.  You can regenerate the report

with Closed selected in the Request Status drop-down menu.

l The One Request Per Page service request report will display the customer name,

service address, service request information, and meter information. The meter

information that will display in the report is the route number, sequence number,

serial number, register ID, number of digits on the meter, MXU ID, manufacturer and

model number. Blank fields will print out for meter read, consumption and read date.

l The report will display all three address fields associated with the UB cus-

tomer account (UB> Maintenance> Account> People tab> Customer sub-tab>

Contact Information section).

l The Service Request List service request report will display the service address, ser-

vice date, service request summary, customer name, and meter identifier 1-2-3 for

each service request included in the report. The report will also include a blank

space Meter Read column for each service request, providing a space for a user to

add meter read or other information.

3     Print the report. 
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l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Service Requests> Proof List

Service Request Proof List

Summary

The Service Request Proof List Report will display active, canceled, closed and void status

service requests filtered by request date, service date, billing cycle and service request

code. If closed status service requests are included on the report, both committed and

uncommitted service requests will display on the report.

Step by Step

1     Open the Service Request Proof List window (UB> Service Requests> Proof List).

2     Configure the report. 

l Select the billing cycles you would like to include in the report in the Cycles field.

This will filter the service requests that display in the report by the billing cycle

attached to the customer account on the service request.
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l If you do not select any of the toggles, all cycles will be included in the report.

l Press CTRL+A to select all of the toggles in the field. Press SPACE to check

or uncheck all of the selected toggles.

l Select the level of detail you would like to display on the report in the Report Type

drop-down menu.

l The only difference between the summary and detail version of the report is

the detail version will display the Request Description and Service Description

of each service request included on the report.

l You can view the Request Description and Service Description

fields on a service request from a customer account on the Account

Maintenance window (UB> Maintenance> Account> Service Requests

tab> Select a service request> Request Description and Service

Description field).

l Select how the report will be sorted in the Sort By drop-down menu.

l The sort option selected in the drop-down menu will not affect the information

that displays on the report.

l The Request Code field is used to filter the service requests that display on the

report by service request code.

l Click the Request Code field label to select a service request code from a list.

l Service request codes are created and maintained in UB> Maintenance> Ser-

vice Request Code.

l Enter a date in the Request Date fields to filter the report by request date.

l The Request Date is entered on the first step of the Service Request Input

Wizard. This field will default to the current date when the service request is
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created.

l The request date generally represents the date that the service request was

generated.

l Enter a date in the Service Date fields to filter the report by service date.

l The Service Date field is entered on the first step of the Service Request Input

Wizard and defaults to the day after the current date when the service request

is created.

l The service date generally represents the date that the service will be per-

formed on the customer account.

l Select the status of the service requests you would like to include in the report in the

Status drop-down menu.

l Committed and uncommitted service requests that have a Closed status will

display on the report if you include Closed status accounts.

l Enter a request number in the Request # fields to filter the report by request num-

ber.

l The service request number is made of three parts: request number, request

month and request year, and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. Just like the batch numbering system, the request month and request

year field default to the calendar month.

l Because the request number is not unique across months, if you enter a

request number in the Request # from and to fields the report will display the

service requests in each request month and year that matches the filter. If you

want to display a range of service requests for a specific request month and
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year, make sure to enter values in the Request Month and Request Year

fields.

l The Service Summary column displays the description of the service request code

attached to the service request. If the report was printed in detail format, the report

will include request and service notes on the service request.

l If the service request is billable, the Amount column will display the billable amount

on the service request. If the amount of the billing was modified when the service

request was generated using the Service Request Input Wizard, the modified bil-

lable amount will display on the report.

3     Print the report. 

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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UB> Service Requests> Input

UB Add Device Service Request

Summary

An Add Device service request is used to add a device or multiple devices to a UB cus-

tomer account. For example, if a water meter should be added to a customer account, cre-

ate an add device service request to add the meter to the lot where the customer lives. The

devices added to the customer account can be created on the fly using the Service

Request Input Wizard, but you can also select devices that have already been created

using the Device Maintenance window (UB> Maintenance> Device). The Service Request

Input Wizard is also used to enter an initial reading on the new meters. For example, if the

meter is installed with a reading of 1000, the meter reading should be entered into the

application so the customer is not charged for that consumption.

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account

Master Maintenance window (UB> Maintenance> Account> Service Requests tab), the

Devices tab of the Account Master Maintenance window (Create , Delete or Change

Out icon ), and from the service request Input window (UB> Service Requests> Input>

Create icon).
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An add device service request is created using an Add Device service request code. Ser-

vice request codes are created and maintained using the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code). A service request code is set

up as an add device service request by selecting Add Device in the Service Type drop-
down menu on the Service Request Code Maintenance window.

When the service request is created and has an Active status, the devices will be created

with a pending status. The install date on the devices will be the service date (Service

Request Input Wizard> Request Date field) on the service request. You will be able to view
the device record on the Device Maintenance window (UB> Maintenance> Device), but you

will not be able to modify the device. If the service request is deleted, the device record with

the pending status will be deleted. Any meter readings on the device will not display on the

Devices tab of the Account Master Maintenance window until the service request has been

closed and committed.

After the service request has been created, the final step of the Service Request Input Wiz-

ard allows you to print a copy of the service request (Print Request on Save toggle). The
printed version of the service request can be handed to a service technician to give them a

record of the service address, the customer information, and the work that should be com-

pleted on the customer account. You can also print out multiple service requests at one

time using the Service Requests Report (UB> Service Requests> Service Requests). The

Service Requests Report allows you to print multiple service requests by criteria such as

request date or service date.
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Once the service request is closed and committed (UB> Service Request> Commit), the

devices on the service request will change to an active status on the account and the initial

meter readings on those devices will display on the Device tab of the Account Master Main-

tenance window.

When the Service Request Input Wizard is launched from the Devices tab of the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab), the default ser-

vice request code attached to the Device Type Maintenance window (UB> Maintenance>

Device Type> Device tab> Default Add field) may populate on the Service Request Input
Wizard. Service request codes can be attached to device types so that when a specific

type of service request (add, remove, change-out) is performed on a certain device type,

the service request will populate with a default service request code. For example, if all

water meter devices should be removed with a certain remove device service request

code, you can attach that service request code to all water meter device types. When a

user clicks on the Remove icon on the Devices tab of the Account Master Maintenance win-

dow (UB> Maintenance> Account> Devices tab), the default remove device service

request code attached to the device type will populate on the Service Request Input Wiz-

ard. This is an optional feature, so there may not be default service request codes set up on

the device types.

Step by Step

1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 
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l You can also create a service request from the UB Account Maintenance window

(UB> Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 

l The Request Number field will only display a service request number when you

open an existing service request. This field will not be enabled.

l The service request number is made of three parts: request number, request

month, and request year and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. The request month and request year portions of the service request

number will populate with the month and year the service request was gen-

erated. Changing the request date on the service request will not affect the

service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

press F1 while the cursor is in the field to select a customer account from a list.

l You may also locate a customer account number by clicking the Account Num-

ber field label.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service

Requests tab> Create icon ), the Account Number and Service Address
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fields will populate with the information of the customer account the wizard

was launched from.

l The Service Address field is used to select the service address of the service

request. The service will be performed on this lot. If you have already selected a UB

customer account in the Account Number field, the lot attached to the selected UB

customer account will populate in the Service Address field.

l Select a lot in this field if you would like to generate a service request for a lot

that is not attached to a customer account. If you would like to generate a ser-

vice request for a lot attached to a UB customer account, select that customer

account in the Account Number field. If you do not know the customer account

number, click the Account Number field label. This will open the Account

Master Search window. Select Lot from the Search By drop-down menu and

then enter information into the Search Criteria section to select the customer

account by the attached lot. When a customer account is selected, the

Account Number and Service Address fields will populate on the Service

Request Input Wizard.

l The Service Address field allows you to select a lot that is not attached to a

UB customer account. This allows you to create a service request for a lot that

is currently not attached to a UB customer account. If you enter a lot in this

field that is attached to a customer account, the customer account will not pop-

ulate in the Account Number field. When the Service Request Input Wizard is

completed and the service request is created, the service request will not dis-

play on the customer account (UB> Maintenance> Account> Service

Requests tab).

l The Request Code field is used to select the service request code that will be used

to create the service request. This field might be populated if the Service Request
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Input Wizard is launched from the Devices tab of the Account Master Maintenance

window.

l Press F1 in the Request Code field to select a service request code from a

list. This will open the Service Request Code Selection window.

l Select an Add Device type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to dis-

play the Maintenance section of the window. The Maintenance section will dis-

play all of the information associated with the highlighted service request

code.

l An Add Device service request code will have Add Device selected in

the Service Type drop-down menu.

l Service request codes are set up on the Service Request Code Maintenance

window (UB> Maintenance> Service Request Code).

l You can add a default device type to a service request code, but those default

device types do not affect the functionality of add device service codes.

Default device types are attached to service request codes to reduce data

entry and will affect all other types of service requests (remove device, show

device, change-out device, etc.).

l The service Request Date field is used to enter the date the service was requested.

This field will default to the current date because the request date is also generally

the date the service request is being entered.

l If you are printing door hangers (UB> Service Requests> Door Hangers), the

door hangers that display on the report will be filtered by the date entered in
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the Service Request Date field.

l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.

l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field, or change the amount to

zero to eliminate the charge on the service.

l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Adjustments and Fees> Bill Service Requests), the

zero amount service request will still display in the Bill Service

Requests window but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code attached to it

(UB> Maintenance> Service Request Code> Fee Code field).

l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service Requests win-

dow (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The device being installed on the customer account will dis-

play on the Devices tab of the UB customer account even when the service request

has an Active status (UB> Maintenance> Account> Devices tab). The device will not

be installed on the customer account until the service request has been closed and

committed.
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l Change the status of the service request to Cancel if the service request has

been canceled.

l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).

l Changing the status of the service request to Closed will populate the

Close Date field with the current date.

l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service

Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.

l The Service Date is the date that the service will be performed on the customer

account.

l The service date will be used as the install date of the device when the new

device is installed on the customer account.

l The Close Date is the date that the service request is changed to a Close status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.
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l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).

l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.

l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. For example, add a meter. The Service Request
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Description field will populate with the description of the service request code, but

you can add to or modify the text in the field.

l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>

Description field).

l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request. For example, if a certain backflow device

was installed to prevent a certain type of backflow hazard, that information could be

entered in this field.

l The service performed description will display in the Service Description field

on the printed version of the service request (UB> Service Request> Service

Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER to move to the next step.

3     Add a device to the service request. 

l Right click on the Add Device button to select the type of device you would like to

add to the account. This will create a new device and reading line item in the
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window. The new line items are created to represent the device that will be added to

the account and are not used to enter the device information. The device inform-

ation will be entered on the next step of the Service Request Input Wizard.

l Each device that you add to the service request will have the Selected toggle

already checked.

l You can add as many devices as you would like to the service request. Each device

that you add will add another step to the wizard in order to enter the device and read-

ing information on the device.

l The Delete Device button is used to delete devices that have accidentally been cre-

ated in the window. You cannot use the Delete Device button to delete devices that

are installed on the account.

l The type of devices added to the service request will determine which information

will be entered on the next step.

l If you do not add or select a device in the window, a device will not be added to the

service request. The only information that will be attached to the service request is

the customer information.

l Click the Next button or press ENTER when complete to move to the next step.

4     Enter the device information of the devices that you are attaching to the account. 

l The devices installed on the customer account do not have to be created on the

Device Maintenance window (UB> Maintenance> Device). The devices can be cre-

ated using the Service Request Input Wizard).
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l The default device type information will populate in the window. Modify the inform-

ation if it does not apply.

l A default device type can be created for each device type. If you would like to

create a water meter default device type, check the Default Type toggle of a

device type on the Device Type - Water Maintenance window (UB> Main-

tenance> Device Type - Water> General tab).

l Click on the Manufacturer or Model Number field to select a device type from a

list. Both of the field labels will open the same window.

l Click the Route Number field label to select a route number from a list.

l Meter route numbers are created and maintained on the Route Maintenance

window (UB> Maintenance> Route).

l Click the Serial Number field label to select a specific device from a list. This allows

you to select a device that has been created using the Device Maintenance window

(UB> Maintenance> Device).

l You cannot install a device that is installed on another lot.

l Enter a Register ID or MXU ID.

l Register Identification numbers are entered on touch read meters.

l MXU Identification numbers are entered on radio read meters.

l The Reading Description field is used to enter a description of the meter reading.

This field will display on the Meter History sub-tab for each reading on the Devices

tab of the Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Meter History sub-tab> Description column).

l This is an optional field.
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l The Reader Information field is used to enter information about the meter. This

information is entered on the meter, not the meter reading.

l This is an optional field.

l The Read Date field is the read date of the meter reading entered into the Reading

field. This field will default to the Read Date field.

l The Read Period/Year fields are used to enter the meter read period and meter

read year of the meter reading entered in the Reading field. These fields are import-

ant if your organization bills by meter read period and you are entering consumption

on the initial meter reading (a value greater than zero in the Consumption field).

l Depending on how the UB module is set up, you may bill readings based on

the meter read period and year (UB> Utilities> Setup> Billing tab> Meter

Reads To Bill field> Period). If there is consumption on the initial meter read-

ing (entering a value greater than zero in the Consumption field) and you bill

by meter read period, make sure to enter a meter read period that has not

been billed. If the meter read period has already been billed, the consumption

entered in the Consumption field will never be included in a billing.

l The Prior Reading field will display the last reading recorded on the meter. If the

meter was installed on a previous account, the final reading on that account will dis-

play in this field.

l If the device you are adding to the account is a meter, enter an initial meter reading

in the Reading field.

l The initial reading is used to enter the current reading on the meter so the cus-

tomer is not charged for consumption previously recorded on the meter. For

example, if the meter is installed with a reading of 1000, if you do not enter the

initial reading the customer will be charged the 1000 units of consumption.
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l The Prior Reading field displays the last reading on the meter. If the meter

was installed on a previous account, the final reading on that account will dis-

play in this field.

l If the initial meter reading equals the prior reading, no consumption will be

included on the initial meter reading.

l If the Prior Reading and initial reading are not the same, but the customer

should not be charged for any consumption on the new meter, enter the initial

reading in the Reading field and then change the Consumption field to zero. 

The customer will not be charged any consumption on the initial read.

l No consumption amount will be associated with the initial reading on the

device. When the next reading is made, the consumption on the billing will be

the new reading minus the initial reading.

l Click the Next button or press ENTER when complete to move to the next step.

5     Complete the Service Request Input Wizard. 

l The Final Account Information step will display after the meter reads have been

entered on the devices being removed from the account.

l The fields in the Final Account Information step will only be enabled if you are cre-

ating a final account service request.

l Check the Print Request on Save toggle if you would like a printed version of the

service request to print after you click the Finish button on this step. The printed ver-

sion of the service request will process on the server as soon as the resources
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become available. You can view the status of the print job using the Jobs Viewer

window (Jobs Viewer icon).

l A printed version of the service request can also be generated using the Ser-

vice Requests report (UB> Service Requests> Service Requests).

l Click the Finish button or press ENTER to complete the wizard.

l The service request has been completed.

l The device will display on the account (UB> Maintenance> Account> Devices tab)

but it will be attached to the account with a Pending status. The initial meter reading

on the device entered on the service request will not display on the Devices tab until

the service request has been closed and committed.
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UB> Service Requests> Input

Change-Out Device Service Request

Summary

A Change-out Device service request is used to replace a device or multiple devices from a

UB customer account. For example, if a water meter on an account has broken and needs

to be replaced, create a change-out device service request to remove the original device

from the account and replace it with a new device. If the removed device is a meter, the

final reading on the removed meter will be entered on the service request.

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account

Master Maintenance window (UB> Maintenance> Account> Service Requests tab), the

Devices tab of the Account Master Maintenance window (Create , Delete or Change

Out icon ), and from the service request Input window (UB> Service Requests> Input>

Create icon).

A change-out device service request is created using a Change-Out Device service

request code. Service request codes are created and maintained using the Service

Request Code Maintenance window (UB> Maintenance> Service Request Code). A ser-
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vice request code is set up as a change-out device service request by selecting Change-

out Device in the Service Type drop-down menu on the Service Request Code Main-
tenance window.

When the Change-out service request is created and has an Active status, the device

being removed from the account will not be affected until the service has been committed

(UB> Service Requests> Commit). The devices being added to the account will have a

pending connection status (UB> Maintenance> Account> Devices tab). The install date on

the devices being added to the account will be the service date (Service Request Input Wiz-

ard> Request Date field) on the service request. You will be able to view the device record

on the Device Maintenance window (UB> Maintenance> Device), but you will not be able to

modify the device.

If the service request is deleted before it is committed, the device being added to the

account will be deleted from the account. Any meter readings on the device will be deleted.

After the service request has been created, the final step of the Service Request Input Wiz-

ard allows you to print a copy of the service request (Print Request on Save toggle). The
printed version of the service request can be handed to a service technician to give them a

record of the service address, the customer information, and the work that should be com-

pleted on the customer account. You can also print out multiple service requests at one

time using the Service Requests Report (UB> Service Requests> Service Requests). The

Service Requests Report allows you to print multiple service requests by criteria such as

request date or service date.
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Once the service request is closed and committed (UB> Service Request> Commit), the

devices on the service request will change to an active status on the account and the initial

meter readings on those devices will display on the Device tab of the Account Master Main-

tenance window. The device being removed on the account will change to a Removed con-

nection status (UB> Maintenance> Account> Device tab> Status), and the Inventory status

of the device will change to Testing (UB> Maintenance> Device> Device tab> Devices sec-

tion> Inventory Status drop-down). The meter readings entered on the removed meter
during the Meter Change-out service request will also be posted to the removed device

when the service request is committed.

When the Service Request Input Wizard is launched from the Devices tab of the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab), the default ser-

vice request code attached to the Device Type Maintenance window (UB> Maintenance>

Device Type> Device tab> Default Change-Out field) may populate on the Service
Request Input Wizard. Service request codes can be attached to device types so that when

a specific type of service request (add, remove, change-out) is performed on a certain

device type, the service request will populate with a default service request code. For

example, if all water meter devices should be removed with a certain remove device ser-

vice request code, you can attach that service request code to all water meter device types.

When a user clicks on the Remove icon on the Devices tab of the Account Master Main-

tenance window (UB> Maintenance> Account> Devices tab), the default remove device

service request code attached to the device type will populate on the Service Request

Input Wizard. This is an optional feature, so there may not be default service request codes

set up on the device types.

Step by Step
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1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 

l You can also create a service request from the Account Maintenance window (UB>

Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 

l The Request Number field will only display a service request number when you

open an existing service request. This field will not be enabled.

l The service request number is made of three parts: request number, request

month, and request year and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. The request month and request year portions of the service request

number will populate with the month and year the service request was gen-

erated. Changing the request date on the service request will not affect the

service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

press F1 while the cursor is in the field to select a customer account from a list.

l You may also locate a customer account number by clicking the Account Num-

ber field label.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service
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Requests tab> Create icon ), the Account Number and Service Address

fields will populate with the information of the customer account the wizard

was launched from.

l The Service Address field is used to select the service address of the service

request. The service will be performed on this lot. If you have already selected a UB

customer account in the Account Number field, the lot attached to the selected UB

customer account will populate in the Service Address field.

l The Request Code field is used to select the service request code that will be used

to create the service request. This field might be populated if the Service Request

Input Wizard was launched from the Devices tab of the Account Maintenance win-

dow.

l Press F1 in the Request Code field to select a service request code from a

list. This will open the Service Request Code Selection window.

l Select a change-out device type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to dis-

play the Maintenance section of the window. The Maintenance section will dis-

play all of the information associated with the highlighted service request

code.

l A Change-Out Device service request code will have Change-out

Device selected in the Service Type drop-down menu.

l Service request codes are set up in UB> Maintenance> Service Request

Code.
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l If there is a default device type attached to the selected service request code,

that device will automatically be selected if it is attached to the customer

account. For example, if a specific water meter device type is attached to the

service request code, that device water meter will be selected if it is attached

to the customer account. This allows you to reduce data entry if a service

request code is generally performed on a certain device type.

l Modify the service Request Date field if it is different from the current date.

l If you print Door Hangers (UB> Service Requests> Door Hangers), the door

hangers that display on the report is filtered by the value entered in the

Request Date field.

l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.

l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field, or change the amount to

zero to eliminate the charge on the service.

l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Cash Receipts> Bill Service Requests), the zero

amount service request will still display in the Bill Service Requests win-

dow but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code attached to it

on the Service Request Code Maintenance window (UB> Maintenance> Ser-

vice Request Code> Fee Code field).
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l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service Requests win-

dow (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The device being installed on the customer account will dis-

play on the Devices tab of the UB customer account even when the service request

has an Active status (UB> Maintenance> Account> Devices tab). The device will not

be installed on the customer account until the service request has been closed and

committed.

l Change the status of the service request to Cancel if the service request has

been canceled.

l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).

l Changing the status of the service request to Closed will populate the

Close Date field with the current date.

l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service

Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.
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l The Service Date is the date that the service will be performed on the customer

account.

l The service date will be used as the install date of the device when the new

device is installed on the customer account.

l The Close Date is the date that the service request is changed to a Closed status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.

l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).

l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.

l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring
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Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. For example, “Remove the water meter on the

account”. The Service Request Description field will populate with the description of

the service request code, but you can add to or modify the text in the field.

l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>

Description field).

l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request.

l The service performed description will display in the Service Description field

on the printed version of the service request (UB> Service Request> Service

Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER to move to the next step.
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3     Select the devices you would like to replace. 

l Check the Select toggle of each device you would like to replace on the account.

l You can replace more than one device on a single service request.

l The Device ID column will display the meter route, sequence number, and

serial number of the meter in the following format: route, sequence, and

serial.

l You cannot use the Delete Device button to remove devices installed on the

account. The Delete Device button is only used when creating an add device

service request.

l The information of the device that will be added to the account will be set up on a

later step.

l Click the Next button or press ENTER when complete.

4     Enter the meter reading of the devices you are removing from the account. 

l The Service Request Input Wizard will display the meter information of the devices

that are being removed from the customer account. Enter a meter reading on the

devices that will be replaced on the account. A separate window will open for each

device that will be replaced on the account.

l By default, the Read Date field will default to the current date.
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l The Reading Description field is used to enter a description of the meter reading.

This field will display on the Meter History sub-tab for each reading on the Devices

tab of the Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Meter History sub-tab> Description column).

l This is an optional field.

l The Reader Information field is used to enter information about the meter. This

information is entered on the meter, not the meter reading.

l This is an optional field.

l The Read Date field is the read date of the meter reading entered into the Reading

field. This field will default to the Read Date field.

l The Read Period/Year fields are used to enter the meter read period and meter

read year of the meter reading entered in the Reading field.

l If you bill meter readings be meter read period (UB> Utilities> Setup> Billing

tab> Meter Reads To Bill drop-down> Period select).

l The Prior Reading field will display the last reading recorded on the meter.

l Enter the final reading on the device in the Reading field.

l Click the Next button or press ENTER when complete.

5     Enter the device information of the devices you are attaching to the account. 

l The device type will default to the device type that is being removed from the cus-

tomer account. Modify the information if it does not apply.
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l The device type will not default to the default device type (UB> Maintenance>

Device Type> Default toggle).

l Click on the Manufacturer or Model Number field to select a device type from a

list. Both of the field labels will open the same window.

l Click the Route Number and Sequence Number fields will populate with the same

information as the device being changed-out.

l Click the Serial Number field label to select a specific device from a list or enter the

serial number of the device being installed.

l You cannot attach a meter than is already installed on a customer account.

Installed meters will have a connection status of Active.

l Enter a Register ID or MXU ID if the device is a meter.

l MXU Identification numbers are entered on radio read meters.

l Register Identification numbers are entered on touch read meters.

l The Reading Description field is used to enter a description of the meter reading.

This field will display on the Meter History sub-tab for each reading on the Devices

tab of the Account Maintenance window (UB> Maintenance> Account> Devices

tab> Meter History sub-tab> Description column).

l This is an optional field.

l The Reader Information field is used to enter information about the meter. This

information is entered on the meter, not the meter reading.

l This is an optional field.

l The Read Date field is the read date of the meter reading entered into the Reading

field. This field will default to the Read Date field.
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l The Read Period/Year fields are used to enter the meter read period and meter

read year of the meter reading entered in the Reading field. These fields are import-

ant if the you bill by meter read period and you are entering consumption on the ini-

tial meter reading (a value greater than zero in the Consumption field).

l Depending on how the UB module is set up, you may bill readings based on

the meter read period and year (UB> Utilities> Setup> Billing tab> Meter

Reads To Bill field> Period). If there is consumption on the initial meter read-

ing (entering a value greater than zero in the Consumption field) and you bill

by meter read period, make sure to enter a meter read period that has not

been billed. If the meter read period has already been billed, the consumption

entered in the Consumption field will never be included in a billing.

l The Prior Reading field will display the last reading recorded on the meter. If the

meter was installed on a previous account, the final reading on that account will dis-

play in this field.

l If the device you are adding to the account is a meter, enter an initial meter reading

in the Reading field.

l The initial reading is used to enter the current reading on the meter so the cus-

tomer is not charged for consumption previously recorded on the meter. For

example, if the meter is installed with a reading of 1000, if you do not enter the

initial reading the customer will be charged the 1000 units of consumption.

l The Prior Reading field displays the last reading on the meter. If the meter

was installed on a previous account, the final reading on that account will dis-

play in this field.

l If the initial meter reading equals the prior reading, no consumption will be

included on the initial meter reading.
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l If the Prior Reading and initial reading are not the same, but the customer

should not be charged for any consumption on the new meter, enter the initial

reading in the Reading field and then change the Consumption field to zero. 

The customer will not be charged any consumption on the initial read.

l No consumption amount will be associated with the initial reading on the

device. When the next reading is made, the consumption on the billing will be

the new reading minus the initial reading.

l Click the Next button or press ENTER to continue.

6     Complete the Service Request Input Wizard. 

l The Final Account Information step will display after the meter reads have been

entered on the devices being replaced on the account and the device information

has been entered on the devices that will be attached to the account.

l The fields in the Final Account Information step will only be enabled if you are cre-

ating a final account service request.

l Click the Finish button or press ENTER to complete the change-out service request.

l The service request has been completed. Change the status of the service request

to Closed when the service is complete, and then commit the service request to

remove the device from the customer account.

l After the service request has been created, the device being added to the account

will display on the account (UB> Maintenance> Account> Devices tab) but it will be

attached to the account with a Pending connection status. The initial meter reading
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on the device entered on the service request will not display on the Devices tab until

the service request has been closed and committed.

l Once the service request is committed (UB> Service Requests> Commit), the

device will be removed from the customer account, and the new device will be

added.

l The device being added to the account will now have an Active connection

status and the initial meter readings on the device will display on the customer

account (UB> Maintenance> Account> Devices tab).

l You will still be able to view the removed device from the Account Main-

tenance window (UB> Maintenance> Account> Devices tab), but the device

will have a Removed connection status.

l The Inventory Status of the removed device will change to Testing (UB> Main-

tenance> Device> Device tab> Device section> Inventory Status drop-

down). Devices with a Testing inventory status can still be attached to cus-

tomer accounts using an Add Device service request code.

CHANGE-OUT DEVICE SERVICE REQUEST 779



UB> Service Requests> Input

New Account Service Request

Summary

A New Account service request is used to change the status of a UB customer account

from Suspended to Active status (UB> Maintenance> Account> Account tab> Account
Status field). When an account is created using the New Account Wizard, by default the

status of the created account is Suspended. In order to change the account to Active

status, you can either process a New Account service request or change the account

status manually on the Account Maintenance window (UB> Maintenance> Account>

Account tab> Account Status field).

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account Main-

tenance window (UB> Maintenance> Account> Service Requests tab), the Devices tab of

the Account Master Maintenance window (Create , Delete or Change Out icon ),

and from the service request Input window (UB> Service Requests> Input> Create icon).

A new account service request is created using a New Account service request code. Ser-

vice request codes are created and maintained using the Service Request Code Main-
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tenance window (UB> Maintenance> Service Request Code). A service request code is set

up as a remove device service request by selecting Remove Device in the Service Type
drop-down menu on the Service Request Code Maintenance window.

When the new account service request is created, the status of the customer account will

stay as Suspended. Once the service request has been closed and committed, the status

of the customer account will change to Active. Service requests can be changed to a

closed status using the Service Requests window (UB> Service Requests> Input) and can

be committed using the Commit window (UB> Service Requests> Commit). Only closed

service requests will display in the Commit window.

Step by Step

1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 

l You can also create a service request from the customer account maintenance win-

dow (UB> Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 

l The Request Number field will only display a service request number when you

open an existing service request. This field will not be enabled.
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l The service request number is made of three parts: request number, request

month and request year, and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. The request month and request year portions of the service request

number will populate with the month and year the service request was gen-

erated. Changing the request date on the service request will not affect the

service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

press F1 while the cursor is in the field to select a customer account from a list.

l You may also locate a customer account number by clicking the Account Num-

ber field label.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service

Requests tab> Create icon ), the Account Number and Service Address

fields will populate with the information of the customer account the wizard

was launched from.

l The Service Address field is used to select the service address of the service

request. The service will be performed on this lot. If you have already selected a UB

customer account in the Account Number field, the lot attached to the selected UB

customer account will populate in the Service Address field.

l This field does not apply to New Account service requests.

l The Request Code field is used to select the service request code that will be used

to create the service request. This field might be populated if the Service Request

Input Wizard was launched from the Devices tab of the Account Master
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Maintenance window.

l Click the Request Code field label to select a service request code from a list.

This will open the Service Request Code Selection window.

l Select a new account type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to dis-

play the Maintenance section of the window. The Maintenance section will dis-

play all of the information associated with the highlighted service request

code.

l A new account service request code will have New Account selected in

the Service Type drop-down menu.

l Service request codes are set up on the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code).

l The Service Request Date field is used to enter the date the service was reques-

ted. This field will default to the current date because the request date is also gen-

erally the date the service request is being entered.

l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.

l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field or change the amount to

zero to eliminate the charge on the service.
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l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Cash Receipts> Bill Service Requests), the zero

amount service request will still display in the Bill Service Requests win-

dow but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code

attached to it (UB> Maintenance> Service Request Code> Fee Code
field).

l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service

Requests window (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The devices selected on the Remove Device service request

will not be removed from the customer account until the service request has been

closed and committed.

l Change the status of the service request to Cancel if the service request has

been canceled.

l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).

l Changing the status of the service request to Closed will populate the

Close Date field with the current date.
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l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service

Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete if the status

of the service request is Closed.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.

l The Service Date is the date that the service will be performed on the customer

account. This field will populate with the current date plus one.

l The service date will be used as the install date of the device when the new

device is installed on the customer account.

l The Close Date is the date that the service request is changed to a Close status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.

l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).

l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.

l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

NEW ACCOUNT SERVICE REQUEST 785



l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. For example, this field might read Remove the water

meter on the account. The Service Request Description field will populate with the

description of the service request code, but you can add to or modify the text in the

field.

l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>

Description field).
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l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request.

l The service performed description will display in the Service Description

field on the printed version of the service request (UB> Service Request> Ser-

vice Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER to move to the next step.

3     Complete the Service Request Input Wizard. 

l The Final Account Information step will display.

l The fields in the Final Account Information step will only be enabled if you are cre-

ating a final account service request.

l Click the Finish button or press ENTER when complete.

l The service request has been completed.

l The status of the service request will not be changed to Active until the service

request is closed and then committed (UB> Service Requests> Commit).
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UB> Service Requests> Input

Read Device Service Request

Summary

A Read Device service request is used to enter a meter reading on a device or multiple

devices on a UB customer account. For example, if a water meter and gas meter should be

read on a customer account, create a read device service request to read the meters.

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account

Master Maintenance window (UB> Maintenance> Account> Service Requests tab), the

Devices tab of the Account Master Maintenance window (Create , Delete or Change

Out icon ), and from the service request Input window (UB> Service Requests> Input>

Create icon).

A read device service request is created using a Read Device service request code. Ser-

vice request codes are created and maintained using the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code). A service request code is set

up as a remove device service request by selecting Read Device in the Service Type
drop-down menu on the Service Request Code Maintenance window.

READ DEVICE SERVICE REQUEST 788



After the service request has been created, the final step of the Service Request Input Wiz-

ard allows you to print a copy of the service request (Print Request on Save toggle). The
printed version of the service request can be handed to a service technician to give them a

record of the service address, the customer information and the work that should be com-

pleted on the customer account. You can also print out multiple service requests at one

time using the Service Requests Report (UB> Service Requests> Service Requests). The

Service Requests Report allows you to print multiple service requests by criteria such as

service date.

Once the service request is closed and committed (UB> Service Request> Commit), the

meter readings on the service request will display on the Device stab of the customer

account (UB> Maintenance> Account> Devices tab). The meter readings will not display on

the device until the service request is closed and committed.

Step by Step

1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 

l You can also create a service request from the customer account maintenance win-

dow (UB> Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 
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l The Request Number field will only display a service request number when you

open an existing service request. This field will not be enabled.

l The service request number is made of three parts: request number, request

month and request year, and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. The request month and request year portions of the service request

number will populate with the month and year the service request was gen-

erated. Changing the request date on the service request will not affect the

service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

press F1 while the cursor is in the field to select a customer account from a list.

l You may also locate a customer account number by clicking the Account Num-

ber field label.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service

Requests tab> Create icon ), the Account Number and Service Address

fields will populate with the information of the customer account the wizard

was launched from.

l The Service Address field is used to select the service address of the service

request. The service will be performed on this lot. If you have already selected a UB

customer account in the Account Number field, the lot attached to the selected UB

customer account will populate in the Service Address field.

l Select a lot in this field if you would like to generate a service request for a lot

that is not attached to a customer account. If you would like to generate a
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service request for a lot attached to a UB customer account, select that cus-

tomer account in the Account Number field. If you do not know the customer

account number, click the Account Number field label. This will open the

Account Master Search window. Select Lot from the Search By drop-down

menu and then enter information into the Search Criteria section to select the

customer account by the attached lot. When a customer account is selected,

the Account Number and Service Address fields will populate on the Service

Request Input Wizard.

l The Service Address field allows you to select a lot that is not attached to a

UB customer account. This allows you to create a service request for a lot that

is currently not attached to a UB customer account. If you enter a lot in this

field that is attached to a customer account, the customer account will not pop-

ulate in the Account Number field. When the Service Request Input Wizard is

completed and the service request is created, the service request will not dis-

play on the customer account (UB> Maintenance> Account> Service

Requests tab).

l The Request Code field is used to select the service request code that will be used

to create the service request.

l Click the Request Code field label to select a service request code from a list.

This will open the Service Request Code Selection window.

l Select a Read Device type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to dis-

play the Maintenance section of the window. The Maintenance section will dis-

play all of the information associated with the highlighted service request
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code.

l An Add Device service request code will have Add Device selected in

the Service Type drop-down menu.

l Service request code are set up on the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code).

l Default device types are attached to service request codes to reduce

data entry. If the default device type attached to the service request

code is attached to the customer account, that device will be auto-

matically selected in the next step of the Service Request Input Wizard.

l Modify the service Request Date field if it is different from the current date. This

field will default to the current date because the request date is also generally the

date the service request is being entered.

l If you print door hangers (UB> Service Requests> Door Hangers), the service

requests that display on the report will be filtered by the value entered in the

Request Date field.

l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.

l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field or change the amount to

zero to eliminate the charge on the service.

l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Cash Receipts> Bill Service Requests), the zero
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amount service request will still display in the Bill Service Requests win-

dow but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code

attached to it (UB> Maintenance> Service Request Code> Fee Code
field).

l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service

Requests window (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The meter readings entered using this service request will not

display on the customer account until the service request has been changed to a

Closed status and the service request has been committed (UB> Service

Requests> Commit).

l Change the status of the service request to Cancel if the service request has

been canceled.

l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).

l Changing the status of the service request to Closed will populate the

Close Date field with the current date.

l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service
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Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.

l The Service Date is the date that the service will be performed on the customer

account.

l The Close Date is the date that the service request is changed to a Close status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.

l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).

l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.

l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:
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l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. The Service Request Description field will populate

with the description of the service request code, but you can add to or modify the

text in the field.

l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>

Description field).

l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request. For example, if a certain backflow device

was installed to prevent a certain type of backflow hazard, that information could be

entered in this field.
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l The service performed description will display in the Service Description field

on the printed version of the service request (UB> Service Request> Service

Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER when complete to move to the next step.

3     Select the devices to enter a reading on. 

l Check the toggle in the Selected column of the devices you would like to enter a

reading on using the service request.

l The Device ID column will display the meter route, sequence number and

serial number of the meter in the following format: route, sequence and serial.

l By default, all devices attached to the customer account that match the

default device type on the service request code will be selected. Uncheck the

select toggles if you do not want to enter a meter reading on those devices.

l Default device types are added to service request codes on the Service

Request Code Maintenance window (UB> Maintenance> Service

Request Codes> Device Type fields).

l The Delete Device button is used to delete devices that have accidentally been cre-

ated in the window. You cannot use the Delete Device button to delete devices that

are installed on the account.
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l If you do not select a device in the window, a device will not be added to the service

request. The only information that will be attached to the service request is the cus-

tomer information.

l Click the Next button or press ENTER when complete to move to the next step.

4     Enter the meter reading in the device. 

l The Reading Description field is used to enter a description of the meter reading.

This field will display on the Meter History sub-tab for each reading on the Devices

tab of the Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Meter History sub-tab> Description column).

l This is an optional field.

l The Reader Information field is used to enter information about the meter. This

information is entered on the meter, not the meter reading.

l This is an optional field.

l The Read Date field is the read date of the meter reading entered into the Reading

field. This field will default to the Read Date field.

l The Read Period/Year fields are used to enter the meter read period and meter

read year of the meter reading entered in the Reading field. If you bill readings by

period (UB> Utilities> Setup> Billing tab> Meter Reads To Bill field> Period), make

sure to enter a meter read period that has not been billed.

l The Prior Reading field will display the last reading recorded on the meter.
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l If the device you are adding to the account is a meter, enter an initial meter reading

in the Reading field.

l The Consumption field will calculate the consumption amount based on the new

reading and the prior reading on the meter.

l Click the Next button or press ENTER when complete to move to the next step.

5     Complete the Service Request Input Wizard. 

l The Final Account Information step will display after the meter reads have been

entered on the devices being removed from the account.

l The fields in the Final Account Information step will only be enabled if you are cre-

ating a final account service request.

l Click the Finish button or press ENTER to complete the wizard.

l The service request has been completed.
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UB> Service Requests> Input

Remove a Device Service Request

Summary

A Remove Device service request is used to remove a device or multiple devices from a

UB customer account. For example, if a water meter should be removed from a customer

account, create a remove device service request to remove the meter. If the removed

device is a meter, the final reading on the removed meter will be entered on the service

request. A remove device service request will only remove the device from the customer

account; it will not disconnect the service and service rates on the account.

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account

Master Maintenance window (UB> Maintenance> Account> Service Requests tab), the

Devices tab of the Account Master Maintenance window (Create , Delete or Change

Out icon ), and from the service request Input window (UB> Service Requests> Input>

Create icon).

A remove device service request is created using a Remove Device service request code.

Service request codes are created and maintained using the Service Request Code Main-
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tenance window (UB> Maintenance> Service Request Code). A service request code is set

up as a remove device service request by selecting Remove Device in the Service Type
drop-down menu on the Service Request Code Maintenance window.

When a Remove Device service request has an Active or Closed status, the status of the

devices attached to the service request will not change and the meter readings attached to

the service request will not be added to the devices. If the service request is deleted, any

meter readings on the service request will be also be deleted and the device will not be

removed from the account.

After the service request has been created, the final step of the Service Request Input Wiz-

ard allows you to print a copy of the service request (Print Request on Save toggle). The
printed version of the service request can be handed to a service technician to give them a

record of the service address, the customer information and the work that should be com-

pleted on the customer account. You can also print out multiple service requests at one

time using the Service Requests Report (UB> Service Requests> Service Requests). The

Service Requests Report allows you to print multiple service requests by criteria such as

service date.

Once the service request is committed (UB> Service Request> Commit), the devices on

the service request will be removed from the account and the meter readings on the ser-

vice request will be posted to the device. The Connection status of the device will change

to Removed (UB> Maintenance> Account> Devices tab> Status column), and the Invent-

ory Status of the device will change to Testing (UB> Maintenance> Device> Device tab>

Device section> Inventory Status field).
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When the Service Request Input Wizard is launched from the Devices tab of the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab), the default ser-

vice request code attached to the Device Type Maintenance window (UB> Maintenance>

Device Type> Device tab> Default Remove field) may populate on the Service Request
Input Wizard. Service request codes can be attached to device types so that when a spe-

cific type of service request (add, remove, change-out) is performed on a certain device

type, the service request will populate with a default service request code. For example, if

all water meter devices should be removed with a certain remove device service request

code, you can attach that service request code to all water meter device types. When a

user clicks on the Remove icon on the Devices tab of the Account Master Maintenance win-

dow (UB> Maintenance> Account> Devices tab), the default remove device service

request code attached to the device type will populate on the Service Request Input Wiz-

ard. This is an optional feature, so there may not be default service request codes set up on

the device types.

Step by Step

1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 

l You can also create a service request from the customer account maintenance win-

dow (UB> Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 
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l The Request Number field will only display a service request number if you are

opening an existing service request. This field will not be enabled.

l The service request number is made of three parts: request number, request

month and request year, and is similar to the batch numbering system. The

request number increments with each service request generated and iden-

tifies a unique service request within a specific request month and request

year. The request month and request year portions of the service request

number will populate with the month and year the service request was gen-

erated. Changing the request date on the service request will not affect the

service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

press F1 while the cursor is in the field to select a customer account from a list.

l You may also locate a customer account number by clicking the Account Num-

ber field label.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service

Requests tab> Create icon ), the Account Number and Service Address

fields will populate with the information of the customer account the wizard

was launched from.

l The Service Address field is used to select the service address of the service

request. The service will be performed on this lot. If you have already selected a UB

customer account in the Account Number field, the lot attached to the selected UB

customer account will populate in the Service Address field.

l Select a lot in this field if you would like to generate a service request for a lot

that is not attached to a customer account. If you would like to generate a
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service request for a lot attached to a UB customer account, select that cus-

tomer account in the Account Number field. If you do not know the customer

account number, click the Account Number field label. This will open the

Account Master Search window. Select Lot from the Search By drop-down

menu and then enter information into the Search Criteria section to select the

customer account by the attached lot. When a customer account is selected,

the Account Number and Service Address fields will populate on the Service

Request Input Wizard.

l The Service Address field allows you to select a lot that is not attached to a

UB customer account. This allows you to create a service request for a lot that

is currently not attached to a UB customer account. If you enter a lot in this

field that is attached to a customer account, the customer account will not pop-

ulate in the Account Number field. When the Service Request Input Wizard is

completed and the service request is created, the service request will not dis-

play on the customer account (UB> Maintenance> Account> Service

Requests tab).

l The Request Code field is used to select the service request code that will be used

to create the service request. This field might be populated if the Service Request

Input Wizard was launched from the Devices tab of the Account Master Main-

tenance window.

l Click the Request Code field label to select a service request code from a list.

This will open the Service Request Code Selection window.

l Select a remove device type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to
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display the Maintenance section of the window. The Maintenance section will

display all of the information associated with the highlighted service request

code.

l A Remove Device service request code will have Remove Device selec-

ted in the Service Type drop-down menu.

l Service request codes are set up on the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code).

l If there is a default device type attached to the selected service request

code, that device will automatically be selected if it is attached to the

customer account. For example, if a specific water meter device type is

attached to the service request code, that device water meter will be

selected if it is attached to the customer account. This allows you to

reduce data entry if a service request code is generally performed on a

certain device type.

l The service Request Date field is used to enter the date the service was requested.

This field will default to the current date because the request date is also generally

the date the service request is being entered.

l If you print door hangers (UB> Service Requests> Door Hangers), the service

requests that display on the report will be filtered by the date entered in the

Request Date field.

l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.
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l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field, or change the amount to

zero to eliminate the charge on the service.

l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Cash Receipts> Bill Service Requests), the zero

amount service request will still display in the Bill Service Requests win-

dow but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code

attached to it (UB> Maintenance> Service Request Code> Fee Code
field).

l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service

Requests window (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The devices selected on the Remove Device service request

will not be removed from the customer account until the service request has been

closed and committed.

l Change the status of the service request to Cancel if the service request has

been canceled.

l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).
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l Changing the status of the service request to Closed will populate the

Close Date field with the current date.

l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service

Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete if the status

of the service request is Closed.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.

l The Service Date is the date that the service will be performed on the customer

account. This field will populate with the current date plus one.

l The service date will be used as the install date of the device when the new

device is installed on the customer account.

l The Close Date is the date that the service request is changed to a Close status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.

l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).

l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.
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l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. For example, the field might read Remove the water

meter on the account. The Service Request Description field will populate with the

description of the service request code, but you can add to or modify the text in the

field.

l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>
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Description field).

l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request.

l The service performed description will display in the Service Description field

on the printed version of the service request (UB> Service Request> Service

Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER to move to the next step.

3     Select the device that will be removed from the account. 

l Check the Selected toggle of each device you would like to remove from the

account.

l You can remove as many devices from the customer account at one time on a

single service request.

l The Device ID column will display the meter route, sequence number and

serial number of the meter in the following format: route, sequence and serial.
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l You cannot use the Delete Device button to remove devices installed on the

account. The Delete Device button is only used when creating an add device

service request.

l If you do not select a device in the window, a device will not be attached to the ser-

vice request. The only information that will be attached to the service request is the

customer information.

l Click the Next button or press ENTER to move to the next step.

4     Enter a reading for each device that is being removed from the account. 

l Enter a meter reading on the devices that will be removed from the account. A sep-

arate window will open for each device that will be removed from the account.

l The Read Date field will default to the current date. Modify this value if it does not

apply.

l The Read Period and Read Year fields are used to enter the meter read period and

year of the meter reading.

l If you generate billings by meter read period (UB> Utilities> Setup> Billing

tab> Meter Reads To Bill field> Period), make sure to enter a meter read

period that has not been billed. If the meter read period entered in these fields

has already been billed, the consumption entered in the Consumption field

will never be included in the next billing.

l The Prior Reading field will display the last reading recorded on the meter. If the

meter was installed on a previous account, the final reading on that account will dis-

play in this field.
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l Enter the final meter reading on the device in the Reading field. The Consumption

field will display the consumption amount based on the values in the Prior Reading

and Reading fields.

l Click the Next button or press ENTER when complete to move to the next step.

5     Complete the Service Request Input Wizard. 

l The Final Account Information step will display after the meter reads have been

entered on the devices being removed from the account.

l The fields in the Final Account Information step will only be enabled if you are cre-

ating a final account service request.

l Click the Finish button or press ENTER to complete the wizard.

l The service request has been completed. Change the status of the service request

to Closed when the service is complete, and then commit the service request to

remove the device from the customer account.

l Once the service request is committed (UB> Service Requests> Commit), the

device will be removed from the customer account. If the service request code is set

up as an auto-commit service request (UB> Maintenance> Service Request Code>

Auto Commit toggle), the service request will be committed as soon as it is

changed to a closed status.

l You will still be able to view the device from the Account Master Maintenance

window (UB> Maintenance> Account> Devices tab), but the device will have a

Removed connection status.
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l The Inventory Status of the removed device will change to Testing (UB> Main-

tenance> Device> Device tab> Device section> Inventory Status drop-

down). Devices with a Testing inventory status can still be attached to cus-

tomer accounts using an Add Device service request code.
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UB> Service Requests> Input

Final Account Service Request

Summary

Final Account service requests are used to input a final read on a device, enter the for-

warding address on the account and add the customer account to the Final Accounts win-

dow on the Final Billing palette. Once a UB customer account displays in the Final

Accounts window (UB> Final Billing> Final Accounts), the account can be processed in the

Final Account Wizard. This is an optional service request because you can run the Final

Account Wizard on a UB customer account from the Account Master Search window (UB>

Maintenance> Account> Delete icon) without processing a final account service request on

the account.

All service requests are created using the Service Request Input Wizard. The Service

Request Input Wizard can be launched from the Service Requests tab on the Account

Master Maintenance window (UB> Maintenance> Account> Service Requests tab), the

Devices tab of the Account Master Maintenance window (Create , Delete or Change

Out icon ), and from the service request Input window (UB> Service Requests> Input>

Create icon).
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A final account service request is created using a Final Account service request code. Ser-

vice request codes are created and maintained using the Service Request Code Main-

tenance window (UB> Maintenance> Service Request Code). A service request code is set

up as a final account service request by selecting Final Account in the Service Type drop-
down menu on the Service Request Code Maintenance window.

After the service request has been created, the final step of the Service Request Input Wiz-

ard allows you to print a copy of the service request (Print Request on Save toggle). The
printed version of the service request can be handed to a service technician to give them a

record of the service address, the customer information and the work that should be com-

pleted on the customer account. You can also print out multiple service requests at one

time using the Service Requests Report (UB> Service Requests> Service Requests). The

Service Requests Report allows you to print multiple service requests by criteria such as

service date.

The meter readings added to the service request will not post to the UB customer account

until the service request code is committed (closed service requests can be committed in

UB> Service Requests> Commit). Once the final account service request has been com-

mitted, the customer account will also display in the Final Accounts window (UB> Final

Billing> Final Accounts).

Step by Step

1     Open the Service Request Input wizard (UB> Service Requests> Input> Create icon ). 
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l You can also create a service request from the customer account maintenance win-

dow (UB> Maintenance> Account> Service Requests tab> Create icon ).

2     Enter the customer and service request information. 

l The Request Number field will only display a service request number if you are

opening an existing service request. This field will not be enabled.

l The service request number is comprised of three parts: request number,

request month and request year and is similar to the batch numbering system.

The request number increments with each service request generated and

identifies a unique service request within a specific request month and

request year. The request month and request year portions of the service

request number will populate with the month and year the service request was

generated. Changing the request date on the service request will not affect

the service request number assigned to the service request.

l Enter a customer number and sequence number in the Account Number field or

click the field label to select a customer account from a list.

l If you have launched the Service Request Input Wizard from the Account

Master Maintenance window (UB> Maintenance> Account> Service

Requests tab> Create icon ), the Account Number and Service Address

fields will populate with the information of the customer account the wizard

was launched from.
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l The Service Address field is used to select the service address of the service

request. If you have already selected a UB customer account in the Account Num-

ber field, the lot attached to the selected UB customer account will populate in the

Service Address field.

l The Request Code field is used to select the service request code that will be used

to create the service request.

l Click the Request Code field label to select a service request code from a list.

This will open the Service Request Code Selection window.

l Select a Final Account type service request code.

l If you would like to view the information attached to the service request codes,

hover the mouse over the right border of the Service Request Code Selection

window. When the border becomes highlighted, left click on the border to dis-

play the Maintenance section of the window. The Maintenance section will dis-

play all of the information associated with the highlighted service request

code.

l A final account service request code will have Final Account selected in

the Service Type drop-down menu.

l Service request codes are set up in UB> Maintenance> Service Request

Code.

l The Request Date field is used to enter the date the service was requested. This

field will default to the current date because the request date is also generally the

date the service request is being entered.

l When the UB customer account is finaled using the Final Account Wizard

(UB> Final Billing> Final Accounts), the Final Date on the account will default

to the value entered in this field.
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l The Charge field is used to set the billable amount on billable service requests (ser-

vice requests that result in a billable charge). The Charge field will populate with a

value if the service request code selected in the Request Code field is set up as a

billable service request.

l The Charge field will default to the flat amount attached to the fee code on the

service request code. Modify the amount in this field or change the amount to

zero to eliminate the charge on the service.

l If you change the Charge field to zero, the charge on the service

request will be zeroed out. When charges are generated on billable ser-

vice requests (UB> Cash Receipts> Bill Service Requests), the zero

amount service request will still display in the Bill Service Requests win-

dow but no charges will be generated on the account.

l A service request code is set up as billable if there is a fee code attached to it

(UB> Maintenance> Service Request Code> Fee Code field).

l The billable service request will not generate a charge on the customer

account until the service request is processed in the Bill Service Requests win-

dow (UB> Adjustments and Fees> Bill Service Requests).

l The Status field is used to define the status of the service request. The Status field

will default to Active. The device being installed on the customer account will dis-

play on the Devices tab of the UB customer account even when the service request

has an Active status (UB> Maintenance> Account> Devices tab). The device will not

be installed on the customer account until the service request has been closed and

committed.

l Change the status of the service request to Cancel if the service request has

been canceled.

FINAL ACCOUNT SERVICE REQUEST 816



l Canceled service requests can still be edited and reported on.

l Change the status of the service request to Closed if the service has already

been performed and you would like to be able to commit the service request.

Only closed service requests can be committed (UB> Service Requests>

Commit).

l Changing the status of the service request to Closed will populate the

Close Date field with the current date.

l If the service request code selected in the Request Code field is set up

as an auto-commit service request code (UB> Maintenance> Service

Request Code> Auto-Commit toggle), the service request will be com-

mitted when the Service Request Input Wizard is complete.

l Change the status of the service request to Void if the service request was

mistakenly created.

l Voided service requests can still be edited and reported on.

l The Service Date is the date that the service will be performed on the customer

account. This field will populate with the current date plus one.

l The Close Date is the date that the service request is changed to a Close status.

This field will populate with the current date when the status of the service request

code is changed to Closed.

l The User Name field defaults to the Springbrook application user account you are

logged in with.

l TheWO Number field will only display a work order number if the Service Request

Wizard is launched from the Work Order Maintenance window (WO> Work Orders>

Work Orders> Service Requests tab> UB Service Request icon ).
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l If the Request Code selected above is associated with a recurring estimate, a

work order will be generated when the Service Request Wizard is completed.

l Once the service request is generated, the WO Number field will display

the work order generated by the attached recurring estimate.

l By associating a service request with a recurring estimate, you can auto-

matically create a new work order to address the needs of the service

request. For example, your organization may need to create a work order to

dispatch a technician every time a water meter needs to be changed. In order

to automate the work order creation, you would follow these steps:

l Create a recurring estimate that includes the labor, equipment, material

and service expenses that are associated with the meter changeout.

Recurring estimates are created and maintained on the Recurring

Estimate Maintenance window (WO> Recurring Estimates> Recurring

Estimates).

l Attach that recurring estimate to the Service Request Code that iden-

tifies the service request as a meter changeout.

l When this service request is created and committed using that service

request code, a new work order will be automatically created to dis-

patch the technician.

l The Assigned To field is used to assign a Springbrook user to the service request.

l The Service Request Description field is used to enter a description of the type

service that will be performed. For example, Final an Account. The Service Request

Description field will populate with the description of the service request code, but

you can add to or modify the text in the field.
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l The Description of the service request code is set up on the Service Request

Code Maintenance window (UB> Maintenance> Service Request Code>

Description field).

l The service request description will display on the printed version of the ser-

vice request in the Request Description field (UB> Service Request> Ser-

vice Requests).

l The Service Performed Description field is used to enter notes on the work that

was completed on the service request. For example, a Service Performed Descrip-

tion note might read The meter reading has been estimated because a car was

parked in front of the meter.

l The service performed description will display in the Service Description field

on the printed version of the service request (UB> Service Request> Service

Requests).

l Click the Save button drop-down menu and select Save and Close or Save and

Print at any stage of the Service Request Wizard to save the service request.

l Click the Next button or press ENTER to continue.

3     Select the devices you would like to enter a final meter reading on. 

l You do not have to select a device if you do not want to enter final meter readings

on the UB customer account. The UB customer account will still display in the Final

Accounts window when the service request is committed.

l Check the Select toggle of each device you would like to enter a meter reading on.
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l Select as many devices as you would like. You can enter a meter reading on

multiple meters on a single service request.

l The Device ID column will display the meter route, sequence number and

serial number of the meter in the following format: route, sequence and serial.

l If you do not select a device in the window, a device will not be added to the service

request. The only information that will be attached to the service request is the cus-

tomer information.

l Click the Next button or press ENTER to continue.

4     Enter the final meter readings. 

l Enter a meter reading on the devices that will be removed from the account. A sep-

arate window will open for each device that will be removed from the account.

l The Reading Description field is used to enter a description of the meter reading.

This field will display on the Meter History sub-tab for each reading on the Devices

tab of the Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Meter History sub-tab> Description column).

l This is an optional field.

l The Reader Information field is used to enter information about the meter. This

information is entered on the meter, not the meter reading.

l This is an optional field.

l The Read Date field is the read date of the meter reading entered into the Reading

field. This field will default to the Read Date field.
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l The Read Period/Year fields are used to enter the meter read period and meter

read year of the meter reading entered in the Reading field. If you bill readings by

period (UB> Utilities> Setup> Billing tab> Meter Reads To Bill field> Period), make

sure to enter a meter read period that has not been billed.

l The Prior Reading field will display the last reading recorded on the meter.

l If the device you are adding to the account is a meter, enter an initial meter reading

in the Reading field.

l The Consumption field will calculate the consumption amount based on the new

reading and the prior reading on the meter.

l Click the Next button or press ENTER to continue.

5     Enter the forwarding address on the account. 

l The final step of the Service Request Input Wizard is used to enter the forwarding

address on the account. The forwarding address will replace the address on the cus-

tomer account.

l Click the Finish button or press ENTER when complete.

l The service request has been completed.

l The final meter readings entered on the service request will not display on the

Devices tab of the UB customer account (UB> Maintenance> Account> Devices

tab) until the service request has been closed and committed.

l The service request can be closed by manually changing the service request

to a closed status using the Service Request Input Wizard or by clicking the
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Close icon on the Service Requests window (UB> Service Requests>

Input> Close icon). The close date of service requests closed using the Close

icon on the Service Request window will be the current date.

l Service requests are committed in UB> Service Requests> Commit. Only

closed service requests can be committed.

l The UB customer account will display in the Final Accounts window (UB> Final

Billing> Final Accounts) once the final account service request has been completed.

FINAL ACCOUNT SERVICE REQUEST 822



UB> Transfers

Process Transfers in UB

Summary

The Generate Transfers process allows you to transfer an account or deposit balance of a

customer account to the account balance or deposit balance of another customer account.

If you want to transfer the deposit balance of a customer account to the account balance of

the same account, you will have to use the UB Refund process.

The Generate Transfers process allows you to process transfers on either multiple cus-

tomer accounts or on a single customer account. If you process multiple transfers in a

single batch, you can filter the customer accounts that you would like to transfer balances

from by Final Date, Deposit Date and Customer Account Status. When processing trans-

fers on multiple customer accounts you can also set up defaults for how the account and

deposit balances will be transferred from the customer accounts pulled into the batch. This

reduces the amount of data entry when processing transfers on many accounts.

When creating transfers, you can attach a special charge code to the transfer to determine

if the revenue or cash GL accounts attached to the service rates or special charge codes

involved in the transfer will be used.
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If you are transferring an account balance or deposit balance to the deposit balance of

another customer account you will need to attach a deposit type special charge code to the

transfer. This special charge code will be used to create the deposit amount in the Transfer

To account.

Follow this process to transfer the credit balances between accounts rather than process

refund checks.

Step by Step

1     Create a Transfers batch. 

l Select the Transfers palette in UB> Transfers. This will expand the Transfers palette

and display the steps of the batch process.

l Modify an existing batch or create a new Transfers batch.

l Select a batch number from the drop-down menu at the top of the Transfers

palette to select an existing batch.

l Select New from the Transfers batch number drop-down menu to create a

new batch. This will open the New Batch window.

l The Batch Month and Batch Year of the Transfers batch is used for ref-

erence only and is not necessarily the fiscal month and year the trans-

actions in the batch will be posted to.

l Click the Save icon to save the batch.
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2     Enter the Transfer batch settings. 

l Open the Generate/Transfers window (UB> Transfers> Generate).

l If you are processing transfers on multiple customer accounts at once, select Mul-

tiple Accounts from the Setup drop-down menu and complete the Settings sec-

tion. The filters in this section are used to select which customer accounts you

would like to transfer balances from.

l The Account Status field will only be active if Multiple Accounts is selected.

l Select the account statuses of the customer accounts you would like to trans-

fer balances from in the Account Status field.

l Unlike the Refunds process, you can process transfers on customer

accounts with a Final account status.

l The Tran Date field specifies the transaction date that will be recorded
in the general ledger for the transfer. The Tran Date will default to

today's date.

l This is only the transaction date of the transfers. The post date of

the transactions will be set when the batch is committed and the

journal entry date is entered on the GL Distribution step.

l The Final Date From and Final Date To fields will only be used as fil-
ters if you check the Final toggle in the Account Status section. This will
filter the customer accounts pulled into the batch by final date.

l You can view the final date of a customer account in the Account

Maintenance window (UB> Maintenance> Account> Account tab>

Account Activity Dates section> Final field).
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l The Deposit Date From and Deposit Date To fields allow you to filter

the customer accounts pulled into the batch by the transaction date

attached to the deposit on the customer account.

l You can view the transaction date of a deposit transaction using

the History tab of the Account Master Maintenance window (UB>

Maintenance> Account> History tab> Select Deposit History in

the drop-down menu at the top of the window> Expand a trans-

action> Transaction Date field).

l The Cash Adjustment Type drop-down menu is used to select the
adjustment type that will be used to make cash type adjustments.

l In order for an adjustment type to display in this drop-down menu,

the adjustment type must be attached to a fee code that is set up

to be used in the transfers process, and the adjustment type must

be set up as a cash type adjustment code.

l Fee codes are set up to be used in the transfers process on

the Fee Code Maintenance window (UB> Maintenance>

Fee Code> Used in transfers toggle).

l Fee codes are attached to adjustment types using the

Adjustment Type Maintenance window (UB> Maintenance>

Adjustment Type> Fee Code fields).

l Adjustment codes are set up as cash type adjustments

using the Adjustment Code Maintenance window (UB> Main-

tenance> Adjustment Type> GL Type drop-down menu).

l The Bill Adjustment Type drop-down menu is used to select the
adjustment type that will be used to make bill type adjustments.

PROCESS TRANSFERS IN UB 826



l In order for an adjustment type to display in this drop-down menu,

the adjustment type must be attached to a fee code that is set up

to be used in the transfers process, and the adjustment type must

be set up as a bill type adjustment code.

3     Enter the default settings. 

l Once you have entered the filters in the Settings section, use the Defaults section

to select how you would like to process the transfers on the customer accounts that

will be pulled into the batch. The selections in these fields only determine the default

values. You will be able to manually change these values on each customer

account included in the batch using the Select/Update step (UB> Transfers>

Select/Update).

l Select how you would like to transfer the account balance of the Transfer

From account in the Balances drop-down menu.

l If you select Default all to Zero, the transfer amount will default to zero

and you will have to manually enter the amount to be transferred out of

the account.

l If you select Default as transfer to balance, the entire account bal-

ance will be transferred to the account balance of the account it is being

transferred to.

l If you select Default as transfer to deposit, the entire account bal-

ance will be transferred to the deposit balance of the account it is being

transferred to.
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l The selection in this field is only a default value. If the selection does

not apply to all of the customer accounts in the batch, you will be able to

change how the balances are transferred using the Select/Update step

(UB> Transfers> Select/Update).

l Select how you would like to transfer the deposit balance in the Depos-
its drop-down menu.

l If you select Default all to Zero, the transfer amount will default
to zero and you will have to manually enter the amount to be trans-

ferred out of the deposit balance.

l If you select Default as transfer to balance, the entire deposit
balance will be transferred to the account balance of the account

it is being transferred to.

l If you select Default as transfer to deposit, the entire deposit
balance will be transferred to the deposit balance of the account it

is being transferred to.

l The selection in this field is only a default value. If the selection

does not apply to all of the customer accounts in the batch, you

will be able to change how the balances are transferred using the

Select/Update step (UB> Transfers> Select/Update).

l The Account drop-down menu is used to select the default account
where the balances will be transferred to. This is only the default value

that will be applied to all of the accounts in the batch. You will be able to

manually select the customer accounts the amounts will be transferred

to using the Select/Update step (UB> Transfers> Select/Update).
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l Select Active account on lot if the amounts should be trans-
ferred to the customer account that is currently active on the lot.

l You can view the current active account on a lot using the

Account Master Maintenance window (UB> Maintenance>

Account> Lot tab).

l The Lot Maintenance window only displays the owner on the

lot. The owner of a lot is not necessarily the active customer

on the lot. For example, a customer could be renting the lot

from the owner.

l Select Do not default if you would like to manually enter the cus-
tomer account number on each transfer on the Select/Update step

(UB> Transfers> Select/Update).

l Select Master Account if you would like the transfer to account to
be the master account attached to each lot. You can set up a mas-

ter account on a lot using the Lot Maintenance window.

l If you are transferring balances to a deposit balance you can select a

special charge code in the Fee Code drop-down menu.

l Check the Use Original Deposit Date toggle to use the original
deposit date as the process date rather than the currently selected

transaction date.

4     Add accounts to the transfers batch. 
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l The Accounts section of Generate/Transfers window is used to manually add

accounts to the batch. Each account that has been added to the batch will be dis-

played in this section.

l Click the Create icon to add additional accounts to the window.

l Click the Confirm icon to generate the transfers.

5     Complete the Exceptions step. 

l Open the Exceptions window (UB> Transfers> Exceptions).

l The Exceptions window will display any exceptions that resulted from the batch gen-

erate step.

l If the generate step did not produce any exceptions, an information window will

appear.

6     Complete the Select/Update step. 

l Open the Select Update/Transfers window (UB> Transfers> Select/Update).

l The Select Update/Transfers window will display all the accounts that fit the search

criteria specified in the Generate step.
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l Check the Selected toggle for each account that you would like to include in the

transfers batch. You can also click the Select All or Deselect All icons to select or

deselect all of the accounts displayed.

7     Print the Transfers Proof List report. 

l Open the Transfers Proof List window (UB> Transfers> Proof List).

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the Proof List for accuracy.

8     Print the GL Distribution report. 
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l Open the UB GL Distribution report window (UB> Transfers> GL Distribution).

l The GL Distribution report will display the journal entry created by the Transfers pro-

cess.

l Enter the Journal Entry date. This date will determine the fiscal period and fiscal

year the journal entry is posted to. The Journal Entry date will default to today.

l The Fiscal Period and Fiscal Year fields will automatically adjust to reflect the

selected Journal Entry date.

l Select a Report Type from the drop-down menu.

l The Summary Report will only display the net effect on the general ledger

accounts. If transaction line items create a wash on a general ledger account,

that general ledger account will not display on the report. The summary report

will display the general ledger account number, general ledger account

description, debit amount and credit amount. The report will be grouped and

totaled by fund and will also display a report total on the debit and credit

columns.

l The Detail Report will display every line item of the transaction, not just the

net effect. The detail report will display the account number, customer num-

ber, utility billing service number, special charge code, general ledger account

description, debit amount and credit amount.

l The Summary Report debit and credit report total amounts may not balance

between the summary by GL account report and the summary by transaction

type report because the summary report only displays the net effect on the

general ledger account in a grouping. Since the two summary reports group

the general ledger accounts differently, certain transactions may not wash in
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both reports. The detail report credit and debit report total amounts will always

balance between the two reports.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Review the Journal Entry and GL accounts used in the transaction for accuracy.

9     Commit the Transfers batch.

10     Review the customer accounts used in the transfers. 
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l Open the customer accounts that were used in the transfers in the Account Main-

tenance window (UB> Maintenance> Account).

l The Description column of the History tab will display the type of transfer trans-

action.
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UB> Utilities> Utility Billing Setup

Utility Billing Module Setup

Summary

The Setup window in the Utility Billing module is used to define how the module will func-

tion. A trainer will establish many of these settings when the application is installed, and

you may want to set up either menu security or database security on this window. Menu

security (SS> Security> Menu Security) will restrict access to the window and database

security (SS> Security> DB Security) will restrict access to specific fields on the window.

Step by Step

1     Open the Setup window (UB> Utilities> Utility Billing Setup).

2     Complete the General tab. 

l The General tab is used to set up general information Utility Billing module.

l Check the CH Interface toggle if you would like the CH module to interface with the

UB module.
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l Interfacing the CH module with the UB module allows you to create ACH trans-

actions in the CH module that will debit the bank accounts of UB customer

accounts.

l Bank account information is entered onto UB customer accounts and the ACH

transactions are created in a CH module Direct Debit batch from committed

UB New Billing or Final Billing batches.

l Check the Charge for Deposit toggle if your organization charges deposits.

l If this toggle is checked, the final and new billing statements will display the

payment and billing transactions that create a deposit on the account.

l Check the Validate SSN (Social Security Number) toggle if you would like only

unique social security numbers to be entered when creating new accounts using the

New Account Wizard. Social Security numbers modified from the People tab of the

Account Master Maintenance window (UB> Maintenance> Account) will not be val-

idated when they are modified. If there are existing customer accounts with duplic-

ate social security numbers, checking the Validate SSN toggle will not locate or

affect those UB customer accounts.

l When this toggle is checked, you will also be required to enter a social secur-

ity number when creating a new customer record in the New Account Wizard

(UB> Maintenance> Account> Create icon).

l If you have set up security on the social security field using the DB Security

feature (SS> Maintenance> DB Security), you may not want to check this

toggle. Users with no access to the Social Security Number field will not be

able to create new customer records because they will not have access the

Social Security field.
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l Check the Validate DLN (Driver’s License Number) toggle if you would like only

unique driver's license numbers to be entered when creating new accounts using

the New Account Wizard. Driver's License numbers modified from the People tab of

the Account Master Maintenance window (UB> Maintenance> Account) will not be

validated when they are modified. If there are existing customer accounts with

duplicate social security numbers, checking the Validate DLN toggle will not locate

or affect those UB customer accounts.

l When this toggle is checked, you will also be required to enter a driver’s

license number when creating a new customer record in the New Account Wiz-

ard (UB> Maintenance> Account> Create icon).

l If you have set up security on the driver’s license field using the DB Security

feature (SS> Maintenance> DB Security), you may not want to check this

toggle. Users with no access to the Driver’s License field will not be able to

create new customer records because they will not have access the Social

Security field.

l Check the Allow Finals to Use Winter Average toggle if you would like to bill UB

customer accounts using a calculated winter average. This only applies to accounts

finaled during a winter average billing period and processed in a Winter Average

batch.

l If this toggle is not checked, the customer accounts will be billed using the

actual consumption even if the account is being finaled during a winter aver-

age period.

l Check the Automatically Fail Payment Plans Daily toggle to direct the system to

roll through all active payment plans every night and automatically change the pay-

ment plan status to FAIL if the account holder has not met the payment plan require-

ments.
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l The Reference Format field is used to set the format of the reference field. The ref-

erence field is mainly for organizations that have imported data from another Utility

Billing software and want to search UB Accounts by the previous customer account

numbers that have been imported into the Reference field in UB> Maintenance>

Account> Account tab.

l Enter an “X” for each character to be included in the format and enter dashes ( 

- ) or other characters ( _ . ) as separations between characters in order to

match the format of the reference fields or customer numbers of the previous

software.

l When searching for Utility Billing accounts by reference number in UB> Main-

tenance> Account> Search By drop-down menu> select “Reference num-

ber”, the format will be applied to the Reference Number field.

l The reference format field will affect the format of reference numbers entered

on the Account tab of the account maintenance window (UB> Maintenance>

Account).

l The Apply Deposit Adjustment Type field is used to select the deposit adjustment

type code you would like to apply to deposits.

l The Deposit Adjustment Type are generally set up as a Cash type adjustment

type code (UB> Maintenance> Adjustment Code> Open the Deposit Adjust-

ment Type> GL Type drop-down> Cash).

l The Check Refund Adjustment Type field is used to select the adjustment type

code that will be used on all adjustment transactions created in the Refunds pro-

cess. The selection in this field will affect the journal entry created by the Refunds

process.
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l The Collections Adjustment Type field is used to select the adjustment type code

that will be used on all adjustment transactions created in the Collections process.

The selection in this field will affect which GL accounts will be used in the journal

entry created by the Collections process.

l The Aging Periods field is used to specify the aging period option for UB Aging

report and Past Due calculations.

l The default 30-60-90-120 option follows the standard aging format when cal-

culating the age of balance forward values on UB accounts.

l The Days in Period option uses the specified days in period on the first

account included when calculating the age of balance forward values on UB

accounts. This option allows organizations to maintain an accurate aging

report when using non-standard billing periods.

l Check the Copy All Services toggle if you would like the New Account Wizard to

copy the services attached to the previous account to the new account on the lot.

This will only copy the services on the account. The service rates attached to the

services will not be copied to the new account.

l All of the services attached to the previous account on the lot will be copied to

the new account, including services that are not attached to service rates. If

you only want the services attached to service rates to be copied onto the new

account, check the Copy Service Codes toggle and do not check the Copy All

Services toggle. This will copy the services and service rates attached to the

previous account to the new account, but will not include the services that are

not attached to a service rate.

l The Copy Service Codes, Copy All Services, Copy Special Multipliers and Re-

Use Reference Numbers toggles determine the information that will be copied

from the previous customer account on a lot to the new customer account when it is
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created using the New Account Wizard. If you are using Account Templates (UB>

Maintenance> Account Templates), the information on the template will populate on

the new account as well as the information copied from the previous account. For

example, if you have the Copy Service Codes toggle checked, the services and ser-

vice rates on the template will be copied to the new account as well as the service

and service rates on the template. The Services step on the New Account Wizard

allows you to add or remove any of the services or service rates that have been

added to the customer account (both copied services/service rates and ser-

vice/service rates on the template).

l Check the Copy Service Codes toggle if you would like the New Account Wizard or

Final Account Wizard to copy the service and service rate codes attached to an

account to a new account on a lot. All services that are attached to a service rate

and all service rates from the previous account will be copied to the new account on

the lot.

l If the Copy Service Codes toggle is checked, but the Copy All Services

toggle is not, only services that are attached to service rates will be copied

onto the new account on the lot.

l Check the Copy Service Codes toggle and the Copy All Services toggle if you

would like all services and service rates attached to the previous account to copy to

the new account on the lot. By checking both toggles rather than only the Copy Ser-

vice Codes toggle, services that are not attached to a service rate will be copied

onto the new account.

l Check the Copy Winter Averages toggle if you want the effective winter average

attached to a meter to copy onto a new meter when a change-out service request is

processed.
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l When the change-out service request is created, the winter average cal-

culation on the changed meter will be copied onto the new meter. The copied

winter average will not be committed, so you can open the Winter Average tab

on the Account Master Maintenance window (UB> Maintenance> Account>

Winter Average) and modify the winter average calculation on the meter.

When the change-out service request is committed (UB> Service Request>

Commit), the winter average line item will also be committed.

l Checking this toggle will not copy the winter average from a finaled account to

the new account on a lot.

l Check the Copy Special Multipliers toggle if you would like the special multiplier

attached to a previous account to copy to the new account on the lot.

l A special multiplier is added to a customer account on the Service Rates tab

of the Account Master Maintenance window (UB> Maintenance> Account>

Service Rates tab> Expand a service> Special Multiplier column).

l The service rate must also be set up to use special multipliers by checking the

Use special multiplier toggle on the Service Rate Maintenance window (UB>

Maintenance> Service Rate> General tab). This toggle allows you to control

the application of the special multipliers at the service rate level.

l Check the Re-Use Reference Numbers toggle if you would like the reference num-

ber of the previous account on a lot to be copied onto a new account when it is cre-

ated using the New Account Wizard.

l Reference numbers entered on UB customer accounts in the Account Master

Maintenance window (UB> Maintenance> Accounts> Account tab> Account

sub-tab> Reference Number field).
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3     Complete the Billing tab. 

l The Consumption Rounding,% of Period Rounding,% of Period Precision

and Round Service Precision fields are used to set up how generated billings will

round. You can also set up rounding options on specific service rates using the Ser-

vice Rate Maintenance window (UB> Maintenance> Service Rate> General tab>

Round Amount to field).

l Select what method you would like to use when rounding consumption to a whole

number in the Consumption Rounding drop-down menu. This field will only affect

how accounts are billed when the Unit Size specified on the Service Rate is some-

thing other than 1 or 0.

l Select None if you do not want to use any consumption rounding.

l Select Off to round consumption up if the consumption decimal amount is 0.5

or greater and down if the decimal amount is less than 0.5.

l Select Up to always round the consumption decimal amount up to the next

whole number.

l Select Down to always round the consumption decimal amount down to the

next whole number.

l For example, if a rate has a unit size of 100, and the consumption for

the period is 155, the system will calculate 155/100 to arrive at a billing

consumption of 1.55 units. If None is selected, the customer will be

billed at 1.55 units. If Off is selected, 2.00 units are billed. If Up is selec-

ted, 2.00 units are billed as well. And if Down is selected, 1.00 units are

billed.
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l Select how you would like to round billing periods in the% of Period Rounding

drop-down menu. The selected rounding method will be used to round the % of

Period to the decimal point entered in the% of Period Precision field.

l Select Normal to round the % of period up or down using the value in the % of

period precision.

l Select Up to round the consumption decimal amount up to the next whole

number.

l Select Down to round the consumption decimal amount down to the next

whole number.

l The% of Period Precision field is used to set the precision used when rounding

the % of Period.

l The Round Service Precision field is used to round the charges on each service

on a billing. The rounding will be applied to all of the service rates in each service.

For example, if the service rates in a service calculate the billing of a service to be

$79.19, the Round Service Precision field can be used to round the billing on the ser-

vice to $79.00, $79.20, or $70.19. All of the service rates in that service will be roun-

ded as well.

l Enter a 1.00 in the field to round the service to the nearest whole dollar

amount.

l You can also set up a rounding precision on the service rates using the Ser-

vice Rate Maintenance window (UB> Maintenance> Service Rates).

l The Exempt Meters Default drop-down menu is used to set up how you would like

devices attached to a meter to affect a billing.

l Select whether you want to subtract or add exempt meter consumption to bil-

lable consumption when a billing is calculated. This is only a default setting
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and can be overridden at the device level.

l The Meter Reads to Bill drop-down menu is used to select how meter readings will

bill.

l Select Period from the drop-down menu to bill only the meter reads with a

read period that is the same as the billing period of the billing being gen-

erated.

l When a New Billing is generated in UB> New Billing, a billing period is

entered on the batch during the Generate step (UB> New Billing> Gen-

erate> Billing Period field). Meter readings with a read period that is

the same as billing period will be included in the New Billing batch. You

can view the read period of a meter reading from the Devices tab of the

Account Master Maintenance window (UB> Maintenance> Account>

Devices tab> Select a meter> Reading Period /Reading Year

column). A meter read period is not the same as the meter read date.

The meter read period is entered separately when a meter reading is

entered, and the meter read month is not necessarily the same as the

meter read period.

l The meter read period is entered in the Read Period field when meter

reads are imported (UB> Meter Management> Readings Import).

l When meter reads are entered manually, the reading period is entered

into the Reading Period field in UB> Meter Management> Input New.

l Select Unbilled from the drop-down menu to bill consumption on unbilled

meter readings regardless of which meter read period they are assigned. For

example, if a UB customer account has an unbilled meter reading in meter
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read period 04 and 05, when a New Billing is generated for billing period 05,

the unbilled meter reading or period 04 will be included in the billing.

l The Prorate Accounts Over 100% drop-down menu is used to control when the %

of period will bill greater than 100%.

l Select Only When New in the drop-down menu if you want to allow only new

accounts to have billing periods greater than 100%.

l The Comparison Method drop-down menu is used to set up a comparison vari-

ance alert on new billings. When enabled, this feature will alert you during the New

Billing Preview step when an account is being billed an amount that exceeds the

specified variance. These alerts are informational only and will not interrupt the New

Billing process.

l Select Do Not Calculate to turn off the comparison functionality.

l Select Average Previous Months to use the average bill of a specified number

of previous months as the variance base value.

l This will enable the Months for Average and Variance Alert Percent

fields.

l The Months for Average field is used to specify how many previous

months will be used to calculate the variance base value. This number

cannot exceed 12.

l The Variance Alert Percent field is used to specify what variance per-

centage should trigger the alert. For example, if the average variance

value is $100, and the Variance Alert Percent is set to 30%, any new

billing amount greater than $130 would trigger the alert.

l Select Same Month Last Year to use the same month of the prior year as the

variance base value.
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l This will enable the Variance Alert Percent field below. Use this field to

specify what variance percentage should trigger the alert. For example,

the account was billed $120 for the same month during the prior year,

and the Variance Alert Percent is set to 25%, any new billing amount

greater than $150 would trigger the alert.

l Check the Prorate 50% / 50% toggle to prorate rates to 50% if the percent of the

period is between 0% and 100%. If the percent of the period does not fall between

zero and one hundred percent, then zero or one hundred percent of the rates will be

billed.

l Check the Use Constant Days in Period toggle to use the number of days in the

period set up on the Billing Cycle Maintenance window (UB> Maintenance> Cycle

Code) when prorating final bills.

l Check the Credit Negative Consumption toggle if you would like negative con-

sumption amounts to create a negative amount on a billing. Meter readings cannot

be entered as a negative value, but if the current reading is less than the previous

reading, the current consumption on the meter is a negative amount.

l If the Credit Negative Consumption toggle is not checked, the negative con-

sumption is not applied to the billing as a negative amount. Billings will only be

generated on positive consumption.

l When calculating negative consumption, the billing engine will include pre-

vious revisions on the service rates. For example, if a service rate was just

increased, the billing engine will calculate the negative consumption using the

rates on the previous service rates.

l The Bill When Consumption is Zero toggle does not have to be checked in

order to use this feature.
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l The Multiply Consumption by Special Multiplier and Multiply Flat by Special

Multiplier toggles will only work if the Use special multiplier toggle is checked on

the Service Rate Maintenance window (UB> Maintenance> Service Rate> General

tab).

l If you would like the special multiplier set up on a customer account to affect a

billing, you must first check the Use special multiplier toggle on the service

rate, then check the Multiply Consumption by Special Multiplier and/or the

Multiply Flat by Special Multiplier toggle on the Setup window.

l A special multiplier is attached to a customer account using the Account

Master Maintenance window (UB> Maintenance> Account> Service Rates

tab> Special Multiplier field).

l Service rates are created and maintained using the Service Rate Main-

tenance window (UB> Maintenance> Service Rates> General tab> Use spe-

cial multiplier toggle).

l Check the Multiply Consumption by Special Multiplier toggle to multiply con-

sumption by a special multiplier specified on each account.

l A special multiplier is added to a customer account on the Service Rates tab

of the Account Master Maintenance window (UB> Maintenance> Account>

Service Rates tab> Expand a service> Special Multiplier column).

l The service rate must also be set up to use special multipliers by checking the

Use special multiplier toggle on the Service Rate Maintenance window

(UB> Maintenance> Service Rate> General tab). This toggle allows you to

control the application of the special multipliers at the service rate level.

l Check the Multiply Flat by Special Multiplier toggle to multiply flat rates by a spe-

cial multiplier specified on each account. If the service rate is not set up as a flat
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amount, checking this toggle will multiply the special multiplier by the minimum

amount on the service rate.

l A special multiplier is added to an account in UB> Maintenance> Account>

Service Rates> Special Multiplier field.

l If there is a promotion amount set up on the account in UB> Maintenance>

Account> Service Rates> Promotion Amount field, the promotion amount

will be multiplied by the special multiplier if the Multiply Flat by Special Mul-

tiplier.

l Check the Bill finals with cycle toggle if Final Billings should be processed using

the New Billing process. If the Bill finals with cycle toggle is checked, accounts in

Final Status will bill in the New Billing process with the billing cycle.

l If the Bill finals with cycle toggle is not checked, final billing must be pro-

cessed in UB> Final Billing. Accounts that are in Final status will not be

included in New Billing batches when the billing cycle is processed.

4     Complete the Payment tab. 

l Select how partial payments should be distributed to bills in the Payment Priority

drop-down menu.

l Select Age then Priority to apply partial payments to the oldest debt first. If the

partial payment covers all of the old debts, then the partial payment will be

applied to the service with the highest priority that has the same age.
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l Select Priority then Age to apply payments to the service with the highest pay-

ment priority first.  Payments will be applied to the oldest debts within that ser-

vice first.

l Payment priorities are set up on each service (UB> Maintenance> Service>

Payment Priority field).

l Select how overpayments should be applied in the Overpayment Distribution

drop-down menu.

l Select Last Bill to apply overpayments to services based on the same per-

centages that were applied on previous bills. If you distribute overpayments

according to the previous bills on an account, enter the number of months that

will be used to calculate the average in the Number of History Months field.

l Select Fixed Percentages to manually specify what percentage of the over

payment will be applied to each service. The overpayment percentages are

set up on each service in the Overpayment Percentage field in UB> Main-

tenance> Service.

l Enter the Number of History Months you would like to include in the overpayment

distribution average if you selected Last Bill from the Overpayment Distribution

drop-down menu.

l Select the amount that should be debited from customer bank accounts in the Dir-

ect Debit Amount drop-down menu.

l Direct Debits are processed on UB customer accounts by attaching customer

bank account information to the accounts (UB> Maintenance> Accounts>

Account tab> ACH Information sub-tab). When UB New Billing batches are

committed that contain UB customer accounts with bank account information,

a Clearing House module Direct Debit batch can be generated on the UB New
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Billing batch in CH> Direct Debit> Generate Direct Debits. If payments or

charges are posted to the customer account after the New Billing batch has

been committed, the Direct Debit Amount drop-down menu allows you to

select how those transactions should be handled.

l Select Balance Immediately After Commit to debit the customer bank account

for the balance forward on the UB account directly after the billing was posted

to the UB account.

l Select this option if you do not want payments and charges posted to

the customer account after the billing has been committed to affect the

direct debit amount. This selection will debit the customer bank account

the balance forward that displays on the billing statement.

l Select Current Balance Forward to debit the current balance forward on a cus-

tomer account.

l The current balance forward will include any payments or charges pos-

ted after the billing batch was committed.

l Select Full Billing Amount to debit just the amount billed in the billing batch

selected during the Generate step.

l Select Lesser of Billing and Balance Forward to debit the lower at the time of

generating the direct debits.

l This option will debit the customer bank account the billed amount or

the current balance forward on the account if it is lower than the billed

amount. The current balance forward will include any payments or

charges posted after the billing batch was committed. If there are pay-

ments posted to the account after the bill is committed, the current bal-

ance forward on the account could be less than the billed amount.
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l The Redistribute Adjustment Type field is used to set up the redistribute credits

adjustment type code. This is the type code that will be used to redistribute credits

and will be attached to the adjustment transactions generated manually (UB>

Adjustments and Fees> Redistribute Credit Balances).

l Click the Redistribute Adjustment Type field label to select an adjustment

type from a list.

l The redistribute adjustment type code should not have any fee codes

attached and can either be set up as a Cash or Bill adjustment type (UB>

Maintenance> Adjustment Type Code> GL Type field).

l If the redistribute adjustment type is set up as a cash type, the following

journal entry will be created when credits are redistributed:

Description Debit Credit

AR account attached to credit balance ser-

vice (service with the balance being redis-

tributed)

XXX

Cash account attached to credit balance ser-

vice
XXX

AR account attached to debit balance ser-

vice (service with a debit balance being

increased by the redistribution of credits)

XXX

Cash account attached to debit balance ser-

vice
XXX
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l If the redistribute adjustment type is set up as a bill type, the following

journal entry will be created when credits are redistributed:

Description Debit Credit

AR account attached to credit balance ser-

vice (service with the balance being redis-

tributed)

XXX

Revenue account attached to credit balance

service
XXX

AR account attached to debit balance ser-

vice (service with a debit balance being

increased by the redistribution of credits)

XXX

Revenue account attached to debit balance

service
XXX

l The Automatically Redistribute Credits toggle has not yet been implemented.

5     Complete the Device tab. 

l The Route Format field is used to set up the format of digits that will be used to

identify a unique route sequence. Enter an “X” to add a digit to the format. The route

sequence cannot be greater than four alphanumeric characters long.
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l Routes are created and maintained in UB> Maintenance> Routes.

l The Sequence Format field is used to set up the format of the meter sequence num-

ber. Enter an “X” to add a digit to the format. The sequence number is limited to six

alphanumeric characters long.

l Select a Device Type from the drop-down menu. This is the device that will be used

when inputting an “Add Device” type service request.

l This default setting only works if the Device Maintenance toggle is

unchecked in UB> Utilities> Utility Billing Setup> General tab. If Device Main-

tenance is enabled, the Default Device Type toggle has no effect on the ser-

vice requests.

l Enter the number of Use Periods if you are using periods of use.

l Periods of use is used to set up multiple rate structures on service rates in

order to charge separate rates for peak and non-peak usage.

l TheWinter Average fields are used to enter the default winter average con-

sumption values for the Winter Averaging process. The default consumption value

will be applied to an account in the Winter Average process (UB> Winter Average>

Generate) if there are less than two readings on the account during the winter aver-

age period. For example, if the winter average amount is being calculated on con-

sumption from April to July but a new account has only one reading during that

period, the account will be billed the default winter average amount. The default

consumption amount will also be applied if the calculated winter average is greater

than a maximum amount set up during the Generate step (UB> Winter Average>

Generate> Maximum column). For example, if the calculated winter average is

1200, but the maximum amount is set at 1000, the default consumption amount will

be applied to the UB customer account.
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l When a Winter Average batch is being generated (UB> Winter Average> Gen-

erate), the default values can be modified either during the Generate step or

after the winter average has been calculated using the Winter Average tab on

the Account Master Maintenance window (UB> Maintenance> Account>

Winter Average).

l Enter the default winter average consumption amount in theWinter Average

1 field. Remember, this is a consumption amount (1000 units), not a billable

amount ($25). The value entered in this field will populate in the Default

column in UB> Winter Averaging> Generate when Winter Averages are gen-

erated and by default will be applied to customer accounts with less than two

meter readings during the calculated winter averaging period.

l TheWinter Average 2 – 6 fields only apply if you have multiple usage

periods. Usage periods are generally used to charge different rates for

peak and non-peak usage. If there is a number greater than 1 in the

Use Periods field, you are using usage periods. Enter a default winter

average consumption amount for each usage period field.

l Check the Enable Zero Padding toggle if you would like leading zeros to be added

to the meter route and meter sequence number when they are resequenced through

the Resequence Meters tool (UB> Meter Management> Resequence).

l The process will look to the format entered in the Route Format and

Sequence Format fields to the left to determine the required format and then

it will enter zeros before the value entered in the Route and Sequence on the

Device tab based on this format (UB> Maintenance> Account> Device tab>

Meter Details sub-tab> Modify Device icon > Connections tab> Route and

Sequence columns).
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l This toggle will not add leading zeros to route number and sequence inform-

ation entered on a service request. The toggle will only affect the Device tab

of the account maintenance window.

l Check the Multiply and Divide Reads Not Entered Via the Meter Management

Process toggle if you would like the system to calculate reading multipliers or read-

ing divisors on manual meter readings.

l When meter reads are processed through the standard Import Meter Reads

process, the system automatically uses any reading multipliers or reading

divisors that are set up on the device being read when calculating the total

meter read amount. When entering meter reads manually, by default these

multipliers and divisors are not included in the calculation. They will only be

included if this toggle is checked.

6 Complete the IVR tab. 

l The IVR tab is used to configure the interface between Springbrook and an Inter-

active Voice Response (IVR) system.

l The Batch Prefix field determines the first three digits of the five digit batch prefix

for the daily IVR-generated cash receipts batch. This number should be sufficiently

high enough to avoid conflicting with standard cash receipts batches created

throughout the normal course of the month.

l For example, if the three digits entered here are 789, the first batch gen-

erated by the IVR system in October of 2019 would be 78901.10.2019.
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l The Batch Name field is used to assign an easily recognizable name to the IVR

batches.

l For example, if your organization's IVR vendor is Selectron, you could use the

name "Selectron IVR."

l In order to use this feature, the system must be set up to use enhanced batch

security (SS> Utilities> System Setup> System tab> Use enhanced batch

security toggle).

l The Pay Method field is used to specify the default pay method that IVR customers

will use to pay fees online. Most users will set up a generic pay method, such as

"IVR", for all payments related to the IVR system.

l Pay methods are created and maintained on the Pay Method Maintenance

window (CR> Maintenance> Pay Method).

l The Charge Type Code field is used to assign a special charge type code to the

IVR transactions. Organizations can use this type code to track things like con-

venience fees that are charged to customers that use the IVR service.

l Type codes are created and maintained on the Type Code Maintenance win-

dow (CR> Maintenance> Type Code).

l The Cutoff Time field is used to set up the daily cutoff time of the IVR-generated

cash receipts batch.

l IVR transactions are processed in one batch per day. Transactions processed

after the IVR cutoff time will be included in the next day’s batch.

l The Delinquent Amount field is used to set up how the system calculates delin-

quent amounts associated with IVR transactions.

l Select Days to calculate delinquency based on the number of days the bill is

past due. The Number of Days field is then used to specify this value.
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l Select Prior Balance if any unpaid balance from a previous bill should be con-

sidered delinquent. When this option is selected, the Number of Days field

will be disabled.

l Click the Save icon when the setup is complete.

7     Track any changes made to the UB Setup window. 

l Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit trail.

l The Audit Trail History section will provide details about any changes made to the

setup window including the date of the change, type of change made, user that

made the change, and data table that was edited.
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UB> Utilities> Account Export

Account Export

Summary

The Account Export window is used to create an export file (MS Access or CSV) containing

Utility Billing customer, meter reading and/or transaction information. If you would like to

create an MS Excel spreadsheet of the exported information, create an MS Access data-

base using this process and then import the database information into an Excel spread-

sheet. (This process is described in a related document.) This allows you to apply query

filters to the information included in the MS Excel Export.

The Account Export window allows you to select which information will be included in the

export: customer information, meter information and financial information.

l The Customer information will always be included on the export. The customer information in

the export includes the address, deposit, refund, lot owner information, lot information, meter

information (but no meter readings), services and miscellaneous fields on the lot, customer,

owner and meter. The standard customer information also includes the balance forward, bill

this period, payment this period, current billing and ending balance.

l The reading history of meters attached to the customer accounts will be included on the

export if Meter History or Both is selected in the Include History drop- down menu. The

meter history will include reading, reading date, reading period, reading year, consumption

and meter read description.
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l The transaction history of customer accounts will be included in the export file if Financial His-

tory or Both is selected in the Include History drop-down menu. The financial history export

will include the batch and transaction information of all transactions for each customer in the

batch. The transaction history will not include the detail line items on the transaction.

The files created by this process contain the social security numbers of customers. You

can use the Menu Security feature (SS> Maintenance> Menu Security) to disable this

menu option on selected user accounts.

The export files are generated by the Account Export window rather than the server. This

means when you are creating the export file the application window will stall as the export

file is being generated.

Step by Step

1     Open the Account Export window (UB> Utilities> Account Export).

2     Select the information to be exported. 

l The Billing Cycles field is used to select the customer accounts that will be

included in the export. Check the toggles of the billing cycles you would like to

include.

ACCOUNT EXPORT 859



l The Account Statuses field is used to select the account statuses that will be

included in the export. Check the toggles of the account statuses you would like to

include.

l The Configuration drop-down menu is used to select a user-configured data export

file or to select the standard non-configurable data export.

l User-configured export files are created and maintained on the Export Con-

figuration Maintenance window (SS> Maintenance> Export Configuration).

l Click the Display Report Layout icon at the top of the window to display

the format of the file that will be created. This will open a window that displays

the fields included in the data export file, the length of each field and the pos-

ition of the field on the data export file.

l Select the format of the export file in the Layout drop-down menu.

l Select Export to MS Access 2003+ if you would like to create an MS Access

database of the exported information. Export the information to an MS Access

database. If you are using an earlier version of Access (prior to MS Access

2003), you may not be able to open the file generated by the Account Export

window.

l If you select this option, the MS Access database will contain the fin-

ancial and meter history tables but those tables will only contain data if

a selection is made in the Include History drop-down menu.

l Select the MS Access version that is installed on your workstation. If

you have a lower version of access than one of the options shown, you

may not be able to export the data. If you have a higher version than the

options shown, you should be able to export without any problem.
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l The MS Access database created by the export will create a database

with fie tables: TEMP-BALANCES, TEMP-FINANCIAL, TEMP-

MASTER, TEMP-METER and TEMP-METER-HIST.

l The TEMP-BALANCES table includes the balance information on each

customer account (for example, balance forward, balance due, pay-

ments in period, etc.).

l The TEMP-FINANCIAL table includes the transactions information of

the customer accounts included in the export. This table will always be

created but will only contain information if financial information is

included on the export.

l The TEMP-MASTER table includes the customer, lot and owner inform-

ation.

l The TEMP-METER table includes the meter information of the cus-

tomer accounts included in the export.

l The TEMP-METER-HIST table includes the meter readings on both

installed and removed meters attached to the customer account. This

table will always be created but it will only be populated with information

if financial information is included on the export.

l Select the ASCII CSV if you would like to export the information to an ASCII

file. The process will create three files regardless of the information you are

exporting. The MTR file will contain the meter history information, the FIN file

will contain the finance information and the MST file will contain the main cus-

tomer information.

l The CSV format will create six files: filename.csv, filename_2.csv, file-

name_3.csv, filename_3.csv, filename_4.csv, filename_5.csv,
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schema.ini. The “filename” will be replaced by the file name entered on

the Export Settings window below.

l The filename.csv file will display the customer, owner and lot inform-

ation.

l The filename_2.csv file will display the balance (balance forward,

billings this period, payments this period, etc.) of the customer accounts

included in the export.

l The filename_3.csv file will display the meter information.

l The filename_4.csv file will display the meter readings if they have been

included in the export. This file will always be created by the export pro-

cess, but it will only contain information if the meter readings have been

included in the export.

l The filename_5.csv file will display the transactions attached to the cus-

tomer accounts in the batch. This file will always be created by the

export process, but it will only contain information if financial trans-

actions have been included in the export.

l The schema.ini file displays the format of the columns included in the

export.

l Choose which information to export in the Include History field.

l Select the blank option if you would like to export the customer, winter aver-

age, lot and meter information.

l Select Meter History to include the meter history information in the export.
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l Select Financial History to include financial information in the export. If you

include the financial history in the export, the export file may take some time

to generate.

l Select Both if you would like to export meter history and financial history.

l The Reading Year field will only be enabled if meter read information is included on

the export file (if Meter or Both is selected in the Include History field). Enter the

meter read year of the meter readings you would like to include on the export.

l The Reading Year field will filter the meter readings by the year of the meter

read date, not the year of the meter read period. For example, if a meter read-

ing has a read date of 12/31/18, but a meter read period of 01/19, the meter

reading will only be included on the export if you enter 2018 in the Reading

Year field.

3     Create the export file. 

l Click the Confirm icon when complete to create the export file.

l You can view the progress of the export on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the export file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.
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l Enter the export path location and click the Save icon to export the file to

the local path.
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UB> Utilities> Add/Remove Bill Tos

Add/Remove Bill Tos

Summary

The Add/Remove Bill Tos tool is used to add or remove a bill to on a filtered set of UB

accounts. Bill Tos are associated with UB accounts on the Account Maintenance window

(UB> Maintenance> Account> People tab> Bill To sub-tab). This tool is often used when an

agency sets up a new Past Due notice and allows users to add or remove bill tos en masse,

eliminating the need to update each affected account individually.

Step by Step

l Open the Add/Remove Bill Tos window (UB> Utilities> Add/Remove Bill Tos).

l The Cycles field is used to select customer accounts based on the billing cycles attached to

those accounts.

l You can view the billing cycle attached to an account using the Account Maintenance

window (UB> Maintenance> Account> Account tab> Billing Cycle field).

l Use Select All or Deselect All icon drop-down menus to select or deselect all

the cycles in the field. This applies to the other filter fields as well.

l The Class field is used to select the customer accounts based on the class code attached to

those accounts.
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l You can view the class code attached to an account using the Account Maintenance

window (UB> Maintenance> Account> Lot tab> Class Code field).

l The Action drop-down menu is used to select the action you would like to perform.

l Select Add if you would like to add a bill to to the selected customer accounts.

l Select Remove if you would like to remove a bill to from the selected customer

accounts.

l The Affected Customer drop-down menu is used to determine which customer accounts

associated with the UB account will be affected.

l Select Owner if the bill to should be added to or removed from the owner associated

with the UB account. The owner account is specified in UB> Maintenance> Account>

Lot tab> Master Account field.

l Select Tenant if the bill to should be added to or removed from the tenant associated

with the UB account.

l Select Both to if the bill to should be added to or removed from both the owner and ten-

ant accounts.

l The Bill To field is used to specify which bill tos will be added or removed from the selected

customer accounts.

l Click the Confirm icon when complete to process the bill to changes.

l You can view the progress of the process using the Jobs Viewer window.
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UB> Utilities> Add/Remove Services

Add/Remove Services

Summary

The Add/Remove Services feature is used to add or remove a service and/or service rate

to a group of customer accounts. The service and/or service rate can be added or removed

to accounts based on:

l The services or service rates already on the accounts (for example, add a MISC service to all

customer accounts with a WATER service).

l The billing cycle attached to the customer accounts.

l The meter routes on the meters attached to the account.

The modifications made using this process will be applied to customer accounts of all

account statuses (active, final, suspended, vacation, delete).

CAUTION

If you are adding service rates to customer accounts and a customer already has that ser-

vice rate attached to their account, that service rate will be reactivated if it is already
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attached to the account. The final date on the service rate will be removed and a new con-

nection date will be assigned (UB> Maintenance> Account> Service Rate tab> Con-
nection Date and Final Date fields).

Step by Step

1     Select a service or service rate to add or remove from the customer accounts. 

l Open the Add/Remove Service window (UB> Utilities> Add/Remove Services).

l The Action drop-down menu is used to select the action you would like to perform.

l Select Add if you would like to add a service or service rate to the selected

customer accounts.

l Select Remove if you would like to remove the selected service or service

rates from the selected customer accounts.

l Select a Service from the drop-down menu. This is a required field.

l The service selected in this field will determine which service rates can be

selected in the Service Code field.

l Select a Service Code if you would like to add or remove a specific service rate

from the selected customer accounts.

l Click the Service Code field label to select a service rate from a list. The ser-

vice rates that display in the window depends on the service selected in the

Service drop-down menu.
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l If the service rate selected in this field is already attached to the accounts

updated by this process, the service rate will be reconnected (the final date

will be removed from the service rate and the service rate will become active

on the account).

l The Connect Date or Final Date field is used to enter the connection date or final

date of the service rates updated by the process. Services do not have a connection

date, so if you are only adding a service to the customer accounts, this field will

have no function.

l If you are adding a service rate to customer accounts, the Connection Date

field is used as the connection date of the service rate added to accounts. The

date you enter in this field will populate the Connect Date field in UB> Main-

tenance> Account> Service Rates tab> Select a service> Connect Date field.

l If you are removing a service rate from customer accounts, the Final Date

field is used as the final date on the service rate. The date you enter in this

field will populate the Final Date field in UB> Maintenance> Account> Service

Rates tab> Select a service> Final Date field.

2     Select which customer accounts you would like to modify. 

l The Filters section is used to select the customer accounts you would like to include

in the process. These are the customer accounts that the service and/or service

rate will be added to or removed from. Customer accounts that match all of the cri-

teria entered in this section will be included in the process.
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l Leave all of the fields in the Filters section blank if you would like to add the service

or service rate to all customer accounts in the Utility Billing module.

l The Services field is used to select customer accounts based on the services

already attached to the accounts.

l You can view the services attached to a customer account using the Account

Master Maintenance window (UB> Maintenance> Accounts> Service Rates

tab).

l The Service Rates field is used to select customer accounts based on the service

rates already attached to the accounts.

l You can view the service rates attached to a customer account using the

Account Master Maintenance window (UB> Maintenance> Accounts> Service

Rates).

l The Cycles field is used to select customer accounts based on the billing cycles

attached to those accounts.

l You can view the billing cycle attached to an account using the Account

Master Maintenance window (UB> Maintenance> Account> Account tab>

Billing Cycle field).

l The Routes field is used to select customer accounts based on the routes on the

meters attached to the accounts.

l You can view the route attached to a meter on an account using the Account

Master Maintenance window (UB> Maintenance> Account> Devices tab>

Meter Details sub-tab> Route – Sequence field).

3     Update the customer accounts. 
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l Before you run the process, you can take a screenshot (SHIFT+CTRL+Print

Screen) of the completed window before you commit the changes and save the

screenshot to a file. This will give you a record of the modification you made so you

can reverse the changes if necessary.

l Press ENTER or click the Confirm icon when complete to process the changes.

You can also add a date and time into the field next to the Confirm icon if you would

like the process to update at a later time.

l You can view the progress of the process using the Jobs Viewer window.
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UB> Utilities> Export Assistance
Accounts

Export UB Assistance Accounts

Summary

The Export Assistance Accounts tool is used to export a filtered set of data about the cat-

egory-based UB assistance program. The standard Assistance Account Export file

includes the Account Number, Start Month, Start Year, End Month, End Year, Total Con-

sumption, and Total Bill Amount values for the included accounts.

Step by Step

1     Open the Export Assistance Program Accounts window (UB> Utilities> Export Assist-

ance Accounts).

2     Select the information to be exported. 

l The Service Number field is used to select the UB services that will be included in

the export. Check the toggles of the services you would like to include.

l Services are created and maintained on the Service Maintenance window

(UB> Maintenance> Service).
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l The Device Types field is used to select the device types that will be included in the

export. Check the toggles of the device types you would like to include.

l Device Types are created and maintained on the Device Type Maintenance

windows (UB> Maintenance> Device Type).

l The Service Rates field is used to select the service rates that will be included in

the export. Check the toggles of the service rates you would like to include.

l Service Rates are created and maintained on the Service Rate Maintenance

window (UB> Maintenance> Service Rate).

l The Configuration drop-down menu is used to select a user-configured data export

file or to select the standard data export.

l User-configured export files are created and maintained on the Export Con-

figuration Maintenance window (SS> Maintenance> Export Configuration).

l Click the Display Report Layout icon at the top of the window to display

the format of the file that will be created. This will open a window that displays

the fields included in the data export file, the length of each field and the pos-

ition of the field on the data export file.

l Enter the Category or click the field label to select the UB assistance program cat-

egory from a list.

l Springbrook uses a user-specified UB category to control which accounts are

enrolled in the assistance program.

l Categories are created and maintained on the Category Maintenance window

(UB> Maintenance> Category).

l The Begin Date and End Date fields are used to filter the exported assistance

account data by a specified date range.
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l Check the Only report on selected Service Rates toggle to limit the consumption

and bill amount data included in the export to only the consumption and bill amount

data associated with the selected service rates in the Service Rates field to the left.

l Click the Create icon drop-down and select Add Account or Add Lot to generate

the export file for a specific set of UB accounts or lots. Only one of the Accounts or

Lots fields can be used for an export.

3     Create the export file. 

l Click the Confirm icon when complete to create the export file.

l You can view the progress of the export on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the export file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l Enter the export path location and click the Save icon to export the file to

the local path.
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UB> Utilities> Import Assistance
Accounts

Import UB Assistance Accounts

Summary

The Import Assistance Account tool is used to add accounts to or remove accounts from an

assistance program. Accounts are associated with an assistance program via a UB cat-

egory. If that category is present on the account, Springbrook recognizes that account as

being enrolled in the assistance program. If that category is not present on the account,

Springbrook recognizes that account as not being enrolled. This import tool will add or

remove that category from existing UB accounts.

Step by Step

1     Open the Import Assistance Accounts window (UB> Utilities> Import Assistance

Accounts).

2     Import the Assistance Accounts file. 
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l The Configuration drop-down menu is used to select the import configuration you

would like to use.

l An assistance account-specific import configuration can be created before

importing the accounts. Import configurations are created and maintained on

the Import Configuration Maintenance window (SS> Maintenance> Import

Configuration).

l The standard Springbrook configuration will be selected by default.

l Click the Display Report Layout icon to view the expected format of the

import file.

l The File Name field is used to select the path of the Assistance Accounts file you

would like to import into Springbrook. Enter a path or click the File Name field label

to locate the file by browsing through the file structure on your network.

l The Category field is used to specify the UB category that will signify the account is

enrolled in the assistance program. Click the field label to select a category from a

list.

l Categories are created and maintained on the Category Maintenance window

(UB> Maintenance> Category).

l If the specified category is already associated with an account included in the

import file, and that account is being added to the assistance program via the

import, a warning message will be displayed and that account will be skipped.

l If the specified category is not already associated with an account included in

the import file, and that account is being removed from the assistance pro-

gram via the import, a warning message will be displayed and that account

will be skipped.
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l If the specified category does not already exist in the system a warming mes-

sage will be displayed and the import will be terminated.

l Press ENTER or click the Confirm icon to import the file. You can view the pro-

gress of the import on the Job Viewer window (SS> Utilities> Show Scheduled

Jobs).
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UB> Utilities> Alert Works Export

Alert Works Export

Summary

The Alert Works Export window is used to export data from your Springbrook database to

Alertworks, Summation360's IVR notification system. The exported file will include Account

Number, Owner Name, Owner Phone, Tenant Name, Tenant Phone, Service Address,

Amount Due and Due Date. This data is often used to alert UB customers when their

account balance is past due.

Step by Step

1     Open the Alert Works Export window (UB> Utilities> Alert Works Export).

2     Configure the export file. 

l Select each Billing Cycle you would like to include in the export file.

l Press CTRL+A to select all billing cycles. With all billing cycles selected,

check or uncheck a toggle to apply the toggle selection to all of the billing

cycles.
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l Hold down SHIFT to select a range of billing cycles. When selecting a range

of billing cycles, make sure to click on the cycle number and not the toggle of

the cycle.

l The CTRL+A and SHIFT selection shortcuts can be used in all the fol-

lowing selection fields.

l Billing cycles are created and maintained on the Billing Cycle Maintenance

window (UB> Maintenance> Cycle Code).

l Select each Class you would like to include in the export file.

l Classes are user-defined groups that are attached to lots and used to group

accounts. Classes are attached to lots on the Lot Maintenance window (SS>

Maintenance> Lot> Lot tab> Details section> Class Code field).

l Classes are created and maintained on the Class Maintenance window (UB>

Maintenance> Class).

l Select each Zone you would like to include in the export file.

l Zones are user-defined codes that are used to group lots. Zones are attached

to lots on the Lot Maintenance window (SS> Maintenance> Lot> Lot tab>

Details section> Zone Code field).

l Zones are created and maintained on the Zone Maintenance window (UB>

Maintenance> Zone).

l Select each Subdivision you would like to include in the export file.

l Subdivisions are user-defined codes that are used to group lots. Subdivisions

are attached to lots on the Lot Maintenance window (SS> Maintenance> Lot>

Lot tab> Details section> Subdivision field).
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l Subdivisions are created and maintained on the Subdivision Maintenance win-

dow (SS> Maintenance> Subdivision).

l Select the Service Rates you would like to include on the export file.

l Service rates are attached to customer accounts and determine the

rate structure, winter average, taxes, bill type and prorating options of a

billing. Service rates are attached to UB accounts on the Accounts Main-

tenance window (UB> Maintenance> Account> Service Rates tab>

Create icon).

l Service Rates are created and maintained on the Service Rate Maintenance

window (UB> Maintenance> Service Rate).

l Select each Account Status for the UB accounts you would like to include in the

export file.

l The status associated with a UB account can be set on the UB Maintenance

window (UB> Maintenance> Account> Account tab> Account Status field).

l At least one account status must be selected in order to generate the export

file.

l The From Date and No of Days fields are used to filter the included accounts by

the number of days an account is past due on a specified date.

l For example, if you wanted to include all accounts that were at least 30 days

past due as of July 1st, 2019, you would enter 07/01/19 in the From Date field

and 30 in the No of Days field.

l A date must be specified in the From Date field.

l The Minimum Balance field is used to filter the included accounts by a minimum

balance.
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l The Tax ID From and Tax ID To fields are used to filter the included accounts by

the tax identification number associated with business UB accounts.

l Tax IDs are not directly associated with UB accounts. They are associated

with Springbrook Customer Numbers that are then attached to UB accounts

on the UB Account Maintenance window (UB> Maintenance> Account>

People tab> Customer Number field).

l The Street Name field is used to filter the included accounts by the street address

attached to the account.

l The Due Date field is used to specify a due date for the Alert Works generated noti-

fication.

l This is a required field.

l Click the Display File Layout icon at the top of the window to display the format

of the file that will be created. This will open a window that displays the fields

included in the export file.

l Click the Confirm icon when complete to create the export file.

l You can view the progress of the export on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

3     Export the file. 

l Once the export file has finished processing, the Export Settings window will open.

This window is used to specify the export path for the export file.
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l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l Enter the Full Path location and click the Export icon to export the file to the

local path.

l Once the export file has been created, it is ready to be used with the Alert Works

system.
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UB> Utilities> UB Defaults

Set UB Defaults

Summary

The UB Defaults window is used to set default values for new account wizard fields that

rarely change. By setting these defaults, the new account wizard will automatically pop-

ulate city, state and zip card information every time a new account is created.

Step by Step

1     Open the UB Defaults window (UB> Utilities> UB Defaults). 

l The UB Defaults window will display all of the existing default field values.

l The Item drop-down menu is used to specify which Utility Billing window the default

values will be assigned to. The New Account wizard is the only item currently avail-

able.

2     Set the default values. 
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l You are not required to specify a value for all of the displayed fields in order to save

the defaults.

l Enter the desired cities in the New Customer City and New Lot City fields.

l Enter the state in the New Customer State and New Lot State fields.

l The state code must be a valid two digit state abbreviation.

l Enter the zip code in the New Customer Zip and New Lot Zip fields.

l You can enter a partial zip code if desired, but the format must match the

standard XXXXX for a five digit zip code or XXXXX-XXXX for the ZIP+4

format.

l Click the Save icon when complete. The specified defaults will now auto-

matically populate the applicable fields on the window selected in the Item drop-

down menu above.
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UB> Utilities> Import Adjustments

Import Collections Adjustments from KVS

Summary

The Import Adjustments window is used to import KVS Collection Balance files into Spring-

brook. These files will update associated UB account information with the current account

balances that are maintained in the KVS system. These account balance amounts will be

imported as billing adjustments and will display as previous balances in the billing process.

This tool is designed for KVS users that would like to utilize Springbrook's UB Billing func-

tionality but must continue to use KVS UB Collections for processing taxes.

Step by Step

1     Open the Import Adjustments window (UB> Utilities> Import Adjustments).

2     Import the KVS collections adjustment file. 

IMPORT COLLECTIONS ADJUSTMENTS FROM KVS 885



l The File Name field is used to select the path of the Collection Balance file you

would like to import into Springbrook. Enter a path or click the File Name field label

to locate the file by browsing through the file structure on your network.

l Each account number included in the Collection Balance file must already

exist as a Springbrook UB account. If not, an error message will be displayed

and the import will fail.

l Click the Display Report Layout icon to view the expected format of the

import file.

l The Fee Code field is used to select the UB Fee Code that will charge the account

balance amounts associated with KVS accounts after importing the file to Spring-

brook. Enter a Fee Code or click the field label to select one from a list.

l The Service to Charge specified on the selected fee code must be an active

service on all the accounts included in the Collection Balance file. If not, an

error message will be displayed and the import will fail.

l Fee codes are created and maintained on the Fee Code Maintenance window

(UB> Maintenance> Fee Code).

l The Tran Date field is used to specify a transaction date that will be associated with

the account balance adjustment transactions created when the Collection Balance

file is imported. This will default to today's date.

l Imported transactions will be assigned a post-date prior to the last billing date. This

ensures the balance displays as a previous balance on the billing statement.

l Press ENTER or click the Confirm icon to import the file immediately or enter a

date and time in the field next to the Confirm icon to schedule the import to process

at a later time. You can view the progress of the import on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).
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UB> Utilities> Modify Account Number

Modify Account Number

Summary

The Modify Account Number window allows you to move a UB customer account to an

existing customer record. If there are already UB customer accounts attached to the selec-

ted customer record, a new sequence number will be created on that customer record. For

example, if you move UB customer account 000915-001 to customer record 000001, the

UB customer account will be assigned number 000001-002 if UB customer account

000001-001 already exists.

You cannot move a UB customer account to a customer record that does not exist. You will

have to create the customer record (Customer icon> INSERT) before you move the UB cus-

tomer account.

Step by Step

1     Open the Modify Account Number window (UB> Utilities> Modify Account Number).

2     Complete the Modify Options section. 
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l The Old Account Number field is used to enter the old UB customer account num-

ber that you would like to change. Click the Old Account Number field label to select

UB customer account.

l The UB customer account information will populate in the window after you enter

the UB customer account number.

l Enter the new customer number in the New Customer Number field or click the

New Customer Number field label to select a customer record from a list. The cus-

tomer record selected in this field is the customer record that the UB customer

account will be moved to.

l The customer name attached to the customer record selected in the New Cus-

tomer field will populate in the Name field after the new customer record is selec-

ted.

l Press ENTER when complete to move the UB customer account to the selected cus-

tomer record.
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UB> Utilities> Pad Meter Sequences

Pad Meter Sequence

Summary

The Pad Meter Sequence window is used to modify and pad meter sequence numbers. 

For example, if a meter sequence is 0005, 0010, 0015 and 0020, you can use the Pad

Meter Sequence window to change the sequence to 0010, 0020, 0030 and 0040.

The Pad Meter Sequence window is also used to move meters to a new route. For

example, if a meter route has become large and a portion of the route should be split into a

new route, use the Pad Meter Sequence window to move some of the meters to a new

route. If all meters on a route with a sequence number greater than 0100 should be moved

to a new route, enter the new route number in the New Route field and enter 0100 in the
Start Sequence field. The meters will be moved to the new route when the Pad Meter

Sequences process is complete.

If you would like to view the meters attached to a specific meter route, generate a Detailed

Meter Information report for a specific meter route.

Step by Step

1     Open the Pad Meter Sequences window (UB> Utilities> Pad Meter Sequences).
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2     Complete the Settings section.

l The Routes field is used to select the routes that will be padded or split.

l Select only one route if a route should be split.

l The Pad By field is used to define the amount of the pad sequence.

l For example, if a meter sequence is 0005, 0010, 0015 and 0020, enter 10 in

the Pad By field to change the sequence to 0010, 0020, 0030 and 0040.

l The Start sequence field is used to define the beginning number of the route

sequence.

l If the Split route toggle is not checked, the Start sequence field defines what

sequence number you would like to begin the padding. For example, if you

enter 0100, all meters with a sequence number greater or equal to this num-

ber will be padded with the padding value entered in the Pad by field.

l If the Split route toggle is checked, the Start sequence field defines the

meters that will be moved to a new route. For example, if you enter 0950 in

this field, all meters with a sequence equal to or greater than this sequence

number will be moved from the route selected in the Routes field to the route

number entered in the New Route field.

l Check the Split route toggle if you would like to split the route selected in the

Routes field.

l The Split route toggle will be enabled if only one meter route is selected in the

Routes field.
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l Enter a route number in the New route field if you are splitting a route. The route

number entered in this field is the route number of the route that will be created

when the route is split.

l You cannot enter the route number of a route that has already been created.

l Press ENTER to pad the meter sequences or split the route immediately, or enter a

date and time in the field next to the Confirm icon to schedule the meters to be

processed at a later time.

l You can view the progress of a scheduled job from the Jobs Viewer window

(Jobs Viewer icon from the main desktop).
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UB> Utilities> Statement Setup

Statement Setup

Summary

The Statement Setup window is used to create and maintain New Billing, Final Billing and

Past Due statements. Once statements have been created they can be selected during the

Statements step of the New Billing, Final Billing and Past Due palettes and printed out for

the UB customer accounts in the batch.

A statement is basically a set of customizations (title text, return address, hours of oper-

ation, message lines, logo display, etc.) done to a standard billing or Past Dues statement.

You can create as many statements as you would like based on the standard reports.

Step by Step

1     Open the Statement Setup Selection window (UB> Utilities> Statement Setup). 

l The Statement Setup Selection window will display all of the statements that have

been created, including inactive statements.

l Highlight a statement and press DELETE to delete the selected statement.
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l If you do not want the statement available for use, but you do not want to

delete the statement, change the status of the statement to inactive. Inactive

statements will not display in the Statement drop-down menu on the State-

ment step of the New Billing, Final Billing, or Past Dues process.

l Statements are set up as inactive by removing the check from the Act-

ive Statement toggle in UB> Utilities> Statement Setup> Select a state-

ment> General tab.

l Highlight a statement and press ENTER to open an existing statement.

l Press INSERT to create a new statement. This will open the Statement Setup Main-

tenance window.

2     Create a new statement. 

l The Statement Name field will automatically populate with the statement name

associated with the file selected in the File Name drop-down menu. This is not an

editable field.

l Enter a name for the statement in the Report Name field. The report name will be

used to select the statement from drop-down menus, so make sure it is named

something you can easily recognize and differentiate from other statements.

l The Report Name field can be up to 25 characters long.

l Select the report you would like to customize in the File Name drop-down menu.

l The report selected in the field will determine which fields are enabled in the

window.
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l The Title Line fields display at the top of the past due statements and most billing

statements. Many organizations enter their organization name and address in these

fields.

l The Title Line fields can be up to 50 alphanumeric characters long.

l The Title Line fields will not display on the four to a page, three to a page, or

standard billing statements.

l The Hours of Operation, Checks Payable To and Phone Number fields will only

display on certain statements.

l The Hours of Operation field is generally used to add the hours of operation to

a statement. For example, “Monday through Friday 8:30 AM to 6:00 PM.”

l The Checks Payable To field is generally used to enter the name of the organ-

ization checks should be made out to. For example, “Make Checks Payable

To: Springbrook Software.”

l When this field is populated, the statement will include a

"MAKE CHECKS PAYABLE TO:" message. If this field is not populated,

the message will not be displayed.

l The Phone Number field is generally used to add a customer service number

to a statement. For example, “Customer Service: 1-800-999-9999.

l Enter a zip code in the Return Address Zip Barcode field if you would like a bar-

code of the zip code to be added to the statement. This will display in addition to the

return address zip code entered on address line three or four. If this field is left

empty, the zip code will not display as a barcode on the statement.

l The Return Address Line fields are used to enter the return address of you organ-

ization.
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l These fields will display on the z-fold, full page, full page detail and state-

ments.

l Check the Active Statement toggle if the statement is an active statement.

l Only active statements will be available for use when printing statements in

New Billing, Final Billing, and Past Dues. If the Active Statement toggle is not

checked the statement will not display in the Statement drop-down menu in

the Statement step of the New Billing, Final Billing and Past Dues process.

l You can have only one active statement for each statement selected in the

Report Name drop-down menu.

l Check the Add To New Accounts toggle if this statement should be added to new

UB customer accounts when they are created using the New Account Wizard.

l When the Use meter cons multiplier and divisor on consumption toggle is

checked, the system will use the consumption multiplier and consumption divisor

values associated with the device type when calculating the consumption that will

display on the statement.

3     Complete the Messages tab. 

l The Message Line fields are used to enter messages on a statement.

l Select a message that has already been created or manually enter a new mes-

sage in a Message Line field.

l Be aware of space limitations when creating statements that print more

than one to a page, such as Past Due Statements 3 and 4. If too many
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characters are entered in the Message Line fields, these statements will

not print properly.

l For example, a single Message Line field on Past Due Statement 3 can

accommodate up to 500 characters. However, if you intend to use all six

Message Fields, you should limit each field to approximately 100 char-

acters in order to maintain the intended formatting.

l Click on a Message Line field label to select a message from a list. Messages

are created and maintained on the Statement Message Maintenance window

(UB> Maintenance> Statement Message).

l Message statements that are manually entered into the Message Line fields

will not be available in UB> Maintenance> Statement Message.

4     Complete the Billing Options tab. 

l Complete the Preferences section of the tab.

l Choose a Pre-Sorted Box option from the drop-down menu.

l The City, State, Zip Code, and Permit Number fields will only be

enabled, and can only be added to the statement, after selecting Yes

from the Pre-Sorted Box drop-down menu.

l Select Yes from the Display Payment Message drop-down menu to include

the payment message on the statement.

l Enter a Payment Message if you have selected Yes in the Display Pay-

ment Message field. This message will replace the default "Payments
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Received" message that appears on the statements.

l The Additional Date Label field is used to add an optional, custom-labeled

additional date field to the New Billing and Final Billing Statement Settings

step. This date field can be customized to meet the specific needs of your

organization.

l By default, this field will be empty. A value must be specified in order to

enable the related field in the New and Final Billing processes.

l This field is only enabled when setting up a standard, full-page billing

statement.

l The Exclude Payment Plan Details field is used to specify how payment

plan details are displayed on the standard, full-page billing statement.

l By default, this field is set to "No" and billing statements will display the

next four installment plan details for payment plan accounts set up to

display on the statement.

l Payment plans are set up to display on the billing statements by

checking the Print on statement toggle on the UB Account win-

dow (UB> Maintenance> Account> Account tab> Payment Plan

Maintenance section).

l Select Yes to exclude those details and to enable the Payment Plan

Message field below. This field can then be used to specify a more gen-

eric payment plan message that will display on the billing statement.

The Payment Plan Message field will populate with a default message

that can be customized to meet your organization's needs.

l Select Yes in the Use Past Due Threshold field if you would like the state-

ment to include an Account Past Due indicator. This indicator will only display
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if the beginning balance on the account minus the payments made during the

current period are greater than the value entered in the Past Due Threshold

field below.

l If Yes is selected in the Use Past Due Threshold field, the Past Due

Threshold field will be enabled. Enter the past due value that must be

exceeded in order to display the Account Past Due value on the state-

ment.

l When generating final bills, please be aware that the Final Bill

indicator WILL be displayed on the statement and the Amount

Past Due indicator WILL NOT be displayed on the statement even

if the past due threshold conditions are met.

l If No is selected in the Use Past Due Threshold field, the Past Due

Threshold field will not be enabled. No is selected by default.

l Check the Address Service Requested toggle if you would like “Address

Service Requested” to display at the top of all of the billing statements.

l Complete the Display Options section of the tab.

l The selections made in this section will determine what is displayed on the

statement.

l Check the Summary Charges toggle to display a single total amount for all

current charges on each service.

l If this toggle is not checked, the statement will display the details of

each charge for all services.

l Check the Logo toggle to include the logo on the statements. The logo image

is set up on the System Setup window (SS> Utilities> System Setup> Organ-

ization tab> Logo field).
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l Do not use the logo option if you have specified a Title, Hours of Oper-

ation and Phone Number on the General tab. These items occupy the

same space as the logo and could result in overlapping if both are dis-

played.

l Check the Tenant Copy toggle to display "Tenant Copy" in red on the top-

right corner of the billing statement for all copies sent to the tenant associated

with the account.

l Check the Owner Copy toggle to display "Owner Copy" in red on the top-right

corner of the billing statement for all copies sent to the owner associated with

the account.

l Check the Duplicate Copy toggle to display "Copy" in red on the top-right

corner of the billing statement for all copies requested by the customer.

l Check the Deposits (Applied) toggle to display any deposits applied to the

total amount due.

l This toggle will only apply to Final bills that include a refund amount.

l Check the Total Days In Period toggles to include this billing information on

the Account Information section of the statement.

l Check the CR Barcode toggle to display a barcode on the statement stub that

contains the customer's account number and total amount due. This barcode

is used to scan information into the Cash Receipts module.

l Check the CR Barcode - Balance Due When Scanned toggle to set the

statement barcode to display the current balance due when scanned in Cash

Receipts.

l The Additional Billings With Current Charges toggle determines how

billings applied to a customer account after a New or Final billing will be
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addressed.

l Check this toggle to include these additional billing amounts and

descriptions in the Current Charges section of the billing statement.

l If this toggle is not checked, all additional billings will be excluded from

the current charges, totaled, and then displayed in the Additional Billing

section of the Bill Summary.

l Check the Adjustment Details toggle if you would like to group adjustments

made during the billing period by adjustment type description and to display

each adjustment type description separately.

l When this toggle is NOT checked, all adjustments made during the

billing period will be displayed in the Bill Summary section on full-page

billing statements.

l This toggle will only be active on full-page billing statements.

l Check the Budget Billing Amounts toggle if you would like to include budget

billing values on the statement.

l When checked, the Budget Current Charges value will display in the Bill

Summary section of the statement.

l Check the Display Deferred Amounts toggle if you would like to include

monthly and total deferred amounts on the statement.

l When checked, the Deferred Amount and Total Deferred Amount val-

ues will display in the Bill Summary section of the statement.

l This toggle will only be enabled if the Budget Billing Amounts toggle is

checked above.
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l Check the Bill-To Message toggle if you would like the message entered on

the Bill To sub-tab of the Account Master Maintenance window to display on

the statement (UB> Maintenance> Account> Open an account> People tab>

Bill To sub-tab> Message column).

l This message will be displayed under the Special Message section of

the statement.

l Check the Final Message toggle to display "Final Bill" under the "Amount

Enclosed" section of the stub.

l Check the Auto Pay Message toggle if you would like an auto pay message

to display on billing statements. The auto pay message will only display on the

statement if there is bank account information entered on the UB customer

account on the Account Master Maintenance window (UB> Maintenance>

Account> Open an account> Account tab> ACH sub-tab). Since payment will

be received from these customer accounts through the Direct Debits process

(CH> Direct Debits), the statements will display as paid.

l Check the Reference Number toggle to include the reference number on the

generated billing statement.

l This display option cannot be used on any of the "4 to a page" state-

ments.

l Check the Hide Service Period toggle to generate the statement without

included the Service Period information at the top.

l Check the Period Dates as Meter Read Dates toggle to display the meter

read dates as the period dates at the top of the statement.

l When this toggle is checked, and if reads are conducted on the 10th of

each month, the Service Period line on the statement will display those
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read dates as the beginning and ending of the service period even if the

actual service period is different. For example:

Service Period: 8/10/2021 to 9/10/2021 (31 Days)

l If the account does not include a prior read date, the period begin date

and the newest read date will be used.

l If the account includes more than one read date, the oldest prior read

date and the newest read date will be used.

l If the does not include any read dates, the period begin date and period

end date will be used.

5     Complete the Consumption Graphs tab. 

l This tab is used to configure the consumption graphs included on the billing state-

ment.

l The Display Consumption Graphs drop-down menu is used to specify if the billing

statements will display zero, one or two consumption graphs.

l If you do not wish to display consumption graphs on your billing statements,

simply select None and save the billing statement to complete the statement

setup process.

l Consumption graphs will display up to eight digits of total consumption. In the

event that the displayed consumption amount exceeds eight digits, the

amount will appear in full on the statement but it will truncated on the graph.
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l The Graph One Title and Graph Two Title fields are used to enter the title that will

appear above the graphs when the billing statement is generated.

l These fields will only be enabled if Single Graph or Two Graphs is selected in

the Display Consumption Graphs drop-down above.

l Graph titles are limited to 10 alphanumeric characters.

l The Reduction Percent field is used to provide a consumption reduction target,

often related to drought-related water reduction initiatives.

l The Comparison Date From and Comparison Date To fields are used to set a

comparison date range that will the reduction percents specified above will be com-

pared to.

l The Graph One Bill Types and Graph Two Bill Types fields are used to specify

what data will be displayed in the graphs.

6     Complete the Meter Display tab. 

l The Meter Display Options drop-down field is used to specify how the billing, read-

ing, and consumption data will display on the statement.

l The first drop-down option is the default meter display. If no selection is

made, that is the option that will be used when generating the statement.

l The Meter Display Options field will not display when setting up a 4-to-a-page

billing statement.

l Check the Meter Info toggle if you would like the meter information included on the

statement. This will include the read data, consumption value, and serial number of
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a meter attached to the account. If no meter information is generated, for example,

on a flat fee customer, this toggle can be left unchecked.

l Check the Meter Changeouts toggle to display both the Active meter and the

Removed meter if the meter was removed within the billing cycle.

l Check the Estimated Read Flag toggle to display an "E" next to the any meter with

an estimated read in the Meter Readings section of the statement.

7     Complete the Past Due Options tab. 

l Enter a Statement Heading for the new statement. The statement heading will dis-

play below the Title Lines near the top of the printed statements. Past Due Notice or

Shut Off Notice are examples of common statement headings.

l The Statement Heading field can be up to 25 characters long.

l The Display Beginning Balance field is used to select which balance will display

on the past due statement.

l Select Past Due Amount if you would only like to display the past due amount

on the statement.

l Select Balance Forward if you would like to display the entire balance forward

on the statement.

l The Stub Location field is used to determine whether the returnable statement

stub will be printed at the top or the bottom of the past due statement.

l The Display Options section allows you to configure the way the Past Due state-

ment is displayed. The Past Due statement type - 1, 2,3, or 4 - selected in the File
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Name field on the General tab will determine which of these display toggles are

enabled.

l Check the Additional Charges toggle if you would like the penalties generated dur-

ing the Past Dues process to display on the statement. For example, if $15.00 worth

of past dues penalties were generated on the customer account during the Past

Dues process, check this toggle to display those charges as a separate line item on

the statement.

l Check the Auto-pay toggle to include an auto-pay indicator on the statement if the

account is signed up for auto-pay. If the account is not signed up for auto-pay, this

toggle will have no effect.

l Check the CR Barcode toggle to display a barcode on the statement stub that con-

tains the customer's account number and total amount due. This barcode is used to

scan information into the Cash Receipts module.

l Check the CR Barcode - Balance Due When Scanned toggle to set the statement

barcode to display the current balance due when scanned in Cash Receipts.

l Check the Logo toggle to include the logo on the statements. The logo image is set

up on the System Setup window (SS> Utilities> System Setup> Organization tab>

Logo field).

l Do not use the logo option if you have specified a Title, Hours of Operation

and Phone Number on the General tab. These items occupy the same space

as the logo and could result in overlapping if both are displayed.

l Check the Service Period toggle to include the service period on the statement.

l Check the Total Due toggle if you would like the total due amount to display on the

statement.

STATEMENT SETUP 905



l Check the Include Aged Balances on Statement toggle to generate a Past Due

statement that will include a past dues table that displays past due balances that are

0-30, 31-60, 61-90, 91-120, and 120+ days old.

l Check the Reference Number toggle to include the reference number on the gen-

erated past due statement.

l This display option cannot be used on any of the "4 to a page" statements.

l Press ENTER or click the Save icon when complete to save the statement

setup.

8     Complete the OCR Scanline tab.

l The OCR Scanline tab is used to configure the OCR scanline values to meet indi-

vidual bank requirements. This scanline is used to scan information into the Cash

Receipts module.

l This tab will only display when configuring the UB Billing Statement and Past

Due Statement 2 statements.

l Check the OCR Scanline toggle to enable the other fields and toggles on the tab.

l The Number of digits for Amount field is used to specify the number of digits that

will display for the account total amount within the OCR scanline.

l This value will default to 8.

l The Left, Top, Height, andWidth fields are used to adjust the location of the scan

line.
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l While negative numbers are allowed when adjusting the size, the Height

value cannot be reduced beyond -0.14.

l The maximum value for each of these fields is 100.00.

l Check the Do not calculate check digit toggle to omit the calculated check digit

that appears at the end of the OCR scanline.

l Press ENTER or click the Save icon when complete to save the statement

setup.
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UB> Utilities> Synchronize Web
Payments

Synchronize Web Payments

Summary

The Synchronize Web Payments tool is used to synchronize auto payment settings

between the Utility Billing module in the enterprise application and the Web Payments

online application. This tool replaces a similar custom tool available in previous versions.

Before this synchronization tool can be used, you will need to export the Web Payments

Profile Report in .csv format from the My Organization tab of the Web Payments site.

Step by Step

1     Open the Synchronize Web Payments window (UB> Utilities> Synchronize Web Pay-

ments).

2     Import the synchronization file. 
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l Enter a File Name or click the field label to browse to the desired file.

l This import file is the Profile Report .csv file that was previously exported from

the Web Payments site.

l Click the File Layout icon to view the expected file format of the .csv file.

l Once you have browsed to the Profile Report .csv file, click the Confirm icon to

import the file and begin the synchronization.

l The tool will now roll through all the UB accounts associated with the Web Pay-

ments accounts on the import file. It will compare the Auto pay activated column on

each Web Payments account to the Reoccurring Web Payments flag on the related

UB customer account.

l If the Auto pay activated column reads "Yes", the system will confirm that the

associated UB account is set to "Reoccurring Web Payments = True." If the

Auto pay activated column reads "No", the system will confirm that the asso-

ciated UB account is set to "Reoccurring Web Payments = False."

l Once the synchronization is complete, an information window will display a sum-

mary of the accounts that were updated.
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UB> Utilities> Import Bill To

Import Bill To

Summary

The Bill To Import process is used to help clients meet California SB-998 requirements

regarding shut-off notices. According to the bill, if the customer’s address is not the

address of the property to which residential service is provided, the notice also shall be

sent to the address of the property to which residential service is provided, addressed to

“Occupant.” The import tool uses a user-created .csv file to efficiently add bill to customer

accounts to existing UB accounts. This customer account/UB account situation is most

commonly encountered when the bill to is not the same as the account owner, such as in a

tenant/landlord situation.

Note: This import process creates a new Springbrook Customer Number for every cus-

tomer included in the file. There is no duplicate customer validation. If a customer included

in the file is already associated with a Springbrook Customer Number, that customer will be

associated with an additional Springbrook Customer Number after importing.

Step by Step

1     Open the Import Bill To window (UB> Utilities> Import Bill To).

2     Import the bill to customer file. 
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l The Statement field is used to select the billing or past due statement that will be

associated with the new bill to record on the UB account.

l The File Name field is used to select the path of the bill to customer file you would

like to import into Springbrook. Enter a path or click the File Name field label to loc-

ate the file by browsing through the file structure on your network.

l Each line item in the imported file will create a new row on the Bill To sub-tab

of the People tab of the UB Account Maintenance window. This new row will

include the customer details in the import file and will be associated with a

new Springbrook Customer Number.

l The import file must include the UB Account Number, Customer Last Name,

and Customer Address, City, State, and ZIP Code. The First Name, Descrip-

tion, and Address 2 fields are optional.

l Click the Display Report Layout icon to view the expected format of the

import file.

l Press ENTER or click the Confirm icon to import the file immediately or enter a

date and time in the field next to the Confirm icon to schedule the import to process

at a later time. You can view the progress of the import on the Job Viewer window

(SS> Utilities> Show Scheduled Jobs).

l After successfully importing the bill to customer file, a message will provide inform-

ation about which customer numbers were created.
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UB> Utilities> Import Comments

Import UB Comments

Summary

The Import Comments tool is used to import comment data that is associated with existing

UB accounts. The standard format comma delimited file will import Account Number, Com-

ment Status, and Comment Date data.

Step by Step

1     Open the Import Comments window (UB> Utilities> Import Comments).

2     Import the Comments file. 

l The Configuration drop-down menu is used to select the import configuration you

would like to use.

l A comment-specific import configuration can be created before importing com-

ments. Import configurations are created and maintained on the Import Con-

figuration Maintenance window (SS> Maintenance> Import Configuration).
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l When creating a comment import configuration, Comment Date and

Comment Code must be included in the import configuration properties.

l The standard Springbrook configuration will be selected by default.

l Click the Display Report Layout icon to view the expected format of the

import file.

l The File Name field is used to select the path of the Comments file you would like to

import into Springbrook. Enter a path or click the File Name field label to locate the

file by browsing through the file structure on your network.

l Each Account Number included in the Comments file must already exist as a

Springbrook UB Account and each Comment Status included in the file must

already exist as a Springbrook Account Status. If an import line item does not

meet these requirements, the line item will be skipped and that information

will be displayed in the Jobs Viewer.

l Press ENTER or click the Confirm icon to import the file. You can view the pro-

gress of the import on the Job Viewer window (SS> Utilities> Show Scheduled

Jobs).
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UB Module

Open an Exported Access Database in MS Excel

Summary

If you created an MS Access database using the Account Export window (UB> Utilities>

Account Export), you can create an MS Excel spreadsheet of the MS Access database.

Some customers use this feature to create customized reports in MS Excel using the data

exported into the MS Access database. You can also skip this step and create a report

using the MS Access database created from the Account Export window.

Step by Step

1     Open a blank MS Excel spreadsheet and select Data> Import External Data> New Database
Query. 

l This will open the Choose Data Source window.

2     Select the MS Access database you created in the Account Export window. 
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l Select MS Access Database as your Data Source and click OK. This will open the

Query Wizard window.

3     Select the fields to include in the MS Excel spreadsheet you are creating. 

l The Query Wizard window allows you to choose which data elements to include on

the MS Excel spreadsheet.

l Click on the plus sign next to a folder in the Available table and columns section to

display the fields that are available to include in the columns on your report.

l Double click on a field to move it over to the Columns in your Query section. You

can select fields from any of the tables displayed.

l If you selected data from only one table the Query Wizard will open. If you have

selected data from more than one table, skip to step 5 of the process.

l If you import data from more than one table, you will have to set up a rela-

tionship between the information that was selected. For example, if you

include meter and customer information on the spreadsheet, you will have to

create a relationship that links the customer information to the meter inform-

ation. If you do not link the information together, the information will display on

the spreadsheet in a random order. For example, the meters attached to

account 000001-000 will display attached to account 000007-000. You can

establish a relationship between the meter table and the customer table using

the UB customer number since that field is included on both tables. Defining

this relationship will ensure that the information displays correctly on the

report.
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4     Import data into a spreadsheet from one database table. 

l If you want to filter the data from the database before you enter it into the spread-

sheet, highlight a field you want to filter the data by in the Column to Filter section.

l After you have highlighted a field in the Column to Filter section, a field in the

Only include rows where section will become enabled.

l Select an argument qualifier (ends with, does not equal, etc.) to filter the

report by from the drop-down menu. This will enable another field in the win-

dow to enter the rest of the argument.

l If you want to add more than one qualifier argument to a field, select the AND

or OR toggle.

l If you want to filter by more than one field, select another field in the Column

to filter field and follow the process above.

l Click the Next button when complete. This will open the Sort Order window.

l Select the fields to sort by in the drop-down menus to sort the data. You can also

sort the data after it has been entered into the spreadsheet.

l Click the Next button when complete. This will open the Finish window.

l Click the Finish button to create the Excel spreadsheet with the data you have selec-

ted. This will open the Import Data window.

l The Import Data window is used to select which cell you would like to begin import-

ing data into the spreadsheet. Select the upper left corner of the area you would like

to import the data into and click the OK button.
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5     If you selected data frommore than one table you will have to establish a relationship between the
data included on the spreadsheet. 

l If you select data from more than one table, the tables will have to be linked

together in order to define which records in the tables are related and should be dis-

played on the same rows of the Excel spreadsheet.

l An error message will display informing you that you must join the selected tables

together using a program called Microsoft Query.

l Click OK. This will automatically open the Microsoft Query window.

l Find the field or fields in each table that are needed to link the data from one table to

the other table, and create a relationship between those fields. Relationships are

established by dragging and dropping a field from one table to another. For

example, highlight and drag the Customer Number field from the Master table to

the Customer Number field on the Meter table to establish a relationship between

the two tables.

l The Customer Number and Customer Sequence fields are in every table

on the database and can be used to link the any or all of the tables together.

When creating a relationship between tables, you should use both the Cus-

tomer Number and Customer Sequence Number.  If a customer included on

the report has more than one customer sequence number (for example,

000001-000, and 000001-001), that customer’s information will only display

correctly on the spreadsheet if you create relationships using both the Cus-

tomer Number and Customer Sequence fields.

l Create a filter in the Microsoft Query window if you would like to filter the data before

exporting the MS Access database to an MS Excel spreadsheet.
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l Click on the icon. This will open the Criteria section in the middle of the win-

dow.

l Click in the first Criteria Field cell, and select the field you would like to filter

the export by. You can resize the columns in order to read the entire field

name.

l The naming convention of the fields is: table. field.

l For example, if you would like to filter the report by transaction type,

select Financial.Transaction-Type from the drop-down menu.

l Double click in the Value cell to enter the filter argument. This will open the

Edit Criteria window.

l Enter an Operator and a Value to create an argument to filter the export by.

l Click on the Values button to see all values available for this field.

l The filter argument in the screen shot above will allow data with a trans-

action type of billing to be exported to the MS Excel spreadsheet you

are creating.

l Click File and Save or Save As to save your query. This could be helpful if you

plan on importing the same data in order to create customized period reports.

l Enter a query name and click the SAVE button.

l This will return you to the Microsoft Query window. If you have entered all the

desired filters and you are ready to export the data to your MS Excel spread-

sheet, select File and Return data to Microsoft Excel Spreadsheet. This will

open the Import Data window.

l The Import Data window is used to select which cell you would like to begin

importing the data into the spreadsheet. Select the upper left corner of the
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area you would like to import data into and click the OK button. This will pop-

ulate the data into your spreadsheet.
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UB Module

Set up Winter Averaging

Summary

The Winter Averaging process is used to calculate an average consumption for UB cus-

tomer accounts based on the billed consumption during selected billing periods. When bills

are generated in the New Billing process (UB> New Billing), the calculated average is billed

instead of the actual consumption.

In order to use the Winter Average process, you must set up the winter average months on

the service rates and select how the Winter Average process will function on the UB Setup

window (UB> Utilities> Setup).

Step by Step

1     Set up the service rates to use in winter averaging. 

l The billing periods that will be used in the winter averaging process need to be set

up on the service rates. For example, if UB customer accounts should be billed the

calculated winter average from November to February, those months need to be set
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up on the service rates.

l Open the Service Rate Maintenance window of a service rate you would like to set

up for the winter averaging process. For example, if GAS service rate 001 should be

billed using a calculated winter average during the winter months, open the Service

Rate Maintenance window for service rate 001.

l When opening a service rate, make sure to select the revision that applies if

there are multiple revisions.

l Open the Winter Average/Taxes tab.

l Select the periods that should be billed using the calculated winter average rather

than the actual consumption. For example, if the calculated winter average should

be billed rather than actual consumption from November to February, check each

month between November and February. The consumption on the meters during

the billing periods selected will not be included on a billing, and customers will be

billed using the Winter Average amounts. If a winter average has not been set up on

a customer account with this service rate, only the minimum/flat rate on the service

rate will be charged.

l Check the Multiply Consumption toggle if you would like the calculated winter

average consumption to be multiplied by the EDU on the meter or the number of

units on the lot when a billing is generated (UB> New Billing). The winter average

consumption will be multiplied by the EDU/Lot Unit value before the service rate

structure is applied to the consumption when the billing is calculated. For example,

if the EDU is 1.1 and the calculated winter average consumption is 200, the winter

average consumption will be multiplied by the EDU (220). The rate structure on the

service rate will then be applied to the new consumption amount (220).
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l If the Use Lot Units toggle is not checked, the calculated winter average will

be multiplied by the EDU value on the meter (UB> Maintenance> Account>

Devices> Connections tab> EDU column). If the Use Lot Units toggle is

checked, the calculated winter average will be multiplied by the number of

units on the lot.

l Check the Cap Consumption toggle to bill the lesser amount of the actual bill or

average consumption.

l When a New Billing is generated, if the actual consumption is less than the cal-

culated winter average amount, the customer will be billed the actual con-

sumption amount. If the actual consumption is greater than the calculated

winter average, the customer will be billed the winter average amount as

usual.

l Click the Save icon at the top of the Service Rate Maintenance window when

complete.

2     Set up the Utility Billing module to process Winter Averages. 

l Open the General tab on the Setup window (UB> Utilities> Setup).

l Check the Copy Winter Averages toggle if you want the effective winter average

attached to a meter to copy onto a new meter when a change-out service request is

processed.

l When the change-out service request is created, the winter average cal-

culation on the changed meter will be copied onto the new meter. The copied
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winter average will not be committed, so you can open the Winter Average tab

on the Account Master Maintenance window (UB> Maintenance> Account>

Winter Average) and modify the winter average calculation on the meter.

When the change-out service request is committed (UB> Service Request>

Commit), the winter average line item will also be committed.

l Checking this toggle will not copy the winter average from a finaled account to

the new account on a lot.

l Check the Allow Finals to Use Winter Average toggle if you would like to bill UB

customer accounts using a calculated winter average. This only applies to accounts

finaled during a winter average billing period and processed in a Winter Average

batch.

l If this toggle is not checked, the customer accounts will be billed using the

actual consumption even if the account is being finaled during a winter aver-

age period.

l Open the Device tab.

l TheWinter Average fields are used to enter the default consumption amount

for the Winter Averaging process. The default value will be applied to an

account in the Winter Average process (UB> Winter Average> Generate) if

there are less than two readings on the account during the winter average

period. For example, if the winter average amount is being calculated on con-

sumption from April to July but a new account has only one reading during

that period, the account will be billed the default winter average amount.

l When a Winter Average batch is being generated (UB> Winter Average> Gen-

erate), the default consumption amount can be modified either during the Gen-

erate step or after the winter average has been calculated using the Winter
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Average tab on the Account Master Maintenance window (UB> Maintenance>

Account> Winter Average).

l Enter the default winter average value in theWinter Average 1 field. Remem-

ber, this is a consumption amount (1000 units), not a billable amount ($25).

The value entered in this field will populate in the Default column in UB>

Winter Averaging> Generate when Winter Averages are generated and by

default will be applied to customer accounts with less than two meter readings

during the calculated winter averaging period.

l TheWinter Average 2 – 6 fields only apply if you have multiple usage

periods. Usage periods are generally used to charge different rates for

peak and non-peak usage. If there is a number greater than 1 in the

Use Periods field, you are using usage periods. Enter a default winter

average consumption amount for each usage period field.
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UB> Winter Averaging

Winter Averaging

Summary

The Winter Averaging process is used to calculate an average consumption for UB cus-

tomer accounts based on previous consumption. The previous consumption included in the

winter average calculation is selected using meter read periods and meter reading dates.

Depending on how the service rates attached to the UB customer accounts are set up, the

calculated average consumption is billed instead of the actual consumption when bills are

generated in the New Billing process (UB> New Billing). The calculated winter average will

only replace the billable consumption on the customer account. The minimum and tax

amounts attached to service rates on the customer account will bill as usual, but the con-

sumption will be using the calculated winter average consumption amount.

Winter averages can only be calculated on Active and Suspended status accounts. You

cannot calculate a winter average on Vacation, Delete or Final status UB customer

accounts. Before you use the Winter Average process, make sure you set up the UB mod-

ule and service rates to use the winter average process.

Springbrook users generally use the Winter Averaging process in two ways:

l Calculate a winter average on accounts based on consumption during the fall months. The

calculated winter average is then applied to accounts during the winter months.
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l If sewer usage is calculated based on water usage, some Springbrook users apply a summer

sewer average so that customers are not charged a higher sewer rate based on increased

water usage during the summer months. An average is calculated on spring water usage,

and then the average is applied to the sewer service rates during the summer months.

The Winter Average process calculates the winter average consumption amount using the

prior meter readings on a device. The prior meter readings that should be included in the

winter average calculation are selected during the Generate step (UB> Winter Average>

Generate). The meter readings are selected by meter read period and meter read date.

Only meter readings of both the selected meter period and meter read date will be included

in the winter average calculation. For example, a meter reading with a read date of

06/15/2021 and a read period of 05 will only be included in the winter average calculation if

both read period 05 and read date of 06/15/2021 are selected. If only the read date or the

read period is selected, the meter reading will not be included in the winter average cal-

culation.

Organizations can also use Percentage Based Cons Levels functionality to encourage or

discourage consumption that exceeds the winter average levels. This is enabled via the

Percent Based On field on the General tab of the Service Rate Maintenance window.

Prior meter readings on a device attached to other customer accounts will not be included

in the winter average calculation. For example, if a new customer moves into a lot, the

meter readings attached to the previous resident on the lot will not affect the winter aver-

age calculation of the new customer.
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The billed status of a meter read does not affect whether it will be included in the winter

average calculation. The winter average calculation treats billed and unbilled readings the

same. For example, if you would like to include unbilled readings in the winter average cal-

culation, just select the read period and read date of the unbilled readings in the Generate

step (UB> Winter Average> Generate).

There is an option on the Generate step (UB> Winter Average> Generate) that allows you

to include the meter readings of removed meters in the winter average calculation. This

option allows you to include the meter readings of meters that have been removed or

changed-out in the winter average. The meter readings on the removed meter will have to

pass the same meter read period and meter read date filter that is applied to the other

meter readings. For example, if a meter has been changed-out, the meter readings of that

meter will only be included in the winter average if the Use Removed Meters toggle is
checked (UB> Winter Average> Generate) and those meter readings occurred during the

selected read period and read date range. If the meter readings are from a previous

account on the lot, the meter readings will not be included in the winter average calculation.

After the winter average has been calculated using the Generate step, the calculated

winter average can be modified using the Winter Average tab on the Account Master Main-

tenance window (UB> Maintenance> Account). Once the Winter Average batch is com-

mitted, the calculated winter average consumption amount will be used instead of the

actual consumption during each billing period set up as a winter average period on the ser-

vice rate (UB> Maintenance> Service Rate> Winter Average / Taxes tab).

Before you use the Winter Average process, make sure you set up the UB module and ser-

vice rates.
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Step by Step

1     Create a newWinter Averages batch. 

l Select Winter Average in UB> Winter Average. This will expand the Winter Average

palette and display the steps of the Winter Average process.

l Select New from the Winter Averaging batch number drop-down menu to create a

new batch. This will open the New Batch window.

l If there are open batches in the Winter Averaging process, you can create a

new batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The effective date of the winter average cal-

culated in the Winter Average process is set up in the Generate step (UB> Winter

Average> Generate> Effective Date field).

l Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and

clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the New Billing palette

and press DELETE to delete a batch. Any uncommitted billing transactions gen-

erated in the batch will be deleted.

2     Generate the winter averages. 
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l The Generate step is used to generate the calculated winter average amount. The

Generate step is where you set up how the winter average will be calculated and

which meter readings will be included in the calculation.

l Select the Generate from the Winter Averaging palette. This will open the Generate

window.

l Select the meter readings to include in the winter average calculation. Meter read-

ings are included in the winter average calculation if both the read date and read

period of the reading are selected. For example, if a meter read has a read date of

06/15/2021, but a read period of 05, the meter reading will only be included in the

winter average calculation if the read date and read period are included. If there are

prior readings on a meter that are attached to the previous UB customer account on

the lot, those meter readings will not be included in the winter average calculation.

For example, if a customer moves into a new lot, the meter readings on the previous

customer on that lot will not affect the calculated winter average on the new cus-

tomer.

l The Periods field is used to select the meter reading periods that will be

included in the winter average calculation. Check the meter reading periods

you would like to include in the winter average calculation.

l The Consumption From and Consumption To fields are used to select the

meter reading dates you would like to include in the winter average cal-

culation. For example, if you would like to include meter readings with a read

date between 04/01/2021 to 06/30/2021, enter those dates in the Con-

sumption From and Consumption To fields.
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l A meter readings will only be included if the winter average calculation if both

the meter read date and meter read period are selected in the Generate win-

dow.

l The Bill Types field is used to select the meters you would like to generate a winter

average on. Winter averages will only be calculated on meters that are attached to

the selected bill types. If a meter is attached to a bill type that is not selected in the

Bill Types field, no winter average will be calculated.

l You can view the bill type attached to a device using the Device Maintenance

window (UB> Maintenance> Device> Meter tab> Device Type section> Bill

Type field).

l The Cycles field is used to select which UB customer accounts you would like to

include in the Winter Average batch. Check the toggles of the billing cycles you

would like to include. Final and Vacation status customer accounts in selected

billing cycles will not be processed in the Winter Average batch.

l Billing cycles are created in UB> Maintenance> Cycle Code and attached to

accounts on the Account tab of the account maintenance window (UB> Main-

tenance> Account> Account tab).

l Enter an Effective Date. The effective date is the date the calculated winter aver-

age will take effect. Billing batches generated with a period begin date after the

effective date will bill the calculated winter average rather than the actual billing

amount on the account.

l If there are multiple winter averages that apply to a UB customer account in

the same billing period, only the most recent average will apply. For example,

if there is a winter average with an effective date of 11/15/2021 and the

account has a previous winter average, a billing that begins on 11/01/2021
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will only use the winter average with the effective date of 11/15/2021. The

winter average will not be prorated on the billing. The billing will apply the

entire 11/15/2021 winter average amount.

l Use the Rounding drop-down menu to select how you would like the winter aver-

age calculation to be rounded.

l Select Off if you would like to round the calculated winter average to the

nearest consumption unit using standard rounding. For example, if the cal-

culated winter average is 100.5, it will be rounded up to 101. If the winter aver-

age is 100.40, it will be rounded down to 100.

l Select Up if you would always like to round the calculated winter average up

to the nearest whole consumption unit. For example, if the calculated winter

average is 100.1, it will be rounded up to 101.

l Select Down if you would always like to round the calculated winter average

down to the nearest whole consumption unit. For example, if the calculated

winter average is 100.9, it will round down to 100.

l Select Nearest Ten if you would like to round the calculated winter average to

the nearest ten digits using standard rounding. For example, if a calculated

winter average in 105.00, it will be rounded up to 110. If the calculated winter

average is 104.99, it will be rounded down to 100.

l The Average drop-down menu is used to select how the winter average will be cal-

culated.

l Select Monthly Average to divide the consumption by the number of months

selected (i.e. if the months of November through April are selected and there

are only three meter readings periods within this period of time, the con-

sumption will still be divided by six).
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l Select Period Average to divide the total consumption by the number of peri-

ods with the meter reads selected (i.e. if the months of November through

April are selected but there are only three meter reading periods within the

months selected, then the total consumption would be divided by 3).

l This option is generally used by organizations that do not bill every

month.

l Select User Defined to enable an edit box and input a value of your choice to

divide the consumption by.

l This will enable the User Defined Amt field below. This field is used to

specify a value that will be the divisor for the total consumption on the

account.

l Check the Exclude partial reads toggle to exclude consumption amounts based

on a meter reading not included in the winter average.

l Assume you are creating a winter average that begins in the month of Novem-

ber. If a device has a reading in October, and November, the consumption cal-

culated on the November reading depends on the October reading. For

example, if the October reading is 100, and the November reading is 250, the

November consumption is 150 based on the October reading. If you check the

Exclude partial reads toggle, the November reading will not be included in the

winter average.

l If there are two meter readings in the month of November (for example,

a meter reading from a Read Meter service request), then the later

meter reading will be included in the winter average even if the Exclude

partial reads toggle is checked. The reading will be included because

the consumption on that reading is dependent on a reading included in
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the winter average. For example, if a device is read on 11/05/2021 with

a consumption of 200, and on 11/15/2021 with a consumption of 35, the

reading on 11/15/2021 will be included in the winter average because

the consumption is calculated based on a reading included in the winter

average.

l Check the Use removed meters toggle to include the meter readings of meters that

have been removed or changed-out in the winter average.

l The meter readings on the removed meter will have to pass the same meter

read period and meter read date filter that is applied to the other meter read-

ings.

l The Defaults section is used to set up the minimum and maximum winter average

values and modify the default winter average amount. The values entered in these

fields will affect the calculated winter averages.

l The value in the Default column is the winter average that will apply if a UB

customer account has less than two readings during the selected meter read

dates and periods.

l The value in the Default column can be modified in this window, but it

populates based on the value entered in the Winter Average fields on

the Setup window (UB> Utilities Setup> Device tab>Winter Average

1-6 fields).

l If the calculated winter average is greater than the value in the Maximum

field, the maximum amount will replace the calculated winter average. For

example, if the calculated winter average is 135 and the maximum amount is

100, the UB customer account will be assigned the maximum amount of 100.
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l If the winter average is assigned the maximum value, an information

line will display on the Exceptions step (UB> Winter Average> Excep-

tions).

l If the calculated winter average is below the value entered in the Minimum

column but above zero, the minimum amount will replace the calculated

winter average. For example, if the calculated winter average is 50 and the

minimum amount is 100, the UB customer account will be assigned the min-

imum amount of 100.

l If the winter average is assigned the minimum value, an information line

will display on the Exceptions step (UB> Winter Average> Exceptions).

l If the calculated winter average is zero, the system will replace the calculated

amount with the value in the Default column.

l The number of rows that will display in the Defaults section is the number of

usage periods. Usage periods are generally used to separate consumption

into peak and non-peak usage. If the Utility Billing module is not set up to use

multiple usage periods, there will only be one row labeled “Period 1.” The

column is labeled “Period 1” because all consumption is applied to usage

period one. This does mean that the default, minimum, and maximum values

entered in the Defaults section will only be applied to period one of the winter

average.

l If you are set up to use multiple periods of use, enter a default, minimum, and

maximum amount for each usage period.

l Click the Confirm icon to calculate the winter averages immediately or enter a

date and time in the field next to the Confirm icon to schedule the winter averages to

generate at a later time.
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l You can view the progress of the process on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

l When the Generate step is complete, you will be able to open the Exceptions

window and generate the Winter Average Proof List.

3     View the exceptions generated on the batch. This is an optional step. 

l The Exceptions step is an optional step that displays the errors and information mes-

sages generated by the Generate step.

l Open the Exceptions window (UB> Winter Average> Exceptions).

l The Exceptions window will display all of the error and information messages gen-

erated during the Generate step.

l The Exceptions window will display an information message each time a calculated

winter average is greater than the maximum set up on the Generate step (UB>

Winter Average> Generate> Defaults section> Maximum column). If the calculated

winter average is greater than the maximum, the maximum amount will be assigned

to the UB customer account.

l The Exceptions window will also display an information message each time a cal-

culated winter average is less than the minimum amount set up on the Generate

step (UB> Winter Average> Generate> Defaults section> Minimum column). If the

calculated winter average is less than the minimum amount, the minimum amount

will be assigned to the UB customer account.
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l The Exceptions window will display an information message for each UB customer

account included in the batch with less than two meter readings during the selected

meter read periods and meter read dates. These UB customer accounts will be

assigned the default winter average amount.

l The Exceptions window will not display an information or error message if there are

Final or Vacation status UB customer accounts in the billing cycles selected during

the Generate step (UB> Winter Average> Generate> Cycles field).

4     Print a proof list of the Winter Average batch. 

l Print a proof list to see the calculated winter averages once the Generate step is

complete.

l You can also view the calculated winter averages from Winter Average tab of

the Account Master Maintenance window (UB> Maintenance> Account>

Winter Average).

l Select Proof List from the Winter Average palette. This will open the Proof List win-

dow.

l The Winter Average Proof List can be printed in detailed or summary format.

l The summary format will display the total consumption included in the winter

average calculation, the number of reads, and the calculated winter average

for each UB customer account included in the Winter Average batch.

l The detail format will display the consumption included in each month of the

winter average calculation, the customer account information, and the
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calculated winter average.

l If you check the Include average for the date range toggle, the report

will also include a date range average value and indicate which months

or periods contribute to the winter average value.

l Select the version of the report you would like to generate.

l Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Modify the winter average using the Account Master Maintenance window. This is an optional
step. 
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l The Winter Average tab can be used to modify the calculated winter average on the

UB customer accounts included in the Winter Average batch. You will not be able to

modify the winter average on the customer accounts after the Winter Average batch

has been committed.

6     Commit the Winter Average batch. 

l Before committing the batch make sure that you have already made all of the modi-

fications to the calculated winter averages on the accounts. Once the Winter Aver-

age batch is committed, you cannot make modifications to the winter average from

the Account Master Maintenance window. You will have to generate a new winter

average batch.

l Select the Commit from the Winter Average palette.

l Click the OK button to commit the batch.

l Committing a winter average will not create a history line item on the customer

accounts (UB> Maintenance> Account> History tab). The winter average will only

display on the Winter Average tab of the Account Master Maintenance window (UB>

Maintenance> Account> Winter Average).
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